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1.  Copyright Notice
© Copyright 2022 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.
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JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com

1.1.  Third party license information

This product includes curl.

      COPYRIGHT AND PERMISSION NOTICE

      Copyright (c) 1996 - 2020, Daniel Stenberg, <daniel@haxx.se>, and many
      contributors, see the THANKS file.

      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
    
------------------------------------------------------------

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.
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    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes QtCopyDialog.
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      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------

This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------
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This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes svgio.

 Copyright Oleg Maximenko 2014.
 Distributed under the Boost Software License, Version 1.0.
    
------------------------------------------------------------

This product includes QtSvg.

      The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes appleseed.
The MIT License (MIT)

Copyright (c) 2010-2013 Francois Beaune, Jupiter Jazz Limited
Copyright (c) 2014-2019 The appleseedhq Organization

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
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The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
    
------------------------------------------------------------

This product includes bcd.
        
    Copyright (c) 2017 Malik Boughida and Tamy Boubekeur. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors
   may be used to endorse or promote products derived from this software
   without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You are under no obligation whatsoever to provide any bug fixes, patches, or
upgrades to the features, functionality or performance of the source code
("Enhancements") to anyone; however, if you choose to make your Enhancements
available either publicly, or directly to the authors of this software, without
imposing a separate written license agreement for such Enhancements, then you
hereby grant the following license: a non-exclusive, royalty-free perpetual
license to install, use, modify, prepare derivative works, incorporate into
other computer software, distribute, and sublicense such enhancements or
derivative works thereof, in binary and source code form.
    
------------------------------------------------------------

This product includes glad.

        The MIT License (MIT)

Copyright (c) 2013-2018 David Herberth

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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------------------------------------------------------------

This product includes murmurhash3.
MurmurHash3 was written by Austin Appleby, and is placed in the public domain. The author
 hereby disclaims copyright to this source code.
------------------------------------------------------------

This product includes zlib.

 (C) 1995-2022 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2020 The Botan Authors
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are met:

      1. Redistributions of source code must retain the above copyright notice,
        this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions, and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
    
------------------------------------------------------------

This product includes pugixml.

      MIT License

      Copyright (c) 2006-2019 Arseny Kapoulkine

      Permission is hereby granted, free of charge, to any person
      obtaining a copy of this software and associated documentation
      files (the "Software"), to deal in the Software without
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      restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the
      Software is furnished to do so, subject to the following
      conditions:

      The above copyright notice and this permission notice shall be
      included in all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
      EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
      OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
      HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
      WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
      FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
      OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products 
  derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version:  7.0

Copyright (C) 1999-2007  Brian Paul   All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.
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Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.
  
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes tesseract.

  Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes robin-map.

    MIT License

    Copyright (c) 2017 Tessil

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in all
    copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
    SOFTWARE. 
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes cereal.

    Copyright (c) 2013-2022, Randolph Voorhies, Shane Grant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:
        * Redistributions of source code must retain the above copyright
          notice, this list of conditions and the following disclaimer.
        * Redistributions in binary form must reproduce the above copyright
          notice, this list of conditions and the following disclaimer in the
          documentation and/or other materials provided with the distribution.
        * Neither the name of the copyright holder nor the
          names of its contributors may be used to endorse or promote products
          derived from this software without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY
    DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
    ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
      
      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.

      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
 THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
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 NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
 ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes llvm.

      University of Illinois/NCSA
      Open Source License

      Copyright (c) 2003-2019 University of Illinois at Urbana-Champaign.
      All rights reserved.

      Developed by:

          LLVM Team

          University of Illinois at Urbana-Champaign

          http://llvm.org

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal with
      the Software without restriction, including without limitation the rights to
      use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
      of the Software, and to permit persons to whom the Software is furnished to do
      so, subject to the following conditions:

          * Redistributions of source code must retain the above copyright notice,
            this list of conditions and the following disclaimers.

          * Redistributions in binary form must reproduce the above copyright notice,
            this list of conditions and the following disclaimers in the
            documentation and/or other materials provided with the distribution.

          * Neither the names of the LLVM Team, University of Illinois at
            Urbana-Champaign, nor the names of its contributors may be used to
            endorse or promote products derived from this Software without specific
            prior written permission.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS WITH THE
      SOFTWARE.
    
------------------------------------------------------------

This product includes OpenSSL.
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      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
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      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes xxHash.

    xxHash Library
    Copyright (c) 2012-2014, Yann Collet
    All rights reserved.

    Redistribution and use in source and binary forms, with or without modification,
    are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this
    list of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
    list of conditions and the following disclaimer in the documentation and/or
    other materials provided with the distribution.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
    ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes lz4.

        Copyright (C) 2011-present, Yann Collet.

        BSD 2-Clause License (http://www.opensource.org/licenses/bsd-license.php)

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:

            * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
            * Redistributions in binary form must reproduce the above
        copyright notice, this list of conditions and the following disclaimer
        in the documentation and/or other materials provided with the
        distribution.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.

      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in the
      Software without restriction, including without limitation the rights to use,
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      copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XByak.
   
Copyright (c) 2007 MITSUNARI Shigeo
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
Neither the name of the copyright owner nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
-----------------------------------------------------------------------------
#######################################
#######################

#######################################
#######
#######################################
##########################
#######################################
###################################
#######################################
#######################################
######################################
########################### ###########
#######################################
######################################
######################################
#######################################
######################################
################
    
------------------------------------------------------------

This product includes ittnotify.
   
Copyright (c) 2011, Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
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   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes PCRE.

  Copyright (c) 1997-2016 University of Cambridge
  All rights reserved.

  Copyright(c) 2010-2016 Zoltan Herczeg
  All rights reserved.

  Copyright(c) 2009-2016 Zoltan Herczeg
  All rights reserved.

  Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions are met:

      * Redistributions of source code must retain the above copyright notice,
        this list of conditions and the following disclaimer.

      * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      * Neither the name of the University of Cambridge nor the names of any
        contributors may be used to endorse or promote products derived from this
        software without specific prior written permission.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
  AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
  LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
  SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
  INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
  CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
  ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
  POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Little CMS.

    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell

25



1 DeskPack Advanced

    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes OpenShadingLanguage.

BSD 3-Clause License

Copyright (c) 2009-2019 Sony Pictures Imageworks Inc., et al.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes leptonica.

 -  Copyright (C) 2001-2016 Leptonica.  All rights reserved.
 -
 -  Redistribution and use in source and binary forms, with or without
 -  modification, are permitted provided that the following conditions
 -  are met:
 -  1. Redistributions of source code must retain the above copyright
 -     notice, this list of conditions and the following disclaimer.
 -  2. Redistributions in binary form must reproduce the above
 -     copyright notice, this list of conditions and the following
 -     disclaimer in the documentation and/or other materials
 -     provided with the distribution.
 -
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 -  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 -  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 -  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 -  A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL ANY
 -  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
 -  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 -  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 -  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
 -  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 -  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 -  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes OpenImageIO.
    
        BSD 3-Clause License

Copyright (c) 2008-present by Contributors to the OpenImageIO project. All Rights
 Reserved.

Redistribution and use in source and binary forms, with or without modification, are
 permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
 conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
 conditions and the following disclaimer in the documentation and/or other materials
 provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to
 endorse or promote products derived from this software without specific prior written
 permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
 OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
 SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
 INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJDK.
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The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".

Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
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you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)

The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
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source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
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If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.
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You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes tessdata.

 Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
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      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes openexr.

      Copyright Contributors to the OpenEXR Project. All rights reserved.

      Redistribution and use in source and binary forms, with or without modification,
 are permitted provided that the following conditions are met:

          * Redistributions of source code must retain the above copyright notice, this
 list of conditions and the following disclaimer.

          * Redistributions in binary form must reproduce the above copyright notice,
 this list of conditions and the following disclaimer 
            in the documentation and/or other materials provided with the distribution.

          * Neither the name of the copyright holder nor the names of its contributors
 may be used to endorse or promote products derived from this software 
            without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
 DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS 
      BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
      GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
 CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
 THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
    
------------------------------------------------------------

This product includes ZXing C++ Library.

      --------------------------------------------------------------------------------
      NOTICES FOR C++ Big Integer Library
      --------------------------------------------------------------------------------

      I, Matt McCutchen, the sole author of the original Big Integer
      Library, waive my copyright to it, placing it in the public domain.
      The library comes with absolutely no warranty.
  
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
    
------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
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------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2020
 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------
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2.  About DeskPack Advanced
The ‘DeskPack Advanced for Illustrator’ bundle offers essential prepress functionality: adding
barcodes, do preflighting, remap image channels, adding white underprint, trap your files, adding
screening… Everything needed to make packaging artwork "ready to print".

It combines the following plug-ins:

• Data Exchange on page 36 (Free)

• Adobe Illustrator Client on page 101

• boostX on page 133

• Channel Mapping on page 161

• Color Engine on page 171

• DeskPack Trapper on page 176

• Dynamic Barcodes on page 197

• Dynamic Marks on page 287

• Dynamic VDP on page 325

• Image Extractor on page 363

• Instant Trapper on page 390

• PDF Import on page 404

• PowerLayout Client on page 412

• PowerTrapper Client on page 428

• Preflight on page 446

• Screening on page 472

• Shuttle on page 476

• Text Recognition on page 505

• Viewer on page 509

• White Underprint on page 537
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3.  Data Exchange

3.1.  Introduction to Data Exchange

The Esko Data Exchange plug-in for Adobe Illustrator combines several plug-ins into one package for
easier installation. The combined plug-ins are:

• The PDF Export Plug-In on page 36
• The Ink Manager Plug-in on page 45
• The Structural Design Plug-in on page 63
• The Page Box Plug-in on page 83
• The Inspection Setup Plug-In on page 88
• Messages on page 91
• Esko Document Setup on page 93
• Annotations on page 94

3.1.1.  Data Exchange Preferences

The option Update XMP on Document Savedefines if the document’s XMP data is updated when the
document is saved  in the .AI format or as Adobe PDF with preserved Illustrator editing capabilities.

The option can be found in Illustrator > Preferences > Esko and is turned on by default. Deselecting
this option results in slightly faster document saves.

3.2.  The PDF Export Plug-In

3.2.1.  Introduction

The PDF Export plug-in allows you to directly export your Illustrator files to Normalized PDF or to PDF+,
depending on the setting in the Ink Manager: see Normalized PDF or PDF+ on page 45

3.2.2.  Saving a File as Normalized PDF or PDF+

To save your Illustrator file as Normalized PDF or PDF+ using PDF Export:

1. Go to File > Export... > Export As...
2. In the dialog that opens, choose your file’s name and location, and choose the Esko PDF (pdf)

format.
3. Click Export.
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4. In the PDF Export Settings dialog that opens, fill in the export settings (see PDF Export Settings on
page 37).

5. Click OK to export the file.

3.2.3.  PDF Export Settings

When exporting your files to Normalized PDF or PDF+ format, you need to set the PDF Export Settings.
The settings are different when exporting Normalized PDF (left) or PDF+ (right), and depend on the
setting in the Ink Manager. See Normalized PDF or PDF+ on page 45

 

 

Preset
Using Presets you can store and reuse the settings for the PDF Export dialog.

You can save the current settings as a Preset by selecting Save... and entering a name. The location for
the Presets is defined in the PDF Export Preferences. See PDF Export Preferences on page 44

You can load a Preset by selecting it in the dropdown.

If you set the Preset to Default, the parameters as set in the PDF Export Preferences will be used. See
PDF Export Preferences on page 44.

If the current settings are not saved as a setting, the Preset dropdown will show "Custom".
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Images and Linked Files (only for Normalized PDF)
1. In the Images and Linked Files group, choose to either Embed Images in the Normalized PDF, or

Save Links to the images.

• If you choose to embed the images, you don’t have any more preferences to fill in and you can
just click OK.

Note:  This doesn’t save the images’ link information (except for linked ArtiosCAD
graphics, see Linked ArtiosCAD Graphics for Normalized PDF export on page 45).

• If you choose to use linked images, fill in the other preferences of the dialog.
2. Enable Add Preview (max 72 DPI) if you want your Normalized PDF to have a low resolution preview

of the linked images.

This preview allows you to view the linked images when opening your file for example in Acrobat.
3. Choose where to copy the linked images:

• Choose Copy Images Next To Output File to copy them next to the folder in which you will save
the Normalized PDF (so other applications like ArtPro or PackEdge can still open them when the
links are broken).

• Choose Use Links And Apply Server Mapping to keep the images where they are but update the
links (for example if the images are in a shared folder located on a different machine).

4. When choosing Use Links And Apply Server Mapping, fill in a Server Mapping if the share names on
the client machine and on the other server do not match.
a) When checked, Copy Links If Not On File Servers verifies if linked images are already on file

servers and if they are not, copies them along with the exported Normalized PDF file. Choosing
this option also enables the File Servers... button where you add the machines that store linked
images so that Esko workflow servers can find them.

For more information, see OPI and Server Mapping (only for Normalized PDF) on page 38

OPI and Server Mapping (only for Normalized PDF)
When you click the OPI and Server Mapping Settings button, either in the PDF Export Settings or in
the PDF Export Preferences, the OPI and Server Mapping dialog appears:
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Note:

This dialog is available only when you have chosen to Save Links in exported Normalized PDF
files. When you export a Normalized PDF, OPI Mapping is applied first and then Server Mapping.

Servers
The top pane of the dialog configures Server Mappings. You need to use Server Mappings when the
Normalized PDF you output:

• has linked images that are located on a different machine (file server),

• will be used on another machine (not your local machine or the file server).

Server Mappings allow you to map the image links from one share name to another automatically
on output. This ensures that the links are not broken when the Normalized PDF is used on another
machine.

For example:

• the linked images are saved on a file server called “Server”, in a shared folder called “Images”,

• your copy of Illustrator with PDF Export is on a Mac, and the shared folder containing the images
is mounted as “Hi-Res_Images”.

• the Normalized PDF you export will be used on a PC, where the shared folder containing the
images is mounted as “Shared_Images”.
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The link to an image called “My_Image.psd” is “Server/Hi-Res_Images/My_Image.psd” on
the Mac, and should be “\\Server\Shared_Images\My_Image.psd” on the PC.

When adding the Server Mapping in the OPI And Server Mapping dialog, you should enter the Share
Details as follows by:

• name of the file server in Server Name,

• name of the shared folder containing the images as seen from your local Mac in Local Share,

• name of the shared folder containing the images as seen from the other PC in Server Share.
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Note:

• You can use subfolders in a Server Mapping.
 

 

• You can also use Server Mappings to replace images (for example to swap low-resolution
for high-resolution images when the low-resolution and high-resolution images have
identical separations).
 

 

To add the Server Mapping, do the following:

1. In the OPI And Server Mapping dialog, click the plus sign button to the lower left of the Servers
pane. This opens the Share Details dialog.

2. Enter or choose the name of the file server containing your linked images in Server Name.
3. Enter or choose the name of the file server’s share containing your linked images as it appears on

your local machine in Local Share.
4. Enter the name of the file server’s share containing your linked images as it appears on the other

machine that will use your Normalized PDF in Server Share.
 

 
5. If you want to add another Server Mapping (to use your Normalized PDF on yet another machine),

repeat steps 1 to 4.

To edit a Server Mapping, double-click it. To remove a Server Mapping, select it and click the minus
button to the lower left of the Servers pane.
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OPI Mapping
The lower half of the OPI And Server Mapping dialog configures OPI Mapping, which defines the rules
for image substitution when exporting a Normalized PDF in a more specific way than Server Mapping.
OPI stands for Open Press Interface.

To add an OPI mapping, do the following:

1. Click the plus sign to the lower left of the list pane. This opens the OPI Rule Editor dialog.
 

 
2. After the word If, decide how many conditions that must be true for this mapping rule to take

effect: All, Any, or None.
3. For the condition In the top pane of the dialog, choose the element of the image file’s path to

examine in the first field. Image paths are in URI (Uniform Resource Identifier) format, such as
file://mymac/MacHD/images/lowres/tests/Spacebar_CMYK.eps. As you select elements, further
controls appear on the same line to refine the condition. For example, if you choose Full Path Is, you
can click ... to browse for a folder, or click x to revert to the previous folder. To add a condition, click
+; to remove a condition, click -.

4. Once you have defined the conditions, define the changes to the path in the lower pane of the
window. Use the same process to define the changes as you did to define the conditions: choose
the change, then set its options on the same line. To add a change, click +; to remove a change, click
-.

5. Click OK to finish defining the rule.
6. To add another rule, click +; to remove a rule, click -.

Consider again this example URI file name: file://ImageServer/LOWRES/images/lowres/tests/
Spacebar_CMYK.eps.

• The condition Extension, Is Equal To, EPS will match.

• Folder Name, Starts With, lowres/ will match. You can specify the text ending with / to state that
it must be the entire Folder name and to make sure that directories starting with (for example)
lowres plus/ will not match.

• Server Name, Is Equal To, imageserver will also match as the case is not compared.
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When you use more than one condition in a rule, the Replace 1st Matching Part Of Path and Replace
2nd Part Of Matching Path changes become effective.

Consider this file: file://Serv/SharedImg/LORESIMAGES/ANIMALS/LOWRES/myimage.eps

• with conditions of Folder Name, Contains, LORESIMAGES, and Folder Name, Contains, LOWRES.
• and changes of Replace 1st Matching Part Of Path, HIGHRESIMAGES, and Replace 2nd Part Of

Matching Path, HIGHRES.

The first change will replace LOWRESIMAGES with HIGHRESIMAGES (since it was first), and the
second change will replace LOWRES with HIGHRES.

Notes and Restrictions
To copy the OPI settings between computers so they all are the same, copy AE10-
OPISettings.prefs. In Windows, that file can be at C:\Documents and Settings\username
\AppData\Roaming\Adobe\Adobe Illustrator CSx Settings, but its exact location
depends on the type of login (local or domain) and Illustrator version (CSx where x is a number). On the
Mac, this file is normally in Users/username/Library/Preferences/Adobe illustrator
CSx Settings/. Copy the file to the same location on the target machines.

There are a few restrictions when using OPI Mapping:

• The high-resolution images must be accessible from the client workstation.
• Ink Manager will not show extra inks that are present in the high-resolution images.
• When exporting the file using Shuttle, only the inks from Ink Manager are shown, not any extra ones

present in the high-resolution images.
• PDF Export, PowerTrapper Client and PowerTrapper Standalone will use the high-resolution images

and will know about any extra inks.

Trim Box and Other Settings
In the Trim Box (Borders) group of the PDF Export Preferences dialog, the Trim Box (Borders) drop-
down list lets you choose how the edge of the exported PDF file is chosen: using the Trim Box from
Document, using the Current Artboard, or by using the Artwork Bounding Box.

Fit Media Box to Artwork expands or shrinks the Media Box as appropriate.

Outline All Text converts all text to outlines.

Include Hidden Objects and Layers includes hidden objects when the PDF file is exported.

Include Notes allows to include annotations in the PDF. This option is only available in combination
with the PDF Import plug-in.

Copy Structural Design files to Server (only PDF+)
If the Copy Structural Design files to Server option is enabled, when you export your PDF+ to an
Automation Engine server, the Structural Design files used in your document will be exported next to
your PDF+ file.

Other (only Normalized PDF)
If Expand Patterns is selected, patterns will be replaced by actual objects. The path containing the
pattern fill, will then be filled with the objects as defined in the pattern.

Contourize Bitmaps will convert 1-bit images (linked or embedded) into vectors.

Convert Blended Objects to Images will convert blended objects to images. You can set the resolution
for this images to High (600dpi), Medium (300dpi) or Low (150dpi)
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Note:  In case of converting blended objects with different oveprint setting (one is
overprinting, the other is not), the convertion might change the final result. The following
message is shown: "Rasterized Blend combines art in overprint and not in overprint mode.
Rasterization may have caused changed appearance."

3.2.4.  PDF Export Preferences

You can open the PDF Export Preferences by choosing Illustrator > Preferences > Esko > PDF Export
Preferences
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The main part of the Preferences contain the same settings as the PDF Export Settings: the General
tab contains settings used for Normalized PDF and PDF+, the Normalized PDF tab contains settings
only used when exporting Normalized PDF, and the PDF+ tab contains settings only used when
exporting PDF+.

The settings in the Preferences will be used if the "Default" preset is selected. See PDF Export Settings
on page 37

The PDF Export Preset Settings Folder defines the location where the Presets are saved: either the
Default Preference Folder, or a custom folder you can select by clicking the Browse... button. See also
Preset on page 37

3.2.5.  Linked ArtiosCAD Graphics for Normalized PDF export

When you export a document with linked ArtiosCAD graphics to Normalized PDF, the graphics are
treated slightly differently:

When choosing “Embed Images” in the Preferences:
• The ArtiosCAD graphics are embedded in your Normalized PDF.

• The original link information is saved in your Normalized PDF.

When choosing “Save Links” in the Preferences:
• The ArtiosCAD graphics are embedded in your Normalized PDF.

• They are also copied to the location you define: Next To Output File or on another server (according
to a Server Mapping if defined).

• The link to the copied graphics is saved in your Normalized PDF.

3.3.  The Ink Manager Plug-in

The Ink Manager palette is a powerful pre-press color editing and proofing tool. You can easily identify
where Pantone colors are used within a document or where custom spot colors can be found, then
convert these colors to a custom spot color or to process colors.

The Ink Manager palette also allows you to specify crucial ink parameters such as the ink type, angle
and lineature. Once defined, these parameters are saved inside the Illustrator document.

3.3.1.  Normalized PDF or PDF+

In the Ink Manager, you can switch between working in Normalized PDF or PDF+ mode. This mode
determines what type of PDF file you want to export your document to.

If you open a document that contains Technical Inks or Varnish Inks, the mode will be set to Normalized
PDF.

If you open a document that contains Processing Steps, the mode will be set to PDF+

If you open any other document or create a new one, the mode will be set according to the default
setting in the Ink Manager Preferences. See Ink Manager Preferences on page 52 The mode is saved
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in the Adobe Illustrator file, so that the next time you reopen the document, it will be opened in the
same mode.

You can switch freely between Normalized PDF and PDF+ mode. However, if you switch, specific
functionality might get lost. If you for example switch from PDF+ to Normalized PDF, all Processing
Step information will get lost, and switching back to PDF+ will not bring it back.

What is the difference between PDF+, and Normalized PDF
Both PDF+ and Normalized PDF are to a large extent regular PDF files that you can open and edit
in any other PDF editor or reader. However, PDF+ and Normalized PDF files also contain additional
information, available to any Normalized PDF or PDF+ compatible editor. When choosing Normalized
PDF or PDF+ mode in the Ink Manager, the specific limitations and specifications of the chosen PDF
format need to be considered.

What PDF+ Normalized PDF

Ink order stored in file

Non-printing data (Cut, Die, …)
and special processing steps
(varnish, …)

Processing Step Layers Technical Inks & Varnish

Ink Types Normal, Opaque Normal, Opaque, Technical,
Varnish

Document Profile as output
intent

Obligated. If none is present, the
default profile will automatically
be added when saving.

Screening Optional Screen Sets based
screening

Every object has screening.
Optional object based screening

Group and Barcode metadata

Marks PDF+ Marks can be applied in
ArtPro+

ArtPro+ does not support
SmartMarks

Images Images can be

• Embedded

• Linked & Embedded. If a PDF
+ file contains image links,
a full resolution embedded
version of the image will still
be saved in the file.

Images can be

• Embedded

• Linked

Placed Art (PDF)
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What PDF+ Normalized PDF

Structural Design
 Limited to one Structural

Design file, and always using the
default Profile

3.3.2.  Using the Ink Manager palette

To use the Ink Manager palette, choose Window > Esko > Ink Manager. The Ink Manager palette
appears.
 

 

The Ink Manager lists all inks used in the document. For every ink you see a color patch, its name, and
additional information about the ink. You can define what columns you want to see in the Ink Manager
fly-out menu. See The Ink Manager fly-out menu on page 49

You can double-click an Ink to open the Ink Options. See Ink Options on page 48

Mode
In the bottom left corner, you can see if you are working in PDF+ mode or Normalized PDF mode. See
Normalized PDF or PDF+ on page 45

Properties from Job Setup Status Icon
When connected to an Automation Engine, Ink Properties can be retrieved from the Job Setup. This
icon indicates the status of the connection. See Job Setup on page 51

 Refresh
To update the list of inks used within your document, click the Refresh button. After modifying a
document, click the refresh button to update the list of used inks.

 Show Processing Steps Palette
Only available when working in PDF+ mode. This opens the Processing Steps palette. See Processing
Steps on page 56

 Move to Processing Step
Only available when working in PDF+ mode. This moves the objects using a specific ink into a
Processing Step. See Processing Steps on page 56

 Select
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To identify objects containing specific inks within your document, select the ink you wish to search for
and click the Select button. It is possible to select more than one ink at a time.

 Convert to CMYK
To convert a selected Spot Color from your document Ink list to a Process Color Mix, CMYK, click
Convert to CMYK. More than one ink can be selected at a time.

Note:  Convert to Other and Convert to CMYK are only available if you have a license for
boostX, Channel Mapping or Color Engine Plugin.

 Convert to Other
To convert a selected ink from your document Ink list to another ink, click 'Convert to other'. More than
one ink can be selected at a time.

Note:  Converting an ink will affect only line art. However, if you have the Channel Mapping
or Color Engine plug-in installed and licensed, converting an ink will also result in the
corresponding channel mapping for all images. See the Channel Mapping documentation for
more information.

 Delete Ink Variant
When working in Normalized PDF mode, you can use Screening for Adobe Illustrator to create
exceptions to the screening settings for an ink. These exceptions appear in the Ink Manager list as
"Variants". To delete such an Ink Variant, select the ink variant which needs to be removed and click
the 'Delete Ink Variant' button. The objects will get the ink settings of the parent ink. See Screening in
Normalized PDF mode on page 53

Ink Options
Double-click an Ink from the list to open the Ink Options dialog.

If you have multiple inks selected, you can change the properties of all the inks at the same time. The
dialog will show "≠" for settings that have different values.

If you are working in PDF+ mode and have one single ink selected, you can set the Printing Unit. See
Working with Printing Units on page 60

The Ink Book dropdown contains all Ink Books that have the current ink defined. By default the last
used ink book is shown.

When working in PDF+ mode, the available Ink Types are Normal and Opaque. When working in
Normalized PDF mode, also Varnish and Technical are available.

• The ink type for process inks cannot be changed. The ink type is always normal.
• The following Pantone inks are always opaque inks: Pantone 8003 C, Pantone 8021 C, Pantone 8062

C, Pantone 8100 C, Pantone 8201 C, Pantone 8281 C, Pantone 8321 C, Pantone 871 C, Pantone 872 C,
Pantone 873 C, Pantone 874 C, Pantone 875 C, Pantone 876 C, Pantone 877 C. The ink type of these
inks cannot be changed.

Note:  If you change an Ink to Technical or Opaque, the ink will be moved to the bottom of the
Ink list. If you change the ink order afterwards, this new order will be respected.
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When working in Normalized PDF mode, you can set the screening (Ruling, Angle, Dot Shape, DGC
Curve) for the ink. See Screening in Normalized PDF mode on page 53

For every ink, you can set the Printing Method.

If you are connected to an Automation Engine server, the dropdown will show the server Printing
Methods. If you are not connected to an Automation Engine server, you will see the default Printing
Methods and the local printing methods, saved locally in the Adobe Illustrator Preferences.

You can select a Printing Method in the dropdown, or you can type in a name to create a new Printing
Method. If Save printing method to presets is enabled, the newly created Printing Method will be
stored as a new preset, either on Automation Engine or in the local Printing Methods.

Note:  All these Ink options are stored in the Illustrator document and are used by other
DeskPack plug-ins like PowerTrapper Client, PowerLayout Client, etc. For example,
PowerTrapper Client will ignore varnish and technical inks and will take the opaqueness of inks
in account when determining trap directions.

The Ink Manager fly-out menu
 

 

• Ink Options... opens the ink options dialog.
• Using PDF+ (Processing Steps Support) or Normalized PDF Compatibility you can switch the mode

for the current document. See Normalized PDF or PDF+ on page 45
• Show Processing Steps and Move to Processing Step: Only when working in PDF+ mode. See

Processing Steps on page 56
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• Convert Ink to... has the same functionality as the 'Convert to Other' button 

• Convert Ink to CMYK has the same functionality as the 'Convert to CMYK' button 

• Convert all Spot Inks to CMYK converts all the spot inks in the document to their CMYK equivalent.

Note:

Keep in mind that this function will also convert white objects created by the White
Underprint plugin, using a special spot ink.

• Update Ink list refreshes the ink list.

• Process Inks In Images…  The plug-in uses Illustrator to determine which inks are used in images.
Illustrator has some limitations:

• With linked EPS images it is not possible to detect whether CMYK was used in the linked image.
Ink Manager will assume that CMYK is present in the linked EPS images, unless the user has
specified otherwise.

• TIFF images with spot channels always have CMYK channels, even if those channels are empty.
• Some effects create embedded images with all four CMYK channels, even if some are empty.

So the plug-in doesn’t really know whether CMYK is used in images. “Process Inks in Images” offers a
manual solution. If you click this option, the “Process Inks in Images” dialog box appears:

 

 

By default all toggles are switched on, which means that the plug-in will assume that external
images contain Cyan, Magenta, Yellow and Black.

If you know that there is no Cyan in the externally placed images or you want to avoid an empty
process plate introduced only by an effect, you can switch Process Cyan off. Click 'Apply' and at the
bottom of the Ink Manager the indication “Disabled in Images: C” will appear.

The plug-in will assume that only Magenta, Yellow and Black were used in the externally placed
images. If Cyan is used in other objects of the document, it will be listed in ink manager.

Note:  Other plugins such as PDF Export and PowerTrapper will also take this setting into
account.

• Using Display Columns you can set what columns of the Ink Manager should be shown:

• the Ink Type
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• the Ink Book
• the Screening Details (ruling, Angle and dotshape). Only when working in Normalized PDF mode.

See Screening in Normalized PDF mode on page 53

• the DGC Curve. Only when working in Normalized PDF mode. See DGC Curve on page 54),

• The Printing Method
• The Job Setup (see Job Setup on page 51)

• Reverse Ink Order will turn the order of the inks upside down.

• By default, the process colors are in Cyan - Magenta - Yellow - Black order. If you change this order
and apply Save CMYK Ink Order as Default, the changed order will be used as default order. By
selecting Restore Default CMYK order, the original default order is restored.

• By using Sort Light To Dark or Sort Dark To Light, you can rearrange the order of inks based on the
luminocity. Note that Opaque and Technical inks are placed at the bottom of the list, but also sorted
light to dark or dark to light.

• When working in Normalized PDF mode, if you have to reuse the same Ink Parameters frequently,
you can use Save Ink Preset ... to save all ink parameters, including Ink Name, Type, Ink Book,
Ruling, Angle, Dotshape, DGC and Printing Method. You can Load Ink Preset... to overwrite all ink
parameters in the current document with the parameters you saved earlier. You can set the location
for the saved Ink Presets in the Preferences. See Ink Manager Preferences on page 52

• By enabling Use Properties from Job Setup, the inks and ink parameters defined in the Job Setup
will be enforced. See Job Setup on page 51

Job Setup
When a document is opened from an Automation Engine Job, for example using File > Job Folder
> Open from Job Folder ..., you can force Ink Manager to use the ink parameters defined in the Job
Setup, overwriting the current Ink Parameters, by enabling Use Properties from Job Setup, either

from the fly-out menu or by clicking the button in the Ink Manager palette 

The Job column will appear automatically. You can change its visibility under Display Columns in the
fly-out menu.

The column will give a status icon for every ink:

•
 : the ink is defined in the Job Setup. The parameters defined in the Job Setup will be used.

•
 : the ink is not in the Job Setup but is used in the document

•
 : the ink is defined in the Job Setup but not used in the document. The line will be greyed out,

and have no number.

If Use Properties from Job Setup is enabled, the Ink Options dialog for inks defined in the Job Setup
will show status icons for every parameter:

•
 : the parameter is taken from the Job Setup, so it can't be modified.

•
 : the parameter is not defined in the Job Setup, so it can be set freely.

If the Job Setup defines multiple variants of the same ink, all variants are listed in the Ink Manager.
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Note:  Next to the settings for every ink, you can also choose to retrieve the Ink Order from the
Job Setup, by enabling the option in the Ink Manager Preferences. See Ink Manager Preferences
on page 52

3.3.3.  Ink Manager Preferences

The Ink Manager Preferences can be opened from Illustrator > Preferences > Esko > Ink Manager
Preferences... (Mac) or Edit > Preferences > Esko > Ink Manager Preferences... (Windows).

 

 

With the Default Document Mode you can define if you want to use Normalized PDF mode or PDF+
mode when opening a document created by Esko plug-ins older than version 20, created without Esko
plugins or importing as Adobe PDF. See Normalized PDF or PDF+ on page 45

In the rest of the Ink Manager Preferences, you can set the Default Values (angle and ruling) for CMYK
inks.

You can also set the default angle and ruling to be used for new Spot inks. However, these defaults can
be overruled when using a Spot ink that was used before, with a different Angle and Ruling value. The
Angle and Ruling for all used spot inks are saved in the Preferences file.

You can also define if inks that are only used in non-printable layers or hidden layers should be shown
in the Ink Manager by setting the Show Inks of Non-printable Layers and Show Inks of Hidden Layers
option.
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Note:

The Remap Ink functionallity also takes the Show Inks of Non-printable Layers and Show Inks
of Hidden Layers option into account: When switched off, inks on non-printable or hidden
layers will not be remapped.

Enable Use ClassicColors Ink Book to use the ClassicColors Ink Book. When using a ClassicColors Ink
Book for your HP device, you can enable the Use ClassicColors Ink Book option, to avoid conflicts for
inks using generic names, such as "White".

The Preferred Ink Book is the Ink book shown by default when opening the Add Ink from Ink Book
dialog. It is also used as the preferred ink book when determining the ink book of spot inks manually
added to the document.

You can set the location to store Ink Manager Preset Settings: either in the default presets folder, or in
a custom folder you choose.

In Job Setup Support you can define if you want to use the Ink Order as defined in the Job Setup. See
Job Setup on page 51

3.3.4.  Screening in Normalized PDF mode

When working in Normalized PDF mode, you can set the screening parameters in the Ink Options.

Note:  The other options are explained in Ink Options on page 48

You can set the Ruling and Angle for the ink.

Dotshape shows a list of all dotshapes available for the FlexRip. However, it is possible to enter any dot
that is available on your rip instead of the proposed dotshapes. Only use a dotshape that is installed on
the rip that will be used to expose the document.

Note:  Entering a dotshape is not compatible with Nexus RIP.

You can define a DGC Curve and a DGC percentage. See DGC Curve on page 54
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The screening settings are applied to all objects in your document.

If you have a Screening for Adobe Illustrator license, you can use the Screening for Adobe Illustrator
plugin to make exceptions to these inks parameters for specific objects. See https://www.esko.com/
en/support/product?id=Screening%20for%20Adobe%20Illustrator

DGC Curve
You can set the Dot Gain Compensation (DGC) Curve for every ink.

By default, the DGC Curve column is hidden. By selecting Show DGC Curve in the fly-out menu you can
make it visible.

You can select one of the predefined Dot Gain Curves, or type in the name to use a custom DGC. When
selecting a PressSync curve, you can enter the percentage for the curve in the DGC % field.

Note:  DGC is not a part of the Job Setup. This means using Use Properties from Job Setup
will not change the DGC, nor does changing the DGC influences the status of the job.

3.3.5.  Screening in PDF+ mode

In PDF+ mode, screening is defined using Screen Sets in the Ink Manager. See Manage Screen Sets on
page 55

Note:  You need a Screening for Adobe Illustrator license to assign a Screen Set to an object.
Without the license, you can view the defined Screen Sets and you can change their screening
parameters, but you can't add new Screen Sets, delete Screen Sets or assign a Screen Sets to
objects. You can also Reset to Default Screening or Remove Screening without a license. See
The Screen Sets Fly-out menu on page 55

Your document can contain a number of Screen Sets, each containing specific ruling, angle, dot shape
and DGC information for each of the defined separations. By assigning a Screen Set to an object, you
can set up object based screening.

Choose Window > Esko > Screen Sets or use its shortcut Cmd+Option+Shift+N (Mac) or Ctrl+Alt
+Shift+N to open the Screen Sets palette.

The Screen Sets palette shows all Screen Sets defined in the document.

The Screen Sets used in the current selection will be highlighted.
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• Click the Screen Set you want to assign to the current selection.
• Click the Select Art Using Screen Set button  to select all objects using that specific Screen

Set.
• Click the Manage Screen Sets button  or choose Manage Screen Sets from the fly-out menu

to create, remove or edit your Screen Sets. See Manage Screen Sets on page 55

Manage Screen Sets
In the Manage Screen Sets dialog you can add, remove and edit Screen Sets.

• In the list on the left, select a Screen Set to see and edit its settings.

• You can set the Ruling and Angle for each ink.
• Dotshape shows a list of all dotshapes available for the FlexRip. However, it is possible to enter

any dot that is available on your rip instead of the proposed dotshapes. Only use a dotshape that
is installed on the rip that will be used to expose the document.

• You can define a DGC Curve and a DGC percentage. See DGC Curve on page 54
• Click + to create a new Screen Set.

The newly created Screen Set is created using the same settings as the currently selected Screen
Set. If no Screen Set is available, a Screen Set with default screening information is created.

• Click - to remove the selected Screen Set.
• Double-click a Screen Set to rename it.
• Click in front of a Screen Set Name to make it the Default Screen Set, indicated by a star.

The Default Screen Set is applied to newly created objects. It is also used in some other specific
situations, e.g. if you remove a Screen Set, or for Mask objects when releasing an Opacity Mask.

• Click Save Preset to save all Screen Sets in a Screen Preset, e.g. to reuse in another document.
• Click Load Preset to load all Screen Sets saved in a Screen Preset. The Screen Sets from the Preset

will be merged with the current Screen Sets. If a Screen Set with the exact same settings already
exists, that Screen Set will not be added.

The Screen Sets Fly-out menu
The Fly-out menu of the Screen Sets palette contains the following functions:

Reset to Default Screening
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This removes all Screen Sets, and adds a new one called "Screen Set 1". The screening information for
this Screen Set is taken from the settings defined in the Ink Manager preferences. See Ink Manager
Preferences on page 52

Remove Screening
This removes all Screen Sets applied to objects in the current document. The Screen Sets palette will
only contain the "None" Screen Set.

Note:  Both functions are available without the Screening plugin installed, and without a
license.

3.3.6.  Processing Steps

Ever since PDF became the preferred file format in the graphic industry, PDF files were used not only
to store the artwork to be printed, but also as a container for information related to the production
process: cutting lines, dimensions, etc.

How the information was stored in the PDF file, depends on the application that was used to generate
the PDF, and the preferences of the user. For example the die cut lines can be in a separation called
"Die", or in a layer named "Cut". Obviously, this leads to a multiple of ad hoc methods, which leads to
interoperability problems, and a complex and error-prone situation.

ISO 19593 defines a new mechanism to store objects and metadata corresponding to such processing
steps in a PDF file in a standardized way.

Based on this ISO norm, the use of Processing Steps was introduced in DeskPack as Processing Steps.

Keep in mind however that these Processing Step Layers are only available when working in PDF+
mode. Normalized PDF mode uses Technical Inks instead. See Normalized PDF or PDF+ on page 45

Objects in Processing Step Layers
Processing Step Layers contain objects in your PDF file (a path, a text object, ...) that are associated
with a specific Processing Step.

The type of Processing Step Layer can influence the properties of the PDF objects. For example, a PDF
object in a Structural Processing Step Layer has to be colored in a spot color (to visualize in viewing
and proofing applications). Because the objects in these Processing Step Layers should not have any
influence on the final printed version (and on the plate making), this spot color should not be used for
"normal" PDF objects, nor should the objects knock out other objects, or participate in transparency
blending with other "normal" artwork objects.

Types of Processing Step Layers
• Structural Data: a collection of contours that describe how the printed product will be finished to

produce a 3D end product from a flat substrate, such as cutting lines, crease lines, etc.
• Braille: braille characters that are applied after printing, e.g. by a die cutter or inkjet device.
• Legend: job related data outside the boundaries of the actual printed products.
• Dimensions: indications of the physical sizes
• Positions: objects that indicate intended, allowed or forbidden positions for certain types of

elements, e.g. allowed positions for content on a flap of a carton.
• White: white ink to be printed on a transparent or metallic substrate.
• Varnish: indicating the application of varnish after printing.
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The Processing Steps palette

You can open the Processing Steps palette by clicking the Show Processing Steps button  or
select Show Processing Steps in the fly-out menu of the Ink Manager palette.

All the Processing Steps appear in the list, grouped per type, along with an "Artwork" entry. You can use
the eye icon to make a processing step visible or invisible.

You can change any layer into a Processing Step Layer, or change the type of a Processing Step Layer
by clicking the Edit Processing Steps button, by selecting Edit Processing Steps... in the fly-out menu,
or by double-clicking an entry in the list.
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You can change any layer into a Processing Step Layer, or change the type of a Processing Step Layer
by selecting a Processing Step type from the dropdown.

You can change a Processing Step Layer into a normal layer by selecting None.

Unlike normal Artwork layers, Processing Step Layers come with a set of restrictions. If one of these
restrictions is not met, a warning is shown in the Processing Steps palette.

You can select the paths causing the warnings in the list. If the Select option is enabled, clicking on
one of the entries will select the corresponding object in the job. If the Zoom option is enabled, clicking
an entry displays the selected object as big as possible in the active window. If the Highlight option is
enabled, the selected objects will be highlighted.

Note:  The list of ISO Standard Violations is not updated automatically. Use the refresh button
to update the list.

You can prevent a number of these issues by using the Move to Processing Step function to create
Processing Step Layers. See Move to Processing Step on page 59

Colorants for Processings
Inks that are only used in Processing Steps are considered "Colorants": they can be used to color
objects in the Processing Step Layers, but are not considered printing inks, as they should not appear
on plates or on the final printed result.

Colorants for Processing Step Layers are represented in the Ink Manager using a round color patch.
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Note:  If an ink is used in at least one "normal" artwork object in an artwork layer, the separation
is shown as a normal printing separation, with a square color patch. Since the use of a
separation both as ink and as colorant usually presents a conflict, it is very likely that a
message will appear in the Messages Side Drawer for any Processing Step Layer using such a
colorant.

Move to Processing Step
Using the Move to Processing Step function, you can move the objects using a specific ink into a
Processing Step.

1. Select a spot color ink in the Ink Manager.
2. Select Move to Processing Step from the fly-out menu or click the Move to Processing Step button

.
3. Select the Processing Step Layer you want to use.
4. All objects using the selected ink will be moved to the selected Processing Step Layer.

• Objects in a flat color, only using the selected separation, will be placed in a Processing Step
Layer, with the same name as the original artwork layer they were in (when available).

• Other objects (e.g. objects in a mixed color, images, ...) will not be moved nor changed.
• If the Ink is only used in the Processing Step Layers, it will become a Colorant. See Colorants for

Processings on page 58

Plate ID Objects
If you are using DeskPack and/or ArtPro+ in combination with Esko's Imaging Engine within the
flexographic printing industry, you can use Plate ID objects to identify Flexo Plates, e.g. for reprint after
being archived, or to be reused in a similar jobs.

Plate ID objects will be exposed by the RIP at "half height". This means the objects are permanently
visible, yet they do not show up on the printed result.

For more information we refer to the chapter on Working with Plate ID in the Automation Engine
documentation here

1. Select the objects you want to create a Plate ID object of.

Note:  Foreign art, mesh, raster, linked image, repeat art and clipping paths are not
supported. Unsupported objects in the selection will be excluded.

2.
In the Processing Steps palette, click the Convert to Plate ID Object button 

• If they don't exist yet, a Plate ID Layer and Plate ID ink are created.

• All (supported) objects in the selection are converted into one Plate ID Object. Marks in the
selection will be expanded and thus no longer be dynamic.

• If the original object has no fill ('none'), the Plate ID Object will also have no fill. In all other cases,
the object is colored in 100% of the Plate ID Processing Step colorant. Gradients and patterns
are changed to 100% flat paint.

• The Plate ID Object is set to overprint, and transparency settings are set to "Normal" at 100%
opacity.
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• The Plate ID Object is moved to the Plate ID layer.
3. Using the Plate ID palette you can define on what plates the Plate ID Object has to be exposed.

 

 
a) Select the Plate ID object you want to edit, and click the Edit Plate ID Object Properties button

b) By default all artwork separations will be enabled, while Processing Step colorants and unused
separations are disabled. You can however manually add or remove separations.

c) Click OK

3.3.7.  Working with Printing Units

Using Printing Units you can define a Printing Order without changing the viewing order in the Ink
Manager. For more information on Printing Order vs Viewing Order, see Viewing Order vs Printing Order
on page 61

Note:  Printing Units are only available in PDF+. See Normalized PDF or PDF+ on page 45

By default, the ink order (i.e. the viewing order) is also used as printing order.

You can switch to using Printing Units by choosing Assign Default Printing Units or Assign Default
Reverse Printing Units from the fly-out menu of the Ink Manager

• The Printing Units icon  or  is shown above the first column, and the arrow indicates the
printing direction.

• When choosing Assign Default Printing Units Printing Units will be assigned to all separations
except for Processing Step Separations in ascending order.

• When choosing Assign Default Reverse Printing Units Printing Units will be assigned to all
separations except for Processing Step Separations in descending order.
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After assigning the Printing Units, you can edit them by clicking the Printing Unit number's location,
or by opening the Ink Options. See Ink Options on page 48. You can use this e.g. to assign a Printing
Station to your Opaque White Processing Step Separation, or to leave an empty station.

Note:  When possible, Ink Manager will try to adjust the other Printing Units when changing
one. E.g. when in a sequential order you change "4" to "5", the next Printing Units will be
increased as well (5 becomes 6, 6 becomes 7 etc).

• When the Printing Units are no longer strictly ascending or descending after manually modifying the

Printing Units or changing the separation order, the icon in the Ink Manager changes to this: 

• You can correct this by manually modify the Printing Units, or by re-assigning the default Printing
Units (see above).

If you want to remove Printing Units, you can choose Remove Printing Units from the fly-out menu of
the Ink Manager.

Viewing Order vs Printing Order
By default, the order of the separations in ArtPro+ defines both the viewing order and the printing
order (what ink is printed first). In the example underneath, you see an example of a clear substrate,
with an opaque white printed first, and CMYK on top.

However, in some cases, you would want to change the printing order, without changing the viewing
order in ArtPro+. If you for example want to print on the inside of a clear substrate (so that the printed
graphics are protected by the substrate), the opaque white ink would be the last ink you print (and end
up on top of the others). You do not want to change the separation order in ArtPro+ to represent that,
as the opaque white ink would block out all graphics underneath.

To avoid this, you can use Printing Units to reverse the printing order without changing the separation
viewing order.

Underneath an example of a label printed on the back side of the clear substrate:

61



3 DeskPack Advanced

3.3.8.  Known limitations

Re-mapping process inks to spot inks.
As it is impossible to simply change one of the process inks to the spot ink, the only solution is adding a
new fill to the object with the new spot ink and use overprint to mix these fills together. 

• Adding a brand new fill is not possible on text objects on the character level. Text objects using
various inks on separate characters aren't mapped and an operator is warned.

• Re-mapping of process to spot inks on paths, using Effects on fill or stroke, will raise a warning,
because adding a new fill could change the visual appearance.

Re-mapping inks in gradients
Re-mapping of the process ink to the spot ink generates a new fill due to the same reason as before.

• Let's have an example that the gradient already contains the target spot ink on one of its stops and
another stop contains the process color being transformed. The re-mapping one of the process
inks will add a new fill with the same gradient but with the target spot inks on the place of the
process ink. In other cases the overprint will blend these two fills and produce expected visual
appearance. In this particular case Illustrator will not blend these fills because both contain the
same spot ink and Illustrator then ignores the overprint. An operator is informed about that.

• Similar issue comes when the object already contains two gradient fills. An operator is again
warned.
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3.4.  The Structural Design Plug-in

3.4.1.  Introduction

Introducing Structural Design
Structural Design enables the Adobe Illustrator users to read in an ArtiosCAD ARD or ACD file, an
Esko flexible .bag file and/or a Collada .dae or .zae file. This structural design can then be aligned to
the graphics and this alignment will be maintained in the rest of the Esko workflow (e.g. ArtiosCAD,
Visualizer, PackEdge, ArtPro, Plato, RIPs). On top of that, you can create a varnish plate from the bleed
outline, from the Illustrator artboard or from the bounding box of the structure automatically excluding
the coating free areas.

Structural Design Export allows an Adobe Illustrator user to export contours from Illustrator to native
ArtiosCAD .ard format. It also allows adding and modifying cutout windows to a loaded ArtiosCAD file.

Structural Design files in Normalized PDF or PDF+
When exporting your document to PDF+, a live link is maintained to each of the placed printable parts.

However, if you export to Normalized PDF, only the printable part that is listed first in the layers palette
will be kept live, other placed printable parts will be expanded. If you want to keep a live link to your
printable parts while exporting to Normalized PDF, you should break up your multi-part design in
different documents, so that each document contains one printable part, and the graphics for that
printable part.

For more information on Normalized PDF and PDF+, see Normalized PDF or PDF+ on page 45

Note:

ArtiosCAD ACD files can't be handled by PackEdge, ArtPro, Plato and Esko RIPs, and can't be
preserved in PDF+ or Normalized PDF export.

You can export the ACD file to separate ARD files by choosing File > Structural Design > Export
and selecting the name of the ACD file. If you choose the option "ARD Files (One per part), each
placed printable part of the ACD file will be replaced by a newly created ARD file. See Structural
Design Export on page 73

3.4.2.  Importing Structural Design files

General Principles
The Structural Design plug-in enables you to open or place Structural Design files inside Adobe
Illustrator. The imported Structural Design files are linked to the Adobe Illustrator (.ai) files, but they are
not embedded.
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Structural Design Files and Printable parts
A Structural Design file describes a 3D scene, of which at least one part can be printed: the Printable
Part. Different types of Structural Design files can be used:

• an ARD Structural Design file, created in ArtiosCAD or Studio Toolkit for Boxes, mainly used for
boxes. For an ARD file, the entire box is one single printable part.

• an ACD Canvas file, created in ArtiosCAD, contains one or more printable parts.

Note:  Copies of the 3D Shape in ArtiosCAD will share the same printable part. In order to
apply different graphics on multiple shapes coming from the same ARD file, you should
import this ARD file multiple times into the canvas file. That way, each shape will have its
own printable part.

• .bag files created in older versions of Studio Toolkit for Flexibles. These .bag files are also one
printable part.

• Collada files, containing one or more 3D shapes with at least one printable part (.dae or .zae files).
For Collada files, a printable part is an Esko extension. A collada file can contain one or more
printable parts, such as a flexible bag, one or more labels on a bottle, a shrink sleeve, …. A Collada
file can also contain non-printable parts, such as the glass bottle itself. Collada files with one or
more printable parts can be created in ArtiosCAD or Studio Toolkit.

Note:  More technical information on Printable Parts in Collada files can be found in the white
paper you can find in the Studio documentation: https://www.esko.com/en/support/product?
id=Studio

With the Structural Design Import plug-in, you can place printable part(s) of a Structural Design file in
an Illustrator document.

Structural Design Layer
After opening or placing a structural design file, the file appears in the Adobe Illustrator layer palette.
The Structural Design paths are special paths that cannot be modified accidentally. By default the
Structural Design layer and its sublayers will be locked. You can unlock the Structural Design layers.
This enables you to select individual Structural Design paths and use the illustrator alignment tools to
align graphics to the Structural Design paths.

Open or Place an ARD, ACD, BAG, DAE, ZAE file
A dedicated Place File showing only Structural Design files is found in the File menu. Choose File >
Structural Design > Place File....

In case a Collada file is placed, a check is performed to see if the Collada file has a printable part
defined. See General Principles on page 63

If a Collada file or ACD file contains multiple printable parts, a dialog will ask you to choose one or to
place all. Choose the part(s) of which you want to create the graphics in Adobe Illustrator.
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After opening a Structural Design file, the Structural Design objects are converted to special Illustrator
objects.

The Structural Design layers are converted to locked Illustrator sublayers so they can't be changed
accidentally. You can unlock these layers. They are grouped under a layer that gets the name of the
Structural Design file.

 

 

The different Structural Design line styles (cuts, creases, bleed) are translated to hard-coded custom
colors. All ArtiosCAD line styles are supported.
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Opening an Illustrator file with a placed Structural Design file
When an Illustrator file is opened that contains Structural Design data, two checks are performed.

1. First of all, the plug-in checks whether the Structural Design file still can be found in its original
place. If that is not the case, the plug-in will look for the Structural Design file in the same directory
where the Illustrator file is. If it finds the Structural Design file there, it will use this Structural
Design file instead, otherwise, you will be asked to browse to the new location of the file.

2. A second check is performed to see if the Structural Design file has been modified since it was
originally embedded in this Illustrator file. If so, the Illustrator document will be updated.

See also Update the Structural Design File on page 68

Adding or replacing a Structural Design File
If a Structural Design file is already loaded and you place a new Structural Design file, the new
Structural Design file will be placed next to the already loaded Structural Design file.

If you want to replace an already placed Structural Design file, choose File > Structural Design >
Replace. See Replace the Structural Design File on page 69

Placing or opening
The difference between placing and opening a Structural Design file is that when opening a Structural
Design file, the artboard will adopt the size of the bounding box of the structure. When placing a
Structural Design file, the artboard will not be changed.

Large Canvas mode
In Adobe Illustrator versions before 24.2 (released june 2020), the maximum size of an Adobe Illustrator
document was 5,779 by 5,779 meter or 227,52 by 227,52 inch ("standard size").

In Adobe Illustrator 24.2 and later, when creating an Adobe Illustrator document, you can use larger
sizes. In that case, the document is in "Large Canvas Mode". The maximum size of an Adobe Illustrator
document in Large Canvas mode is 10 times larger: 57,79 by 57,79 meter or 2270 by 2270 inch.
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When opening a Structural Design file, the Adobe Illustrator document is created in regular mode. If
the printable part you place doesn't fit the "standard size" canvas, you can choose to create a document
in "Large Canvas Mode", and place the structural design file in the newly created large-sized Adobe
Illustrator document.

Warning:  When you save or export the artwork created on a large-sized canvas to a legacy
Illustrator document (lower than Illustrator 2020), the artwork will appear ten times smaller.
In this case, the Structural Design Import plug-in will expand all structural design artwork.
This means that the artwork will no longer be tagged as Structural Design objects, and will
become regular Illustrator art. The structural design data will no longer be live in such a legacy
document.

Open or Place from Shapes
The Shapes Store is a constantly growing online collection of quality 3D models in Collada file format.
If you have a subscription or maintenance contract for Studio or ArtiosCAD, you can download all
available models. The section "free samples" are free for anyone with an Esko ID.

You can open files from Shapes directly or place them into existing Illustrator files by using the
commands in File > Structural Design.

Opening and placing a file from Shapes follows the same general workflow. This example will show you
how to place a Shapes file.

1. In an open Illustrator document, click File > Structural Design > Place from Shapes....

In order to access the Shapes store, you need to enter your Esko ID when opening the Shapes
window for the first time. You can also enter it or change to a different Esko ID in the Shapes
Preferences dialog in Preferences > Esko > Shapes Preferences.

 

 

There is a Shapes Store section where you can browse all the models on the cloud, and a Library
section, where you see all the assets that you have downloaded so far. When opening the Shapes
window, the last used section will be active.

2. If you want to use a new Shape, choose it and download it. It gets downloaded to your local
machine’s Shapes Library.
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3. If you downloaded a new Shape, the Shapes window should switch to the Shapes Library
automatically. To use an existing Shape, click Library in the Shapes window. Select the desired
Shape and click Place.
 

 
4. The Shape is either placed in the open Illustrator document or opened as a new document. Only the

printable area of the Shape is visible in Illustrator. If you have one of the Studio products, use the
Studio palette to view the Shape with the printable area.

Shown below is a bottle from Shapes with the label designed in Illustrator and with the 3D model shown
in the Studio palette.
 

 

Update the Structural Design File
If any of the Structural Design files has been modified while still editing the Illustrator file, an update
of the Structural Design files can be forced. All Structural Design files placed in the current Illustrator
document will be updated. Choose File > Structural Design > Update All
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Replace the Structural Design File
If you want to replace the placed printable parts of a Structural Design file while preserving the
alignment between the technical drawing and the artwork, you can replace a Structural Design file.

Choose File > Structural Design > Replace and select the name of the file you want to replace

Align Structure and Graphics

Interactive Move Structural Design tool

 

 

The Move Structural Design tool has been added underneath the Illustrator select tool. Select this tool
to move the Structural Design interactively without unlocking the Structural Design layers. Hold down
the mouse button and drag to move the Structural Design.

Tip:

If you choose View > Smart Guides, the Structural Design will snap to the graphics.

Structural Design window
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The Structural Design palette provides information on the bleed and structure contours of the selected
printable part. It allows you to rotate or numerically move the contours.

Open the palette by choosing Window > Esko > Structural Design > Show Structural Design Window.

If your document contains multiple printable parts, you can use the dropdown to select the printable
part for which you want to see or change the information.

If your selected printable part contains a bleed contour, you can use the dropdown to choose whether
you want to see the position of the bleed or of the structure bounding box.

The upper part gives you the coordinates of the (left, top) point of the bounding box around the
structure (cut and crease) or bleed contours. The coordinates are relative to the origin of the Illustrator
file. You can choose to see the coordinates of nine points on the bounding box. You can also choose to
see the position of the bounding box around the bleed contour.

By entering a new value in the X and Y entry fields, you move the selected point to the new position.

It is possible to flip the Structural Design so that you can add graphics to the back of the Structural
Design. This feature is enabled for ArtiosCAD files and for Collada files with a placed printable part that
can have graphics applied to the back side.

The lower part of the palette shows the width and height of the Structure and Bleed bounding boxes.
Bleed Offset indicates the offset between the structure and the bleed contour.

The bottom part provides information whether or not fold angles and animation were defined in the
structural design.

Click one of the Rotation icons to rotate the Structural Design contours. Rotation always happens
around the center of the structure contour.
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Create Varnish Plate
Choose Window > Esko > Structural Design > Create Varnish Plate....

 

 

• If you choose Use Bleed Outline then the contour will be created from the bleed outline
minus the coating free areas (if any).

• If you choose Use Artboard, then the contour will be created from the Artboard minus the
coating free areas.

• If you choose Use Bounding Box of Structure, then the contour will be created from the
Bounding Box of the structure minus the coating free areas.

Note:  When using Use Bleed Outline or Use Bounding Box of Structure, a varnish
plate will be created for every printable part in the current Illustrator document.

When choosing Use Artboard or Use Bounding Box of Structure, you can specify a positive
or negative offset. The resulting varnish plate will be enlarged or shrunk with the specified
offset in relation to the artboard or the bounding box.

This tool outputs a contour filled with a light-yellow spot color. This contour will be put in
a new layer named ‘Varnish’. This layer will be inserted directly under the Structural Design
layers.

Note:

Create Varnish Plate will automatically exclude the coating free zones in the
Structural Design file, if any.
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Expand Structural Design Layer
Choose Window > Esko > Structural Design > Expand Structural Design Layer....

 

 

Select the Structural Design layer that you want to expand into a new Illustrator layer. If there
are multiple printable parts with a Structural Design layer with the same name, they will all be
expanded.

All art on the Structural Design layer will be copied to the new Illustrator layer. The art on the
new layer is no longer tagged as Structural Design objects.

In Normalized PDF mode, the resulting objects are in the technical Structural Design inks. In
PDF+ mode they will share the same processing step types of the corresponding layers in the
Structural Design. See also Normalized PDF or PDF+ on page 45 and Processing Steps on
page 56.

One common use where you would use this tool is when you are interested in creating a
clipping path from the bleed outline of the Structural Design file.

Structural Design Preferences
You can open the Structural Design Preferences by choosing Illustrator > Preferences > Esko
> Structural Design Preferences… on MAC or File > Preferences > Esko > Structural Design
Preferences… on PC.
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ArtiosCAD files can contain Dynamic Art placeholders. Using these placeholders, a structural designer
can for example tell the graphics designer where the barcode should be placed on the design. If
the option Import Dynamic Art as Placeholders is enabled, and you have the Dynamic Art plugin
installed, a live Dynamic Art placeholder object will be created for every ArtiosCAD Dynamic Art. These
placeholders can then be filled automatically with their content. For more information, we refer to
the Dynamic Content documentation. See https://www.esko.com/en/support/product?id=Dynamic
%20Content%20Advanced

3.4.3.  Exporting Structural Design files

Structural Design Export
The Structural Design Export saves a copy of the selected Structural Design file to a new location,
The Illustrator file will link to the newly saved Structural Design file. Choose File > Structural Design >
Export and select the Structural Design you want to export.

If you are exporting an Artios Canvas file (.acd) containing multiple printable parts, you can choose to
export the ACD file as a single ACD file, or as multiple individual ARD files, one for each part.

Export Selected Objects to ArtiosCAD File
ArtiosCAD Export adds the item Export Selected Objects to ArtiosCAD File to the Structural Design
menu. Only ARD files can be included when exporting to a new ArtiosCAD file.

Select the contours to export to the ARD file and choose File > Structural Design > Export Selected
Objects to ArtiosCAD File.

The Export Selected Objects to ArtiosCAD File dialog opens.
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Save selected objects in
You can choose to save the selected objects in the Main Design Layer or in Annotation Layers. If you
save them in Annotation Layers, an ARD file will be created with annotation layers with the same name
as the illustrator layers.

Next to this, you can choose Layers based on ArtiosCAD Line Type swatches. If the selected objects
are stroked with a swatch color with an ArtiosCAD line type name (e.g. cut, crease, bleed), then this
option will create layers depending on the stroke color name:

• Cut and crease lines will go to a Main Layer
• Outside Bleed lines will go to an Outside Bleed Layer
• Outside Coating lines will go to an Outside Coating Layer
• Dimensions and text will go to a Dimension Layer
• All other linetypes will go to an Annotation Layer

For convenience, a swatch library ArtiosCAD Line Types is included with the plug-in. You can display
the swatch library by selecting Window > Swatch Libraries > ArtiosCAD Line Types. In this swatch
library, all ArtiosCAD design line types have been predefined.

Include a copy of ****.ARD
You can choose to include a copy of the ARD file that was loaded in the Illustrator document that is
closest to the selected objects. The resulting ARD file will contain the selected objects AND what is in
the CAD layers in Illustrator.

Remove lines
It is possible to remove some lines of the original ArtiosCAD file. This is meant to modify cutout
windows. Do not attempt to remove fold lines with this tool. If you do this, the original fold angles will be
lost.

Place this ArtiosCAD file in the document
If you switch this option on, the resulting ARD file will be placed in the Illustrator document. It will
replace the Structural Design file that was loaded originally.
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Preview
In the preview window, you see a preview of what will be saved. You can highlight the selected contours
by toggling on Highlight Selection. You then see the distinction between the contours that are newly
added to the resulting ARD file and those contours that come from the original ARD file.

If you click Export, you can set the name and location for the file to be saved.

If you have an ArtiosCAD file loaded in your Illustrator document, the software suggests as file name
the name of the loaded ArtiosCAD file followed by _copy.

We recommend you not to overwrite the original ARD file as some functionality of the ARD file will be
lost: graphics layers are not copied and it will not be possible to rebuild the created ARD file and text
will be contourized.

Note:

Placed EPS objects and/or pixel-based objects cannot be copied to an ARD file. The fill color of
the selected contours is not maintained in ArtiosCAD. Rather, the stroke color of the contour
determines the line type in ArtiosCAD. If the selected contour is in the Main Design layer, the
pointage of the contour will be 2. In all other cases, the pointage will be 0.

ArtiosCAD - Copy to Clipboard

Note:

This function is only available on PC.

It can be found on the Edit menu:

ArtiosCAD - Copy to Clipboard copies the selected contours to the Windows Clipboard. They can
directly be pasted into ArtiosCAD. If you have the same ArtiosCAD workspace open in ArtiosCAD
and have not modified it since opening it in Illustrator, when you paste the contents of the clipboard
into ArtiosCAD, they use the same placement as was used in Illustrator. This function is useful for
ArtiosCAD users who need shapes from the graphics to be added to the box design.

Copy to Clipboard also offers you the possibility to add the ARD file that is currently loaded in the
Illustrator document that is closest to the selected objects. Keep in mind that graphics layers are not
copied. The resulting ARD file is also not rebuildable and text will be contourized.
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Note:

Placed EPS objects and/or pixel-based objects cannot be copied to an ARD file. The fill color
of the selected contours is not maintained in ArtiosCAD. The stroke color of the contour
determines the line type in ArtiosCAD. If the selected contour is in the Main Design layer, the
pointage of the contour will be 2. In all other cases, the pointage will be 0.

Relationship between stroke color in Illustrator and line type in ArtiosCAD
If the contours are stroked with a swatch color with an ArtiosCAD line type name (e.g. cut, crease),
then the corresponding items in ArtiosCAD will have the corresponding line type. For example, if you
give your contour a stroke color with as name 'Annotation', the contour will be in line type 'Annotation'
in ArtiosCAD. If the name is not an ArtiosCAD line type name, the contour will be a cut line. For
convenience, a swatch library ArtiosCAD Line Types is included with the plug-in. You can display the
swatch library by selecting Window > Swatch Libraries > ArtiosCAD Line Types. In this swatch library,
all ArtiosCAD design line types have been predefined.

How to add a cutout window to an existing ArtiosCAD file?
1. Open or place an ARD file.

If you also have Studio Designer, you will see a 3D view of your folded box in the Studio window.

 

 
2. Create and select the cutout shape that you want to add to the ArtiosCAD file.
3. Choose File > Structural Design > Export Selected Objects to ArtiosCAD File.

The Export Selected Objects to ArtiosCAD File appears.
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4. Do one or more of the following:

• Save the selected objects in the Main Design Layer.
• Include a copy of the original ARD file.
• Place this ArtiosCAD file in the document.

For more information on the different options, please refer to Export Selected Objects to ArtiosCAD
File on page 73.

5. Click Export.

The selected objects are saved in the Main Design Layer. They get the cut line type (which is
the default if you did not specify a swatch with as name an ArtiosCAD line type). Apart from the
selected objects, the original ARD file is copied in the resulting ARD file and the resulting ARD file is
immediately placed in the Illustrator document. If you have Studio Designer, you will automatically
see the ARD file with the cutout folded in 3D:
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How to modify a cutout window in an ArtiosCAD file?
1. Open or Place an ARD file that already contains a cut-out window.

 

78



3DeskPack Advanced

 

If you also have Studio Designer, you will see a 3D view of your folded box in the Studio window.
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2. Create and select the new cutout shape that you want to add to the ARD file.

 

 
3. Choose File > Structural Design > Export Selected Objects to ArtiosCAD File.

The Export Selected Objects to ArtiosCAD File appears.
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In the preview window you notice that you do not get the desired result. We need to remove the
original cutout window.

4. Click Remove Lines.

The Remove Lines dialog appears.

 

 
5. In this dialog, you can select the lines you would like to remove. It will not be possible to select the

new lines. You can choose to hide the new lines by enabling Hide New Lines.
6. Click and drag a rectangle around the original cutout window.

This window will be grayed out. This means that it will be removed in the final ARD file.
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7. Click OK.

This bring you back to the Export Selected Objects to ArtiosCAD File dialog. In the preview window
you notice that the original cutout has been removed.

 

 
8. Click Save As.
9. Specify a file name in the Save As dialog.

The software suggests the name of the loaded ArtiosCAD file followed by _copy.

82



3DeskPack Advanced

10. Click Save.

If you have Studio Designer, you will automatically see the ARD file with the new cutout folded in 3D.

 

 

3.5.  The Page Box Plug-in

3.5.1.  Introduction

Page Boxes are used to define the outside borders and margins of your document, and it is used in the
Esko Software Suite workflow environment.

Page Box definitions are saved as part of the Illustrator file used by the plug-ins Shuttle and
PowerLayout Client.

Page Boxes are not taken into account when printing directly from Adobe Illustrator, nor are they
exported when exporting to a non-native format via standard Adobe plug-ins. They do not appear as
objects in the Layers palette.

You can find the Page Box plug-in in Window > Esko > Trim Box and Media Box

The Page Box plugin can work in two modes:

• Trim Box and Media Box (defining only those two page boxes). See Trim Box and Media Box on page
84

• All Page Boxes. See All Page Boxes on page 87

You can switch mode by selecting Switch to [mode] from the fly-out menu.
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3.5.2.  Trim Box and Media Box

 

 

1. Trim Box Size: Select the size from the dropdown list.
2. Trim Box Width/Length: Enter the Width/Length if you want a custom size.

Tip:

The units are defined in the Illustrator preferences.

3. Trim Box Orientation: Select the orientation: portrait/landscape.

Note:

When the Trim Box is being dragged or Width or Height editboxes edited, the radio buttons
Portrait/Landscape flip automatically so that Landscape is active whenever Width > Height
and Portrait whenever Width < Height.

4. Fit Trim Box to

•
 Fit Trim Box to Artboard

•
 Fit Trim Box to Artwork

•
 Fit Trim Box to Selection

•
 Fit Trim Box to CAD

5. Media Box (Margins) enter the top, bottom, left and right values.
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Tip:

The units are defined in the Illustrator preferences.

6. Fit Media Box to

•
 Fit Media Box to Artboard

•
 Fit Media Box to Artwork

•
 Fit Media Box to Selection

•
 Fit Media Box to Bleed / CAD (when no bleed was defined the cad will be taken as reference)

7. Fit Artboard to

• Fit Artboard to Trim Box
• Fit Artboard to Media Box

8. Show Trim Box and Media Box: To display or hide the trim Box and Media Box, use this toggle.
9. See more page boxes: In case page boxes other than Trim and Media box are defined, this link will

open the All Page Boxes version of the palette. See All Page Boxes on page 87
10. Trim Box and Media Box dropdown menu

• Switch to All Page Boxes. see All Page Boxes on page 87

• Fit Trim Box to Artboard

• Fit Trim Box to Artwork
• Fit Trim Box to Selection
• Fit Trim Box to CAD
• Fit Trim Box to Crop Area
• Fit Media Box to ArtBoard
• Fit Media Box to Artwork
• Fit Media Box to Selection
• Fit Media Box to Bleed / CAD (when no bleed was defined the CAD will be taken as reference)
• Fit Media Box to AI Bleed Box
• Fit Artboard to Trim Box
• Fit Artboard to Media Box
• Use Transform bounds: if this option is enabled, TrimBox/MediaBox will respect as they are

defined in Adobe Illustrator. If disabled, TrimBox/MediaBox will respect visible bounds.
• Move Trim Box and Media Box ... open the 'Move Trim Box and Media Box' interface
• Delete Trim Box and Media Box

The figure below illustrates the Trim Box (borders) and Media Box (margins) of an output document as
interpreted on an Esko system. The full black line represents the borders (corresponding to one of the
above options) while the dotted black line indicates the margins of the document:
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Moving and Scaling Trim Box and Media Box
To move or change the size of the Trim and Media Boxes, you can either

• Select the Trim and Media Box Tool from the AI tool palette.

Use the Trim and Media Box to click and drag the Trim and Media Box.

• Select the Trim and Media Box Tool from the AI tool palette.

• ALT +drag = scale from the center out

• SHIFT + drag = constrained scaling

• ALT + SHIFT + drag = constrained scaling from the center out
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OR
• Select a preset from the drop down menu. OR
• Use the numeric input field. The numeric input field appears when you select Move Trim Box and

Media Box in the dropdown menu.
 

 

Tip:

Double-clicking Trim and Media Box tool in toolpalette opens the 'Move Trim Box and Media
Box' dialog.

OR
• You could use one of the “fit to” options (to Artboard, artwork, selection, cad or crop area).

Tip:

The units are defined in the Illustrator preferences.

3.5.3.  All Page Boxes

Using the All Page Boxes mode, you can set all 5 page boxes: Media Box, Crop Box, Bleed Box, Trim Box
and Art Box

 

 

1. Media box: this is the page format
2. Crop box: includes the Bleed box and all marks.
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3. Bleed box: defines the trimmed page plus the bleed.
4. Trim box: this is the net document format.
5. Art box: the Art box can be used to specify any section of the page.

You can see the dimensions of all Page Boxes in the Page Box list. You can

1. Select a Page Box in the list. Its details will be shown in the bottom part of the dialog.
2. Enable (or disable) the specific page box by enabling the Set [...] Box option.
3. Enter the offset, width and heigth. You can click the button to swap width and height. In the Size

dropdown, you can select any of the preset sizes.
4. Click one of the Fit to buttons to fit the selected page box respectively to the ArtBoard, Artwork,

Selection or CAD.
5. Use the Show All Page Boxes to show or hide all Page Boxes in your job.

3.6.  The Inspection Setup Plug-In

The Inspection Setup Plug-In allows you to define Inspection points or Inspection boxes in your job.

For each of these Inspection points, you will see the Lab value and DeltaE. For every Inspection box,
you can set the Profile. Inspection points and boxes will be exported, e.g. to be used in an Inspection
System in inline presses. This Inspection System will warn if the values measured at a specific position
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are more different from the entered Lab values than the allowed deltaE, or if the Inspection box or
Dynamic Art box doesn't match the defined profile.

The plug-in consists of

•
the Inspection Setup tool , under the Eyedropper tool in the toolbar

• the Inspection Setup palette, which can be opened by selecting the Inspection Setup tool, or by
adding an Inspection point.

3.6.1.  Adding and changing Inspection points

The Inspection Setup palette shows all the Inspection points, indicating the coordinates (distance
from the top left corner of the trim box), Lab value and default deltaE value.

•
Select the Inspection Setup tool  from the Illustrator toolbar and click in the job to insert a
new Inspection point.

The Inspection point will be visible in the job, with its number next to it.
• Select an Inspection point in the palette to highlight the corresponding Inspection point on the

Illustrator job. You can select multiple Inspection points
•

Select one or more Inspection points and click the delete button  to delete the Inspection
points
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• You can manually change the Lab and deltaE value for every Inspection Point.
•

Click the Refresh button  to update the Inspection Point list.
• You can move an Inspection point in two ways:

• Click within the Inspection point, and drag it to the new location
• In the Inspection Point list, change the coordinates for the Inspection point.

3.6.2.  Adding and changing Inspection boxes

The Inspection Setup palette shows all the Inspection boxes.

•
Select the Inspection Setup tool  from the Illustrator toolbar and click and drag in the job to
insert a new Inspection box.

The Inspection box will be visible in the job, with its number next to it. When creating a new
Inspection box, the Default Profile is used

• Select an Inspection box in the palette to highlight the corresponding Inspection box on the
Illustrator job. You can select multiple Inspection boxes.

•
Select one or more Inspection boxes and click the delete button  to delete the Inspection
boxes

• You can manually change the Profile.
• You can move or change an Inspection box in different ways:

• Click on the center point of the Inspection box, and drag it to move the Inspection box to a new
location

• Click one of the 8 handles on the Inspection box, and drag to modify the Inspection box

3.6.3.  Dynamic Art Placeholders

The Dynamic Art section of the Inspection Setup palette shows all Dynamic Art placeholders defined in
the job.

• Enable the checkbox in front of a Dynamic Art placeholder to use it as an Inspection box.

When adding a Dynamic Art placeholder, the Default Profile is used
• Select a Dynamic Art placeholder in the list to highlight the corresponding Dynamic Art placeholder

on the Illustrator job. You can select multiple Dynamic Art placeholders
• You can manually change the Profile.
• Disable the checkbox in front of a Dynamic Art placeholder to stop using it as an Inspection box.

3.6.4.  Import and Export

When exporting Normalized PDF, Inspection points and boxes added to a job are saved in the PDF file,
and these Inspection points and boxes will be recognized by Packadge and Automation Engine.
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Also, when opening a Normalized PDF from another Esko product (such as PackEdge), the Inspection
points and boxes information stored in the PDF document will be shown in the Inspection Setup
palette.

Note:  Dynamic Art placeholders are not saved as such in Normalized PDF. The selected
Dynamic Art placeholders will be exported as "Inspection Box". If you import the Normalized
PDF in Adobe Illustrator again, or open the Normalized PDF file in e.g. Packedge, these
Dynamic Art placeholders will be shown as Inspection Boxes

3.7.  Messages

The Messages plug-in is included with all Esko DeskPack plug-ins.

It displays the information, warnings and errors from all the other DeskPack plug-ins, and tells you
which plug-in generated them.

You can filter the messages you see when the Messages palette is open, and clear or save all messages
if you need to.

3.7.1.  The Messages Palette

The Messages palette pops up automatically when another DeskPack plug-in generates a warning or
an error.

You can also open it from Window > Esko > Messages.

 

 

This palette shows you:

•
the message’s severity (  information,  warning or  error),

• the message’s text in the Message column,

• which Plugin generated the message,

• the Time the message was generated at.
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Tip:  You can click the column headers to sort the messages, and drag the columns horizontally
to adjust their widths.

You can also use the palette to get extra information and / or select the objects that generated
warnings or errors:

• click a message to display extra information at the bottom of the palette.

 

 
• click the triangle in front of a message to see the list of objects it relates to.

 

 
• click one of the objects in the list to select it in the file.
• double-click that object to select it and zoom in on it in the file.
• double-click the message to select and zoom in on all objects it relates to in the file.

3.7.2.  Filtering the Messages

You can show or hide certain types of messages using the palette’s fly-out menu.

• To hide:

• all informational messages, select Hide Info Messages in the fly-out menu,
• all warnings, select Hide Warning Messages,
• all errors, select Hide Error Messages.

• To show them again, select either:

• Show Info Messages,
• Show Warning Messages,
• Show Error Messages.

• To only show the last message, select Show Last in the fly-out menu.
• To show all messages again, select Show All.

When showing all messages, you can see Show: All at the bottom right of the palette.

When filtering messages (for example filtering out the warning messages, or showing only the last
message), you can see Show: Filtered at the bottom right of the palette.

3.7.3.  Saving the Messages

To save all messages in a text file:
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1. Select Save Messages as... in the fly-out menu.
2. In the browser window that opens, choose the name and location to use for saving your file.

3.7.4.  Clearing the Messages

• To remove all messages from the Messages palette, select Clear in the fly-out menu.

3.8.  Esko Document Setup

By choosing File > Esko Document Setup you can open the Esko Document Setup dialog.

The settings made here are saved in the Esko XMP Document Information.

3.8.1.  Distortion

The vertical and horizontal distortion value is saved with the document and used by Esko RIPs when
generating the final output. It allows to compensate for distortions in certain printing methods, e.g.
flexography. On mounting a flexo plate on the press, it is stretched out in one direction. By making the
output slightly smaller than needed (e.g. 95%), we compensate for this distortion.

Values for vertical and horizontal distortion is limited to 90% - 110%.

3.8.2.  Screen Registration

The Screen Registration parameter allows to choose

•

if the RIP should reset the screening origin for every one-up 

•

or keep the same screening origin for the complete document 

Below a schematic representation of a Repetition with (left) and without (right) resetting the screen
origin for every one-up.
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3.9.  Annotations

With the Annotations plugin, you can view .xfdf annotations generated by Global Vision and
WebCenter.

Since version 16, Global Vision SDK has been integrated in Esko's Automation Engine, allowing several
types of Global Vision Check tasks to be run.

The output of a Global Vision Check is an .xfdf file, highlighting the found errors and problems on the
document.

The .xfdf file can be loaded (see Loading XFDF files on page 94) and the annotations are shown in the
Annotations palette (see The Annotations palette on page 95).

3.9.1.  Loading XFDF files

Whenever a file is opened in Adobe Illustrator, the Annotations plugin will try to find the corresponding
XFDF file to open.

• For GlobalVision annotations, the supported file types are Adobe PDF, Normalized PDF and Adobe
Illustrator file

• For WebCenter annotations, the supported file types are Adobe PDF, Normalized PDF, Adobe
Illustrator file, Adobe Illustrator ZIP file and ARD.

If for example a file "sample.pdf" is opened, the plugin will search for the corresponding .xfdf file in the
following locations, in the specific order shown below.

1. .view/sample.pdf/*.xfdf

94



3DeskPack Advanced

2. .view/sample*.xfdf

3. sample*.xfdf

4. ./sample_wcr.xfdf for WebCenter annotations

3.9.2.  The Annotations palette

The Annotation palette will show all Annotations found in the .xfdf file. You can open the palette by
choosing Window > Esko > Annotations.

 

 

There are different types of annotations: Barcode, Braille, Spell Check, Artwork, Text Compare and
WebCenter annotations.. You can browse to them by clicking the buttons on top of the palette.

Note:  If the document only contains WebCenter annotations, you will not have any filtering
options. If your document only contains Global Vision annotations, the "WebCenter" button will
be hidden.

For every issue found, an entry in the list is shown. Some of these annotations have text content, while
others can have an image preview, showing the difference between the actual artwork and how it
should look.
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If Show only selected annotations is enabled, only the annotations you select in the list will be
highlighted in your job using a colored rectangle. Otherwise, all annotations in the job will be
highlighted.

If Zoom is enabled, selecting an annotation in the list will automatically zoom in on the issue.

3.9.3.  Multipage PDF files with Annotations

An XFDF file can contain annotations for a multipage PDF. Every annotation will have a reference to
what page it belongs to.

If you import a multipage Normalized PDF, the plugin knows what page you imported, and only the
Annotations for that specific page will be shown.

If you import a multipage PDF as Adobe PDF, the plugin can't know what page you imported. In that
case, the Annotation palette will have a dropdown at the bottom of the palette, to decide for what page
you want to load the annotations.

Note:  Multi-page annotations is not supported for WebCenter annotations

3.9.4.  Editing WebCenter annotations

You can edit existing WebCenter annotations or create new annotations, and save them back to
WebCenter.

To create new annotations, you can use the Annotation Tool. See Creating new annotations using the
Annotation Tool on page 97

For every annotation (or reply), you can use the dropdown menu to modify the annotation.
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• Select Accepted. Rejected, Cancelled, Completed, or None to change the status of the annotation
accordingly.

• Select Edit to change the text of an annotation, or to move or resize the annotation.

You can click and drag the annotation to move it, or you can click and drag any of the handles on the
annotation to resize it.

The dialog will be extended, offering text editing options.

 

 

Note:  Clicking the Save button will store your changes in the (local) annotation, but will
NOT save the annotation back to WebCenter. The annotation will be an "unsaved annotation"
until you use Save Annotations from the fly-out menu. See below.

• Select Delete to remove the annotation.

• Select Copy to copy the content of a comment or annotation. This will open the Copy to Clipboard
dialog. Select the text you want to copy, and click Copy.

• Select Reply to add a reply to an annotation.

Note:  You can only reply to an annotation, not to a reply.

• If there are unsaved changes in the annotations, the Annotations palette will show a warning.

Choose Save Annotations from the fly-out menu in the Annotations palette to save the new or
modified annotations back to WebCenter. See Updating and Saving Annotations on page 98

3.9.5.  Creating new annotations using the Annotation Tool

Using the Annotation Tool you can create new annotations.

1. Click the Annotation Tool in Adobe Illustrator's tool box.
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2. Select the type of annotation you want to create.
3. Click or drag where you want to create the annotation.
4. In the Annotations palette, enter the text for the annotation

 

 
5. Click the Save button to store your annotation text, or click Delete to remove the annotation.
6. If necessary, repeat the previous steps to create additional annotations.
7. Choose Save Annotations from the fly-out menu in the Annotations palette to save the new

annotations back to WebCenter. See Updating and Saving Annotations on page 98

3.9.6.  Updating and Saving Annotations

Each annotation contains a time stamp of creation. In case the source file is modified and saved later
than the annotation, a warning icon will be shown on top of the palette, indicating the annotations
might be out of sync with the document.

Also when you edit Annotations (see Editing WebCenter annotations on page 96) or create new
annotations (see Creating new annotations using the Annotation Tool on page 97), a warning icon is
shown, indicating that these annotations are unsaved.

You can use Save Annotations from the fly-out menu to save all unsaved annotations to WebCenter.

You can use Update Annotations from the fly-out menu in the Annotations palette to get the latest
annotations from WebCenter.
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If you select Update Annotations while your document contains unsaved annotations, a warning will
be shown, asking if you wish to save the annotations. You can select Yes to save the annotations to
WebCenter, or click No to ignore the unsaved changes and get the latest annotations from WebCenter.

Note:

In case the annotations can not be loaded or saved (e.g. you are no longer logged in with
WebCenter Connector, there are no annotations available for the document, or the document
no longer exists) you will get a warning message indicating why loading or saving didn't work.

You can not save annotations, edit annotations or reply to an annotation if the Annotations
plugin is older than version 16.1.2, or if the WebCenter Connector plugin or WebCenter server is
not the latest version.

3.10.  Esko Plug-ins Dashboard

On your Esko Plug-ins Dashboard, you can:

• See which features you use, and how often,
• Learn how many files are processed with your Esko plug-ins,
• Get configurable reports for your company.
• Get personalised suggestions and complimentary training.

To build the dashboard, Esko needs to collect personal data about your plug-ins usage.

1. Open the Dashboard panel by choosing Help > Esko > Dashboard...
2. Click the Yes, I want a dashboard button.
3. Sign in with your Esko ID

More information about Esko ID can be found here

Note:  If you already enabled Dashboard before, you can skip step 2 and 3.

4. Click the Go to my Esko Plug-ins Dashboard link to open the Dashboard

3.10.1.  Opt Out

At any time, you can opt-out and stop the personal data collection.

1. Open the Dashboard panel by choosing Help > Dashboard...
2. Click the Opt Out button.
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3. If you click Opt Out, Esko stops collecting personal data, but still gathers anonymous usage data to
help us improve the product.

3.10.2.  More about the dashboard and data collection

Insights for you and your team
You will get a dashboard for DeskPack and/or for Studio where you can check that you are getting
the most out of your software investment. You can filter on those features that are the most valuable
to you, and keep track of how often they are used, how many files are handled, and by how many
people across your company. If your colleagues also opt in, you can also combine the data in a single
dashboard for your company.

What data is collected?
We automatically collect your Esko plug-in usage:

• Basic information about your computer (OS version, language, screen resolution, ...).
• Your version of Adobe Illustrator and which Esko plug-ins are installed.
• Which actions you perform on Esko plug-in, including some of their parameters.

If you opt in to the dashboard, then this usage data is tagged with your EskoID (name and email). If you
do not opt in, then this usage data is anonymous.

Either way, We do not collect information that can be used to identify your client or the designs that
you work on (such as text statements, barcodes, separation names or filenames).

Your data is protected
Your usage data will be available only to Esko and (if you opt-in) to you and to your colleagues (based on
the company code of their Esko IDs). Learn more about Esko ID and check out our privacy policy.

Help us improve our products
Sharing your usage data with Esko allows us to learn about your configuration and your use of our
products. This data enables us to focus on the features that matter the most to you.

Opt-out whenever you want
At any time, you can opt-out and stop sharing personal data. Just choose Help > Esko > Dashboard and
click the Opt Out button.
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4.  Adobe Illustrator Client

4.1.  Copyright Notice
© Copyright 2022 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com

4.1.1.  Third party license information

This product includes curl.

      COPYRIGHT AND PERMISSION NOTICE

      Copyright (c) 1996 - 2020, Daniel Stenberg, <daniel@haxx.se>, and many
      contributors, see the THANKS file.

      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
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------------------------------------------------------------

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
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    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------

This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
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        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes svgio.

 Copyright Oleg Maximenko 2014.
 Distributed under the Boost Software License, Version 1.0.
    
------------------------------------------------------------

This product includes QtSvg.

      The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes appleseed.
The MIT License (MIT)

Copyright (c) 2010-2013 Francois Beaune, Jupiter Jazz Limited
Copyright (c) 2014-2019 The appleseedhq Organization
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Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
    
------------------------------------------------------------

This product includes bcd.
        
    Copyright (c) 2017 Malik Boughida and Tamy Boubekeur. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors
   may be used to endorse or promote products derived from this software
   without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You are under no obligation whatsoever to provide any bug fixes, patches, or
upgrades to the features, functionality or performance of the source code
("Enhancements") to anyone; however, if you choose to make your Enhancements
available either publicly, or directly to the authors of this software, without
imposing a separate written license agreement for such Enhancements, then you
hereby grant the following license: a non-exclusive, royalty-free perpetual
license to install, use, modify, prepare derivative works, incorporate into
other computer software, distribute, and sublicense such enhancements or
derivative works thereof, in binary and source code form.
    
------------------------------------------------------------

This product includes glad.

        The MIT License (MIT)

Copyright (c) 2013-2018 David Herberth

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes murmurhash3.
MurmurHash3 was written by Austin Appleby, and is placed in the public domain. The author
 hereby disclaims copyright to this source code.
------------------------------------------------------------

This product includes zlib.

 (C) 1995-2022 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2020 The Botan Authors
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are met:

      1. Redistributions of source code must retain the above copyright notice,
        this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions, and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
    
------------------------------------------------------------

This product includes pugixml.
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      MIT License

      Copyright (c) 2006-2019 Arseny Kapoulkine

      Permission is hereby granted, free of charge, to any person
      obtaining a copy of this software and associated documentation
      files (the "Software"), to deal in the Software without
      restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the
      Software is furnished to do so, subject to the following
      conditions:

      The above copyright notice and this permission notice shall be
      included in all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
      EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
      OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
      HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
      WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
      FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
      OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products 
  derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version:  7.0

Copyright (C) 1999-2007  Brian Paul   All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
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BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.
  
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes tesseract.

  Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes robin-map.

    MIT License

    Copyright (c) 2017 Tessil

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in all
    copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
    SOFTWARE. 
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
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      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes cereal.

    Copyright (c) 2013-2022, Randolph Voorhies, Shane Grant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:
        * Redistributions of source code must retain the above copyright
          notice, this list of conditions and the following disclaimer.
        * Redistributions in binary form must reproduce the above copyright
          notice, this list of conditions and the following disclaimer in the
          documentation and/or other materials provided with the distribution.
        * Neither the name of the copyright holder nor the
          names of its contributors may be used to endorse or promote products
          derived from this software without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY
    DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
    ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
      
      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.
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      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
 THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
 ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes llvm.

      University of Illinois/NCSA
      Open Source License

      Copyright (c) 2003-2019 University of Illinois at Urbana-Champaign.
      All rights reserved.

      Developed by:

          LLVM Team

          University of Illinois at Urbana-Champaign

          http://llvm.org

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal with
      the Software without restriction, including without limitation the rights to
      use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
      of the Software, and to permit persons to whom the Software is furnished to do
      so, subject to the following conditions:

          * Redistributions of source code must retain the above copyright notice,
            this list of conditions and the following disclaimers.

          * Redistributions in binary form must reproduce the above copyright notice,
            this list of conditions and the following disclaimers in the
            documentation and/or other materials provided with the distribution.

          * Neither the names of the LLVM Team, University of Illinois at
            Urbana-Champaign, nor the names of its contributors may be used to
            endorse or promote products derived from this Software without specific
            prior written permission.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
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      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS WITH THE
      SOFTWARE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
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         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes xxHash.

    xxHash Library
    Copyright (c) 2012-2014, Yann Collet
    All rights reserved.

    Redistribution and use in source and binary forms, with or without modification,
    are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this
    list of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
    list of conditions and the following disclaimer in the documentation and/or
    other materials provided with the distribution.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
    ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes lz4.

        Copyright (C) 2011-present, Yann Collet.

        BSD 2-Clause License (http://www.opensource.org/licenses/bsd-license.php)

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:

            * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
            * Redistributions in binary form must reproduce the above
        copyright notice, this list of conditions and the following disclaimer
        in the documentation and/or other materials provided with the
        distribution.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.
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      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in the
      Software without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XByak.
   
Copyright (c) 2007 MITSUNARI Shigeo
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
Neither the name of the copyright owner nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
-----------------------------------------------------------------------------
#######################################
#######################

#######################################
#######
#######################################
##########################
#######################################
###################################
#######################################
#######################################
######################################
########################### ###########
#######################################
######################################
######################################
#######################################
######################################
################
    
------------------------------------------------------------

This product includes ittnotify.
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Copyright (c) 2011, Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes PCRE.

  Copyright (c) 1997-2016 University of Cambridge
  All rights reserved.

  Copyright(c) 2010-2016 Zoltan Herczeg
  All rights reserved.

  Copyright(c) 2009-2016 Zoltan Herczeg
  All rights reserved.

  Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions are met:

      * Redistributions of source code must retain the above copyright notice,
        this list of conditions and the following disclaimer.

      * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      * Neither the name of the University of Cambridge nor the names of any
        contributors may be used to endorse or promote products derived from this
        software without specific prior written permission.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
  AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
  LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
  SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
  INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
  CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
  ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
  POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Little CMS.
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    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes OpenShadingLanguage.

BSD 3-Clause License

Copyright (c) 2009-2019 Sony Pictures Imageworks Inc., et al.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes leptonica.

 -  Copyright (C) 2001-2016 Leptonica.  All rights reserved.
 -
 -  Redistribution and use in source and binary forms, with or without
 -  modification, are permitted provided that the following conditions
 -  are met:

116



4DeskPack Advanced

 -  1. Redistributions of source code must retain the above copyright
 -     notice, this list of conditions and the following disclaimer.
 -  2. Redistributions in binary form must reproduce the above
 -     copyright notice, this list of conditions and the following
 -     disclaimer in the documentation and/or other materials
 -     provided with the distribution.
 -
 -  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 -  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 -  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 -  A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL ANY
 -  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
 -  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 -  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 -  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
 -  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 -  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 -  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes OpenImageIO.
    
        BSD 3-Clause License

Copyright (c) 2008-present by Contributors to the OpenImageIO project. All Rights
 Reserved.

Redistribution and use in source and binary forms, with or without modification, are
 permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
 conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
 conditions and the following disclaimer in the documentation and/or other materials
 provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to
 endorse or promote products derived from this software without specific prior written
 permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
 OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
 SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
 INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
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 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJDK.
 
The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".
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Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)
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The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
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spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
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    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes tessdata.

 Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
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      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes openexr.

      Copyright Contributors to the OpenEXR Project. All rights reserved.

      Redistribution and use in source and binary forms, with or without modification,
 are permitted provided that the following conditions are met:

          * Redistributions of source code must retain the above copyright notice, this
 list of conditions and the following disclaimer.

          * Redistributions in binary form must reproduce the above copyright notice,
 this list of conditions and the following disclaimer 
            in the documentation and/or other materials provided with the distribution.

          * Neither the name of the copyright holder nor the names of its contributors
 may be used to endorse or promote products derived from this software 
            without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
 DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS 
      BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
      GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
 CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
 THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
    
------------------------------------------------------------

This product includes ZXing C++ Library.

      --------------------------------------------------------------------------------
      NOTICES FOR C++ Big Integer Library
      --------------------------------------------------------------------------------

      I, Matt McCutchen, the sole author of the original Big Integer
      Library, waive my copyright to it, placing it in the public domain.
      The library comes with absolutely no warranty.
  
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
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------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2020
 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------
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4.2.  Server Connection Assistant

The assistant will appear automatically the first time you start Illustrator after installing the DeskPack
plug-ins and every time the Esko Plugins preferences are deleted.

You can also find the DeskPack Server Connection Assistant: Edit > Preferences > Esko > Server
Connection Assistant… (on PC) or Illustrator > Preferences > Esko > Server Connection Assistant…
(on Mac).

Note:

Not only DeskPackContainer but also bg_data_cms_v010 will be mounted.

The Server Connection Assistant is a wizard-like configuration tool. It tells the DeskPack plug-ins:

1. Which Automation Engine Server to use (e.g. on which server to write temporary data and to launch
workflows).

Note:

This server will automatically be added to the Shuttle Server List. See the Shuttle
documentation.

2. Where the DeskPackContainer file share is located (by default this share is located on the
Automation Engine server).

3. Which user account should be used to authenticate to Automation Engine and to launch AE tasks.

Note:

All the configuration data you supplied in the Server Connection Assistant are stored in the
Esko Plugins preferences.

You may delete the Preference file, to delete the current set up and to force the Server
Connection Assistant to pop up the next time Illustrator is started.

You will need the Server Connection Assistant in the following cases:

1. At system installation time. After installing the plug-ins (see Installation Manual) the Server
Connection Assistant will start up automatically the first time you launch Illustrator.

2. If the Esko Plugins preferences have been deleted or have become corrupt.
3. If you need to switch to a different Automation Engine server. In this case the Server Connection

Assistant can be started manually using the menu: Illustrator > Preferences > Esko > Server
Connection Assistant….

The Server Connection Assistant Step-by-Step

1. When launching the Server Connection Assistant you will first get this Introduction screen.

• Choose the first option to connect to an Automation Engine Server
• Choose the second option if you only want to connect to a Color Engine share, without using

a complete Automation Engine server. If the share is not on the specified server or if it's not
available, a message is shown. If you cancel, the local bonsai CMS will be used instead.
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• Choose the third option to remove the connection to a server.

 

 
2. Click right arrow to continue.

Fill out the name of the Automation Engine Server that will be used by the plug-ins to execute
background tasks on.

 

 
3. IP address of the Automation Engine Server. If the Server Connection Assistant is unable to retrieve

the IP address corresponding with the server name you entered, it will display an additional screen
which allows you to specify the IP address manually.
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4. Allows you to specify the name of the server that hosts the DeskPackContainer file share. By default

the share is located on the Automation Engine server itself.

 

 
5. Enter User Name and Password to access the Automation Engine server.

• If you have an internal or Windows user account on Automation Engine, you can sign in with a
User Name and Password.

• When available, you can choose to sign in using an identity provider, which will redirect you to
the corresponding webpage to enter your credentials
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6. The next screen confirms that the server has found the network.

 

 

Note:  For DeskPack 20 and later, if the shares cannot be auto-mounted by the operating
system (for example using the password stored in the macOS Keychain), a standard OS
dialog for mounting the shares pops up.

7. Click Go Ahead and then Done to finish the setup.
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Note:

After completion of the Server Connection Assistant, Adobe Illustrator must be restarted to
make the settings effective.

You can launch the Server Connection Assistant at any time manually: Illustrator > Preferences > Esko
> Server Connection Assistant…:

4.3.  Launch Workflow

Note:

Launch Workflow is available when both Adobe Illustrator Client and the Automation Engine
Server you are connected to are version 22.07 or later.

When either Adobe Illustrator Client or Automation Engine Server are version 22.03 or older:

• When connected to an on-premises server, launching workflow is done using Shuttle. For
more information we refer to the Shuttle documentation here.

• When connected to an Automation Engine SaaS server, you can use the Tasks palette. Fore
more information we refer to the Adobe Illustrator Client documentation version 22.03 here.

Use Launch Workflow to submit the current document to a selected output task (running in
background on the server).

Click File > Launch Workflow...

The Launch Workflow dialog opens:
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Click the button next to Job to select a Job on Automation Engine. Click the button next to Workflow
to select a Workflow on your Automation Engine Server.

If you get the messages "Workflow doesn't exist" or "No public workflows defined in the servers", you
need to make your workflows public in the Automation Engine Pilot.
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Once a task is launched, you can use the My Workspace Activity palette to monitor the
task status and open the output file from the palette. To open it, choose Window > Esko >

Server

For more information on My Workspace, we refer to the Automation Engine documentation here and
the Blended Learning modules here.

Note:  When Adobe Illustrator Client 22.07 or later is connected to an on-premises Automation
Engine server version 22.07, you can switch back to the old Shuttle based Launch Workflow
by enabling Use Legacy Shuttle in the Preferences: Illustrator > Preferences > Esko > Shuttle
Preferences. For more information on Shuttle we refer to the Shuttle documentation here

4.4.  Job folder: Open, Save, Place, Relink Image

When connected to an Automation Engine server, you can open a document from an Automation
Engine Job or Product using File > Job Folder > Open from Job Folder...

When opening from a Job folder, you can use the Search dialog to find a specific Job or Product

When connected to an Automation Engine SaaS server, you can use File > Job Folder > Place from Job
Folder... to place a file located on the SaaS server directly into your document.

When connected to an Automation Engine SaaS server, you can use File > Job Folder > Relink from
Job Folder... to replace an image by an image located on the SaaS server, e.g. to solve a missing link
issue.
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You can save a document to an Automation Engine Job or Product using File > Job Folder > Save to
Job Folder...

4.5.  Known Limitations

RGB

RGB documents or documents containing linked RGB images are not supported.
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5.  boostX

5.1.  Using boostX

5.1.1.  boostX Preferences

To open the boostX preferences, choose Illustrator > Preferences > Esko > boostX Preferences.
Please refer to the chapter on Working with Crosshair alignment tools  on page 145, for the explanation
on the Crosshair Preferences.

The boostX Tool Layout preference allows you to place the different boostX tools either integrated
with the Illustrator tools, grouped or as individual tools in the Illustrator tool bar.

With the boostX Menu Layout preferences you can choose if the boostX menus should appear in
menus Object > Path and Select > Esko (Integrated) or in Object > Filters > Esko (Single Menu Group).

 

 

5.1.2.  Selecting Objects

Area Select Tool
The Area Select tool allows you to marquee select objects. The objects are only selected if the Marquee
select box is created around the entire object or clicked on directly.

The Area Select tool allows you to select only the objects you wish to work with, in contrast, the Adobe
Illustrator Selection tool will select an object if the Selection tool touches or is drawn through an
object.

With the boostX Area Select tool objects cannot be moved inadvertently.

 

133



5 DeskPack Advanced

 

 

 

The boostX Select Tool can be found in the toolbar under the Adobe Illustrator Select tool.

Create a Marquee Selection box around the object or objects you wish to select. The selection is
highlighted.
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Tip:

Holding down the Option key while making a boostX marquee selection, rotates the selection
from the point of “marquee" origin. Holding down the Shift key will “snap” rotate the marquee
selection in 45 degree increments.
 

 

Tip:

Use shortcut 'v' to switch to the Illustrator select tool.

The boostX Direct Select Tool can be found in the toolbar under the Adobe Illustrator Direct Select
tool.

Create a Marquee Selection box around an object’s compound path or individual objects within a
“Group” of objects. The selection is highlighted.

The boostX Area Direct Select tool allows you to marquee select objects and then edit or modify the
object’s compound path, as in the inside of a “donut like” object. The boostX DirectSelect tool also
works on individual objects within a “Group” of objects.

Using the Adobe Illustrator Direct Select tool only allows you to edit and reposition an object’s
individual node points. Using the boostX Select tool allows you to select “complete” subpaths of
compound or grouped objects.

 

 

Dust Select Tool
The Dust Select tool allows you to select objects of equal or lesser size based on the Marquee Select
box you create. The marquee Select box can be created anywhere on the drawing surface. The Dust
Select tool will calculate the area and search the drawing for other objects of the same size or smaller
and select those objects.
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Note:  The Dust Select tool will take both width and length into account and will not only look at
the surface area.

The Dust Select tool is a useful utility for finding small, dust-like objects. These small objects can be
too small for printing or are artifacts of scanned artwork that need to be removed.

The Dust Select tool can be found in the toolbar under the Adobe Illustrator Select tool.

To create a selection, use your mouse to make a Marquee Selection box of a desired size. The Dust
Select Tool will search the drawing to select the objects of the same size or smaller, all objects
satisfying the size parameters are now highlighted.

The Dust Direct Select tool allows you to marquee select objects or their compound paths to
determine a selection. The Dust Direct Select tool can be found in the toolbar under the Adobe
Illustrator Direct Select tool.

 

 

Tip:

First draw your selection marquee and press CTRL holding the selection to delete everything in
the selection.

To create a selection, use your mouse to make a Marquee Selection box of a desired size. The Dust
Direct Select Tool will search the drawing to select objects, paths of compound objects, or paths of
groups of the same size or smaller.
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Selection tools under Select > Esko

Select Dust

The Dust Select filter searches your document for objects of the same size as the selected object, by
area calculation or smaller. Ideal for scanned artwork clean-up.

Inspect the drawing to determine the biggest object that should be removed, select that object, then
enable the boostX Dust select filter. All objects of the same size or smaller are selected. Now you can
decide to delete these objects or edit them.

To use Select Dust, select the object you want to use as reference, and choose Select > Esko > bX
Select Dust

The filter will search the drawing document and select the objects which are the same size, by area, or
smaller.
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Select Overprinting Objects

The bX Select Overprinting Objects searches your document for objects that are in overprint.

Click Select > Esko > bX Select Overprinting Objects and all objects in overprint will be selected.

Select White Overprinting Objects

The bX Select White Overprinting Objects searches your document for objects which fill or stroke is
white (all inks = 0%) and overprintring.

Click Select > Esko > bX Select White Overprinting Objects and all objects with a fill or stroke that is
white and overprinting will be selected.

Select Uncolored Art

The bX Select Uncolored Art selection filter searches your document for objects that have no fill color
or stroke color assigned to them.

Click Select > Esko > bX Select Uncolored Art and all objects without a fill color and stroke color will be
selected.

Select by Attributes
Select by Attributes opens the Select by Attributes palette, from which you can define a custom
selection filter based on the attributes of the objects in the Illustrator document.

Select By Attribute is both a productivity and a QA tool. It allows you to quickly select all elements in
the file (or sub-select within a selection) that comply with your criteria; color, object type, appearance
and even the shape of the object. Use it as a QA tool to trace elements in your document that are
outside the printing specifications (small text, thin lines, ...).

Click Select > Esko > Select By Attributes, to open the Select By Attributes palette.

Why Select by Attributes?
By combining multiple selection criteria in the Select by Attributes panel, you can create your own
special, tailor-made selection filter.
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The Select By Attributes option comes with four buttons Select, Refine, Deselect and Collect.

• Select: Select all objects in the document that match the criteria that are currently selected .
• Refine: Refine the current selection by adding additional selection criteria. This allows you to

quickly fine tune your result.
• Deselect: Deselect all objects that match the new selection criteria within the current selection.
• Collect: Make a Collection of all the objects in the document that match the criteria that are

curently selected. See Collection on page 142

Selection groups
The following groups of selection criteria are available:

• Object Type
• General Attributes
• Fill and Stroke
• Appearance
• Color

It's good to know that Select By Attributes works differently when combining selections within the
same selection group or when combining selection criteria in different selection groups.

When adding selection criteria in the same selection group, Select by Attributes will simply add the
search criteria, e.g. searching in "Object Type" for a "Path", "Text" and a "Mesh" will result in a selection of
all paths, all text and all mesh objects.

However when combining selections in different selection groups, Select by Attributes will combine
the selection criteria. e.g. searching for "Text" in "Object Type" and "Stroke" in "Fill and Stroke" will only
select text objects colored with a stroke.

Note:  Click on a triangle to collapse or expand the section. Alt-click on an expanded section to
open all the sections. Alt-click on a collapsed section to expand that secttion and collapse all
others.

Object Type

The Object Type group has 11 options:

• Path: Select objects based on the path type: Open, Closed or Compound. Using Any option, the
selection is made between objects which are Open, Closed or Compound.
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• Text: Select all text, or all text smaller than the point size you specify in the Text field.

• Symbol: Select all the objects that are Adobe Illustrator symbols.

• Linked File: Select objects or images which have been linked to (and not embedded into) the Adobe
Illustrator file.

• Image: Selects all placed image files of the file type defined in the list. The image has to be
embedded in the file.

• Mesh: Select all objects that are Adobe Illustrator Mesh objects.

• Dynamic Barcodes: Select dynamic barcode objects generated by the Esko Dynamic Barcodes
plug-in.

• Dynamic Table: Select dynamic table objects generated by the Esko Dynamic Tables plug-in.

• Dynamic Object: Select XML-driven dynamic objects generated by the Esko Dynamic Content plug-
in.

• Thin Part Fix: Select objects created by using the Fix button in the Thin Parts function of the
Preflight For Illustrator plugin.

• Trapping Tags: Select objects that have a Trapping Tag or Reverse Trapping Tag defined, used by
Esko Trapping.

General Attributes

The General Attributes group has three options:

• Name: Select an object by typing its name. The name of an object can be found and modified in the
Illustrator Layer palette. Object names are by default placed between angled brackets (< >). Note
that you do not need to type the brackets, and that object names are case sensitive.

• Size: Select the size of the object (smaller or bigger than the typed size in mm).

• Shape: Select the objects which are of the same shapes as defined in the list. Note that the Similar
as Selected Objects option will only function if an object is selected.

Fill and Stroke

The Fill and Strokes group has two options:
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• Fill: Select the objects with a fill.

• Stroke: Select all strokes, or strokes smaller than the size you specify in the Text field.

Appearance

The Appearence group has seven options:

• Current Style: Select objects similar to the selected object. The selection is tied to the style of the
Illustrator color palette. This means that you can also search for any object with a certain style.

• Fill Type: Select the objects with a certain Fill type. You can choose between Solid, Gradient or
Pattern.

• Opacity: Select the objects that have a fill or a stroke with an opacity level or transparency lower
than a certain percentage.

• Blending: Select objects that have a fill or a stroke set with one of the blending types, for example
darken or multiply . Select a blending mode from the drop down list.

• Overprint: Select the objects set in overprint.

• Opacity Mask: Select any objects with an Opacity mask linked to it. Opacity masks are used to alter
the transparency of objects and can also be selected via the "Opacity" option.

• Effects: Select any object that has an Adobe Illustrator Effect applied to it.

Color

The Color group has several options:
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• Fill Contains Ink: Select an object based on the ink used for its fill. This can be a process color ink or
a spot color ink.

• Use the "Lower than" and "Higher than" options to only select the objects with certain
percentages of the ink.

• Select the No other inks present check box if you only want to select objects with a fill in the
selected ink, but without other additional inks.

• Stroke Contains Ink: Select an object based on the ink used for its stroke. This can be a process
color ink or a spot color ink.

• Use the "Lower than" and "Higher than" options to only select the objects with certain
percentages of the ink.

• Select No other inks present check box if you only want to select objects with a stroke in the
selected ink, but without other additional inks.

• Fill Color is: Select an object based on the color used for its fill. By clicking once the color patch will
take the color of the object currently selected or when no selection is made it takes the Illustrator
current style. When multiple different objects are selected and you click once the default color
black is chosen. Double-clicking the patch will open the Illustrator Color Picker.

• Stroke Color is: Select an object based on the color used for its stroke. By clicking once the color
patch will take the color of the object currently selected or when no selection is made it takes the
Illustrator current style. When multiple different objects are selected and you click once the default
color black is chosen. Double-clicking the patch will open the Illustrator Color Picker.

Tip:  Change your current style for fill or stroke to "None" (see Tools palette or Appearance)
and select all objects with no fill or no stroke.

• White: Select any object with a white fill or stroke.

5.1.3.  Collection

A Collection is a temporary set of objects, based on a selection. It allows to navigate through the
objects in the Collection, automatically zooming in on them.

A collection is temporary, and only kept until it is cleared, or until the document is closed.

1. Select a number of objects.
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You can select objects manually, or by using e.g. Select by Attribute
2. Choose Window > Esko > Collection... to open the Collection dialog

 

 
3. Click the Make Collection button to make a collection based on the selection

Note:  By clicking the Collect button in the Select by Attribute palette, you can skip step
2 and 3, and immediately create a collection based on the properties set in the Select by
Attribute palette . See also Select by Attributes on page 138

4. Browse through the collection
 

 

The Collection dialog will show the number of objects in the Collection

• Use the browse buttons to navigate through the different objects in the collection
• The Info field shows the type of object currently selected
• Select the Zoom option to automatically zoom in on the currently browsed object.
• Select the Select option to automatically select the currently browsed object.

Note:

Selecting or deselecting objects doesn't change the collection. You can still select and/or
edit objects, without loosing your collection.

Modifying a Collection
You can modify the Collection using one of the functions in the fly-out menu of the Collection palette:

• Click the Make New Collection button or select Make Collection from the fly-out menu to "forget"
the current collection, and create a new collection based on the current selection.
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• Select Clear Collection from the fly-out menu to "forget" the current collection.
• Select one or more objects in the job, and select Add Selection from the fly-out menu to add the

selected objects to the collection.
• Browse to an object in the collection, and select Remove Selection from the fly-out menu to

remove the selected objects from the collection.

Note:  Objects that are removed in the job, are automatically removed from the collection.

• Select Select All from the fly-out menu to select all objects in the collection.

5.1.4.  Crosshair Tool

Crosshair Palette
The Crosshair palette allows you to create Origin Guide rules, intersecting 'x' and 'y' guide lines. These
guide lines can be rotated and positioned anywhere within the Adobe Illustrator drawing area. Objects
within the drawing can be snapped to position along the guides.

To select the Crosshair palette Choose Window > Esko > boostX > Crosshair. The boostX Crosshair
palette appears.

 

 

Horizontal Crosshair offset
 

 
Position of the “x’ axis crosshair guide line, positioned from the drawing origin point.

Vertical Crosshair
 

 
offset Position of the “y” axis crosshair guide line, positioned from the drawing origin point.

Crosshair Rotation
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Specify rotation angle of Crosshair Guide lines, - 45 degrees to +45 degrees around the Horizontal and
Vertical intersection point.

1. Align Art: Selected objects will be positioned to Crosshair guides according to Crosshair alignment
options.

2. Align Crosshair: Crosshair guides will be positioned to selected objects according to Crosshair
alignment options.

3. All Directions: Objects will be positioned along both Crosshair guides. Choose a position from the
Alignment Position Window. All 9 Alignment Position Buttons are active.

4. Align Vertical: Objects will be positioned along the vertical crosshair guide. Choose a position from
the Alignment Position Window. Center vertical Alignment Position Buttons are active.

5. Align Horizontal: Objects will be positioned along the horizontal crosshair guide. Choose a position
from the Alignment Position Window. Center Horizontal Alignment Position Buttons are active.

6. Visual Bounds: Objects are aligned along the object’s paint attributes, using the outside of the
stroke width.

7. Transformation Bounds: Objects are aligned using the object’s actual artwork path, ignoring the
paint attributes of the objects.

8. Align Ruler: The drawing’s ruler origin is aligned to the Crosshair origin point.

Note:  In Adobe Illustrator CS5 and CS5.5, only Global Rulers can be aligned to the Crosshair
position. If you are using Artboard rulers, you need to change them first to Global Rulers.

Working with Crosshair alignment tools
To interactively position the Crosshair

Start using the Crosshair tool by clicking the tool in the default toolbox .

The first time you select the Crosshair tool, the blue guide lines will align to the “0,0” Ruler origin.
The Crosshair Guides can be positioned using the mouse to set the Crosshair origin point. Hold down
the Option key and mouse button to set the angle of the Crosshair guide lines. Hold down the Option
key, the Shift key and the mouse button to rotate and Snap the Crosshair Guide lines to 45 degree
increments.

Aligning the Crosshair Guide lines to selected objects

To align the Crosshair Guide lines to selected objects:

1. Select the objects to align to.
2. Click the Align Crosshair button.
3. Select All Directions, Align Vertical, or Align Horizontal to create the alignment configuration you

desire.

Clicking one of the 9 crosshair alignment buttons will align the Crosshair guides to the selected
objects, while maintaining the Crosshair angle. You can use Crosshair alignment tools to change the
angle. As such, you obtain a reference to align objects to, or just to get an accurate readout on the
objects used as a reference.
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Aligning Objects to the Crosshair Guide lines

To align Objects to the Crosshair Guide lines:

1. Select the objects to be aligned.
2. Click on the Align Art button.
3. Select All Directions, Align Vertical, or Align Horizontal to create the alignment configuration you

desire.

 

 

Clicking on one of the 9 art alignment buttons will align the objects to crosshair guides using the
selected settings. The combination of aligning the Crosshair guides to objects, and then objects to the
Crosshair guides, gives you the ability to quickly create objecs that are correctly aligned to each other.

To align the left border of an object A to the right border of an object B while at the same time
keeping the vertical position of object A, do the following:

1. Select object B.
2. Align the crosshair to the right border of object B (set angle to zero first).
3. Select object A.
4. Change the align mode to align Art.
5. Select the Align Horizontal mode.
6. Left align the object A to the Crosshair guides.

Assigning Crosshair Preferences

The Crosshair Preferences dialog allows you to determine crosshair settings across documents.
You can keep the Angle and Position of the Crosshair for all documents when switching between or
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opening documents (by selecting remember for each document) or you can use the same Crosshair
settings across all documents (by deselecting the option). This allows you to align the crosshair in one
document, and align objects to these settings in another document.

To set boostX Crosshair Preferences :

Choose Edit  > Preferences > Esko > boostX Preferences (PC) or Illustrator > Preferences > Esko >
boostX Preferences (Mac).

The boostX Preferences Dialog appears. Select the desired setting for Crosshair Angle + Position and
save the settings.

 

 

Note:  Never put graphics on the boostX cross hair layer. All objects on the boostX layer will be
ignored.

5.1.5.  Crosshair Cut Tool

Using the Crosshair Cut Tool you can cut away parts of an object, based on the position of the
Crosshair.

1. Select the objects you want to cut.
2. Place the Crosshair inside the selection, using the Crosshair Tool. See Crosshair Tool on page 144
3. Select the Crosshair Cut Tool, situated under the Crosshair Tool in the toolbox.

 

 

The cursor will change to a pair of scissors
4. Click in the quadrant you want to be clipped away.
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Using a clipping path, the quadrant you selected will be cut away.

 

 

5.2.  Ink Mix

5.2.1.  Working with Document Inks

The InkMix Palette is a combination of Plug-in filters allowing you to develop and manage your own
custom Ink Base Colors (color swatch palette). These user-defined Base Inks become the basis for
which a commercial printer sets his presses up for your particular print job. It is recommended for you
to work closely together with a commercial printer before your work is press-ready, ensuring the “Base
Inks” are appropriate for the job. InkMix allows you to assign more than one spot color to an object
and to mix process colors and spot colors in the same object. The Ink Mix Plug-in helps answer some
critical print production questions:

• Which colors and special inks do you plan to specify so they can by applied correctly?
• Which colors within your document need special printing instructions?
• How many colors can be printed in one press run?
• Will your job run on a two-color, four-color, or six-color press?
• What color separation instructions does your commercial printer need?

5.2.2.  Using the Ink Mix palette

To use the Ink Mix palette Choose Window > Esko > boostX > InkMix.
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1. Fill or Stroke
2. Add to Graphic Styles
3. Fly-out menu
4. "None" button
5. Ink slider & percentage

Changing the Ink Mix of an object
When selecting an object, the Ink Mix palette will show the actual (Fill or Stroke) color.

You can simply change the color by entering the percentages in the input fields, or by dragging the
sliders for each ink.

You can apply a Swatch color by dragging and dropping a color from the Swatches pallete onto the fill/
stroke icon.

You can erase all inks in the selected object(s) by clicking the None button (4).

Note:

You can also mix the gradient color stops. Simply select the object with the gradient, and click
on one of the color stops.

Inks in the Ink Mix palette
The Ink Mix palette shows all inks currently used in the documents.

There are several ways to add inks:

• Drag and drop a color from the Swatches palette onto the Ink Mix Palette.

• Select Add Inks of Selected Color Swatch from the fly-out menu to add the inks used in the
selected Color Swatch

• Select one of the Add [...] inks options from the fly-out menu to add Process Inks, Hexachrome
Inks, Opaltone Inks or Process Inks + Orange and Green.
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When removing or converting inks in your document, the Ink Mix will only be updated after selecting
Remove Unused Inks from the Fly-out menu

Adding an Ink Mix to Graphic Styles
You can add the current Ink Mix to the Graphic Styles, by clicing the Add to Graphic Styles button, or by
selecting "Add to Graphic Styles" from the Fly-out menu.

Handling ink mixes from previous versions
Ink Mixes made in earlier versions of boostX use special BG inks. These ink mixes can still be read, but
are no longer created.

Using Upgrade to Appearances will upgrade BG inks used in the selected objects to appearances.

Restrictions
Please keep in mind that Ink Mix is not available in these situations:

• if the selection contains multiple objects with different colors (fill or stroke)
• if the selection contains multiple objects with a different stroke width
• if any effectis applied on a single fill or stroke in the Appearance palette. An effect on the complete

object is ok
• if a stroke with "Arrowhead" or "Profile" is selected (Uniform is ok)
• if an object with an "Appearance" with reversed order is selected: Fill - Stroke instead of Stroke -

Fill.
• if a mix of gradient and non gradient objects are selected
• if the "Appearance" palette has fills or strokes, but not all of them are in overprint. Only the last fill or

stroke can be overprinting or not.
• if the gradient sliders are not in the exact same position in the selection or in the multiple fills in the

Appearance palette.

5.3.  Split / Join Fill & Stroke

The Split Fill & Stroke filter separates a selected object’s Fill from its Stroke. This filter can be used for
modifying trapping options and working with chokes and spreads for printer color registration.

To use Split Fill & Stroke

Select an object with a fill and stroke. Choose Object > Path > boostX Split Fill & Stroke

The filter will separate the object’s fill and stroke into two distinct objects, one with a fill, no stroke and
the other with a stroke, no fill.

Using the Join Fill & Stroke Filter

The Join Fill & Stroke filter combines previously Split Fill and Stroke of an object.

To use Join Fill & Stroke Choose Object > Path > boostX Join Fill & Stroke

The Join Fill & Stroke filter will search the document for split objects. The filter then joins the objects’
fill and stroke into one object, having one stroke and one fill.
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The Fill & Stroke filters work on all objects including text, as in our example. Applying the Split Fill &
Stroke filter will separate the text object into two independent text objects. The result is one “text
object” with only a fill and another “text object” with only a stroke.

 

 

5.4.  Replacing Contour

The Replace Contour Tool allows you to create new objects by combining two objects, a closed path
object with an open path.

 

 

To use boostX Replace Contour, choose Window > Esko > boostX > Replace Contour. The Replace
Contour Palette appears.

1. Select a closed path object and an open path
2. Click the Keep Biggest button to create a single merged shape excluding the large closed path. The

new shape is the larger of the two objects calculated by area.
3. Click the Keep Smallest button to create a single merged shape excluding the small closed path.

The new shape is the smaller of the two objects calculated by area.
4. Click the Keep Both button to create two shapes. The new shape is the combination of both the

larger and smaller area objects.
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5.5.  Inner Outer Stroke

The Inner / Outer Stroke allows to create strokes with a different width on the inside and outside of the
object.

You can open the dialog by choosing Window > Esko > boostX > Inner Outer Strokes

Note:  Inner Outer Stroke is disabled if the selected object doesn't allow Inner/Outer Stroke,
such as an image object or text.

The Inner Width sets the distance from the original object to the inside, the Outer Width to the
outside.

The Corner buttons option allows you to change how the stroke’s sharp corners will be handled.

•
Round  (default): a round cap will be placed at all corners.

•
Beveled : this will cut sharp corners off.
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•
Mitered : this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the
stroke to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4
times the distance, then the corner will be cut off (beveled). If it is less than 4 times the distance,
the corner will be left as it is.

 

 

The Color allows to define the color for the Inner/Outer Stroke. You can double-click the color to
open the Adobe Illustrator Color Picker, or you can drag and drop a color patch from Adobe Illustrator
Swatch.

You can set the stroke to overprint using the Overprint option.

When selecting a single object with an Inner/Outer Stroke, the Inner/Outer Stroke dialog will reflect the
properties of the Inner/Outer Stroke. If multiple objects are selected, the common settings are shown.
If the objects have different settings, e.g. different Inner/Outer Width, or a different color, the settings
will be empty, or (in case of different colors) show a question mark.

Ink Mix
Inner/Outer Stroke can work with InkMix Colors. The Inner/Outer Palette color patch will get a mixed
color (indicated by a "m" in the patch) which is same as InkMix Palette Stroke color patch.

If you change the Inks value from the InkMix Palette, the Inner/Outer stroke will change automatically. If
the Inner/Outer Stroke color patch is a mixed color, double clicking the color patch will open the Ink Mix
Palette, since mixed inks can only be changed in InkMix.

For more information on Ink Mix, see Ink Mix on page 148

In the example underneath, the star has a Inner Width of 2pt, and an Outer Width of 6pt.
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5.6.  Spread & Choke

Using the Spread / Choke function, you can enlarge (Spread) or reduce (Choke) the selected object(s).

1. Select the objects you want to spread or choke

Note:  Spread / Choke is not supported on images, barcodes, text, PowerLayout Grids,
Dynamic Marks, Esko plugin art and meshes.. If your selection contains unsupported
objects, they will be ignored from the selection, and you will get a warning when spreading /
choking. If your selection only contains unsupported objects, Spread/Choke will be
disabled.

2. Select Object > Path > bX Spread & Choke to open the Spread & Choke dialog.
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3. Using the buttons on the top, choose between Spread  and Choke 
4. Enter the Offset to be used.

The Offset is the distance between the edge of the Spread/Choke object and the edge of the
original object.

5. Select how the sharp corners should be handled:

• Mitered: this option works with a Miter Limit. The Miter Limit serves to limit the length of the
sharp corner (the distance from the base of the trap to the corner point). The default Miter Limit
value is 4. This means that if the length of the sharp corner is more than 4 times the Offset, then
the corner will be cut off (beveled). If it is less than 4 times the Distance, the corner will be left as
it is.

• Round: a round cap will be placed at all corners.
• Beveled: this will cut sharp corners off.

6. Enable Copy if you want to keep the original object as well as the spread / choke.

• Select Behind if you want to place the spread/choke object underneath the original (default for
spreading).

• Select In Front if you want to place the spread/choke object on top of the original (default for
choking).

5.7.  Rotate Document

Using Rotate Document, you can rotate the complete document: the artboard, page boxes and all
objects. All objects and page boxes keep their relative positions.

Choose File > Document Rotation and select the rotation you want to apply.

The options are:

• 90º CW (ClockWise)
• 90º CCW (Counter ClockWise)
• 180º

Note:  In some cases, rotating the complete document is not supported. For example Dynamic
Marks, Adobe Illustrator effects, PowerLayout Standalone Grids etc. are not supported. If this
occurs, a message will be shown.
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5.8.  Dimension Lines

Using the Dimension Lines functionality, you can add dimension lines to your Illustrator file.

Dimension lines can be added to the full document, based on the artboard, trim box or media box.

You can also add dimension lines of subdivisions of the document, either in columns or in rows.

 

 

1. Open the Dimensions palette by choosing Window > Esko > boostX > Dimension Lines
2. Set the general settings:

a) Choose he Units to be used in the dimensions: either the units defined in the Illustrator
preferences, or a specific unit from the dropdown

b) Choose the style for the Arrows and the line thickness
c) Choose the Font Family and font size for the dimensions.

3. Set up the dimension lines for the complete job in the Total Dimensions section
a) Set the Size to put the dimension lines on: either the Artboard, or one of the Page Boxes.

The Width and Height fields will show the dimensions of the currently selected size.
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b) Define where the dimension lines should be placed by setting the Width Position and Height
Position. The Margin defines the distance between the job and the dimensions or between two
dimensions on the same side.

c) Set the Color for the total dimensions. The last used colors will be remembered for each new
document. By default, a technical spot color named "Dimensions and Text" is used.

4. Set up the subdivision lines in the Subdivisions section.
a) Set the Line Style for the Subdivisions: either a dashed line, solid line or no line.
b) Set the Color for the Dimensions and for the dashed lines. The last used colors will be

remembered for each new document. By default, a technical spot color named "Secundary
Dimensions" and "General Structural Lines" is used.

c) Set the Columns by entering a distance in the different fields.

• Click the + button to add a new field. If an input field is selected, the new field is added in
front of it, otherwise it's added at the end.

• Click the - button to remove the currently selected field. If no input field is selected, the last
one is removed.

• In case the size of the columns does not add up to the total size, a yellow warning is shown.
Clicking this button will automatically adjust the columns to match the total width. If the sum
of all columns is lower than the total width, a column is added, using the difference as width.
If the sum of all columns is higher than the total width, any columns completely outside of the
total width are removed, and the last column is reduced to make the sum of all column widths
match the total size.

d) Define where the column dimensions should be placed, either Top or Bottom. The Margin
defines the distance between the job and the dimensions.

e) Set the Rows by entering a distance in the different fields. This works the same way as for
Columns (see above).

f) Define where the row dimensions should be placed, either Left or Right. The Margin defines the
distance between the job and the dimensions or between two dimensions on the same side.

5. Click Create to create the dimension lines and dimensions in a separate locked Dimension Lines
layer.
If you already created dimension lines in the document, the button will change to Modify, allowing
you to change the current dimension lines using different settings.

5.8.1.  Dimension Lines Presets

With Dimension Lines Presets, you can save all your settings as a preset to be able to reuse them on
other documents.

1. Define your settings in the Dimension Lines dialog.
2. In the Presets list, choose Save...
3. Give your preset a name and click OK.

You can now see your preset in the Presets list. To reuse it in the future, just select it in the list.

Note:  The Preset dropdown also contains the Bag Types. See Bag Presets on page 158

• To delete a preset, select it in the Presets list and select Remove.
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• To edit a preset, select it in the Presets list, make your changes in the settings, and save it again
with the same name.

• The location where the Presets are saved, is set in the Dimension Lines Preferences. See Dimension
Lines Preferences on page 159

5.8.2.  Bag Presets

By selecting a Bag Type from the Preset dropdown, you can add the dimensions corresponding to the
selected Bag Type.

1. In the Dimension Lines dialog, select the desired Bag Type in the Preset dropdown.

You can choose from these bag types:

• Pillow Bag - Fin Seal
• Gusseted Bag - Fin Seal
• Gusseted Bag - Block Bottom
• Stand-up Pouch
• Sachet - Horizontal Fold
• Sachet - Vertical Fold

For more information on the different bag types, we refer to the Studio documentation: https://
www.esko.com/en/support/product?id=Studio%20Advanced

Note:  Note that the available Sachet bag types don't match the bag types available in
Studio Toolkit. Sachet - Horizontal Fold should be used for both three-seal four seal
sachets, where the "Orientation" option is set on the left or right side, while Sachet -
Vertical Fold should be used for three-seal and four seal sachets, where the "Orientation"
option is set on the top or bottom.

As soon as you select a bag type, the parameters to be set will change. Changing the Bag Type will
reset all parameters.

2.
Set the Orientation of the dimensions in your document using the orientation buttons 

3. Use the Attach dropdown to define the position of the dimensions. The dimensions will be placed in
the top left corner of the selected page box or the Artboard.

4. Set the dimensions for the bag. The parameters to be set depend on the selected bag type.
5. Click Create to create the Dimension Lines, or Modify to adjust the already created Dimension Lines

5.8.3.  Dimension Lines Options

In the Dimension Lines Options, you can change the appearance of the dimension lines

1. Select Show Options in the fly-out menu of the Dimension Lines dialog.
2. Set the Units: you can either use the units defined in Illustrator, or set the units to be used.
3. Define the Arrows, Line Style and Line Width for the dimension lines.
4. Set the Font Family and Size for the text
5. Set the Position and Margin for the Width, Height, Columns and Rows dimensions.
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6. Set the Color for the total dimensions, the subdivisions dimensions and the lines.
7. Click Create to create the Dimension Lines, or Modify to adjust the already created Dimension Lines
8. Select Hide Options in the fly-out menu of the Dimension Lines dialog to hide the additional

options.

5.8.4.  Dimension Lines Preferences

Open the Dimension Lines Preferences by selecting Illustrator > Preferences > Dimension Line
Preferences

• With Inch Units you can choose if a dimension in inch should be shown using the text (e.g. 12 in) or
the symbol (e.g. 12")

• By setting the Show Decimals, you can define how many decimals should be shown in the
dimension text. When set to Default, the amount of decimals is defined by Adobe Illustrator, based
on the selected unit. When set to 0, 1, 2 or 3, the distances are rounded off when necessary. Ending
zeroes (after rounding) are not shown.

• If the option Overprint Dimension Lines is enabled, all newly created dimension lines will be placed
in overprint.

• Dimension Lines Preset Settings Folder:

When choosing Use default preference folder, Presets are saved in the default "shared users"
folder.

When choosing Use custom folder, Presets are saved in the folder you define by clicking the
Browse button.

5.9.  Add Bleed

The Add Bleed function allows you to extend artwork beyond the cutting lines, to avoid white areas
when cutting the printed material.

Add Bleed requires a Processing Step Layer "Cutting", and is only available for PDF+. For more
information on PDF+ Mode and PDF+ in general, we refer to the Ink Manager chapter of the Esko Data
Exchange documentation: https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange
%20for%20Adobe%20Illustrator

1. Select the object(s) you want to add bleed to.
2. Choose Window > Esko > boostX > Add Bleed.

The Add Bleed palette is opened.
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3. Set the Bleed Distance and the Corners (Round or Square)
4. Set the Clone From distance: the color of the newly created Add Bleed object will be based on

pixels cloned from this distance inside the Cut line.
5. Click Add Bleed

The Add Bleed objects are created in a Layer named "Bleed", filled with an embedded image, filled with
pixels cloned from inside the Cut line.
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6.  Channel Mapping

6.1.  Inks remapping in Channel Mapping

With Channel Mapping, you can remap inks in CMYK images that are either embedded or placed in your
Illustrator documents.

In the case of placed images, Channel Mapping doesn’t alter the original (linked) image, but the
embedded version in your document, making the changes non-destructive. Channel Mapping also
remembers the original image’s name after you edited it.

Channel Mapping can remap the inks of all commonly used images formats (TIFF, JPEG, PSD,
Photoshop DCS, Photoshop EPS, PNG, GIF...), and remap several images that have the same
characteristics at once.

Channel Mapping also allows you to set your images to overprint other objects in your document, or to
use ink tints in your images.

6.2.  Getting Started

1. Place a CMYK image in your Illustrator Document.
 

 
2. Go to Window > Esko > Channel Mapping.

This opens the Channel Mapping palette. It shows the inks used in your image in the Inks column,
and allows you to map them to other inks using the Map to column.
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3. To remap an ink, click on its name in the Map to column and select another ink in the drop-down list.

 

 

Note:  The drop-down list only contains inks that are defined in your document.

4. Click the Apply button at the bottom of the palette.

You can see that the ink has been remapped in your image.
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Note:  If you want to undo the remapping, use Command + Z.

6.3.  The Channel Mapping Palette

You can open the Channel Mapping palette from Window > Esko > Channel Mapping.

When you select a CMYK image, this palette shows:

• the Name of the original linked image,

• if this image is in Overprint or not,

• the inks used in your image in the Inks column,

• the inks those inks are currently mapped to in the Map to column,

• the tint percentage used for each ink in the Tint column.
 

 

Attention:

To see information in the Channel Mapping palette, you must select either only one image, or
only images with similar characteristics (for details, see Remapping Inks in Several Images on
page 166).

If you can’t see information in the palette after selecting an image, it may be because you
accidentally selected other objects too.

To have a better control over which image(s) you select, you can select it/them from
Illustrator’s Layers palette or use the Go To Link button in Illustrator’s Links palette.
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6.4.  Remapping Inks

6.4.1.  Remapping an Ink

1. Select the CMYK image you want to remap in your Illustrator Document.
 

 

To make sure you select only the image, select it from Illustrator’s Layers palette or use the Go To
Link button in Illustrator’s Links palette.

2. Go to Window > Esko > Channel Mapping.

This opens the Channel Mapping palette. It shows the inks used in your image in the Inks column,
and allows you to map them to other inks using the Map to column.

 

 
3. To remap an ink, click on its name in the Map to column and select another ink in the drop-down list.
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You can remap an ink to any other ink that:

• is defined in your document (to see all the inks defined in your document, go to Window > Esko >
Ink Manager),

• is defined in the swatch list as a spot color (you should see a dot in the swatch’s lower right

corner ).

Note:

If you want to remap one of your inks to an ink that is not defined in your document, see
Creating a New Ink for Remapping on page 166.

4. Click the Apply button at the bottom of the palette or click Apply in the fly-out menu to apply the
remapping to your image.

You can see that the ink has been remapped in your image.
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Note:

To undo the last remapping, use Command + Z.

To undo all remappings and get back to the original image, click Revert at the bottom of the
palette or Reset To Original in the fly-out menu.

6.4.2.  Creating a New Ink for Remapping

If your document doesn’t contain the ink you want to remap one of your inks to, you can create it in
Illustrator.

1. With your document open, go to Illustrator’s Swatches palette.
2. Define a new spot color swatch as you would normally do in Illustrator.
3. Use this swatch to create an object in your document.
4. Save your document.
5. Map your ink to this new ink in the Channel Mapping palette (as described in Remapping an Ink on

page 164).
6. Delete the object you created in the new swatch (in step 3) if necessary, and save your document

again.

6.4.3.  Removing an Ink from an Image

1. Select your image.
2. In the Channel Mapping palette, click on the ink you want to remove in the Map to column, and

select None in the drop-down list.
 

 
3. Click Apply.

6.5.  Remapping Inks in Several Images

You can use Channel Mapping to remap inks in several images at once if those images:

• are all embedded, or all linked;
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• are either not mapped, or all mapped the same way (with the same source channels and the same
target channels);

• all have the same Overprint state (either overprinting or not overprinting).

1. Select the images you want to map either using Illustrator’s Selection tool or from the Layers or the
Links palette.

The Channel Mapping palette displays the inks as it normally would for one image, and the names of
the selected images.
 

 
2. Remap your inks as explained in Remapping an Ink on page 164.

When you click Apply, it applies your changes to all selected images.
 

 

6.6.  Remapping Images with Masks

6.6.1.  Embedded Images

With embedded images, you can remap any ink to a mask, to use it as an alpha channel, whether the
original image had a mask or not.

If your embedded image has a mask, you can remove it by remapping it None or to an ink.

Note:  You can only have one ink mapped as a mask in your image.

• To remap an ink to a mask:
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a) Select your image.

To make sure you select only the image, select it from Illustrator’s Layers palette or use the Go
To Link button in Illustrator’s Links palette.

b) In the Channel Mapping palette, remap your chosen ink to Mask.
 

 
c) Click Apply.

 

 
• To remap a mask to an ink / remove it completely:

a) Select your image.
b) In the Channel Mapping palette, remap your mask to your chosen ink / to None.
c) Click Apply.

6.6.2.  Linked Images

If your linked image has a mask, you can remove it and restore it. You cannot map inks to a mask for
linked images. If your linked image doesn’t have a mask, you cannot create one.

• To remove the mask from the image:
a) Select your image.
b) In the Channel Mapping palette, remap the mask to None.
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c) Click Apply.

 

 
• To restore the mask, map it back to Mask.

Alpha Channel Special Considerations
When a linked image has process (CMYK) colors, spot colors, and a mask, Illustrator’s default behavior
is to apply the mask only to the CMYK channels, and put the spot color channels in Multiply blending and
unmasked. Channel Mapping preserves this behavior.

6.7.  Making an Image Overprint

You can use Channel Mapping to set your images to overprint.

• To do this, enable the Overprint checkbox at the bottom of the Channel Mapping palette.

You don’t need to click Apply.
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6.8.  Using Ink Tints

With Channel Mapping, you can use Ink Tints in your image. To change the tint of an ink in your image,
do the following.

1. Go to the Tint column in the Channel Mapping palette and edit the tint percentage.
 

 
2. Click Apply.
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7.  Color Engine

7.1.  Introduction

The Color Engine plug-in allows to add or replace inks using the Color Engine Ink Books.

The Color Engine plug-in can only use a Server License on an Automation Engine Server.

7.2.  Adding an ink from Ink Book

To add an Ink from an Esko Ink Book:

1. Open the Add Ink from Ink Book dialog, by selecting Window > Esko > Color Engine > Add Ink From
Ink Book...
 

 
2. In the Choose from dropdown, select the Ink Book you want to select a color from.
3. Select the ink you want to add

• by clicking the ink patch in the dialog
• by entering its name or part of its name in the Search field. By clicking the triangle button next

to the search field, you can go to the next search result.
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4. Click the Add button or double-click the ink patch to add the selected ink to the Swatches.
5. Repeat step 2, 3 and 4 to add additional inks
6. Click Done to close the dialog.

The added inks will be in the Illustrator Swatches.

Spot colors added from an inkbook will follow the Illutrator Spot Color options, which can be found in
the fly-out menu of the Swatches palette. So you define to use LAB or CMYK values BEFORE adding the
ink.

Note:

If you add an Ink Book or add an Ink to an Ink Book in Color Engine, these will only be available
after restarting Illustrator.

If the Use Swatch Group option in the Color Engine Plugin Preferences is enabled, an Ink added from an
Ink book will be placed in a Group in the Illustrator Swatches. The Group will have the same name as the
Ink book.
 

 

Note:

If you try to add an Ink that already exists in the Swatches, you will get the choice to update the
Ink in the Swatch List using the parameters from the Ink Book, or leave the ink as is.

7.3.  Replacing an Ink

To replace an Ink:

1. Open the Replace Ink by dialog

• by selecting Window > Esko > Color Engine > Replace Ink ..., or
•

by clicking the  Replace Ink button in the Ink Manager
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2. In the Current Inks and Colors, select the Ink you want to replace.

Inks defined in an Ink book will have a droplet icon next to their name. Using the option, you can
choose if you want to Hide unused inks from the list.

The Details window will show extra information on the selected ink.
3. Define the Replace by type:

• Replace by A Document Ink allows to select an Ink from the document inks. By enabling Include
Unused Inks, all spot color inks from the swatch list will be available, even the inks that aren’t
used in the job.

• Replace by CMYK Color allows to convert the selected ink into its CMYK equivalent. The CMYK
values that will be used are shown underneath.
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• Find Best Match will scan the selected Ink Book, and list the inks with the lowest dE compared

to the ink you want to replace. At the bottom, the New and the Current ink are shown side by
side.
 

 
• Replace by Color from Ink Book allows to replace the ink by a new ink from an Ink book.

Selecting the Ink is done in the same way as adding a new ink from Ink Book (see Adding an ink
from Ink Book on page 171
 

 
4. Define if you want to replace the ink for every object (including images) or if you want to exclude

images from the replacing, by setting the Include images option. Obviously, if you exclude images,
the replaced ink will remain in the list of used inks.

5. Click the Replace Ink in Document button to replace the ink in the complete document, or click
Replace Ink in Selection to replace the Ink for the currently selected objects only.
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Note:

If one or more objects can’t be converted, a description of the problem will appear in the
Messages dialog, and the converted ink will not disappear from the list of used inks in the Ink
Manager.

Note:  If an ink is replaced, the new ink will use default screening settings. The screening
settings of the original ink are not preserved.

7.4.  Color Engine Plugin Preferences

The Color Engine Plugin Preferences can be opened from Illustrator > Preferences > Esko > Color
Engine Preferences...

If Use Swatch Groups is selected, an Ink added from an Ink book will be placed in a Group in the
Illustrator Swatches. The Group will have the same name as the Ink book.

7.5.  Pantone+ ink books

As from DeskPack 10.1, you can use the Pantone+ ink books instead of the regular Pantone ink books.

You can do this by running the Pantone+ installer, from the Extras folder on the DVD.

Note:

We advise to only use these ink books if you are familiar with Pantone+.
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8.  DeskPack Trapper

8.1.  Introduction to DeskPack Trapper for Adobe Illustrator

If you install PowerTrapper Client, PowerTrapper for Adobe Illustrator or Instant Trapper for Adobe
Illustrator version 18.1 or higher, DeskPack Trapper for Adobe Illustrator is installed as well, using the
same license.

• If you have a PowerTrapper Client license, you can only Launch Trap Tasks.

• If you have an Instant Trapper license, you can also apply manual trapping.

• If you have a PowerTrapper Standalone license, you can also do automatic trapping and update the
trapping layer.

Note:  You don’t need a license to set or change trapping tags.

DeskPack Trapper for Adobe Illustrator offers the same trapping engine and functionality as the
Trapping function in Esko's ArtPro+ editor, within Adobe Illustrator.

There are two trapping modes: Trapping and Reverse Trapping.

Trapping will extend the lightest color into the darkest, to avoid white lines in case of misregistration.
See Trapping mode: Trapping on page 177

Reverse trapping will generate white lines, to avoid colors touching or overlapping in case of
misregistration. This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where
overprinting of inks is not allowed as the inks would contaminate each other on the blanket. See
Trapping Mode: Reverse Trapping on page 188

If you have a PowerTrapper Client license, the Trapping task can be launched and executed on an
Automation Engine server version 18.1.1 or higher. See Trapping on Server on page 192

8.1.1.  What is Trapping?

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process.

Minor discrepancies in registration, slight paper shifting or stretching of e.g. PE foil can cause inks to
misregister. When two adjoining colored objects do not meet exactly, you can end up with a printed
result like the one below:
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The overlap creates a dark area and the gaps cause an undesirable light area. To prevent these
potential discrepancies, a trap can be added, causing the original colors to slightly overlap each other:

 

 

In general trapping is necessary when:

• The two colors each consist of at least one ink but they have no common inks.

• The two colors have one or more common inks, but the percentages of those common inks are
significantly different in the two colors (for example a color made of 50% M and 10% C will be
trapped with a color made of 50% Y and 80% C).

Placing a fine line where the colors join, made of a color that contains components of both adjoining
colors, can trap such areas effectively.

8.2.  Trapping mode: Trapping

Using Automatic Trapping, you can create a special Automatic Trapping layer. See Automatic Trapping
on page 177

You can also manually create all Traps, using Manual Trapping. See Manual Trapping on page 180

8.2.1.  Automatic Trapping

This is a typical Automatic Trapping workflow:

1. Set up your document to be trapped.
2. Set the general trapping settings, and generate the Automatic Trap Layer. See Starting Automatic

Trapping on page 178
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Attention:  A file can not contain both an Automatic Trap Layer and a Reverse Trap Layer.
Creating an Automatic Trap Layer will remove an earlier created Reverse Trap Layer.

3. Make any changes necessary

• You can change the general trapping settings
• You can add a Trap Tag to one or more objects, to overwrite the general trapping settings for

those objects. See Working with Trap Tags on page 190

Note:  You can also add Trap Tags before you start Automatic Trapping.

• You can still modify your document, e.g. remove, move or add objects

Any of these changes will result in the Trapping Layer to be out of sync. To continue, update the
Trap Layer. See Updating the Automatic Trap Layer on page 180

4. Using Trap Tags and updating the Automatic Trap Layer you can finetune the trapping to your liking.
However, if you prefer to manually tweak certain traps, you can do so by expanding the Automatic
Trap Layer and manually edit the traps. See Edit and expand on page 180.

Warning:  If you expand the Automatic Trap layer, it is no longer a special "Automatic Trap"
layer: you will no longer be able to update it.

Starting Automatic Trapping
To start Automatic Trapping:

1. Open the document you want to trap
2. Open the Trapping dialog by choosing Window > Esko > Trapper > Trapper...
3. Set the Trapping Mode to Trapping

The Automatic tab will be selected by default.
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The Trapping dialog will indicate how many objects have a Trap Tag set. See Working with Trap Tags
on page 190

4. Set the Trapping and Pullback Settings to be used. For more information on the Trapping / Pullback
settings, see Trapping / Pullback Settings on page 183

5. Define the size of Gaps you want to automatically close.
6. If you want to allow Trap Overshoot, enable Allow Overshoot. A Trap Overshoot is a trap that goes

over 2 edges, going across a thin area of a different color. See also Trap Overshoot on page 186
7. Click Create Trap Layer

Note:  If your document already contains an Automatic Trap Layer, the button will show
Update Trap Layer. See Updating the Automatic Trap Layer on page 180

A new layer "Automatic Trap Layer" is created in the Layers list. It will contain all trapping objects.

Attention:  A file can not contain both an Automatic Trap Layer and a Reverse Trap Layer.
Creating an Automatic Trap Layer will remove an earlier created Reverse Trap Layer.

Automatic Trapping takes into account all visible objects. Processing steps will not be taken into
account.
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Updating the Automatic Trap Layer
Any change to the document or trap settings will result in the Trapping Layer being out of sync.
Updating it will recalculate the Automatic Trap Layer.

There are different ways to update the Trap Layer:

• Choose Window > Esko > Trapper > Update Trap Layer

• Use its shortcut Cmd+Alt+Shift+4 (Mac) or Ctrl+Alt+Shift+4 (Windows)

• Open the Trapping dialog and click Update Trap Layer

All traps will be updated, and the Automatic Trap layer will be in sync again.

Edit and expand
If Automatic Trapping in combination with Trap Tags still doesn't get you the result you want, you can
expand the Automatic Trap Layer and manually edit the traps.

Warning:  If you expand the Automatic Trap layer, it is no longer a special "Automatic Trap"
layer: you will no longer be able to update it.

1. Open the Trapping dialog by choosing Window > Esko > Trapper > Trapper...
2. Select the Manual tab
3. Enable Edit and Expand Automatic Trap Layer
4. Click the Enter Trapping Mode button.

If the Automatic Trap Layer is out of sync, it will first be updated. See Updating the Automatic Trap
Layer on page 180

The Automatic Trap Layer will become a regular layer, and you will enter Trapping Mode as when using
Manual Trapping. You can use the Manual Trapping tools to modify or create traps. See Manual Trapping
on page 180

8.2.2.  Manual Trapping

Using the Trapping tool, you can add traps. Manual trapping works on all visible objects.

1. Open the Trapping dialog by choosing Window > Esko > Trapper > Trapper...
2. Select the Manual tab.
3. Select Add a New Layer
4. Define the size of Gaps you want to automatically close, and click Enter Trapping Mode.

This will open your document in a separate Trapper window. See The Trapper workspace on page
181

5. In the Trapper window, you have different tools available from the bottom of the window to create
your traps.

1.
The Trap tool and Trap Similar tool , shortcut T. See Trapping tool on page 184

2.
The Pullback  and Pullback Similar tool , shortcut P. See Pullback tool on page 184
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3.
The Trap + Pullback  and Trap + Pullback Similar tool , shortcut B. See Trap and
Pullback tool on page 185

6. If you are done creating traps, you can click the OK button to exit Trapping mode.

Trap objects will use a Darken blend mode, and are placed in a layer "Trap Layer x".

The Trapper workspace
When you click the Enter Trapping Mode button, the current document is opened in the Trapper
window. This is a modal window, meaning that you can only continue working in Adobe Illustrator after
closing this window, either by accepting (OK) or canceling (Cancel) the traps.

 

 

1. Working area The main section shows the document, initially using
the same zoom as when starting the trapping session.

2. Layers All layers are grouped in one single layer named
"Artwork". Trap objects are placed in a "Trapping
Objects" layer. You can change the visibility of a layer by
clicking the eye icon.

3. Separations The Separations section shows all separations in the
document. Using the eye icons, you can change the
visibility. If only one separation is visible, the buttons
on top can set the single separation preview:

1. Color: the single separation is shown in its own
color
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2. Positive film: the single separation is shown in
black

3. Negative film: the single separation is shown in
black, but negative.

When using the Densitometer tool, the measured
values are shown here too. See Densitometer tool on
page 186

4. Quality Control Using the Quality Control you can get a preview of
the possible effect of registration errors. See Quality
Control: Registration Errors on page 187

5. Info The Info section gives some information on how to
use the Trapping Tools. It also shows the Close Small
Gaps value that was used when starting the trapping
session.

Note:  To change this value, close the
Trapping dialog and start a new trap session.

6. Trapping & Pullback Settings See Trapping / Pullback Settings on page 183. You
can hide or show the settings using the Hide Options /
Show Options button or using the shortcut O.

7. Toolbar The toolbar contains different tools to change the
zoom. See Zoom and Pan on page 186. It also contains
the Densitometer tool (see Densitometer tool on page
186) and the Measure tool (see Measure tool on page
187)

8. Trapping tools 1.
The Trap tool and Trap Similar tool ,
shortcut T. See Trapping tool on page 184

2.
The Pullback  and Pullback Similar tool ,
shortcut P. See Pullback tool on page 184

3.
The Trap + Pullback  and Trap + Pullback

Similar tool , shortcut B. See Trap and Pullback
tool on page 185

9. OK / Cancel Click OK to accept all traps and close the Trap session.

Click Cancel to close the Trap session without adding
the traps.
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Trapping / Pullback Settings
When in Trapping mode, you can set the Trapping and/or Pullback settings at the bottom of the
workspace.

 

 

• Distance: the size for the trap. Enter a number to use the default unit, or add the unit and it will be
converted to the default unit.

• Truncate: DeskPack Trapper can truncate the trap so that it doesn’t stick out on another color.
There are two truncation modes:

• On Edge (A): when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object’s edge.

• On Center (B): when a portion of a trap comes too close to the contour of another object,
DeskPack Trapper limits it to half the distance between the trapped object and the other object.

 

 
• Joins:

• A Mitered corner closes in one point. A Miter limit of 4 is used. This means the corner will be cut
off at a distance of 4 times the trapping distance.

• A Rounded corner joins the corners with a circular arc with the diameter equal to the trapping
width.

• End Caps: This option specifies how to shape the ends of an open trap.

• Square: this option ends the trap at right angle to the adjoining object.
• Round : this rounds the ends of the trap. This option is typically only used in combination with

white knockout (reverse trapping).
• Keep: the color(s) that will be kept (i.e. not pulled back) when applying a pullback. Click to select,

click again to deselect a color.
• If the Link option is enabled, Trapping and Pullback parameters are kept the same.

Note:  When you click OK, the settings you used are stored in the Esko Preferences, and will be
entered when you start a new trapping session.
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Trapping tool
The Trap tool allows to create traps from one object to another.

Using the Trap Similar tool applies the trap to the edge you selected, but also to all edges of the same
color combination. You can temporarily switch to the Trap Similar tool by holding the Shift key.

The shortcut T will toggle between Trap and Trap Similar.

• Click and drag from one area to a neighbouring area to create a trap.
• Click and drag in the opposite direction to change the direction of a trap. You don't need to remove

it first.
• After changing the Trapping Settings, you can click and drag over an existing trap again to apply the

new settings.
• Hold the ALT key to remove a trap. The cursor will change to a cross. Click and drag over an existing

trap to remove it.

Pullback tool
The Pullback tool allows to create pullbacks. An ink pull back keeps away all but the darkest ink of a
color area composed of multiple inks that borders to a very light background. It prevents individual inks
from the composed color to become visible on the background due to registration errors during the
printing process. Ink pull backs are also known as “Cutbacks” or “Keepaways”.

The example below shows an object with 100% dark blue and 50% magenta on an empty background
(1). If misregistration occurs, a magenta line might be visible (2). 50% magenta is pulled back and a fine
line of 100% dark blue remains (3). In this case, misregistration will not cause any magenta lines (4). The
color that remains (dark blue) is the Keep ink.

 

 

Using the Pullback Similar tool applies the pullback to the edge you selected, but also to all edges of
the same color combination. You can temporarily switch to the Pullback Similar tool by holding the
Shift key.

The shortcut P will toggle between Pullback and Pullback Similar.
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• Set the Keep ink(s) (i.e. the ink that is not pulled back) in the Pullback Settings by selecting the ink(s)
you want to keep. You can also press K to open a separate Keep Color selector.

• Click and drag from one area to a neighbouring area to create a pullback.
• After changing the Pullback Settings, you can click and drag over an existing trap again to apply the

new settings.
• Hold the ALT key to remove a pullback. The cursor will change to a cross. Click and drag over an

existing pullback to remove it.

In case the "rich" color touches a colored background (e.g. yellow), it is advised to use Trap and
Pullback. See Trap and Pullback tool on page 185

Trap and Pullback tool
The Trap and Pullback tool allows to create pullbacks and a trap in the same pass.

A normal pullback keeps away all but the darkest ink of a color area composed of multiple inks.
However, if this "rich" color borders another (light) color (1), the pullback will pull back the other colors
(2). In case of misregistration of the dark blue, a white line might become visible (3). Trap and Pullback
will pull back all inks except the Keep ink, and trap the light color in the pullback (4), so that no white
lines can be seen in case of misregistration. (5)

 

 

Using the Trap and Pullback Similar tool applies the trap and pullback to the edge you selected, but
also to all edges of the same color combination. You can temporarily switch to the Trap and Pullback
Similar tool by holding the Shift key.

The shortcut B will toggle between Pullback and Pullback Similar.

• Click and drag from one area to a neighbouring area to create a trap and pullback.
• After changing the Trapping or Pullback Settings, you can click and drag over an existing trap and

pullback again to apply the new settings.
• Hold the ALT key to remove a trap and pullback. The cursor will change to a cross. Click and drag

over an existing trap and pullback to remove it.
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Trap Overshoot
In DeskPack Trapper for Adobe Illustrator you can apply a manual overshoot: a trap that goes over 2
edges, going across a thin area of a different color.

Since it is not possible to drag a trap line across more than one edge (the trap line will be dashed,
indicating the trap can not be applied), creating a trap overshoot will be done in different steps.

 

 

1. First create the trap between the two adjacent objects.
2. This is the resulting trap, set to clip "on edge"
3. Click and drag the trap line from the first to the third object, indicating the overshoot.
4. The overshoot is calculated, resulting in the cyan being trapped into the yellow and the magenta.

Note:  You can only apply overshoot if the trap was added in the same trapping session.

Zoom and Pan
To change the zoom and pan in the Trapper window, you can use different tools:

•
You can set the Zoom factor :

• Click the left button to Zoom out, or the right button to zoom in.
• Select the Zoom factor you want using the dropdown.

•
You can use the Zoom tool, either by clicking the button  or by using the shortcut Ctrl + Space
(Windows) or Space + Cmd (Mac).

• Click to double the zoom in on that location, or drag to zoom in on a specific area
• Hold the Alt key and click to zoom out

• You can hold the Space bar key and drag to pan.

Densitometer tool
The Densitometer tool can be used to measure densities at a specific location.
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1.
Select the Densitometer tool  or use its shortcut Cmd+Alt+Shift (Mac) or Ctrl+Alt+Shift
(Windows)

2. Click the point you want to measure, or drag over the area to measure the average densities.

The Separations section will show a color patch of the measured color, the density for every
separation, and the total density.

Measure tool
The Measure tool can be used to measure dimensions (distance, angle, …).

1.
Select the Measure tool 

2. Click the first point where you want to start measuring
3. Click the second point, or drag to the second point.

Underneath the Separation section, you will see:

• the position of the start point in relation to the top left corner of the artboard, both horizontally
(X) and vertically (Y).

• The horizontal distance or width (W) and vertical distance or height (H).
• The total distance (D) and angle (A).

Quality Control: Registration Errors
The Registration Error Preview is a simulation of a design printed with registrations. It can be very
helpful to see if trapping is applied suciently and correctly.

You can enable the Registration Error Preview by enabling the eye icon.

 

 

The separations are randomly shifted. In fact, all separations are moved exactly half the distance of the
Maximum Deviation, but all under a random angle.
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If you want to see another random registration error simulation, press Y.

 

 

In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

8.3.  Trapping Mode: Reverse Trapping

This is a typical Reverse Trapping workflow when working on a PDF+ document:

1. Set up your document to be trapped.
2. Set the general trapping settings, and generate the Reverse Trap Layer. See Starting Reverse

Trapping on page 188

Attention:  A file can not contain both an Automatic Trap Layer and a Reverse Trap Layer.
Creating a Reverse Trap Layer will remove an earlier created Automatic Trap Layer.

3. Make any changes necessary

• You can change the general Reverse trapping settings
• You can add a Trap Tag to one or more objects, to overwrite the general trapping settings for

those objects. See Working with Trap Tags on page 190

Note:  You can also add Trap Tags before you start Reverse Trapping.

• You can still modify your document, e.g. remove, move or add objects

Any of these changes will result in the Trapping Layer to be out of sync. To continue, update the
Trap Layer. See Updating the Reverse Trap Layer on page 190

8.3.1.  Starting Reverse Trapping

To start Reverse Trapping:

1. Open the document you want to trap
2. Open the Trapping dialog by choosing Window > Esko > Trapper > Trapper...
3. Set the Trapping Mode to Reverse Trapping
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The Trapping dialog will indicate how many objects have a Reverse Trap Tag set. See Working with
Trap Tags on page 190

4. Set the Trapping settings to be used.
a) Distance: the size for the trap. Enter a number to use the default unit, or add the unit and it will

be converted to the default unit.
b) Joins: A Mitered corner closes in one point. A Miter limit of 4 is used. This means the corner will

be cut off at a distance of 4 times the trapping distance. A Rounded corner joins the corners
with a circular arc with the diameter equal to the trapping width.

c) Trap Position: You can use the slider or manually enter a value between 50 and 100. 100% will
position the Reverse Trap object completely in the selected direction (in most cases into the
lightest ink). 50% will place the trapping object 50% in both directions (i.e. centered on the
edge).

5. Define the size of Gaps you want to automatically close, and click Create Reverse Trap Layer

Note:  If your document already contains a Reverse Trap Layer, the button will show Update
Reverse Trap Layer. See Updating the Reverse Trap Layer on page 190

A new layer "Automatic Reverse Trap Layer" is created in the Layers list. It will contain all trapping
objects.

Attention:  A file can not contain both an Automatic Trap Layer and a Reverse Trap Layer.
Creating a Reverse Trap Layer will remove an earlier created Automatic Trap Layer.

189



8 DeskPack Advanced

Reverse Trapping takes into account all visible objects. Processing steps will not be taken into
account.

8.3.2.  Updating the Reverse Trap Layer

Any change to the document or trap settings will result in the Reverse Trap Layer being out of sync.
Updating it will recalculate the Reverse Trap Layer.

There are different ways to update the Reverse Trap Layer:

• Choose Window > Esko > Trapper > Update Trap Layer

• Use its shortcut Cmd+Alt+Shift+4 (Mac) or Ctrl+Alt+Shift+4 (Windows)

• Open the Trapping dialog and click Update Reverse Trap Layer

All traps will be updated, and the Reverse Trap layer will be in sync again.

8.4.  Working with Trap Tags

A Trap Tag is a property attached to a group or object and saved in your document, allowing you to
overwrite the general trapping settings during Automatic Trapping or Reverse Trapping.

There are two types of Trap Tags: Trapping Tags are taken into account when using Automatic
Trapping, while Reverse Trapping Tags are taken into account when using Reverse Trapping

Trap Tags can be created before starting Automatic Trapping or Reverse Trapping, or after the Trap
Layer was created. In the latter case, you will have to update the Trap Layer to see the result. See
Updating the Automatic Trap Layer on page 180 or Updating the Reverse Trap Layer on page 190

Note:  Trap tags are saved in your Adobe Illustrator file, and included when saving as PDF+ file.
When saving as a Normalized PDF, trap tags will not be included.

1. Select the group(s) or object(s) you want to assign a Trap Tag.
2. Open the Trapping Tags panel by choosing Window > Esko > Trapper > Trapping Tags
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3. Using the Tag dropdown, you can select if you want to add or edit Trapping Tags or Reverse
Trapping Tags.

4. Define the settings for the Outer Edges, i.e. edges between the selected group or object and other
objects in your document

• If set to No Tag, the 'default' action will be used. This can be the default trapping settings,
but can also be the Trap Tag of the parent group: if e.g. a group has a Trap Tag to set Trap to
"Always", an object within that group can have a Trap Tag to set Trap to "Automatic", whereas
setting it to No Tag would apply the Trap Tag of the group.

• Set Trap to decide if the edges should Always be trapped, Never be trapped, or Automatic to let
DeskPack Trapper decide.

• Set Pullback (Trapping Tag only) to decide if the edges should Always be pulled back, Never be
pulled back, or Automatic to let DeskPack Trapper decide.

• Set Direction to decide if the edges should always be trapped Inwards, Outwards or Automatic,
to let DeskPack Trapper decide.

• Enable Distance to set a fixed distance for the traps.
• Set the Trap Position (Reverse Trapping Tag only) to set the position of the Trap by entering a

value between 50 and 100. 100% will position the Reverse Trap object completely in the selected
direction (mostly into the lightest ink). 50% will place the trapping object 50% in both directions
(i.e. centered on the edge)

Note:  You can remove a trapping tag setting by setting the dropdown to "No Tag". For
distance, you remove it by clearing the input field.

5. Define the settings for the Inner Edges, i.e. edges within the group or object. This can be e.g. two
adjacent objects in the same group, or the stroke and fill of a single object)

In the Tagged Objects section, you can get an overview of all objects with Trap Tags or Reverse Trap
Tags, depending on the Tag dropdown. Clicking an entry in the list will select the corresponding object,
and show the Trap Tag settings in the panel.
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Note:  You can remove all Tags (Trapping Tags and Reverse Trapping Tags) from your document
by choosing Clear All Tags in the fly-out menu of the Trapping Tags panel.

Changing a Trap Tag will result in the Trapping Layer being out of sync. To continue, update the Trap
Layer. See Updating the Automatic Trap Layer on page 180 or Updating the Reverse Trap Layer on page
190

8.5.  Trapping on Server

By sending Trap Tasks to an Automation Engine, you can free up Adobe Illustrator for other jobs.

Note:  Trapping on Server requires a PowerTrapper Client license.

The concept:

1. Open the Adobe Illustrator file, and click Window > Esko > Trapper > Launch Trap Task...
 

 

Important:  Trapping on Server is only available when working in PDF+ Mode. For more
information on PDF+ Mode and PDF+ in general, we refer to the Ink Manager chapter of the
Esko Data Exchange documentation: https://www.esko.com/en/support/product?id=Esko
%20Data%20Exchange%20for%20Adobe%20Illustrator

2. Choose a Trapping Ticket and click Launch
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3. The Illustrator file is saved locally to reflect the latest changes
4. The file is copied to the Server, and is trapped with the selected ticket.

 

 
5. Adobe Illustrator is freed up for other jobs, while the Shuttle palette monitors the progression of the

trapping
6. The Server generates trap objects and saves them in a separate Trap Layer
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7. Once finished, you open the file by double-clicking the task in the Shuttle window, and the Trap layer

is automatically placed on top of the artwork layers.
 

 

8.5.1.  The Trapping on Server Workflow

1. To start trapping the current AI file, select Window > Esko > Trapper > Launch Trap Task...
The Launch Trap Task Window opens.
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2. Check the ink options. DeskPack Trapper supports spot colors or opaque inks. To change the Ink
Options, use the Ink Manager palette.

3. Select the Trapping Ticket. The list presents all Trap Tickets stored centrally on the Automation
Engine Server.
 

 
4. Click Trap

a) First the AI file is overwritten in native AI format at its original location (in order to include all the
latest changes!)

b) Secondly, it is also saved as an Esko PDF+ file into the Automation Engine Container on the
Automation Engine Server, and the trapping ticket is communicated to the server.

c) Adobe Illustrator closes the document that is being trapped and becomes free for other tasks.
a) The Shuttle palette pops up and provides information regarding the status.

5. Once it is finished successfully , double-click the name of the file in the Shuttle palette to open
the selected document.

The DeskPack Trapper plug-in now merges the trapping layer with the original design. The
document is opened and the traps are fully editable objects in a separate Automatic Trap Layer, on
top of the unmodified artwork layers. If your document already contained an Automatic Trap Layer
or Automatic Reverse Trap Layer, it will be replaced.

Note:

You should always open a trapped document from the Shuttle window. That way the
Automatic Trap Layer will be fetched from the server and added to the document.

If not, you will see a warning. If you click OK the document will open, without the Automatic
Trap Layer.

8.5.2.  Selective Trapping

Selective trapping is trapping just a selection of objects rather than the whole design.
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DeskPack Trapper ignores non-printable and hidden layers. Actually, they are even omitted from the
temporary PDF+ file on the Automation Engine Container.

If you do not want certain objects to be trapped, it should be enough to move them to a non-printable
or hidden layer.

8.5.3.  Processing Step Layers

Processing Step Layers and all objects in them are excluded from trapping.

For more information on Processing Step Layers, we refer to the Processing Step Layers chapter of
the Esko Data Exchange documentation: https://www.esko.com/en/support/product?id=Esko%20Data
%20Exchange%20for%20Adobe%20Illustrator
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9.  Dynamic Barcodes

9.1.  What is a barcode ?

A barcode is a machine-readable representation of information in a visual format on a surface.
Barcodes can be read by optical scanners, allowing quick and easy identification of all kind of goods.

Originally barcodes stored data in the widths and spacings of printed parallel lines, but today they also
come in patterns of dots, concentric circles, and hidden in images.

The information contained in a barcode varies from numbers to complete ASCII texts. The drive to
encode ever more information in combination with the space requirements of simple barcodes led to
the development of matrix barcodes or 2D barcode, which do not consist of bars but rather a grid of
square cells.

Barcodes are just the visible part of often quite large systems frequently referred to as automated
identification systems. These systems are increasingly proving to be some of the most cost-effective
management tools, since they enable organizations to keep track of their goods and stocks in all kinds
of situations in a fast, accurate and ecient way.

With the Dynamic Barcodes plug-in, you can add a dynamic barcode to your document without leaving
your application. Dynamic means that your barcode settings can be changed later on, even after you
saved, closed and reopened your document.

9.2.  Getting Started with Dynamic Barcodes

To introduce you to Dynamic Barcodes, here is how to make your first barcode in four simple steps.

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

This opens the Dynamic Barcodes dialog.
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2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
 

 
3. Enter the barcode parameters (Barcode Type, numeric Code...) in the Dynamic Barcodes dialog.

For example, for an EAN 13 barcode, select EAN 13 as Barcode Type and enter a 13 digit Code.
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4. Click the Create button and Dynamic Barcodes will generate the barcode in your document.
 

 

9.3.  Using Dynamic Barcodes in Unlicensed Mode

If you don't have a license for the Dynamic Barcodes plug-in, you still use it in unlicensed mode to
perform limited operations. You can:

• Open documents containing barcodes created by Dynamic Barcodes without warning messages.
• Create barcode placeholders (with no data in them) in your design.

See Creating a Barcode Placeholder Quickly on page 205.

You can also use the regular Illustrator functions to:

• change the barcode's position in your document,
• rotate it by multiples of 90 degrees (using Object > Transform > Rotate),

Tip:  You can rotate several barcodes at once.

• change its fill color (it is not possible to apply a stroke),

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

• copy and paste it.
• delete it.

9.4.  Dynamic Barcodes Basics
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9.4.1.  Creating a Barcode

1. Create a CMYK Illustrator document and go to Windows > Esko > Dynamic Barcodes.

You can also use the Command + Option + 4 shortcut on Mac, or the CTRL + Alt + 4 shortcut on PC.

This opens the Dynamic Barcodes dialog.
 

 
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.

Dynamic Barcodes creates bars by generating rectangular objects and assigning the current fill
style to them.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),
• not too light (or the barcode might be dicult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.
4. Enter a Rotation angle for your barcode, or use one of the rotation buttons. Choose the Orientation

of your barcode using one of the buttons or by entering an angle.
5. Enter the barcode's data in the Code field. For most barcodes, you can choose to also show this

data as a (human-readable) number.

Attention:  Make sure the barcode data you enter is valid for the barcode type you chose. If
it isn't, a warning / error will pop up.
 

 

Note:  If you enter a wrong check digit, Dynamic Barcodes can fix it automatically for you.
 

 

6. To fill in other parameters specific to the barcode type you chose, open the Additional parameters
section and see Barcode Types on page 225.
 

201



9 DeskPack Advanced

 
7. Click the Create button.

• If you have the boostX plug-in installed, Dynamic Barcodes generates your barcode at the
intersection of the boostX crosshair.

• If you don't have the boostX plug-in installed, Dynamic Barcodes generates your barcode in the
center of the view.
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9.4.2.  Editing a Barcode

With Dynamic Barcodes, you can also edit existing barcodes.

1. Open the Dynamic Barcodes.
2. Select the barcode to edit in your Illustrator document.
3. Change its parameters as you wish in the Dynamic Barcodes dialog.

Note:

If you change the Barcode Type and the previous Code is not valid for this barcode type,
Dynamic Barcodes will reset it to the (first) default code for this barcode type.

This is the default code used for placeholder barcodes; you can see it in the preset
barcodes dialog (see Previewing and Creating a Barcode Placeholder on page 206).

You can then either:

• enter your own valid code,

• use this default code to create a placeholder barcode (see Creating a Barcode
Placeholder Quickly on page 205).

4. Click the Apply button to apply your changes to the barcode.

9.4.3.  Setting Barcode Parameters to Default

• To reset all the parameters of the selected barcode to default, click the palette menu  in the
top right corner of the Dynamic Barcodes dialog then click Set Default Parameters.
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Note:  The Bar Width Reduction, Device Compensation and Snap Bars to Output
Resolution parameters are not reverted to the defaults, since these parameters are related
to the press settings, and not related to the selected barcode.

9.4.4.  Barcode Placeholders

If you don't have the exact data to encode in your barcode yet, you can already create a barcode
placeholder in your design.

This placeholder will have the correct symbol type for the barcode type you choose, but will only
contain “empty” or “default” data (for example 0000000000000 for EAN 13).
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Creating a Barcode Placeholder Quickly
1. Open the Dynamic Barcodes dialog from Windows > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
 

 

Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

3. In the Dynamic Barcodes dialog, select your Barcode Type.

The Code field is automatically filled out with a nul / default value that has the correct number of
digits for your Barcode Type (for example 0000000000000 for EAN 13).
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4. Click the Create button to create your barcode placeholder.

 

 

Note:  You can also create a barcode placeholder in unlicensed mode (see Using Dynamic
Barcodes in Unlicensed Mode on page 199).

Previewing and Creating a Barcode Placeholder
You can use Dynamic Barcodes to preview different barcode types before creating your barcode
placeholder.

1. Open the Dynamic Barcodes dialog from Window > Esko > Dynamic Barcodes.
2. Define the color of the barcode: in your Illustrator color palette, define a single-color fill style and no

stroke.
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Attention:

Choose a fill color that is:

• a process or a spot color (other colors might generate trapping problems),

• not too light (or the barcode might be dicult to scan).

3.

In the Dynamic Barcodes dialog, click the Pre-set barcodes icon .

This opens the Select Barcode dialog.

 

 
4. Select your Barcode Type on the right to see a Preview of it on the left.
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Note:  This shows previews of barcode placeholders. Your actual barcode (with data and
specific parameters affecting its size) may look slightly different. For more information on
barcode parameters, see Barcode Types on page 225.

5. If your barcode data can have several possible lengths (for example EAN 13 can have 13, 15 or 18
digits), choose the length you want to preview in Code Preset.
 

 
6. If your barcode can have a Composite Component (some GS1 barcodes), you can choose to preview

it with or without that component.
 

 
7. Click OK to use the preview parameters (Barcode Type, Code Preset and Composite Component as

applicable) in the Dynamic Barcodes dialog and close the Select Barcode dialog.
8. In the Dynamic Barcodes dialog, click the Create button to create your barcode placeholder.

 

 

9.4.5.  Expand

By using the Expand function, you can replace a barcode by regular objects (rectangles, text, …) in a
group, without any barcode information.
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Note:  Adobe Illustrator also contains an "Expand" function. However, since this does not
remove the barcode metadata, the barcode remains editable.

1. Select the barcode you want to expand
2. From the fly-out menu of the Dynamic Barcodes panel, select Expand

Note:  Barcodes used by Dynamic Marks and Dynamic VDP can't be expanded.

9.5.  Dynamic Barcodes Advanced

9.5.1.  Choosing a Font Standard

You can choose between two font standards for the human-readable characters of your barcodes.

1. Go to Illustrator > Preferences > Esko >  Dynamic Barcodes Preferences... to open the Dynamic
Barcodes Preferences dialog.
 

 
2. Choose either OCR-B Standard or OCR-B Bitstream and click OK.

OCR-B Standard fonts are rounder and typically
used in the Western market.

 

 

OCR-B Bitstream fonts are typically used in the
Asian market.
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Note:  If the OCR-B Bitstream font is not installed on your system, the option will be
disabled. Esko does not provide this font.

9.5.2.  Using Dynamic Content with Dynamic Barcodes

You can use the Dynamic Content plug-in to turn barcodes created with Dynamic Barcodes into XML-
driven objects. These barcodes update automatically when the XML files to which they are linked
change.

For more information, see the Dynamic Content documentation.

9.5.3.  Barcode Protection

Once you create a barcode with Dynamic Barcodes, this barcode is protected. This means that it
won't be possible to edit it with most regular Illustrator tools. This protects the barcode against
modifications that might render it invalid, for example distorting it or modifying its size.

The only transformation allowed is moving or rotating the barcode. When rotating the barcode,
a message is shown in the Messages palette, and the barcode's Rotation parameter is adapted
accordingly.

You can still edit the barcode's parameters at any time through the Dynamic Barcodes dialog.

Protecting a Barcode
You can protect a Dynamic Barcodes barcode that has been unprotected, or a barcode made in a
previous version of Dynamic Barcodes.

1. Open the Dynamic Barcodes plug-in.
2. Select the barcode to protect in your Illustrator document.
3. If necessary, change its parameters in the Dynamic Barcodes dialog.
4. Click the Apply button to apply the parameter changes and protect your barcode.

Tip:  You can use this to fix some invalid barcodes.

Handling a Barcode without Dynamic Barcodes

Opening a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes

When opening a document containing a Dynamic Barcodes barcode in an Illustrator application that
doesn't have the Dynamic Barcodes plug-in, you will get the following warning:
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This doesn't create any problem in your file, and you can continue to work with this file as you normally
would, without editing the Dynamic Barcodes barcode.

If you need to edit the Dynamic Barcodes barcode with your Illustrator application, see Editing a
Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes on page 211.

Editing a Document Containing a Dynamic Barcodes Barcode without Dynamic Barcodes
If you don't have the Dynamic Barcodes plug-in, you can still use Illustrator to do the following
operations without rendering your barcode invalid.

If you don't have Dynamic Barcodes installed, you will not be able to

• move or scale the object using the Selection tool
• move or distort it (reflect, shear or scale)
• change a color

You will be able to

• expand the bar code
• Rotate by Selection or Free transform - this can lead to inconsistent results so we recommend not

doing this.
• move, rotate and distort by the Transform Each command - this can lead to inconsistent results so

we recommend not doing this.
• enclose it in the Envelope and distort
• delete it
• copy and paste it

If the Dynamic Barcode plugin is installed, but without a valid license, you will be able to do everything
that is allowed by the plugin, except modifying the content. This means for example moving and
rotating is allowed, but due to the bar code protection, any potentially dangerous operations such as
scale, reflect or shear are not allowed. You will also be able to change the color of the bar code.

Unprotecting a Dynamic Barcodes Barcode for Further Editing
You can expand your Dynamic Barcodes barcode to a regular Illustrator group art to be able to edit it
further, but this is not recommended as it will remove the barcode's protection.

Attention:  It will then be possible to make modifications that might render the barcode
invalid.

1. To do this, go to Object > Expand... in the Illustrator menu.
2. Choose the object's characteristics to expand, then click OK.
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This turns your barcode into a regular Illustrator object. You can now for example edit each bar of the
barcode individually.

9.5.4.  Exporting Documents with Barcodes

If you are using other Esko applications, you can export Illustrator documents containing barcodes to
the Esko Normalized PDF format, preserving the barcodes' information and editability.

Viewing Barcode Information in Other Esko Applications
1. Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen workflow.
This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF as the export
format.

2. Select (in Automation Engine) or open (in PackEdge / Acrobat) your document and open the XMP
information as explained below:

If you have... go to...

Automation Engine File > Info.

PackEdge File > XMP Info.

the Esko XMP plug-in in Adobe Acrobat Esko > XMP Document Info...

3. Click Barcodes in the Data type column (as below in PackEdge) to show the barcode information.
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For more information, see the Shuttle, Automation Engine, PackEdge or XMP plug-in documentation.

Editing Barcodes in Other Esko Applications
The Dynamic Barcodes functionality is available both as a DeskPack plug-in and in PackEdge.

• To edit your document containing barcodes in PackEdge:
a) Export your Illustrator document to the Esko Normalized PDF format:

• If you have Automation Engine, use Shuttle to launch the document into your chosen
workflow. This converts it to Normalized PDF automatically.

Note:  See the Adobe Illustrator Client documentation for setup information.

• If you don't have Automation Engine, use File > Export and choose Normalized PDF as the
export format.

b) Open your document in PackEdge.
c) Go to Production > Bar Code... to edit your barcode as you would edit it with Dynamic Barcodes.

For more information, see the Shuttle and PackEdge documentation.

9.6.  Barcode Recognition

Barcode Recognition is a new function in Dynamic Barcodes to convert vectorized (contourized)
barcodes and images (e.g. a scanned in barcode) back into live editable barcodes.

1. Choose Window > Esko > Dynamic Barcodes to open the Dynamic Barcodes palette.
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2. Select the objects (lineart or image) that you want to convert.
3. Click the Extract button.

Dynamic Barcode will analyse the selected objects, and when possible a Dynamic Barcode is
generated replacing the selection.

a) Click and hold Hold to View Original to hide the converted barcode and see the original lineart or
image.

b) Change any of the barcode parameters and click Apply to modify the generated barcode.
c) Enable Compare View to show the newly generated barcode semi transparent on top of the

original objects. This allows you to easily change position and parameters of the new barcode to
match the original.

4. When you're happy with the result, click the Finish button.

This will remove the original objects from the document and close the Barcode Recognition
session, leaving you with a barcode object that you can edit as needed.

Note:  You can not do any other barcode recognition as long as the previous session wasn't
ended, either by clicking the Finish or the Cancel button.

9.6.1.  Supported Barcode Types and known limitations

The barcodes that are currently supported for Barcode Recognition are these:

• Code-128
• Code-128 (long)
• Code-39
• DATAMATRIX
• EAN-13 (including add-ons)
• EAN 13 Swissmedic
• EAN-8
• GS1-128
• GS1 DataMatrix
• GS1-QR
• HIBC-128
• HIBC-39
• Int. 2 of 5
• ITF-14
• ITF-16
• NDC-HRI
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• PZN
• PZN8
• QR
• UPC-A (including add-ons)
• UPC-E (including add-ons)
• UPC-SCS

The barcode parameters that are currently recognized (when possible) are these:

• Barcode type
• Code
• Add-on presence
• Color (only when recognizing line art objects)
• HRI presence (only when recognizing line art objects)
• Height (only when recognizing line art objects)
• Rotation
• Magnification
• BWR (only when recognizing line art objects)
• Characters per unit
• Ratio

Other limitations:

• White Box, Light margin indicators, H gauges for ITF barcodes and HRI text parameters are not
recognized.

• Device Compensation and Bar Width Reduction are both combined in the Bar Width Reduction
• An Int. 2 of 5 needs to have at least 6 digits.
• UPC-SCS with add-on is not recognized.
• If the original is an image, rotation is deduced from the rotation of the image. If the barcode inside

the image is rotated over an angle other than a multiple of 90º, the recognizing will not work.
• Pre-defined barcode sizes for PZN barcodes may not always be recognized.

9.7.  Barcode Types and Parameters

9.7.1.  Supported Barcode Types

General Purpose Barcodes

1D 2D

• Code 39

• Code 93 on page 232

• 2 of 5

• DataMatrix

• QR

• MicroQR
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1D 2D

• Interleaved 2 of 5

• Codabar

• Code 128

• Code 128 (long)

• Klebrand on page 252

• MSI

• SICK Code on page 266

Retail Barcodes

1D 2D

• EAN 13

• EAN 8

• UPC-A

• UPC-E

• GS1 DataBar Omnidirectional

• GS1 DataBar Truncated

• GS1 DataBar Stacked

• GS1 DataBar Stacked Omnidirectional

• GS1 DataBar Limited

• GS1 DataBar Expanded

• GS1 DataBar Expanded Stacked

• GS1 128

• GS1 U.S. Coupon Interim

• M+S 7

• Marks & Spencer

• GS1 DataMatrix
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Pharmaceutical, Healthcare and Cosmetic Barcodes

1D

• Bobst on page 226

• NDC / HRI

• EAN 13 Swissmedic

• Kurandt on page 253

• Laetus Pharma Code

• CLF-8

• HIBC 39

• HIBC 128

• Paraf Italy

• PZN

• PZN8

Shipment Container Barcodes

1D

• ITF-14

• ITF-16

• UPC-SCS

Identity Document Barcode

2D

• PDF417

• MicroPDF417

GS1 Application Identifiers
These are the GS1 Application Identifiers available in Dynamic Barcodes:

AI Data Content Format (*) FNC1 Required
(*****)

00 Serial Shipping Container Code (SSCC) N2+N18
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01 Global Trade Item Number (GTIN) N2+N14

02 GTIN of Contained Trade Items N2+N14

10 Batch or Lot Number N2+X..20 (FNC1)

11 (**) Production Date (YYMMDD) N2+N6

12 (**) Due Date (YYMMDD) N2+N6

13 (**) Packaging Date (YYMMDD) N2+N6

15 (**) Best Before Date (YYMMDD) N2+N6

16 (**) Sell By Date (YYMMDD) N2+N6

17 (**) Expiration Date (YYMMDD) N2+N6

20 Internal product variant N2+N2

21 Serial Number N2+X..20 (FNC1)

22 Consumer product variant N2+X..20 (FNC1)

235 Third Party Controlled, Serialised Extension
of GTIN (TPX)

N3+X..28 (FNC1)

240 Additional Item Identification N3+X..30 (FNC1)

241 Customer Part Number N3+X..30 (FNC1)

242 Made-to-Order Variation Number N3+N..6 (FNC1)

243 Packaging Component Number N3+X..20 (FNC1)

250 Secondary Serial Number N3+X..30 (FNC1)

251 Reference to Source Entity N3+X..30 (FNC1)

253 Global Document Type Identifier (GDTI) N3+N13+X..17 (FNC1)

254 GLN Extension Component N3+X..20 (FNC1)

255 Global Coupon Number (GCN) N3+N13+N..12 (FNC1)

30 Variable Count of Items (Variable Measure
Trade Item)

N2+N..8 (FNC1)

310n (***) Net weight, kilograms (Variable Measure
Trade Item)

N4+N6

311n (***) Length or first dimension, metres (Variable
Measure Trade Item)

N4+N6

312n (***) Width, diameter, or second dimension,
metres (Variable Measure Trade Item)

N4+N6

313n (***) Depth, thickness, height, or third dimension,
metres (Variable Measure Trade Item)

N4+N6

314n (***) Area, square metres (Variable Measure Trade
Item)

N4+N6

315n (***) Net volume, litres (Variable Measure Trade
Item)

N4+N6
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316n (***) Net volume, cubic metres (Variable Measure
Trade Item)

N4+N6

320n (***) Net weight, pounds (Variable Measure Trade
Item)

N4+N6

321n (***) Length or first dimension, inches (Variable
Measure Trade Item)

N4+N6

322n (***) Length or first dimension, feet (Variable
Measure Trade Item)

N4+N6

323n (***) Length or first dimension, yards (Variable
Measure Trade Item)

N4+N6

324n (***) Width, diameter, or second dimension, inches
(Variable Measure Trade Item)

N4+N6

325n (***) Width, diameter, or second dimension, feet
(Variable Measure Trade Item)

N4+N6

326n (***) Width, diameter, or second dimension, yards
(Variable Measure Trade Item)

N4+N6

327n (***) Depth, thickness, height, or third dimension,
inches (Variable Measure Trade Item)

N4+N6

328n (***) Depth, thickness, height, or third dimension,
feet (Variable Measure Trade Item)

N4+N6

329n (***) Depth, thickness, height, or third dimension,
yards (Variable Measure Trade Item)

N4+N6

330n (***) Logistic weight, kilograms N4+N6

331n (***) Length or first dimension, metres N4+N6

332n (***) Width, diameter, or second dimension,
metres

N4+N6

333n (***) Depth, thickness, height, or third dimension,
metres

N4+N6

334n (***) Area, square metres N4+N6

335n (***) Logistic volume, litres N4+N6

336n (***) Logistic volume, cubic metres N4+N6

337n (***) Kilograms per square metre N4+N6

340n (***) Logistic weight, pounds N4+N6

341n (***) Length or first dimension, inches N4+N6

342n (***) Length or first dimension, feet N4+N6

343n (***) Length or first dimension, yards N4+N6

344n (***) Width, diameter, or second dimension, inches N4+N6

345n (***) Width, diameter, or second dimension, feet N4+N6

219



9 DeskPack Advanced

346n (***) Width, diameter, or second dimension, yard N4+N6

347n (***) Depth, thickness, height, or third dimension,
inches

N4+N6

348n (***) Depth, thickness, height, or third dimension,
feet

N4+N6

349n (***) Depth, thickness, height, or third dimension,
yards

N4+N6

350n (***) Area, square inches (Variable Measure Trade
Item)

N4+N6

351n (***) Area, square feet (Variable Measure Trade
Item)

N4+N6

352n (***) Area, square yards (Variable Measure Trade
Item)

N4+N6

353n (***) Area, square inches N4+N6

354n (***) Area, square feet N4+N6

355n (***) Area, square yards N4+N6

356n (***) Net weight, troy ounces (Variable Measure
Trade Item)

N4+N6

357n (***) Net weight (or volume), ounces (Variable
Measure Trade Item)

N4+N6

360n (***) Net volume, quarts (Variable Measure Trade
Item)

N4+N6

361n (***) Net volume, gallons U.S. (Variable Measure
Trade Item)

N4+N6

362n (***) Logistic volume, quarts N4+N6

363n (***) Logistic volume, gallons U.S. N4+N6

364n (***) Net volume, cubic inches (Variable Measure
Trade Item)

N4+N6

365n (***) Net volume, cubic feet (Variable Measure
Trade Item)

N4+N6

366n (***) Net volume, cubic yards (Variable Measure
Trade Item)

N4+N6

367n (***) Logistic volume, cubic inches N4+N6

368n (***) Logistic volume, cubic feet N4+N6

369n (***) Logistic volume, cubic yards N4+N6

37 Count of Trade Items N2+N..8 (FNC1)

390n (***) Applicable Amount Payable or Coupon Value,
local currency

N4+N..15 (FNC1)
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391n (***) Applicable Amount Payable with ISO Currency
Code

N4+N3+N..15 (FNC1)

392n (***) Applicable Amount Payable, single monetary
area (Variable Measure Trade Item)

N4+N..15 (FNC1)

393n (***) Applicable Amount Payable with ISO Currency
Code (Variable Measure Trade Item)

N4+N3+N..15 (FNC1)

394n (***) Percentage discount of a coupon N4+N4 (FNC1)

395n (***) Amount payable per unit of measure single
monetary area (variable measure trade item)

N4+N6 (FNC1)

400 Customer's Purchase Order Number N3+X..30 (FNC1)

401 Global Identification Number for
Consignment (GINC)

N3+X..30 (FNC1)

402 Global Shipment Identification Number (GSIN) N3+N17 (FNC1)

403 Routing Code N3+X..30 (FNC1)

410 Ship to - Deliver to Global Location Number N3+N13

411 Bill to - Invoice to Global Location Number N3+N13

412 Purchased from Global Location Number N3+N13

413 Ship for - Deliver for - Forward to Global
Location Number

N3+N13

414 Identification of a Physical Location - Global
Location Number

N3+N13

415 Global Location Number of the Invoicing
Party

N3+N13

416 GLN of the production or service location N3+N13

417 Party GLN N3+N13

420 Ship to - Deliver to Postal Code Within a
Single Postal Authority

N3+X..20 (FNC1)

421 Ship to - Deliver to Postal Code with ISO
Country Code

N3+N3+X..9 (FNC1)

422 Country of Origin of a Trade Item N3+N3 (FNC1)

423 Country of Initial Processing N3+N3+N..12 (FNC1)

424 Country of Processing N3+N3 (FNC1)

425 Country of Disassembly N3+N3+N..12 (FNC1)

426 Country Covering full Process Chain N3+N3 (FNC1)

427 Country Subdivision of Origin N3+X..3 (FNC1)

4300 Ship-to / Deliver-to company name N4+X..35 (FNC1)

4301 Ship-to / Deliver-to contact N4+X..35 (FNC1)

221



9 DeskPack Advanced

4302 Ship-to / Deliver-to address line 1 N4+X..70 (FNC1)

4303 Ship-to / Deliver-to address line 2 N4+X..70 (FNC1)

4304 Ship-to / Deliver-to suburb N4+X..70 (FNC1)

4305 Ship-to / Deliver-to locality N4+X..70 (FNC1)

4306 Ship-to / Deliver-to region N4+X..70 (FNC1)

4307 Ship-to / Deliver-to country code N4+X2 (FNC1)

4308 Ship-to / Deliver-to telephone number N4+X..30 (FNC1)

4309 Ship-to / Deliver-to GEO location N4+N20 (FNC1)

4310 Return-to company name N4+X..35 (FNC1)

4311 Return-to contact N4+X..35 (FNC1)

4312 Return-to address line 1 N4+X..70 (FNC1)

4313 Return-to address line 2 N4+X..70 (FNC1)

4314 Return-to suburb N4+X..70 (FNC1)

4315 Return-to locality N4+X..70 (FNC1)

4316 Return-to region N4+X..70 (FNC1)

4317 Return-to country code N4+X2 (FNC1)

4318 Return-to postal code N4+X..20 (FNC1)

4319 Return-to telephone number N4+X..30 (FNC1)

4320 Service code description N4+X..35 (FNC1)

4321 Dangerous goods flag N4+N1 (FNC1)

4322 Authority to leave N4+N1 (FNC1)

4323 Signature required flag N4+N1 (FNC1)

4324 Not before delivery date time N4+N10 (FNC1)

4325 Not after delivery date time N4+N10 (FNC1)

4326 Release date N4+N6 (FNC1)

7001 NATO Stock Number (NSN) N4+N13 (FNC1)

7002 UN/ECE Meat Carcasses and Cuts
Classification

N4+X..30 (FNC1)

7003 Expiration Date and Time N4+N10 (FNC1)

7004 Active Potency N4+N..4 (FNC1)

7005 Catch Area N4+X..12 (FNC1)

7006 First Freeze Date N4+N6

7007 Harvest Date N4+N6..12 (FNC1)

7008 Species for Fishery Purposes N4+X..3 (FNC1)
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7009 Fishing Gear Type N4+N..10 (FNC1)

7010 Production Method N4+X..2 (FNC1)

7020 Refurbishment lot ID N4+X..20 (FNC1)

7021 Functional status N4+X..20 (FNC1)

7022 Revision status N4+X..20 (FNC1)

7023 Global Individual Asset Identifier (GIAI) of an
assembly

N4+X..30 (FNC1)

703s Number of Processor with ISO Country Code N4+N3+X..27 (FNC1)

7040 GS1 UIC with Extension 1 and Importer index N4+N1X2+X3+X4 (FNC1)

710 National Healthcare Reimbursement Number
(NHRN) – Germany PZN

N3+X..20 (FNC1)

711 National Healthcare Reimbursement Number
(NHRN) – France CIP

N3+X..20 (FNC1)

712 National Healthcare Reimbursement Number
(NHRN) – Spain CN

N3+X..20 (FNC1)

713 National Healthcare Reimbursement Number
(NHRN) – Brasil DRN

N3+X..20 (FNC1)

714 National Healthcare Reimbursement Number
(NHRN) - Portugal AIM

N3+X..20 (FNC1)

715 National Healthcare Reimbursement Number
for US Food & Drug Agency

N3+X..20 (FNC1)

723s (****) Certification reference N4+X2+X...28 (FNC1)

7240 Clinical Trial Protocol ID N4+X..20 (FNC1)

8001 Roll Products (Width, Length, Core Diameter,
Direction, Splices)

N4+N14 (FNC1)

8002 Cellular Mobile Telephone Identifier N4+X..20 (FNC1)

8003 Global Returnable Asset Identifier (GRAI) N4+N14+X..16 (FNC1)

8004 Global Individual Asset Identifier (GIAI) N4+X..30 (FNC1)

8005 Price Per Unit of Measure N4+N6 (FNC1)

8006 Identification of the Components of a Trade
Item

N4+N14+N2+N2 (FNC1)

8007 International Bank Account Number (IBAN) N4+X..34 (FNC1)

8008 Date and Time of Production N4+N8+N..4 (FNC1)

8010 Component / Part Identifier (CPID) N4 + X..30 (FNC1)

8011 Component / Part Identifier Serial Number
(CPID SERIAL)

N4 + N..12 (FNC1)

8012 Software version N4+X..20 (FNC1)
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8013 Global Model Number (GMN) N4+X..30 (FNC1)

8017 Global Service Relation Number to identify
the relationship between an organisation
offering services and the provider of services

N4+N18 (FNC1)

8018 Global Service Relation Number to identify
the relationship between an organisation
offering services and the recipient of
services

N4+N18 (FNC1)

8019 Service Relation Instance Number (SRIN) N4+N..10 (FNC1)

8020 Payment Slip Reference Number N4+X..25 (FNC1)

8026 ITIP of contained pieces N4+N18

8110 Coupon Code Identification for Use in North
America

N4+X..70 (FNC1)

8111 Loyalty points of a coupon N4+N4 (FNC1)

8112 Paperless coupon code identification for use
in North America

N4+X..70 (FNC1)

8200 Extended Packaging URL N4+X..70 (FNC1)

90 Information Mutually Agreed Between Trading
Partners

N2+X..30 (FNC1)

91 to 99 Company Internal Information N2+X..30 (FNC1)

Notes
• *: The first position indicates the length (number of digits) of the GS1 Application Identifier. The

following value refers to the format of the data content.

The following convention is applied:

n implied decimal point position

N numeric digit

X any character

N3 3 numeric digits, fixed length

N..3 up to 3 numeric digits

X..3 up to 3 characters

• **: If only year and month are available, DD must be filled with two zeroes.

• ***: The fourth digit of this GS1 Application Identifier indicates the implied decimal point position.
Example:

• 3100 Net weight in kg without a decimal point
• 3102 Net weight in kg with two decimal points

• FNC1: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall
be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter
shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and

224



9DeskPack Advanced

GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1
QR Code Symbology.

• ****: The fourth digit of this AI indicates the sequence number, allowing multiple occurrences of
this AI

• *****: All GS1 Application Identifiers indicated with (FNC1) are defined as of variable length and shall
be delimited unless this Element String is the last one to be encoded in the symbol. The delimiter
shall be a Function 1 Symbol Character in GS1-128 Symbology, GS1 DataBar Expanded Versions and
GS1 Composite Symbology and should be a Function 1 Symbol Character in GS1 DataMatrix and GS1
QR Code Symbology.

9.7.2.  Barcode Types

To create a barcode of a specific type, select it in the Barcode Type parameter. This displays
parameters specific to this barcode type in the Dynamic Barcodes dialog.

2 of 5

About this Barcode...
2 of 5 is a numeric self-checking barcode, which can have a variable length. This barcode only encodes
data in the bars. It is used for industrial applications, article numbering, photo development and
ticketing.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275
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• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

Bobst

About this Barcode...
The Bobst barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
CLF-8. It is used in the pharmaceutical industry.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278

• Box on page 281
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CIP 39

About this Barcode...
Code 39 is a barcode based on the standard Code 39 barcode, used by the French pharma industry. The
barcode accepts 7 (CIP7) or 13 (CIP13) digits. The last digit is a check digit; if 6 or 12 digits are entered,
the check digit is added automatically. The CIP13 code must start with 340.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Narrow Bar on page 277

• Box on page 281

CLF-8

About this Barcode...
The CLF-8 barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Kurandt and
Bobst barcode. It is used in the pharmaceutical industry.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278

Codabar

About this Barcode...
The Codabar barcode is commonly used in libraries, blood banks, and the air parcel business. It can
encode up to 126 characters of data and two control characters, using digits and the “-”, “$”, “:”, “/” and
“+” characters.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270
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Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Rational (Constant Bar Width): By enabling this option, you can create a "Rational" Codabar bar
code.

• Use “992” Prod. Family in UPC on page 273

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

Code 128

About this Barcode...
Code 128 is a variable length, high density, alphanumeric barcode. It has the second highest density of
all the 1D barcodes (after the GS1 Databar Expanded).

It can contain a set of control characters. These control characters can change the character encoding
type. In the absence of control characters, the encoding type is chosen automatically, to optimize the
content encoding.

To force the usage of the code-set A, precede your data with the [a] control character. To force
the usage of the code-set B, precede your data with the [b] control character. To obtain an optimal
utilization of the code-sets A and B but prevent the usage of the space saving code-set C, use the Code
128 (long) barcode type instead.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270
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Text Parameters

• Add Human Readable Characters on page 271

• Light Margin Indicator on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Narrow Bar on page 277

• Width on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

Code 128 (long)

About this Barcode...
Code 128 (long) is a version of Code 128 that doesn't use the space-saving “C” character set. This makes
Code 128 (long) barcodes generally longer.

You can include FNC characters in your code by entering [F1] for FNC1, [F2] for FNC2 or [F3] for
FNC3

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Light Margin Indicator on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273
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• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Narrow Bar on page 277

• Width on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

Code 39

About this Barcode...
Code 39 is a popular barcode in industrial barcoding systems, mainly in the U.S.A. It is used in the
non-retail industry, particularly in the manufacturing, military, and health sectors. It can encode
alphanumeric data.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277
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• Narrow Bar on page 277

• Add Check Digit on page 279

• Box on page 281

Code 93

About this Barcode...
Code 93 is a variable length, high density, alphanumeric barcode. It's an enhancement of the Code 93
using spaces as well as bars as a data carrier. It contains two check characters for higher data security.
The Code 93 barcode allows encoding the first 128 characters of the ASCII table.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Narrow Bar on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

DataMatrix

About this Barcode...
DataMatrix is used for encoding large amounts of alphanumeric data and / or marking small objects. It
can encode all the standard ASCII and extended ASCII characters.
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The DataMatrix symbol size can adjust automatically depending on the amount of data.

Dynamic Barcodes doesn't generate human readable characters for DataMatrix symbols. The data to be
encoded in a DataMatrix symbol can contain an FNC1 character but only at the beginning of the data.

Note:  Dynamic Barcodes always generates DataMatrix symbols with the recommended
ECC200 error correction scheme.

 

 

DataMatrix Macro functions
Using DataMatrix Macro sequences, you can reduce the amount of data to encode by omiting obvious
headers and trailers. The structured data uses control characters, entered using their standard
abbreviations between "<" and ">"

The Macro sequence contains different parts:

• The optional Macro header: [)>. This is optional, and can be omited

• One of the starting sequences: <RS>05<GS> or <RS>06<GS>

• The macro content in a structured format

• The ending sequence: <RS><EOT>

Here are a few examples of a valid Macro function:

• [)><RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

• <RS>05<GS>PAP16559-2<GS>S0<72>017<GS>IPWP4511<RS><EOT>

Note that apart from the Macro functions, you can enter all control characters to a DataMatrix code.
These are all accepted codes:

<NUL><SOH><STX><ETX><EOT><ENQ><ACK><BEL><BS><HT><LF><VT><FF><CR><SO><SI><DLE><DC1><DC2><DC3><DC4><NAK><SYN><ETB><CAN><EM><SUB><ESC><FS><GS><RS><US>

Note:  If you want to use one of the control character substitutions literally (e.g. "<EOT>") it can
be escaped by doubling the first character: <<EOT>

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Symbol Type on page 279

• Cell Size or Cell Width/Height on page 279

• Width / Total Height on page 280
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• Box on page 281

EAN 8

About this Barcode...
EAN 8 is an abbreviated version of EAN 13, for use on smaller packages. It can encode eight digits, and
can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Light Margin Indicator on page 272

• Add-on Text On Top on page 273

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

EAN 13

About this Barcode...
European Article Numbering system or EAN is the standard for article numbering in Europe. It is also
used in Japan where it is called JAN.
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Note:  EAN is the European equivalent of the UPC system in the U.S.A. and Canada. Both
systems use the same size requirements and a similar encoding scheme. This means that most
European and American retail barcode scanners can read both EAN and UPC barcodes. For
more information on UPC, see UPC-A on page 267.

 

 

An EAN 13 is a numeric barcode of thirteen digits, and can have two or five additional digits.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Light Margin Indicator on page 272

• Add-on Text On Top on page 273

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281
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EAN 13 Swissmedic

About this Barcode...
EAN 13 Swissmedic is an EAN 13 barcode used for items licensed by the Swiss Agency for Theraputic
Products

It always starts with "7680", uses a specific text positioning and adds the text "swissmedic" below the
code.

For EAN 13 Swissmedic barcodes, only the default font settings can be used.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

Eberle

About this Barcode...
Eberle is a barcode using two bar and two space thicknesess to encode the data. The input can be both
in decimal and quarternal numerical systems. In the quarternal numerical system the barcode allows
numbers up to 30 digits (0, 1, 2 or 3).

In non-decimal mode, the minimal number is "0", while in decimal mode it is 1. Decimal "0" is not
allowed.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Narrow Bar on page 277

• Decimal Input on page 278

• Box on page 281

GS1 128

About this Barcode...
GS1 128 (formerly EAN 128) is a Code 128 barcode designed primarily to identify products.

It contains one or more FNC1 (GS1 Function Code 1) control characters and Application Identifiers. It
shows parentheses around the human readable interpretation of the Application Identifiers, but those
parentheses are not encoded in the barcode.

 

 

It is alphanumeric and can also contain composite symbols.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

GS1 DataBar Omnidirectional

About this Barcode...
Barcodes of the GS1 DataBar family (formerly Reduced Space Symbols or RSS) can identify small items,
and encode more information than the current EAN or UPC barcodes.

They can include GS1 Application Identifiers such as serial numbers, lot numbers, expiration dates...

Note:  GS1 DataBar codes are expected to replace most common EAN and UPC barcodes from
2010.
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GS1 DataBar Omnidirectional encodes Global Trade Item Numbers (GTIN) in a linear symbol that can be
scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

GS1 DataBar Stacked

About this Barcode...
GS1 DataBar Stacked is a variation of the GS1 DataBar barcode, that is stacked in two rows and used
when the normal barcode would be too wide for the product.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

GS1 DataBar Stacked Omnidirectional

About this Barcode...
GS1 DataBar14 Stacked Omnidirectional is taller version of GS1 DataBar14 Stacked, that can be read by
omnidirectional scanners.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271
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Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

GS1 DataBar Truncated

About this Barcode...
GS1 DataBar Truncated (formerly RSS Limited) is similar to GS1 DataBar but the height of its bars is
truncated.

It encodes Global Trade Item Numbers in a smaller symbol for use on small items. It cannot be scanned
omnidirectionally.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273
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• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

GS1 DataBar Expanded

About this Barcode...
GS1 DataBar Expanded (formerly RSS Expanded) encodes regular barcode data (“primary item
identification” data) and Application Identifiers. It can encode alphanumeric characters.

This barcode can be scanned omnidirectionally by suitably programmed slot scanners.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277
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• Snap Bars to Output Resolution on page 278

GS1 DataBar Expanded Stacked

About this Barcode...
GS1 DataBar Expanded Stacked can encode the same amount of data as GS1 DataBar Expanded, but
can also “stack” the barcode into several rows to save space.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Max. Row Width on page 273

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278
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GS1 DataBar Limited

About this Barcode...
GS1 Databar Limited is smaller than the GS1 DataBar barcode and can only encode Global Trade Item
Numbers whose data part starts with “1”.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

• Composite Component on page 271

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

GS1 DataMatrix

About this Barcode...
The GS1 Data Matrix barcode is a high density, high capacity, scalable 2D barcode. It is used to
concentrate a lot of (alphanumeric) information in a very small space.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272

• Multiple Text Lines on page 272

• Light Margin Indicator on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Symbol Type on page 279

• Cell Size or Cell Width/Height on page 279

• Width / Total Height on page 280

• Box on page 281

GS1 QR

About this Barcode...
The GS1 QR barcode is a high density, high capacity, scalable 2D barcode. It is used to assembly
multiple GS1 Application Identifiers to a barcode with limited space needs. The GS1 QR barcode can
contain numbers, 0 - 9, upper case letters A -Z, and nine special characters: space $ % * + - . /

For more technical information on the QR code, see QR on page 263

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Put on Top on page 272
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• Multiple Text Lines on page 272

• Light Margin Indicator on page 272

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Symbol Type on page 279

• Cell Size or Cell Width/Height on page 279

• Width / Total Height on page 280

• Box on page 281

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

GS1 U.S. Coupon Interim

About this Barcode...
GS1 U.S. Coupon Interim is an interim coupon barcode. It is used during the transition between UPC-A
coupons and the new GS1 Databar Expanded Stacked coupons, that can encode more information.
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It is made of both an old UPC-A coupon barcode, and a new Databar Expanded Stacked coupon
barcode, to be readable by both old and new scanners.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

Additional Parameters

• Use “992” Prod. Family in UPC on page 273

• Max. Row Width on page 273

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Narrow Bar on page 277

• Gap on page 277

• Vertical alignment on page 278

HIBC 128

About this Barcode...
This barcode is based on the Code 128 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Narrow Bar on page 277

• Width on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

HIBC 39

About this Barcode...
This barcode is based on the Code 39 symbology.

It encodes the organization's primary and / or secondary Labeler Identification Code (LIC). This
encoding begins with the “+” character. If both primary and secondary Labeler Identification Codes are
encoded in one barcode, they are divided by the “/” character.

 

 

Parameters
General Parameters

• Rotation on page 270

248



9DeskPack Advanced

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

ITF-14

About this Barcode...
ITF-14 is a standardized version of the Interleaved 2 of 5 barcode, containing 14 digits, the last being a
check digit.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Text Format on page 274
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• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Total Height on page 280

• Smax / Smin on page 280

• Box on page 281

ITF-16

About this Barcode...
ITF-16 is a standardized version of the Interleaved 2 of 5 barcode, containing 16 digits, the last being a
check digit.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Text Format on page 274

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274
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• Height on page 275

• Snap Bars to Output Resolution on page 278

• Total Height on page 280

• Smax / Smin on page 280

• Box on page 281

Interleaved 2 of 5

About this Barcode...
Interleaved 2 of 5 (or Int. 2 of 5) is a barcode originally used for transportation packaging, that can have
any even number of digits. Since this type of packaging consists mainly of cardboard boxes printed in
low quality, the Interleaved 2 of 5 barcode is more tolerant to distortion than other barcodes.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

• Stroke Weight: Bearer Bars on page 282
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Klebrand

About this Barcode...
Klebrand is a barcode used in the packaging industry. It uses four different bar thicknesess to encode
the data. The barcode uses the quarternal numerical system and each bar thickness represents one of
four numbers allowed in the non-decimal input (0, 1, 2 and 3). It can have up to 30 bars. The input can be
both in decimal and quarternal numerical systems.

• In non-decimal (quarternal) mode all digits are encoded, including any leading zeroes. For example
"0031" is encoded to 4 bars.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number
(6) defines the total number of bars, the second (4) defines the value to be encoded. If you you
enter a single number without defining the number of bars, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value
will change to "4/9", as you need at least 4 bars to encode this value. The text below the barcode (if
enabled) only shows the decimal value itself.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278
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• Box on page 281

Kurandt

About this Barcode...
The Kurandt barcode is part of the same "binary" barcode family as the Laetus Pharma Code, Bobst and
CLF-8. It is used in the pharmaceutical industry.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278

• Box on page 281

Laetus Pharma Code

About this Barcode...
The Laetus Pharma Code is part of the same barcode family as the Kurandt, Bobst and CLF-8 barcode.
It was developed specifically to meet the requirements of the pharmaceutical packaging process.
It has established itself as the worldwide pharmaceutical industry barcode standard. It can encode
numeric or binary data.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Miniature: Use this option to create a miniature version of the bar code

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278

• Box on page 281

M+S 7

About this Barcode...
The M+S 7 barcode is an EAN 8 barcode modified by Marks & Spencer's, for use on own-brand products
sold in their stores.

To make the M+S 7 barcode, the initial “0” is removed and the extra letters “M” and “S” are added to the
human readable characters.

This means that the human readable characters contain seven digits plus the “M” and “S” letters.

Note:  This doesn't affect the data encoded in the barcode (it still encodes eight digits), so you
should enter eight digits when creating a M+S 7 barcode.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

MSI

About this Barcode...
MSI, also known as Modified Plessey, was developed by the MSI Data Corporation, based on the original
Plessey Code. It is a numeric barcode used primarily to mark retail shelves for inventory control.

 

 

Parameters
General Parameters
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• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

Marks & Spencer's

About this Barcode...
The Marks & Spencer's barcode is also an EAN 8 barcode modified by Marks & Spencer's for use on
own-brand products.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271
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• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

NDC / HRI

About this Barcode...
The NDC / HRI barcode is a variant of the UPC barcode with special human readable interpretation
formats compliant to the US National Drug Code definition.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Text Format on page 274

• Bar Width Reduction on page 274
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• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

Paraf Italy

About this Barcode...
This barcode is a variant of Code 39 used by the Italian Health and Cosmetics Industry. It is also called
Code 32.

 

 

Use Code Base32 when your barcode data is encoded in the Base 32 format. This format uses case-
insensitive alphanumeric characters to encode data.

Use Code Base10when your barcode data is in decimal format. Paraf Italy barcodes in decimal format
should start with an “A” (included automatically by Dynamic Barcodes), have 8 digits of data and end
with a check digit (calculated automatically by Dynamic Barcodes).

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Narrow Bar on page 277

• Box on page 281

PDF417

About this Barcode...
PDF417 is a 2D barcode mainly used in security printing (passports, identity cards, driving licences...).

It is a “self-checking” barcode that can have different levels of error correction.
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It can encode data using one of three “compaction” modes: Text (to encode all alphanumeric and
punctuation characters in the ISO-8859-1 character set), Numeric (to encode only numeric characters)
or Binary (to encode 8-bit characters).

It can use the three compaction modes in a single barcode if necessary, but you can choose to disable
the Text and/or Numeric compaction modes.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Narrow Bar on page 277

• Box on page 281

Specific Parameters
Columns
You can give your barcode between 1 and 30 Columns. The number of columns corresponds to the
number of PDF417 codewords.

Rows
You can give your barcode between 3 and 90 Rows.

Truncated
Choose Truncated to make the symbol less wide by truncating the end character (which is not part of
the encoded data) and the end pattern. In the example below, the top PDF417 barcode is not truncated,
and the bottom barcode is truncated (but encodes the same data).
 

 

Initialize in Alpha Submode
Choose this option to generate a “shift to Text mode” character at the beginning of the barcode when
using Text compaction mode. This makes the encoding clear for barcode scanners.

Allow Text Compaction
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Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your
barcode contains text data.

This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your
barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode
contains binary data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic
Barcodes will only use Binary compaction mode.

Error Correction Level

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose an Error correction level from 0 to 8.

The higher the correction level, the more check sums are added to the barcode and the more incorrect
data can be corrected. Keep in mind that a higher correction level makes the barcode bigger and may
limit the maximum length of the encoded data.

Note:  Level 0 means that there is only one check sum added to the data, so incorrect data
can be detected but not corrected.

You can choose Automatic to let the plug-in pick the best error correction level for the data encoded.

MicroPDF417

About this Barcode...
MicroPDF417 is a 2D multi-row barcode derived from PDF417, for use on smaller areas. It can encode up
to 150 bytes.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274
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• Height on page 275

• Narrow Bar on page 277

• Snap Bars to Output Resolution on page 278

• Box on page 281

Specific Parameters
Columns
You can give your barcode between 1 and 4 Columns.

Rows
You can give your barcode between 4 and 44 Rows.

Allow Text Compaction

Choose this to let Dynamic Barcodes switch to Text compaction mode automatically when your
barcode contains text data.

This encodes the text data in your barcode more eciently (it makes that part of your barcode
smaller).

Allow Numeric Compaction

Choose this to let Dynamic Barcodes switch to Numeric compaction mode automatically when your
barcode contains numeric data.

This encodes the numeric data in your barcode more eciently.

Note:

Dynamic Barcodes can always switch to the Binary compaction mode if your barcode
contains binary data.

If you don't enable either Allow Text Compaction or Allow Numeric Compaction, Dynamic
Barcodes will only use Binary compaction mode.

PZN

About this Barcode...
The PZN (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and healthcare
products in Germany. The PZN code is written in the format “PZN-nnnnnnn” but only the numeric part
including the leading dash is encoded.

 

 

Parameters
General Parameters
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• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Size on page 275

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

PZN8

About this Barcode...
The PZN8 (Pharma-Zentral-Nummer) barcode is used for distribution of pharmaceutical and
healthcare products in Germany. The PZN code is written in the format “PZN-nnnnnnnn” but only the
numeric part including the leading dash is encoded.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters
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• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Size on page 275

• Height on page 275

• Characters per unit on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Box on page 281

QR

About this Barcode...
The QR barcode is a 2-dimensional barcode used for commercial tracking and convenience-oriented
applications aimed at mobile phone users (known as "mobile tagging").

QR codes storing addresses and URLs may appear in magazines, on signs, buses, business cards, or
other objects... Users with a camera phone equipped with the correct reader application can scan the
QR code to display text, contact information, connect to a wireless network, or open a web page in the
phone's browser.

 

 

QR codes have the following structure:
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•

 Position pattern (required)

•

 Alignment pattern (required)

•

 Timing pattern (required)

•
 Version information

•
 Format information

•
 Data and error correction keys

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Cell Size or Cell Width/Height on page 279

• Width / Total Height on page 280

• Box on page 281

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction

Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.
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• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

For example, a symbol of 25 x 25 cells where each cell is 2 mm gives a Width and Height of 50 x 50 mm.

MicroQR

About this Barcode...
The Micro QR Code is a very small QR Code for use on smaller spaces (for example to encode the ID of
printed circuit boards and electronics parts).

It works with smaller amounts of data (maximum 35 numeric characters), and uses only one position
pattern.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Cell Size or Cell Width/Height on page 279

• Width / Total Height on page 280

• Box on page 281

Specific Parameters
Minimum Symbol Size

Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will use a bigger symbol size automatically.

Error Correction
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Error correction adds check sums to the barcode to detect and correct incorrect data. You can
choose one of the following Error correction levels:

• Level L: 7% of codewords can be restored.

• Level M: 15% of codewords can be restored.

• Level Q: 25% of codewords can be restored.

• Level H: 30% of codewords can be restored.

Note:  Keep in mind that a higher correction level makes the barcode bigger (as more check
sums are added to the barcode) and may limit the maximum length of the encoded data.

Width / Height

The Width and Height parameters depend on the Cell Size and the number of cells used for the symbol
(Minimum Symbol Size).

For example, a symbol of 15 x 15 cells where each cell is 2 mm gives a Width and Height of 30 x 30 mm.

SICK Code

About this Barcode...
SICK is a bar code used in the German packaging industry. It's a binary bar code, using a thick bar for a
0, and a thin bar for a 1. It can have up to 12 bars. It can encode numeric or binary data.

• In binary mode all digits are encoded including leading zeroes, ie. "0001" is encoded as a three thin
and one thick bar.

• In decimal mode you can define the number of bars in total, by enter e.g. "6/4". The first number (6)
defines  the total number of bars, the second (4) defines the valueto be encoded. If you don't define
the number of bars, in other words if you enter a single number, the minimal number of bars needed
for the value is used, and the code is adjusted accordingly. If you for example enter "9", the value will
change to "4/9", as you need at least 4 bars to encode this value.

• The defaults follow the mostly used standard "Codetype A", for generating the "Codetype B" should
be changed the barcode parameters as following: Narrow Bar to 1.25mm (from 0.5mm), Wide Bar to
3.75mm (from 1.5mm) and Gap to 2.5mm (from 1mm)

By default, the values for the Narrow Bar (0.5mm), Wide Bar (1.5mm) and Gap (1mm) are set for the
mostly used standard "Codetype A". If you want to generate a SICK code using "Codetype B", you should
set the Narrow Bar to 1.25mm, the Wide Bar to 3.75mm and the Gap to 2.5mm

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters
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• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Alignment on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Height on page 275

• Ratio on page 277

• Narrow Bar on page 277

• Wide Bar on page 277

• Gap on page 277

• Decimal Input on page 278

• Box on page 281

UPC-A

About this Barcode...
Universal Product Code or UPC is the standard for article numbering in the U.S.A. and Canada. It is
similar to the EAN system and compatible with it. For more information on EAN, see EAN 13 on page
234.

 

 

UPC-A is a numeric barcode of up to twelve digits, plus two or five additional digits.
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Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

UPC-E

About this Barcode...
UPC-E is an abbreviated version of UPC-A, for use on smaller packages. It is a numeric barcode of
eight digits, with an optional 2 or 5 digits add-on. You can also directly enter the 12-digit code of UPC-A
codes that can be represented in 8 digits.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273
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• Vertical Offset on page 273

Additional Parameters

• Bar Width Reduction on page 274

• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Box on page 281

UPC-SCS

About this Barcode...
The UPC–SCS (Shipping Container Symbol) barcode is a version of the Interleaved 2 of 5 barcode that
has a structure very similar to the Universal Product Code's (UPC) and specific formatting of the human
readable interpretation.

 

 

Parameters
General Parameters

• Rotation on page 270

• Code on page 270

Text Parameters

• Add Human Readable Characters on page 271

• Font Family, Style and Size on page 273

• Vertical Offset on page 273

Additional Parameters

• Text Format on page 274

• Bar Width Reduction on page 274
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• Device Compensation on page 274

• Magnification on page 274

• Height on page 275

• Snap Bars to Output Resolution on page 278

• Total Height on page 280

• Box on page 281

• Stroke Weight: Bearer Bars on page 282

9.7.3.  Barcode Parameters

Rotation
To rotate your barcode by 90, 180 or 270 degrees, use the Rotation buttons.

 

 

To rotate it by any other angle, enter that angle in the Rotation field.

Code
Enter the data to encode in your bar code.

Dynamic Barcodes checks that the data you have entered is valid for your chosen Barcode Type. If it
isn't, a warning / error will pop up.

Code for GS1 Bar Codes
When entering data to be encoded in GS1 bar codes, you can either enter Application Identifiers (AI)
including the brackets, or you can enter the code without brackets, using FNC1 code at the end of
each variable-length element in the data. The FNC1 code will be represented by [F1] when entering the
code (with an exception for the GS1 DataMatrix barcode, which also allows the ASCII 29 <GS> control
character as a seprator).While entering GS1 data, following remarks should be taken into account:

• Do not add the mandatory FNC1 character at the beginning of the data. Dynamic Barcodes will add it
automatically.

• For GS1 bar codes intended for encoding AI (01) only, AI has to be omitted, i.e. don't enter '01' at the
beginning. It doesn't matter if entered with or without brackets.

• The Composite Component can be created using the same rules for using brackets and [F1]. It's not
necessary to keep the same way of entering the Composite Component and the main code.

• If you don't use brackets for entering AI, type [F1] at the end of each variable-length element in the
data, to represent a FNC1 terminating character, except when the variable-length element is placed
at the end of the whole code.
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• You don't need to type [F1] at the end of fixed-length elements.

• Do not mix using [F1] as terminators of variable AI and entering brackets around the AI.

 

 

Dynamic Barcodes also checks the validity of the Application Identifiers you enter in the Code and / or
in the Composite Component of GS1 bar codes.

Composite Component
A Composite Component is a 2D symbol placed on top of a GS1 barcode, that encodes extra
information (batch number, expiration date...).

If you want your barcode to have a Composite Component, enter the (alphanumeric) data to encode in
this field.

Note:  Dynamic Barcodes checks the data you enter for the Composite Component (for
example to see if the Application Identifiers you entered are correct), and displays a warning if
it is invalid.
 

 

Add Human Readable Characters
This parameter adds “human readable” characters (numeric or alphanumeric characters) under your
barcode.

This is the same barcode with and without human readable characters:
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Put on Top
This parameter allows you to put the Human Readable Characters above instead of below the barcode
bars.

Multiple Text Lines
Select this parameter if you want the human readable characters to be printed on multiple lines below
the barcode. Dynamic Barcodes will start a new line for every element of the barcode data (starting
with the Application Identifier).

 

 

Note:  When opening your document in PackEdge, the characters will be placed back on a
single line.

Light Margin Indicator
This parameter adds “<“ and “>” signs (or only “>” depending on the barcode type) at the bottom of your
barcode. This indicates the width the barcode should have for optimal reading.

 

 

Note:  When creating a bar code, the current Light Margin Indicator setting is stored for the
specific barcode type. This means that the next time you select the same barcode type (e.g.
when creating a new barcode of that same type) the Light Margin Indicator setting will be
adjusted.
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Add-on Text On Top
This parameter allows you to put the add-on HRI text above instead of below the barcode bars. By
default, this option is enabled.

Font Family, Style and Size
These options can be used to define the font family, style and size to be used for the human readable
characters. By choosing [default font], all other Text Parameters are disabled, as the default values
are used.

Note:  If the font used in a bar code is not available when opening the file, Adobe Illustrator will
warn about a missing font. You can however only fix the problem using the Dynamic Barcode
palette, since Adobe Illustrator's "Find Font" feature can not be used.

Alignment
When using human readable characters, in combination with custom font settings, you can set text
alignment to Left, Center or Right.

Vertical Offset
This parameter allows you to add extra space between your barcode bars and the human readable
characters.

 

 

Note:  When opening your document in PackEdge, the characters will be placed just below the
bars again.

Use “992” Prod. Family in UPC
Enable this parameter to use the special “992” product family in your barcode (for specific offers like
discounts on the customer's next purchase or on variable weight items...).

Max. Row Width
Use this parameter to define how many segments of data (groups of bars encoding several digits) can
fit in one row. If the barcode contains more segments, they will be stacked.

In the example below, the first barcode has a Max. Row Width of 8 segments. When reducing this to
4 segments, the segments that don't fit in the row width anymore are stacked, forming a second row
(second barcode).
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The GS1 Max Row Width parameter applies to the GS1 Databar Expanded Stacked component of the GS1
U.S. Coupon Interim barcode.

Text Format
Choose a text format for the human readable characters of your barcode.

For NDC/HRI barcodes, you can choose a variant of the U.S. National Drug Code.

For ITF-14, ITF-16 and UPC-SCS barcodes, you can choose a variant of the Shipping Container Symbol.

Bar Width Reduction
Use this to adjust the width of barcode bars, in order to compensate for ink bleeding when printing on
your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells
you that the line width will increase by 0.01mm, you should use a Bar Width Reduction value of 0.01
mm.

You can enter the Bar Width Reduction in microns, milliinches (“mil”), millimeters or inches.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation
Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width
to compensate for bleed caused by the plate or film making process.

You can enter the Device Compensation in microns, milliinches (“mil”), millimeters or inches.

Note:  If you use both a Bar Width Reduction and a Device Compensation value, Dynamic
Barcodes will add them to adjust the bar's width.

Tip:  You can enter a negative value if you want to print thicker and not thinner bars.

Magnification
Use this parameter to increase or decrease the barcode size proportionally.

In the example below, you can see the same barcode at 80%, 100% and 120% magnification.
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Size
Choose to give your PZN barcode a Small, Normal or Large size. Those are predefined sizes for this
barcode. The actual Height, Characters per unit, Ratio and Narrow Bar values are shown underneath.

By selecting Custom, you can manually edit these four parameters.

Height
Enter the height to give to your barcode's bars. They need to be tall enough to be read easily by barcode
scanners.

Code 128
In Dynamic Barcodes, you can create Code 128 barcodes shorter than the minimum height. Dynamic
Barcodes will just display a warning, but if you export the document to EPF and open it in PackEdge,
PackEdge will extend the barcode to its minimum required height.

 

 

Bars and Digits
For:

• EAN 8 & 13
• HIBC 128 and 39
• M+S 7, and Marks & Spencer's
• NDC / HRI
• UPC-A and UPC-E

For the bar codes listed above, the height you enter is the combined height of the bars and the human
readable characters). Your barcode needs to be tall enough to be read easily by barcode scanners.

Attention:  Do not change the Height of the barcode before entering a Magnification value.
The Height will change again according to the Magnification factor you define.

Characters per unit
This parameter allows you to define your barcode's width based on the encoding of (numeric or
alphanumeric) characters.

You can choose the unit to use: micron, mil (milliinches), mm or inch.
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For example, choose mm and use 1 Character per unit in the Dynamic Barcodes dialog if you want the
bars needed to encode one character to take up 1 mm.

 

 

Increase the Characters per unit value to make the barcode narrower, or decrease it to make the
barcode wider. For example, if you choose 0.5 Character per unit, the bars needed to encode one
character will take up 2 mm.

 

 

Note:  Barcodes like Interleaved 2 of 5 encode two characters together in a group of black and
white bars. For these barcodes, Dynamic Barcodes takes half of the group of black and white
bars to measure one character.
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Ratio
The Ratio is the factor between the width of the narrow bar and the width of the wide bar in your
barcode. For example, enter 3 if you want your wide bar to be three times as wide as your narrow bar.

Narrow Bar
This parameter determines the width of the narrowest bar of your barcode. In some cases (for example
GS1 DataBar barcodes) this affects the size (height and width) of your barcode proportionally.

Width
This parameter determines the width of the barcode from the leftmost bar to the rightmost bar.
Changing the Width will update the Narrow Bar and Characters per unit settings to achieve the desired
size.

The Light Margin Indicators and Box are not included.

Wide Bar
This parameter determines the width of the widest bar of your barcode.

Gap
Enter the width of the white space between the bars.

Note:  The Ratio influences the Gap size: increasing the Ratio also increases the Gap size.
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Vertical alignment
Dynamic Barcodes allows you to resize either the UPC-A or the GS1 Databar Expanded Stacked coupon
barcode, so they are aligned vertically with each other. You can choose:

• None to keep the original size of both the UPC and the GS1 barcodes,
 

 

• Resize UPC to GS1 to resize the UPC barcode so it has the same height as the GS1 barcode,
 

 

• Resize GS1 to UPC to resize the GS1 barcode so it has the same height as the UPC barcode.
 

 

Snap Bars to Output Resolution
Use this to adjust the barcode size parameters (Bar Width Reduction, Device Compensation and
Magnification) so that the bars' width and height take up a complete number of pixels or dots.

Enable Snap Bars to Output Resolution and enter the resolution you will use to print your barcode in
ppi.

Decimal Input
Use this parameter to change the type of data you can enter in the Code field.

• Disable it to enter the data to encode in binary or quaternal format.

• Enable it to enter the data in decimal instead of binary/quaternal format.
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Note:  When using binary format for the Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode
data, you need to use a special "Pharma" binary format.

To convert a decimal number into a Pharma binary number, do the following:

1. Add 1 to your decimal number.
2. Convert the result to a binary number using a regular binary conversion algorithm.
3. Remove the first digit (which is 1).

You now have your Pharma binary input for the Laetus Pharma Code, CLF-8, Bobst or Kurandt
barcode.

For example, you want to encode the number 3.

1. 3+1=4
2. 4 in binary is 100.
3. Without the first digit, it's 00.

Enter 00 in the Code field of your Laetus Pharma Code, CLF-8, Bobst or Kurandt barcode.

Add Check Digit
Use this parameter to add a check digit to your barcode data.

Note:  Code 39 doesn't usually contain a check digit but it can be required in some cases.

Symbol Type
Choose the number of cells to use for your barcode (in the format “horizontal cells x vertical cells”).

Note:  If the number of cells you choose for your symbol is too small to encode the data you
entered in Code, Dynamic Barcodes will display an error.
 

 

You can choose Best Fit to make Dynamic Barcodes automatically adapt the number of cells to the
amount of data you entered in Code.

Cell Size or Cell Width/Height
Enter the size you want to give to each cell of the symbol. Cell Size defines both the width and height of
the cell, while with Cell Width and Cell Heigth you can set these parameters separately.
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The unit used is the one you chose as Illustrator's General unit in the Units & Display Performance
Preferences.

In the example below, the first symbol has a 1 mm cell size (cells sides are 1 mm), and the second one a 2
mm cell size.

 

 

Width / Total Height
The Width and Total Height parameters depend on the Cell Size and the number of cells used for the
symbol (Symbol Type).

In the example below, a symbol of 10 x 10 cells where each cell is 3 mm gives a Width and Total Height of
30 x 30 mm.

 

 

Total Height
Enter the total height you want to give to your barcode. This is the combined height of the bars, the
human readable characters and the box. If your barcode doesn't contain human readable characters or
a box, the Total Height is the same as the bars' Height.

Smax / Smin
Use these parameters to define the width of the printability gauges (“H” marks) either side of your
barcode. Smax defines the width of the left “H”, Smin defines the width of the right “H”. Enter 0 in both
fields if you don't want printability gauges.

In the example below, the top barcode has a value of 0 for both Smax and Smin, the middle one has a
value of 4 and the bottom one has a value of 8 (the maximum).
 

280



9DeskPack Advanced

 

Box
Use this parameter to create an opaque white box under your barcode.

 

 

Use the Top, Bottom, Left and Right fields to add a white margin around your barcode and make the
box bigger.
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By default, Dynamic Barcodes links the four margins' values so that when you change one of them, the
other ones are updated automatically.

 

 

If you want to change them independently, click the link symbol to make it look detached  .

For ITF, UCP and UPC-SCS bar codes, the box will be transparent.

Note:  When creating a bar code, the current Box parameters are stored for the specific
barcode type. This means that the next time you select the same barcode type (e.g. when
creating a new barcode of that type) the Box parameters will be adjusted.

Stroke Weight: Bearer Bars
For ITF-14, ITF-16 and UPC-SCS barcodes, enabling the Box option will create a transparent box, always
with bearer bars around it. The Stroke Weight parameter defines the width of the bearer bars. In this
case, it can't be set to zero.

For 2 of 5, Code 128,Code 128 long, Code 93,GS1 128, HIBC 128 and Int 2 of 5 barcodes, the Stroke
Weight defines the width of the bearer bars, but also define if bearer bars should be added: if the value
is set to zero, no bearer bars are added, even if Box is enabled. If the value is not zero, bearer bars will
be added, even if the Box option is disabled.

The bearer bars are positioned at the outside of the defined box, taking into account the margins (even
if the box option is disabled for the barcode types mentioned above). See also Box on page 281.

The option Only Top and Bottom Bars limits the bearer bars to only the top and bottom line.

9.8.  Barcode Parameters from the Job Folder

Automation Engine stores information related to the printing jobs within the Job Folder. Each Job
Folder can hold various job-related technical information, including barcode parameters.

The following barcode parameters can be set in Automation Engine Pilot:

Parameter Note Link

Type The type of barcode. You can't have two different
bar codes of the same type in one job.

Sub Type The size of the symbol for Datamatrix barcodes. Symbol Type on page
279

Code The encoded value including check digits. Code on page 270
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Parameter Note Link

Composite Code For barcodes with a Composite Component -
mainly GS1 Databar codes

Composite Component
on page 271

Output Resolution Snap Bars to Output
Resolution on page
278

Bar Width Reduction Bar Width Reduction on
page 274

Device Compensation Device Compensation
on page 274

Narrow Bar Main size parameter for Code 128, Code 39,
Interleaved 2 of 5, Codabar or MSI based
barcodes, for GS1 DataBar barcodes, and for
binary barcodes. For 2D barcodes such as
DataMatrix, the parameter is used to set the Cell
Size.

Narrow Bar on page
277 and Cell Size or
Cell Width/Height on
page 279

Magnification Main proportional size parameter for EAN and
UPC based barcodes

Magnification on page
274

Ratio Used for Int2of5 barcodes Ratio on page 277

Important:  Automation Engine does not check the parameters. All listed parameters are
available for all barcode types, even if they are not valid for the given barcode type. Make sure
you're entering the valid inputs, including a correct Code with its check digit.

Note:  It is not necessary to have the parameters already set on the Job Setup when creating
barcodes: as soon as the Job Setup contains the settings for connected barcodes, these
barcode parameters will be applied. This allows you to create templates or placeholders before
the actual data (code for the barcode, etc) is available.

9.8.1.  Connecting to a Job Folder

In order to take parameters from an Automation Engine Job Folder, you need to be connected to an
Automation Engine, and open the file from the Automation Engine Job Folder. For easy locating the file
on the server, you can use File > Job Folder > Open from Job folder
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For more information on how to connect to Automation Engine, and on opening from a Job Folder, we
refer to the Esko DataExchange documentation. See http://help.esko.com/products/Esko%20Data
%20Exchange%20for%20Adobe%20Illustrator

9.8.2.  Connect Dynamic Barcodes to Job Setup

To use the Barcode properties from the Job Folder, enable the Get Properties from Job Setup.

When enabled, the icon on the right will indicate the status:

• Gray: the feature is disabled
• Green: the connection is established
• Red: the file is not in a Job Folder, or the connection is down.

9.8.3.  Use Barcode parameters from Job Setup

To use the barcode parameters from Job Setup, select a barcode type from the Barcode Type list that
is defined in the Job setup. You can recognize these barcode types by the green icon in front.
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As soon as you select one of the barcode types defined in the Job Setup, all parameters that are
defined in the job setup will be entered (and no longer be editable), indicated by the same green icon.
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In the example above, only the Code is defined in the Job Setup. All other parameters can be entered
freely.

9.8.4.  Updating barcode parameters from Job Setup

If a barcode is connected to the Job Setup, any changes to the barcode parameters in the Job Setup,
whether it is a changed parameter or a newly added parameter, will automatically and immediately be
taken into account in Dynamic Barcodes.

When opening a file, all barcodes with the Get Properties from Job Setup option enabled will be
updated automatically

If a barcode type is removed from the Job Setup, the corresponding barcodes in the job will no longer
be connected, so the Get Properties from Job Setup option is disabled.

A barcode will also be disconnected and the Get Properties from Job Setup option will be disabled
in case the barcode parameters in the Job Setup are invalid for the given barcode type. You will need
to change the parameters in the Job Setup. Note that after correcting the parameters, you need to
manually reconnect the barcode by enabling Get Properties from Job Setup.
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10.  Dynamic Marks

10.1.  Getting started

Using the Dynamic Marks plugin, you can create sets of marks, add them in a document, and have full
control over these marks.

10.1.1.  Creating a first Mark Set

1. Open a file in Illustrator. Create some objects you want to use as marks.
2. Go to Window > Esko > Dynamic Marks > Dynamic Marks to open the Dynamic Marks  panel.

 

 
3. Click Create a Mark Set to start a new Mark Set.

Note:  This step is optional. If no Mark Set is present, you can also immediately start adding
marks (see step 4), a new Mark Set will be created automatically.

4. You can add marks in two ways:

• Select the objects you want to use as mark one by one, and click the Add Selected Art as Mark

button 
•

Click the Add Standard Mark button  to add a standard mark to the set.
5. From the fly-out menu, select Save mark set
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Note:

You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do
so before saving the Mark Set

10.2.  The Dynamic Marks palette

In the Dynamic Marks palette, you can manage the marks in a set.

The palette will show the name of the latest loaded or saved mark set, and all the marks in the set. The
icon in front of the mark name will show the type of mark: a standard mark, text, an object, ...

 

 

In the palette, you can

• change the name of a mark by double-clicking it

•
select and zoom in on a mark, by clicking the button  or from the fly-out menu

•
add the selected artwork as a mark, by clicking the button  or from the fly-out menu. See
Adding objects as Mark on page 290

•
add a Standard Mark, by clicking the button  or from the fly-out menu. See Adding a Standard
Mark on page 289

•
remove the selected mark, by clicking the button  or from the fly-out menu.

Note:

Removing a mark will remove the entry in the Mark Set as well as the actual object.

•
update an On Demand mark (indicated by the  icon) by clicking the Update button . See
Updating Dynamic Marks on page 290
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• expand a mark, by selecting the function in the fly-out menu. Expanding a mark replaces the
dynamic mark by a normal object.

• change the order of the marks by clicking and dragging.

• If the corresponding objects are in the same layer in the Layers menu, their order will be
changed the same way.

• If you change the order in the Layers palette, the marks in the Dynamic Marks palette will change
accordingly

Note that the Marks list shows the topmost mark at the bottom of the list, while the Layers palette
works the other way around.

Note:  Same as in Adobe Illustrator's Layer palette, there are two different types of selecting in
the Dynamic Marks palette:

• If you click the name, the mark is selected in a blue bar, but the actual art is not selected in
Adobe Illustrator. This selection is used for Dynamic Marks palette operations (zoom, trash,
expand, remove).

• If you click at the right side of the row (or if you select the art using the Illustrator select
tools), the mark is showing a colored rectangle, indicating that the actual art is selected in
Adobe Illustrator. This selection is used for the Marks Properties.

10.2.1.  Adding a Standard Mark

You can add one of the predefined Standard Marks to your Mark set:

1.
Click the Add Standard Mark button  or select Add Standard Mark from the fly-out menu

2. Select the Standard Mark you want to add.
3. Click Add

The Standard Mark will be added to the Mark Set, and in the current document. You can change its
properties in the Dynamic Marks Properties palette. See Dynamic Mark Properties on page 290

The Standard Marks currently available are:

• Cut Mark
• Bearer Bars
• Gradation Strip
• Grid Marks
• Corner Marks
• Color Patches
• Image Mark

For more information on the properties for the Standard Marks, see Specific Mark Properties on page
295
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Note:  It is not possible to apply scaling on standard marks. Every time the marks are updated,
they will be regenerated at their original size.

10.2.2.  Adding objects as Mark

You can add existing objects as a Mark to your set.

1. Select the object you want to use as a mark
2.

Click the Add Selected Art as Mark button . or select Add Selected Art as Mark from the fly-
out menu.

The new Mark will appear in the Dynamic Marks palette. You can change its properties in the
Dynamic Marks Properties palette. See Dynamic Mark Properties on page 290

Note:  If you select multiple objects, these objects will be grouped and added as one single
mark in your set.

10.2.3.  Updating Dynamic Marks

By default, all dynamic marks are updated automatically. There are however some exceptions to this.

Changes in the Ink Manager
If the ink list in the document changes after adding the marks, you must click Update Ink List in the Ink
Manager for the marks to adjust to the updated ink list. See Color on page 293

On Demand marks
On Demand marks are marks that are not updated automatically. These marks are indicated in the

Dynamic Marks palette using this icon: .

These marks will only be updated by clicking the Update button .

The only On Demand mark at this moment is a Text Mark using the "Ink Coverage" variable.

10.3.  Dynamic Mark Properties

You can open the Dynamic Mark Properties by choosing Window > Esko > Dynamic Marks > Dynamic
Mark Properties or by choosing Show Properties Palette from the flyout menu of the Dynamic Marks
palette.
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10.3.1.  Position

The position of a mark is based on 3 settings:

Attach to
The position of the mark can be based on

• Any page box: Media Box, Crop Box, Bleed Box, Trim Box or Art Box

Note:

• a Page Box that is not defined in the file, will be greyed out
• If you load a marks set that uses a page box not defined in the current file, the Trim Box

is used instead, and a warning is shown
• You can't delete a Page Box if there 's a mark attached to it.

• another dynamic mark

• a PowerLayout Repetition, such as "PowerLayout Grid 1"
• Named Art

Named Art is any art in your Illustrator document, that you gave a name in the Layers palette: browse to
the object you want to name in the Layers palette, double click the default name (eg. <path>) and enter
a name.

When selecting Named Art..., you get a separate dialog, in which you can either type the name of the
Named Art you want to use, or select it from the dropdown at the right. Once Named Art has been used,
it remains available in the Attach To dropdown.

Named Art is only possible on objects, not on groups. Named Art can't be hidden or locked.

Note:  Standard Marks will be automatically attached to a currently selected PowerLayout
Standalone grid or another selected dynamic mark. If no grid or dynamic mark is selected, the
Standard Mark is attached to the Trim Box.

A PowerLayout Standalone grid is a Step and Repeat of a single file or object(s), generated by the
PowerLayout Standalone plug-in. If such a grid is available in the document, you can select its name in
the dropdown. For more information, see the PowerLayout Standalone documentation.
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Positioning
The way the mark is attached, can be chosen by clicking and dragging the blue square (representing
the mark) to the desired position on the grey square (representing the Attach To reference). Each
square has 9 reference points (top left center and right, middle left center and right, and bottom left
center and right), so you have 81 different ways of positioning the mark.

This setting is not available for Bearer Bars and for Cut Marks.

In the example underneath, the top center of the (bounding box of the) mark will be placed on the left
bottom corner of the (bounding box) of the reference defined in the Attach to field.

 

 

Note:  If you create a mark from an existing object, the Positioning settings (the blue rectangle)
will be automatically set, using the smallest offset possible while keeping the object at the
same location.

Offset
In the offset fields, you can move the mark based on the defined position. The direction
of the offset (up, down, left or right) depends on the positioning, and is shown by the

arrows.

Note:  You can also manually move marks. In that case, the offset will automatically adjust to
the new location. The other settings (Attach To and Positioning) will NOT change.

Repeat
For custom marks, you can use the Repeat buttons, to choose if the mark should be repeated or not.

 

 

From left to right:

• No repeat
• Repeat on all 4 sides. The positions of the marks are rotated 90º around the center of the Attach To

object. Examples:
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• Repeated horizontally. The positions of the marks are mirrored over the vertical center line.
Examples:
 

 

• Repeated vertically. The positions of the marks are mirrored over the horizontal center line.
Examples:
 

 

Note:  For vertical and horizontal repeat, the position of the marks is mirrored, but the actual
marks are rotated 180 degrees.

10.3.2.  Color

The color of a mark can be one of these settings:

Registration
The mark will be colored with 100% of every ink used in the document. If you change the tint to e.g.
42%, the mark will get 42% of every ink used in the document.

Changing the inks in the document can change the color of the mark.

Note:  If you manually change the color of a mark set to Registration, its color setting will
change to "Static" (see below), using the newly set color.

Static
If color is set to "Static", the current color is stored, based on the actual inks. The color of the mark will
not change if the order of the ink list is changed.

Note:

When placed on an existing document, "Static" marks are the only marks that affect the ink list:
the inks used in the mark will be added if necessary.

Dynamic
If color is set to "Dynamic", the current color is stored, but based on the ink positions in the Ink
Manager, and not the actual inks.
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For example, if the first ink is Cyan, a 100% cyan mark is stored as "100% of the first ink". If the first ink
is different (by changing the ink order, or by placing the mark on a different file), the mark will become
100% of the first ink.

Note:  If the ink list in the document changes after adding the marks, you must click Update Ink
List in the Ink Manager for the marks to adjust to the updated ink list.

Darkest
The mark will be colored with 100% of the darkest ink used in the document. You can't change the
percentage for "Darkest" ink, it will always be 100%.

Changing the inks in the document can change the color of the mark. Technical inks and Processing
Step Inks are not used in the mark.

Note:  If you manually change the color of a mark set to Darkest, the color will change back to
the darkest ink at the next mark update.

Black or Darkest
If the document contains a Process Black ink, the mark will be colored with 100% Black, otherwise the
darkest ink used in the document is used. You can't change the percentage for "Black or Darkest" ink, it
will always be 100%.

Changing the inks in the document can change the color of the mark. Technical inks and Processing
Step Inks are not used in the mark.

Black
The Mark will be colored with 100% Process Black, regardless of the inks already used in the document.

Note:  To ensure Marks using this color are supported on previous versions of Automation
Engine, it will be saved as a 100% solid black "Static" color when exporting a Mark Set to
Automation Engine. See Export Mark Sets on page 319

Fill / Stroke
For custom marks and for Color Patch marks, you can define both the Fill and the Stroke Color. For
Stroke, you have an extra option Same as fill

Defaults
Every dynamic mark has a default color attribute:

Mark Type Available Color Options Default

Custom mark (plain object) all* Dynamic

Cut Mark Registration, Darkest, Static Darkest

Text all Dynamic

Image Mark Static, Dynamic** Static

Dynamic Objects (Barcode,
Panel, Table)

all Static

Bearer Bar all Registration
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Mark Type Available Color Options Default

Gradation Strip No Color Options not applicable

Grid Marks Registration, Darkest, Static Registration

Corner Marks Registration, Darkest, Static Registration

Color Patch only applicable for stroke: all same as fill

(*): A Custom mark created from a mesh or gradient object will always have color attribute "Static". This
can't be changed.

(**): EPS image marks can only be Static.

Note:  A Gradation Strip doesn't allow setting Color options. A Gradation Strip always uses
every ink, except for technical inks.

Inks
When using Dynamic color, you can choose what inks to include: All, Only Technical, Only Printing
or Custom when working in Normalized PDF, or All, Only Processing Step Inks, Only Artwork Ink or
Custom when working in PDF+.

When choosing Custom, you can set a combination of rules to define what inks should be included,
based on the Printing Method, Ink Names or Ink Group (process or spot colors).

For any other color option, you can't change the drop down: for Static color and Registration it is fixed
at "All", while for "Darkest" it is fixed at "Only Printing".

If the option Include Varnish Inks is disabled, inks set as "Varnish" will not be taken into account for
Dynamic color.

Note:  When using All (inks) while working in PDF+, the Include Varnish Inks option will always
be enabled.

10.3.3.  Specific Mark Properties

Standard Marks have, beside Position and Color, some specific properties.

Also Text Marks have specific properties, allowing to create dynamic text marks.

Cut Mark Properties
Cut Marks are created from a symbol named "CutMark", and are by default 0,1mm wide and 10mm long.
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Position: Cut Marks will be automatically attached to a currently selected PowerLayout Standalone grid
or another selected dynamic mark. If no grid or dynamic mark is selected, the Cut Mark is attached to
the Trim Box.

Color: Cut Marks are by default in "Darkest" color.

Offset: allows to define the offset for the Cut Marks. A positive offset will move the Cut Marks to the
outside.

Symbol: allows to change the symbol used for the Cut Mark. See Changing the Symbol of a Standard
Mark on page 316,

Bearer Bars Properties
Adding a Bearer Bars mark will create two bars, one on each side, left and right (default) or top and
bottom. The bars will automatically take the size (vertical or horizontal) of the "Attach" selection.
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Position: Bearer Bars will be automatically attached to a currently selected PowerLayout Standalone
grid or another selected dynamic mark. If no grid or dynamic mark is selected, the Bearer Bars are
attached to the Trim Box.

If the Show on Both Sides option is selected, you will get a Bearer Bar on both sides (top and bottom, or
left and right).

By positioning the blue rectangles, you can choose between a vertical or horizontal orientation.

Color: Bearer Bars are by default in Registration color.

Width: The width of the Bearer Bar.

Extend: allows to extend the Bearer Bar on both size. Entering e.g. +5mm will extend the Bearer Bar by
5 mm on both ends.

Offset defines the distance between the Attach to object and the Bearer Bars.

Gradation Strip Properties
Gradation Strips are created from a symbol named "GradationStrip", and are by default 3 rectangles of 5
x 5mm, horizontally, colored 40%, 80% and 100%, one strip per ink.

 

 

Position: Gradation Strips will be automatically attached to a currently selected PowerLayout
Standalone grid or another selected dynamic mark. If no grid or dynamic mark is selected, the
Gradation Strip is attached to the Trim Box.

If you change the Positioning setting (the blue rectangle), the gradation strip will rotate automatically
based on the position of the blue rectangle.

Width: The width can be set to "One Strip per Ink" or to "Repeat to Fit".

Symbol: allows to change the symbol used for the Gradation Strip Mark. See Changing the Symbol of a
Standard Mark on page 316,

You can use any type of art in the symbol, but only paths and compound paths will be colored. If you will
use any text in your Gradation Strip symbol, it will be automatically colored with darkest ink.

If you change the default Gradation Strip symbol, the default position will be based on the size of
the symbol. If the width of the symbol is bigger than its height, the Gradation Strip will be created
horizontally by default. If the height is bigger, the Gradation Strip will be created vertically by default.
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Flip: when set to "Normal", the gradation is built from left to right, when set to "Reverted", the gradation
strip is built from right to left.

Grid Mark Properties
Grid Marks are created from a symbol named "GridMark", and are by default a rectangle of 5 x 5mm, in
Registration color.

 

 

Position: Grid Marks will be automatically attached to a currently selected PowerLayout Standalone
grid. If no grid is selected, you will get an error message.

Mark Positions & Copies:

Using the Where buttons, you can define where you want the Grid Marks:

• on the left side of the Repeat
• on the right side of the Repeat
• on top of the Repeat
• below the Repeat
• in between the columns
• in between the rows.

Note:  The "in between" options can not be used in combination with stagger. If you enable
stagger while grid marks are set to "in between", or if you load a mark set containing such a
mark, the grid marks will be placed at the side, and a warning will be given.
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For the Mark Position, you can (besides the normal Position settings) set the Reference. The Reference
defines what cell or column to use as a reference:. You can set the Reference to Outer Left Cell or
Outer Right Cell, or to Outer Left Column or Outer Right Column.

If the Grid Marks are placed on the top or bottom of the repeat, the options become top/bottom instead
of left/right, and Row instead of Column.

If a Column is used, a single Grid Mark is placed, using the column as reference.

In case you use a Cell as Reference, you can choose to Repeat the grid mark every Row (or Column),
every 2 rows, ect...

The examples underneath shows a 5 by 5 repeat with staggering. The Position is always centered at the
left side.

Outer Left Column:

 

 

Outer Right Column:

 

 

Outer Left Cell, no repeat:

 

 

Outer Right Cell, no repeat:

 

 

Outer Left Cell, repeat every 1 rows:

 

Outer Left Cell, repeat every 2 rows:
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If you enable Reverse Start Position, the repeat will start at the opposite side (top instead of bottom,
left instead of right, …). This option is only available if Repeat Every is enabled and uses a value of 2 or
more.

Symbol: allows to change the symbol used for the Gradation Strip Mark. See Changing the Symbol of a
Standard Mark on page 316.

White Underprint: see White Underprint on page 315

Corner Mark Properties
Corner Marks are created from a symbol named "CornerMark".

 

 

Bounding Box Corners or Repetition Corners:

Using the buttons, you can define if you want corner marks on the bounding box of the selected Attach
To area, or on the corners of every one-up. This option is only available if you attached the corner mark
to a Repeat Grid.
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Set Symbol: allows to change the symbol used for the Gradation Strip Mark. See Changing the Symbol of
a Standard Mark on page 316.

Offset allows to define the offset between the corner and the corner mark. If the lock is enabled,
vertical and horizontal offset are kept the same. If the lock is disabled, you can enter different values
for vertical and horizontal offset.

If an offset of 0mm is used (in the image underneath on the left), the bounding box of the corner mark is
placed on the outside of the selected page box. The page box is shown in red, the corner mark in black
and the bounding box in blue.

In the image on the right, the default offset of -8mm is used. You can see the Corner Mark being moved
8 mm to the inside, based on the original position. Since the default symbol is 10 mm by 10mm, this
default setting places the corner mark at 2 mm to the outside of the selected page box.

Color Patch Properties
Color Patch marks are created from a symbol named "ColorPatch".
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Set Symbol: allows to change the symbol used for the Color Patch Mark. See Changing the Symbol of a
Standard Mark on page 316.

A Color Patch mark is dynamically colored in one ink. The Index defines the ink to use, based on the ink
position in the Ink Manager.

You can however define a different color for the text and for the stroke.

The number of text fields depends on the number of text fields in the symbol. When using the default
symbol, a Color Patch contains 3 text fields, set to the short ink name, the ruling and angle, and the
index.

Note:  When you create a symbol for Color Patch using exact the same variable names (case
sensitive), Dynamic Marks will automatically use these variables. This way, you can quickly
create a Color Patch symbol with working variable text fields.

Text Mark properties
A Text Mark is a Custom Mark created from a text object. Text Marks can consist of static and dynamic
text.

1. Create a text object, using the font and text settings you want to use, and add it as a Custom Mark.
For more info on adding objects as Mark, see Adding objects as Mark on page 290

2. Open the Dynamic Mark Properties palette, by choosing Window > Esko > Dynamic Marks >
Dynamic Mark Properties

The existing text is static, which means it won't change when you use the Mark into another
document, or if the document changes.

You can make all or part of the text dynamic, to have it change with every document you use your
mark into.
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Note:  If you want to have some static text, just leave that part of the text as it is (or type in
new text) in the Text area.

3. To get dynamic text, you need to insert dynamic fields.

Place your cursor where you want the field to be, or select the text to replace with a field, and click
the Insert / Modify ... button.

4. In the Insert Field dialog that opens, choose the fields to insert:
a) Select Local Variables to select variables from the local file, or Server Variables to use

SmartNames from the Automation Engine server. In that case, all Database queries defined on
the server will be available, as well as all job and product parameters.

b) choose a field Category, for example Barcodes, Date & Time...
c) in that Category, choose the Field you want to use (see Categories and Types on page 304 for a

list of available categories and fields),
d) if applicable, choose the Format to use for your chosen Field (see Formatting Dynamic Fields on

page 308 for details),
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Note:  The Preview line shows how the field will be resolved in the current document.

e) when you are satisfied with how your field will look like, click OK.

The dynamic parts of a text object will appear between square brackets.

White Underprint allows to add White Underprint to your Mark. See White Underprint on page 315

Categories and Types

Local Variables

Barcodes • Number of Barcodes
• Barcode Type
• Barcode Code
• Bar Width Reduction
• Barcode Magnification
• Barcode Device Compensation
• Barcode Narrow Bar

Date & Time • Date
• Time
• Date and Time
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Document • File Name
• Fonts
• Layer Names
• CMYK Profile
• RGB Profile
• Color Mode
• Trim Box
• Crop Box
• Bleed Box
• Media Box
• Art Box

File Info (XMP) • Description
• Author
• Document Title
• Author Title

Inks • Number of Inks
• Number of Technical Inks1

• Number of Processing Step Inks2

• Ink Names

• Technical Ink Names1

• Processing Step Ink Names 2

• Short Ink Names

• Abbreviated Ink Names
• Ink Types
• Ink Dotshapes
• Ink Angles
• Ink Rulings
• Printing Method
• Ink Coverage
• Ink Printing Unit 2

Links • Placed Files
• XML Content Files
• Structural Design File

System • Illustrator Version
• Creative Suite Version
• OS Type
• OS Version
• Short User Name
• Full User Name
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Server Variables

File Info • Extension of File
• File
• File Type
• First Folder of File
• Folder of File
• Folder of Input

Job Info • Job Name
• Order ID
• Sub Order ID
• Description
• Due Date
• Project ID
• Last Actor
• Job URL
• Category
• Category2
• Category3
• Category4
• Category5
• Category6
• Category7
• Customer Ref
• CSR
• CSR Email
• Customer ID
• Customer Name
• Customer Description
• Due Day
• Due Time
• Job Container Name
• Job Container URL
• Job CT URL
• Job ID
• Name of Folder of Job
• JI Legacy Job (JDF)
• JI Originator (JDF)
• PS Printer Name
• PS Printer Name (JDF)
• Job Parameters
• Number of Barcodes
• Barcode Type
• Barcode Code
• Bar Width Reduction
• Barcode Magnification
• Barcode Device Compensation
• Barcode Narrow Bar
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• Number of Inks
• Number of Technical Inks1

• Number of Processing Step Inks2

• Ink Names

• Technical Ink Names1

• Processing Step Ink Names 2

• Short Ink Names

• Ink Types
• Ink Dotshapes
• Ink Angles
• Ink Rulings
• Ink Printing Methods

Global <user defined smart names>

Misc • Server

Path Info • File URL
• Job Temp URL
• URL Folder of Input
• URL of Input

Product Info • Customer's Product Reference
• Product Amount
• Product Custom Field 1
• Product Custom Field 2
• Product Custom Field 3
• Product Customer Description
• Product Customer ID
• Product Customer Name
• Product Description
• Product ID
• Product Name
• Product Part Custom Field 1
• Product Part Custom Field 2
• Product Part Custom Field 3
• Product Part Datazone
• Product Part Name
• Product Part Status

Job Barcodes • 2of5
• Bobst
• CLF8
• Codabar
• Code 39
• Code 128
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• Code 39 Extended
• Data Matrix ECC 200
• EAN 8
• EAN 13
• GS1 128
• GS1 Databar Omnidirectional
• GS1 Databar Expanded
• GS1 Databar Expanded Stacked
• GS1 Databar Limited
• GS1 Databar Stacked
• GS1 Databar Stacked Omnidirectional
• GS1 Databar Truncated
• GS1 Datamatrix
• GS1 US Coupon Interim
• HIBC-39
• HIBC-128
• ITF-14
• ITF-16
• Int. 2of5
• Kurandt
• Laetus Pharma
• MS7
• MSI
• Marks and Spencer
• NDC-HRI
• PDF417
• MicroPDF417
• Plessey
• PZN
• PZN8
• Paraf Italy
• QR
• MicroQR
• UPC-A
• UPC-E
• UPC-SCS

1: Only when working in Normalized PDF.
2: Only when working in PDF+. For more information on Normalized PDF vs PDF+ we refer to the
Data Exchange documentation. See https://www.esko.com/en/support/product?id=Esko%20Data
%20Exchange%20for%20Adobe%20Illustrator

Formatting Dynamic Fields
You can format certain fields so they look a certain way (for example, have the date in European or
American format).

You can use predefined formats or create custom formats. You can also choose to use a different
format for each field, or the same format for all fields.
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Using an Existing Format

• You can choose an existing format to apply to your field in the Format list.

For example, use [name][ext] to display the file name and extension when using the File Name
field.

 

 

Tip:  Hover over  to get more information about the different formats.

Defining a Custom Format

To define your own field format:

1. Choose Custom in the format list.
2.

Define your format in the box below (using the predefined formats and the information under  for
help).
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Note:

• The items in square brackets, like [major], are dynamic, the rest of the text is static.

• Use the Enter key to get a new line.

3. Check how your format resolves for the current file in the Preview line.
4. Click OK when you are satisfied.

Repeating the Format for All Items

If the field you want to use can have several values (e.g. Fonts, Ink Names, Placed Files...), you can put
them all in one dynamic object.

You can also set the same format for all those values at once.

After choosing an existing format or defining a custom one:

1. Select Repeat format for all items.
2. Choose the Separator you want to use between the values (Comma, Space...).
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Note:  You can also specify your own separator by typing it directly in the Separator list.
 

 

3. When you are satisfied with what you see in the Preview, click OK.

Formatting Dynamic Fields for Inks

When using variables of the category Ink, the Format field is used to select the ink based on the ink
index.

If for example you use the variable "Ink Names", and set the Format to [3], the variable will return the Ink
Name for the 3rd ink in the document, e.g. "Process Yellow".

Note:  This does not apply to the "Number of Inks" and "Number of Technical Inks" variables.

Ink Coverage
When using the Ink Coverage variable, you can set some additional parameters.
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• The Area defines in which page box the Ink Coverage will be calculated. You can choose any defined
page box.

• The Unit. This can be pt2, in2, mm2, cm2 or a percentage of the total area (%). When possible, the
area unit corresponding to the current Adobe Illustrator unit is used, otherwise it will be %.

Important:  If you use the Ink Coverage variable, the dynamic mark becomes an "On Demand"
mark, so it will not be updated automatically. See Updating Dynamic Marks on page 290

Reflow text

If you create a custom mark based on text in a text frame, resizing using standard transform tools will
resize the text "as is" instead of reflowing the text inside the resized text box.

If the Reflow Text option is enabled, resizing using standard transform tools will resize the text box,
and the text will reflow inside the resized text box.

Barcode Mark properties
A Barcode Mark is a Custom Mark created from a Barcode object. For more information on creating
barcodes, please refer to the Dynamic Barcodes documentation.

1. Create a barcode, using the barcode type and settings you want to use, and add it as a Custom Mark.
For more info on adding objects as Mark, see Adding objects as Mark on page 290
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2. Open the Dynamic Mark Properties palette, by choosing Window > Esko > Dynamic Marks >
Dynamic Mark Properties

The existing Barcode is static, which means it won't change when you use the Mark into another
document, or if the document changes.

You can make all or part of the code dynamic, to have it change with every document you use your
mark into.

 

 
3. To get a dynamic barcode, you need to insert dynamic fields.

Place your cursor where you want the field to be, or select the text to replace with a field, and click
the Insert / Modify ... button.

4. In the Insert Field dialog that opens, choose the fields to insert:
a) choose a field Category, for example Barcodes, Date & Time...
b) in that Category, choose the Field you want to use (see Categories and Types on page 304 for a

list of available categories and fields),
c) if applicable, choose the Format to use for your chosen Field (see Formatting Dynamic Fields on

page 308 for details),

Note:  The Preview line shows how the field will be resolved in the current document.

d) when you are satisfied with how your field will look like, click OK.

The dynamic parts of a barcode will appear between square brackets.
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Note:  Only the barcode's code can be changed after making. You can not change the barcode
type or other settings after creating a Mark from a bar code. To change these settings, you
have to delete the Mark and create a new one.

White Underprint allows to add White Underprint to your Mark. See White Underprint on page 315

Image Mark properties
An image Mark is a mark created from a linked image

1. There are two ways to create an Image Mark

•
Click the Add Standard Mark button  or select Add Standard Mark from the fly-out menu,
and choose Image Mark as type.

• Place an image (supported file formats are JPG, PDF, TIFF, EPS and PSD) as a link, and add it as a
Custom Mark. For more info on adding obejcts as Mark, see Adding objects as Mark on page 290

2. Open the Dynamic Mark Properties palette, by choosing Window > Esko > Dynamic Marks >
Dynamic Mark Properties

If the Image Mark was created from an existing image, the Dynamic Mark Properties will reflect the
properties of this image: its position attached to the top left corner of the trim box, and the path of
the linked file.
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3. Set the Scaling

• When set to Numeric, you can enter the scaling in %.
• Scale to Fit will scale the image proportionally to fit the object defined in the "Attach to" field.

You can use this for example to fit the image inside a named object. The % field will reflect the
current scale factor.

• Downscale to Fit is the same as "Scale to Fit", but the image will only be downscaled (if
necessary), not upscaled. The % field will reflect the current scale factor.

4. Set the Rotation for the image using the buttons
5. Use the File field to set the path for the linked image. If the path is valid, the image will be shown in

the document. Otherwise, a placeholder is shown.

If you used a placed image to create the Image Mark, its file path will be entered automatically.

You can enter the path manually, or use the Browse button.

You can use dynamic text in the path, e.g. the Job Folder. Use the Insert/Modify button. For more
information on dynamic text, see Text Mark properties on page 302

6. Color can be set to Static or Dynamic. For an EPS image, only Static is allowed.

Note:  If you switch from Dynamic to Static, the colors from the original file are used. If
there is a difference in the number of channels between two real images, the mark will
switch back to static.

7. White Underprint allows to add White Underprint to your Mark. See White Underprint on page 315

Note:  Image marks can NOT be modified (rotating, channel mapping, etc) outside of the
Dynamic Marks Properties palette.

White Underprint
White Underprint allows you to create a white background underneath the selected marks. This white
background can be necessary when printing on transparent or metal material. White Underprint is
available for Text Marks, Barcode Marks and Grid Marks

White Underprint Object
White Underprint objects will be created in a top-level "White Underprint" layer, and will be put in
overprint.

The White Underprint object will be

• a solid rectangle, using the bounding box of a Text Mark

• a solid rectangle, using the bounding box of a Barcode Mark

• a solid rectangle, using the bounding box of a Grid Mark

The Add Bar option, available for Grid Marks, will stretch the White Underprint over the full size of the
Media Box (or Trim Box if no Media Box is defined).

• For vertical grid marks, the White Underprint object will be a vertical bar, using the width of the grid
mark, and the height of the Media Box

• For horizontal grid marks, the White Underprint object will be a horizontal bar, using the height of
the grid mark, and the width of the Media Box

315



10 DeskPack Advanced

If the Mark is modified, deleted or expanded, the White Underprint will also be modified, deleted or
expanded.

White Underprint Ink
The Ink used for White Underprint on dynamic marks can be defined by clicking the Ink Settings
button, and entering the name of the Ink to be used for White Underprint.

In case the defined ink doesn't exist yet, a new spot color will be added to the swatches, using the Ink
name and the Color patch.

When the name of an existing swatch is entered, this ink will be used for White Underprint.

Note:  White Underprint can only use Spot Colors. If an existing swatch name is entered, and
the swatch is not a spot color, a warning will be generated: "A swatch by this name already
exists but is not defined as a Spot Color".

If you change the White Underprint ink, all White Underprint objects on dynamic marks in the open
document will be changed as well.

The White Underprint ink definition is saved in the Mark Set. If you load a Mark Set containing a
different White Underprint ink definition as in the open document, you can choose if you want to keep
your White Underprint ink, or if you want to load the White Underprint ink definition from the Mark Set.

10.3.4.  Changing the Symbol of a Standard Mark

You can change the Symbol used for a Standard Mark in the Dynamic Mark Properties, by clicking the
Set Symbol button, and selecting the desired Symbol from the list.

To change or add Symbols,

1. In the Dynamic Marks palette, select Open Symbol Library from the fly-out menu.
The file DynamicMarks_CS6.ai (CS6) or DynamicMarks_AI18.ai (CC2014 and CC2015) will be
opened.

2. Open the Illustrator Symbol Library by choosing Window > Symbols and use the Illustrator tools to
add, edit, remove, duplicate, ... the symbols defined in the file.

3. Save and close the Dynamic Marks file.

The new and modified symbols will now be available when clicking Set Symbol in the Dynamic Mark
Properties.

10.4.  Mark Sets

When no mark set is loaded, you get the option to load a mark set, or to create a new set.

From the Fly-out menu of the Dynamic Marks palette, you can

• Load a Mark Set
• Save the current Mark Set
• Delete the current Mark Set
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• Manage Mark Sets

10.4.1.  Load Mark Set

To load a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select Load Mark Set
 

 

The Load dialog will show the Esko Default Mark Sets, and Mark Sets saved at the location defined in
the Dynamic Marks Preferences. See Esko Mark Sets on page 320 and Dynamic Marks Preferences
on page 320

Note:  Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator
files at the defined location. When loading an Illustrator file that doesn't contain a Mark Set,
nothing will happen.

2. Select a Mark Set from the list, and click Load.

Note:  If the Mark Set contains a mark with the same name as a mark already in the Dynamic
Marks palette, an error message will be given, and the Mark Set will not be loaded.

The marks from the loaded Mark Set are added in the Dynamic Marks palette. If you want to replace the
current marks with the ones from the loaded Mark Set, you need to select all marks and delete them
first.

If you load marks with dependencies, the mark will be attached to the object (e.g. PowerLayout Grid
or Named Art) with the same name as in the Mark Set file. If no such object exists, you will get an error
message and the mark will be attached to the Trim Box.

10.4.2.  Save Mark Set

To save a Mark Set:

1. In the Fly-out menu of the Dynamic Marks palette, select Save Mark Set
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The Save dialog will show the Mark Sets already saved at the location defined in the Dynamic Marks
Preferences. See Dynamic Marks Preferences on page 320

2. Enter a name for the Mark Set and click Save. If a Mark Set with this name already exists, you will get
the option to overwrite it.

Note:

You can only save a Mark set if the Illustrator file is saved. If not, you will be prompted to do
so before saving the Mark Set

Mark Sets are saved as simple .ai documents, containing only the objects needed for the Mark Set.

Note:  All Marks in a set need to have a unique name. If not, an error message is shown, and the
Mark Set is not saved.

10.4.3.  Delete Mark Set

To delete a Mark Set, select Delete Mark Set in the Fly-out menu of the Dynamic Marks palette.

The Mark Set, including all dynamic marks will be removed from the file.

Note:  This does not remove a saved (and loaded) Mark Set from disk. To do so, select Manage
Mark Sets from the Fly-out menu. See Manage Mark Sets on page 318

10.4.4.  Manage Mark Sets

To manage your Mark Sets:

1. In the Fly-out menu of the Dynamic Marks palette, select Manage Mark Sets
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The Manage Dynamic Mark Set dialog will show the Mark Sets saved at the location defined in the
Dynamic Marks Preferences. See Dynamic Marks Preferences on page 320

Note:  Since Mark Sets are regular .ai documents, the list will show all Adobe Illustrator files
at the defined location.

2. Select a Mark Set from the list, and

• Click Rename, enter a new name for the Mark Set, and click Rename to change the name of the
Mark Set

• Click Delete to remove the Mark Set from the list. The actual Illustrator file will be deleted. This
can not be undone.

10.4.5.  Export Mark Sets

To use a mark set in the Dynamic task on an Automation Engine server, you can export your dynamic
marks set as a Dynamic Marks Set (.dmk).

Note:  Export Mark Set is only available when working in Normalized PDF. For more information
on Normalized PDF vs PDF+ we refer to the Data Exchange documentation. See https://
www.esko.com/en/support/product?id=Esko%20Data%20Exchange%20for%20Adobe
%20Illustrator

To export your mark sets:

1. In the Fly-out menu of the Dynamic Marks palette, select Export Mark Set for Server
2. Select a file name and location for the Dynamic Marks Template.
3. Move the file to your DFE server at this location: server

\bg_data_marks_v010\DynamicMarks

Limitations:

• Color Patch marks are not yet supported. As a workaround, you could manually create a custom
mark that looks like the Color Patch.
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Note:  It is not possible to import a mark set back into Illustrator. It is highly recommended to
keep the native Adobe Illustrator files for future modifications in the marks.

10.4.6.  Dynamic Marks Preferences

You can open the Dynamic Marks Preferences by choosing Illustrator > Preferences > Esko > Dynamic
Marks Preferences on Mac, or Edit > Preferences > Esko > Dynamic Marks Preferences on Windows.

 

 

In the Dynamic Marks Preferences, you can set the location to save and load Mark Sets.

• Default Folder: Mark Sets will be saved to and loaded from the default Esko location.

• on Mac OS X: /Users/Shared/EskoArtwork/DynamicMarks/

• on Windows Vista and 7: x:\Users\Public\Documents\EskoArtwork\DynamicMarks\

• on Windows XP: x:\Documents and Settings\All Users\Application Data
\EskoArtwork\DynamicMarks\

• Custom Folder: Mark Sets will be saved to and loaded from a custom folder which you can select by
clicking the Browse button.

10.4.7.  Esko Mark Sets

When installing Dynamic Marks, a number of default Mark Sets are installed as well. These sets can not
be changed, but you can load one of these sets, change it and save it under a different name.

Here is an overview of these Mark Sets:

1 x KAMA
A Custom Mark, using these settings:

• The mark is a circle of 3.2 mm diameter, and a vertical and horizontal line of 6.5 mm. All lines are
0.15 mm thick.
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• Attached to the Trim Box
• The center of the mark is vertically centered, and 12 mm to the right of the left border of the trim

box.
• Using Darkest color

1 x Label Row
A Grid Mark, using these settings:

• attached to PowerLayout Grid 1
• on the right side, with a reference to the outer left cell
• using a 3mm offset in horizontal direction, 0mm in vertical direction
• repeat Every 1-up.
• symbol 10 x 5 mm in Registration color

1 x Sheet
A Custom Mark, using these settings:

• The mark is a rectangle of 10 by 5 mm.
• Attached to the Media Box
• A 3 mm horizontal offset to the upper right part of the Media Box
• using Registration color

2x Label Row
Two Grid Marks, using these settings:

• attached to PowerLayout Grid 1
• Right mark is on the right side, Left mark is on the left side, both with a reference to the outer left

cell
• Right mark is aligned to the right bottom corner, Left mark to the upper left corner
• using a 3mm offset in horizontal direction, 0mm in vertical direction
• repeat Every 1-up.
• symbol 5 x 5 mm in Registration color

Mark Set 1 (Esko)
A set for maximum 6 inks in the document, units: mm

• 1 Registration Mark placed on every side
• a Text Mark with the name of the document
• a Text Mark with the date
• a Gradation Strip on the left, with 1 rectangle per ink, colored in 100%
• a Gradation Strip on the right, with a 40%, 80% and 100% rectangle for every ink.
• 6 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.

Mark Set 2 (Esko)
A set for maximum 6 inks in the document, units: mm

same as Mark Set 1, but with different type of Registration Mark

Mark Set 3 (Esko)
A set for maximum 4 inks in the document, units: mm
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• 12 Gallus elements on left and right side of the document

Mark Set 4 (Esko)
A set for maximum 6 inks in the document, units: mm

• Bearer Bars in vertical orientation and attached to the Trim Box
• 6 Text Marks, one per ink, with the name of the ink, placed inside the Bearer Bar, and colored with

0,2% tint to knock out the Bearer Bar in the same separation

Mark Set 5 (Esko)
A set for maximum 12 inks in the document, units: mm

• Bearer Bars in vertical orientation and attached to the Trim Box
• a Gradation Strip on the left, with one circle per ink, colored in 100%.
• a Gradation Strip on the right, with one circle per ink, colored in 50%.
• Registration Marks placed on the left and right side.
• 12 Gallus elements on left and right side of the document
• a Text Mark with the name of the document, colored in registration
• a Custom Mark setting a background for the above mentioned Text Mark
• 12 Text Marks, one per ink, with the name of the ink, and colored in 100% of the ink.
• a Custom Mark setting a background for the above mentioned Text Marks
• 12 Text Marks, one per ink, with the current Angle of the ink, and colored in 100% of the ink.
• 12 Text Marks, one per ink, with the current Ruling of the ink, and colored in 100% of the ink.
• a Text Mark with the date and time
• a Text Mark with the name of the author, based on the XMP info

10.5.  Dynamic Marks Layer

When adding a dynamic mark for the first time to a document, a layer named "Dynamic Marks" will
be created. Standard Marks are created in the Dynamic Marks layer, Custom Marks are moved to the
Dynamic Marks layer. If you rename the Dynamic Marks Layer, all dynamic marks created later will still
be created in or moved to this layer already containing dynamic marks.

Loading a Mark Set
If you load a Mark Set, the dynamic marks in the set will be placed in the same layer as saved in the set.
This means you can have two different layers containing dynamic marks at that point. Newly created
marks will then be placed in one of those layers.

Locking or hiding the Dynamic Marks Layer
If the Dynamic Marks layer is locked, you will not be able to add any mark. A message will be shown
in the message palette. However, all indirect operations are possible, for example changes in the Ink
Manager will change the gradation strip, even if the Dynamic Marks Layer is locked.

If the Dynamic Marks layer is invisible, marks will be created / moved in the Dynamic Marks layer, and
will immediately turn invisible.
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10.6.  Dynamic Panels in Dynamic Marks

When opening a document containing a Dynamic Panel, you will see those dynamic panels in the
Dynamic Marks palette.

By selecting a dynamic info panel and choosing Convert Panels to Dynamic Marks from the fly-out
menu, you can convert the selected dynamic panel into one or more dynamic marks.

• Every text item in the dynamic panel is converted to a separate dynamic text mark, using the same
variables.

• If possible, other panel items with the same color attribute will be grouped and combined in one
single mark.

• The inks used in the dynamic panel are replaced by the corresponding dynamic mark color:

• A dynamic panel ink will become dynamic color with mode "Only Printing Inks"
• A dynamic panel technical ink becomes dynamic color with mode "Only Technical Inks"
• Darkest ink becomes darkest color
• An object using registration swatch becomes registration color
• Other inks (not dynamic) become a static color.

• The position of converted panels will always be defined relative to the top left corner of the trim box

• Panel items that can't be converted into a dynamic mark (e.g. a linked image) will remain as a panel
item, while other items are converted. A message will be shown.
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10.7.  Tips and tricks

I open a new document, create an object to be used as a mark, and as soon as I use "Add Selected
Art as Mark", the color of the object changes or disappears. Why ?

If you have a document with e.g. only one rectangle, colored with 100% cyan in your document, the Ink
Manager will only contain one ink (Cyan).

When you create a custom mark, the default color attribute is "Dynamic". At this moment, the color
definition of the mark becomes "100% of the first ink in the ink manager". Because Ink Manager doesn't
read inks from marks with color attribute "Registration", "Darkest" or "Dynamic", and because there are
no other objects in the document, the inks list in the Ink Manager will be empty, and so will the custom
mark be.

As soon as another ink is used in the document, this ink will be the first ink in Ink Manager, and will be
used by the Custom Mark.

In the same way, if the original document would contain e.g. one object in cyan and one in magenta
(and nothing else), creating a Custom Mark from the cyan object would make magenta the first ink in
the ink manager, so the mark would change from cyan to magenta.

Can I start from an existing standard mark to create my own mark symbols ?

Yes, you can, as long as you remember to expand the mark / symbol first (i.e. making it a regular object
instead of a symbol).

What if I delete a symbol in the DynamicMarks(_CS6).ai file ?

If you delete a symbol in the DynamicMarks.ai file, the symbol will obviously no longer be available in
the Set Symbol list. If you delete the default symbol for a Standard Mark, creating the corresponding
Standard Mark will result in an error message. To fix this, you have to create these symbols again
manually.

Existing marks will NOT be affected, since the symbol is internally copied in the file when creating the
mark, or when setting a different symbol. This also means that you can open a file with marks using
custom symbols (saved in your local DynamicMarks.ai file) on another computer without loosing the
marks.
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11.  Dynamic VDP

11.1.  Dynamic VDP Overview

Dynamic VDP plugin is a tool to create variable documents (e.g. labels) where each label can be
different. Dynamic VDP combines static content (that is identical on all labels) with variable texts,
barcodes and images. The values for these variable objects are specified in a database. The whole
workflow has three main steps:

1. Design the variable document
2. Expand (i.e. generate the individual labels)
3. Step and Repeat the labels, and RIP

Designing a variable document is done using the Dynamic VDP plugin.

Expansion can be done directly in Dynamic VDP plugin or on a server. When special Illustrator text
features are used (such as text on a path, text in a complex path or text with a shadow), expansion can
only be done in Illustrator. Expansion on a server however is much faster and it can handle bigger jobs:
it is e.g. not recommended to expand significantly more than 10000 labels in Illustrator, while a server
can handle databases of any size.

Step and repeating and RIPing is always done on a server.

Note:

Dynamic VDP within DeskPack Essentials allows you to design the variable document. However,
to expand, you need a DeskPack Advanced license.

Typical workflow
• Design a static label containing all elements, using normal (static) text, barcodes or images.

• Convert the static design to a variable one. Open the database, and link objects with the
corresponding database fields.

• Preview the design (label) for several database records, and make the necessary adjustments (font
size, exact position,...)

• Optional: define Database Rules or Object Rules. Preflight and check for errors.

• Expand directly in Adobe Illustrator or export a template to the server and expand on the server

Processing the result of the Expansion
The result of expanding is a PDF/vt file (or multiple PDF/vt files when expansion is done on the server).

PDF/vt is a ISO standard for storing variable documents. It is a special optimized version of multipage
PDF file where the static content is stored only once and reused on all pages. It can be handled like
any other multipage PDF files, but Esko server tools such as Step and Repeat and RIP, are optimized to
handle it better than normal multipage PDF files.
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Important:  Dynamic VDP for Adobe Illustrator is not available when working on a PDF+ file. For
more information on PDF+, we refer to the Ink Manager chapter of the Esko Data Exchange
documentation: https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange
%20for%20Adobe%20Illustrator

11.2.  How to convert a static design to variable job

This chapter will explain how to convert a label design into variable one.

The first thing you need is a label design itself.

The design should be ready for print production, including correct overprint settings, inks, sucient
bleed area and trapping. All barcodes should be created by the DeskPack Dynamic Barcodes plug-in.

The second thing you need is a correct database file which contains all the data for variable objects.
The most common format for database exchange is CSV file format, eg. created in Microsoft Excel.

The result will be a multipage PDF/VT file which can be viewed by a PDF viewer or sent to a server for
further processing. It is highly recommended to use Adobe Acrobat to check the file as other viewers
might not handle the PDF/VT file correctly.

11.2.1.  Tutorial: Converting a static design to a variable job

In this tutorial, we will convert a static design to a variable job. The files needed can be found in the
Samples Files folder

On Mac the "Sample Files" folder can be found in the installation package (inside
the .dmg file) or DeskPack installation disk, on Windows please see [Installation
Folder]\bg_data_DynamicVDP_v010\Sample Files. By default the Installation Folder is C:
\Esko

1. Open Salmon2012.ai from the Samples folder
2. Select Window > Esko > Dynamic VDP to open the Dynamic VDP palette.
3. Click Select a database in the Dynamic VDP palette

The Select Database palette allows you to define the source of the database. It can either be a
database file or a sequence of numbers called "Counter". See  The Dynamic VDP Database  on page
331
 

326

https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator
https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator


11DeskPack Advanced

 
4. Click No file. Click here to specify database file

The Select database file will open, in which you can select the database file, database encoding
and field separator. The default values should cover the majority of cases.
 

 
5. Click Browse to select Salmon2012_ExampleDatabase_500.csv from the Samples folder

After selecting a CSV file, field names are now listed with their first records in the Select Database
palette. Using the Preview controls, you can inspect the database. The Rules allow to define the
database checking features.
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6. Click OK.

The Dynamic VDP palette is now enabled. The Record Set drop-down list can be used in case
database checking features are involved. Preview controls are useful in case some variable objects
are correctly defined.
 

 
7. Select the QR bar code in the top left corner (created by the Dynamic Barcodes plug-in), and click

the Convert to VDP object button  in the VDP Objects palette
The Dynamic VDP palette will show this first variable item, and the Dynamic VDP Properties shows
several parameters of the selected object. See Dynamic VDP Properties  on page 336
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8. In the Dynamic VDP Properties, in the Code field, select all leading zero's and click the Dynamic

Field button 
9. In the Insert Field dialog, select the "id_code" field, and click Insert

 

 

The zeros in the Dynamic VDP Properties are replace by [id_code] which represents the variable
inserted from the database
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10. Repeat the two previous steps to replace "John" and "Doe" by the database items "FirstName" and

"LastName"
11. Now it is time to create some variable text. Select the text object "Imported and smoked for John

Doe".
 

 
12.

Click the Convert to Universal Text button  to make the object variable.
The line of text will now appear in the Dynamic VDP plugin, and its properties are shown in the
Dynamic VDP Properties.
 

 
13. Select the text "John" in the Dynamic VDP Properties palette, and click Insert/Modify
14. In the Insert Field dialog, select "Database" and "FirstName", and click Insert. Repeat the same to

replace "Doe" by database item "LastName".

Both the QR barcode and text are now variable. You can check this by browsing through different
records, using the arrow buttons in the Dynamic VDP palette. You can see the QR barcode and the
text will change according to the selected record.

15. Choose Start Expansion from the contextual menu of the Dynamic VDP palette to create a PDF/VT
document. Define name and location, and click OK

The generated PDF/VT file can be viewed in Adobe Acrobat. It will contain one page for every record
in the Database, using the corresponding variables in the QR barcode and text line.

In Adobe Illustrator, the Dynamic VDP log will show all warnings and errors.
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11.3.  The Dynamic VDP Database

To make a job variable, a source of variable information is needed. This is set in the Select Database
dialog. Click Select a database in the Dynamic VDP palette (only if no Database is set yet), or choose
Select Database in the fly-out menu of the Dynamic VDP palette.
 

 

Database
In Dynamic VDP you can either use a Database File or a Simple Database.

A Database file is used in case the job should contain complex information such as names, serial
numbers or links to images.

See A Database file on page 332 for more info on the Database file.

When using a Simple Database, you only use Simple Counters, and don't need a Database file. This is
suited for jobs that only require a simple sequence of numbers.

You can define how many records need to be generated in the Number of records field.

Data Preview
The Record Set offers functionality to limit the set of records used. This is also available in the
Dynamic VDP palette. See Record Sets on page 359

The Preview allows to select what record will be used for preview, both in the Dynamic VDP palettes
as in the Adobe Illustrator file. You can use the arrows to navigate through the records. You can easily
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jump to the first or last record by clicking an arrow button while holding the Control key. This is also
available in the Dynamic VDP palette.

Database Fields
If a Database File is selected, this section will show the available Field Names, and the corresponding
value for the record selected in Data Preview

You can apply Rules and Global Rules. See Database Rules on page 352

Counters
You can click the Add button to add a new Counter, click Edit... to modify the selected Counter, or click
Remove to delete it.

If you use a Database File, you can add Database Driven Counters and Simple Counters. When using a
Simple Database, you can only use Simple Counters

See Counters on page 332 for more info on Counters.

11.3.1.  A Database file

Database files must be saved in CSV file format. This format is supported by many database engines
and oce tools like Microsoft Excel.

An example of the CSV format is provided below:

id_code,name
4859323,Libor Šindlar
8529512,Michal Polanský
7418529,Milan Arnošt
9874561,Milan Brunclík 

Values in a CSV file are separated by a delimiter. This can be a space, a tab, a comma or a semicolon.

The first line of a CSV file by default defines the database field names. Field names are case sensitive,
so you can have both a field "Name" and "name".

Note:  Only uppercase and lowercase ASCII letters, digits and underscores can be used in the
field names.

You can also use a database split into a header file and a database file, but only if

• the header file contains only a single line with database field names
• the amount of field names corresponds to the amount of columns used in a database file
• the Header and database file use the same delimiter and text encoding

11.3.2.  Counters

Counters allow to add a sequence of numbers to the job.

• A Simple Counter is a simple sequence of numbers, without the need for a database file. See Simple
Counters on page 333

• When using a Database file, you can create a Database Driven counter, which uses database
records as input for the counter. See Database Driven Counters on page 333
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Simple Counters
A Simple counter will generated a sequence of numbers based on the first value, step and eading
zeros.

The First Value can be any numeric value, and is used as first value in the sequence.

The Step defines the number added to the previous value. Eg. a step of 5 will give a sequence such as
0, 5, 10, 15, ...

Note:  A negative step is not allowed

If Leading zeros is enabled, zeros will be added to the numbers in the sequence

• When set to Automatic, leading zeros are added so that every number in the sequence has the
same amount of digits as the highest number. For example a sequence going up to 200, will result in
001, 002, 003, ..., 010, 011, ... , 199, 200.

• When set to Minimum counter length, leading zeros will be added so that every number in the
sequence has at least the amount of digits defined here. For example the same sequence, with a
minimum counter length of 4 will result in 0001, 0002, 0003, ..., 0010, 0011, ... , 0199, 0200. In this
case, numbers above 9.999 would not get any leading zero.

Database Driven Counters
Using Database driven Counters allows to take a numerical value from a database and perform simple
mathematical operations or add leading zeros.

333



11 DeskPack Advanced

1. Select the Variable from the Database file you want to use. Obviously, it only makes sense to select
a numeric variable.

2. Set the Step. The value of the Variable will be multiplied by the step.
3. Set the Base Value. The Base Value will be added to the result of the previous calculation.
4. Define the Leading zeros. Only Minimum counter length is available for Database driven Counters:

leading zeros will be added so that every number in the sequence has at least the amount of digits
defined here.

Example:

• Step is set to 3

• Base value is set to 1500

• Leading zeros is set to a Minimum counter length 5

If the selected Variable has a value "12", the counter value will be "01536"

11.4.  The Dynamic VDP palette: Dynamic Objects

The Dynamic VDP palette can be opened by choosing Window > Esko > Dynamic VDP > Dynamic VDP.
The Dynamic VDP palette lists all variable elements and allows to browse through a database.

If no database is selected, the palette is disabled. You can click Select a database or choose Select
Database in the fly-out menu to open the Select Database palette. See  The Dynamic VDP Database  on
page 331.

After a database is selected and some objects are created, the palette will show all Dynamic VDP
objects .
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The Record Set offers functionality to limit the set of records used. This is also available in the Select
Database palette. See Record Sets on page 359

The Preview allows to select what record will be used for preview, both in the Dynamic VDP palettes
as in the Adobe Illustrator file. You can use the arrows to navigate through the records. You can easily
jump to the first or last record by clicking an arrow button while holding the Control key. Preview is also
available in the Select Database palette.

The palette gives an overview of all Dynamic objects. The icon indicates the type of Dynamic VDP
object, while the name of the object is constructed from its type and actual text content. A blue square
on the right side indicates if the object is selected in the Adobe Illustrator file. A single click will select
a Dynamic Object in the list, double-clicking will select the object in the Adobe Illustrator job.

The Details section shows information about the Dynamic VDP job, about the currently selected
Dynamic VDP object and about the currently previewed record.

The Convert to Universal Text button  will convert the selected text to Universal Text. See 
Dynamic Text  on page 340.

The VDP Properties button  opens the Dynamic VDP Properties palette. Properties of Dynamic
VDP Object selected in the document will be shown immediately. See Dynamic VDP Properties on page
336

The Select button  selects the highlighted Dynamic VDP object in the Adobe Illustrator job.

The Convert to VDP Object button  will transform selected object in to Dynamic VDP Object or
Named Object. See

• Dynamic Text on page 340

• Dynamic Barcodes on page 342

• Dynamic Images on page 344
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Named Objects can be used to position Dynamic VDP Objects. See Position on page 336

11.4.1.  Dynamic VDP Properties

The Dynamic VDP Properties shows the properties for the currently selected Dynamic VDP object.

There are some common properties for every Dynamic VDP object:

• Position on page 336

• Rotation on page 337

• Color on page 337

There are also properties depending on the type of Dynamic VDP object that is currently selected. See

• Text Properties on page 341

• Barcode properties on page 343

• Image Properties on page 345

At the bottom of the dialog, you can define Object Rules. See Object Rules on page 354

Position
The position of a Dynamic VDP object is based on 3 settings:

Attach to
The position of the Dynamic VDP object can be based on

• the Trim Box
• the Media Box
• another Dynamic VDP object
• Named Art

Named Dynamic Art is any art in your Illustrator document, that you gave a name in the Layers palette,
and converted to a Dynamic Object: browse to the object you want to name in the Layers palette,
double click the default name (eg. <path>) and enter a name. Next, click the Convert to Dynamic VDP
Object button.
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Positioning
The way the Dynamic VDP object is attached, can be chosen by clicking and dragging the blue square
(representing the Dynamic VDP object) to the desired position on the grey square (representing the
Attach To reference). Each square has 9 reference points (top left center and right, middle left center
and right, and bottom left center and right), so you have 81 different ways of positioning the Dynamic
VDP object.

In the example underneath, the top center of the (bounding box of the) Dynamic VDP object will be
placed on the left bottom corner of the (bounding box) of the reference defined in the Attach to field.

 

 

Note:  If you create a Dynamic VDP object from an existing object, the Positioning settings (the
blue rectangle) will be automatically set, using the smallest offset possible while keeping the
object at the same location.

Offset
In the offset fields, you can move the Dynamic VDP object based on the defined position. The direction
of the offset is down/left, as shown by the arrows.

Note:  You can also manually move Dynamic VDP objects. In that case, the offset will
automatically adjust to the new location. The other settings (Attach To and Positioning) will
NOT change.

Rotation
The value for rotation can be defined either by using the buttons or by typing custom values in to the
text field. Negative values are supported.

You can also manually rotate Dynamic VDP objects. In that case, the rotation value will automatically
adjust.

Note:  Since rotation changes the bounding box of the selected Dynamic VDP object, the offset
values (which are based on the bounding box) in the Position will be updated.

Color

As defined by Illustrator
In most cases, Dynamic VDP object use the color settings As defined by Illustrator.

Each change performed by the Adobe Illustrator tools is automatically reflected. You can also apply
specific formatting on a selected part of a text string. However, formatting applied on a first character
of a variable string will be applied on the rest of the string.
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Process Color
By choosing Process Color you can define the color of the Dynamic VDP object. The selected color
will be applied on the complete Dynamic VDP object. You can define the color in a CMYK, CMYKOV or
CMYKOVG ink set.

1. Set Color to Process Color
2. Click the Select Color button

3. Select the Ink Set you want to use: CMYK, CMYKOV or CMYKOVG
4. Define the color by setting the ink percentages. You can enter constant percentages, or define the

ink percentage using variables from the database by clicking the blue square button next to ink
percentage value. Obviously, the selected database fields should only contain numbers between 0
and 100.

5. Click OK

The resulting color will be shown next to the Select Color button, along with the ink set used.

Named Color from Database
Using Named Color from Database you can change the color of a Dynamic VDP object by using the
entries of the database file to select the correct Swatch defined in the Adobe Illustrator document.
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1. Set Color to Named color from Database

2. Choose the Database Field you want to use in the dropdown menu
3. Choose Check Colors from Database from the fly-out menu of the Dynamic VDP palette. A dialog

will open, informing you about the number of swatches found in the Database that don't exist yet.

 

 
4. Click Yes. A new group "VDP" is added to the Swatches palette

 

 
5. For each unique record, a new swatch is created inside the "VDP" group, using a black color. Double-

click them to open the Swatch Options dialog and adjust the settings.
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Dynamic VDP is now set to color the Dynamic VDP object using the database entries

Tip:  Do not forgot to apply the Check Colors from Database function when the database file is
changed.

11.4.2.  Dynamic Text

The most common way to make a job variable is to change some text or number on every label/page.
Dynamic Text can be a combination of static and variable strings inside a text object.

Note:  Dynamic VDP was made to fit the needs of the label market. No advanced direct mail
features are provided.

Adobe Illustrator offers 3 types of text objects :

• Point Text
• Area Text
• Text on Path

These text objects can be converted to two types of variable texts.

Adobe Illustrator Text

• All the features provided by the Adobe Illustrator text engine can be applied on this type of text.
• Adobe Illustrator effects like warping or drop shadow are available for variable text strings.
• Text object must be expanded by Adobe Illustrator.
• Expansion on the DFE is not supported.

Note:  The Adobe Illustrator document is automatically saved during expansion if Adobe
Illustrator text is used

Universal Text

• This type of text offers all the mandatory text formatting features. Advanced features like Tracking
or Kerning are not supported

• You can define font, size and color of a text string. Rotation is supported as well.
• The text objects can be expanded by Adobe Illustrator, at a higher performance than for Adobe

Illustrator Text.
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• Expansion on the DFE is supported
• Text on Path is not supported for Universal Text
• Text inside a complex path (e.g. star) is also not supported for Universal Text. Rectangular shapes

are supported only.

Creating a VDP text object
1. Create the appropriate text objects, using Adobe Illustrator's text tools, and select it.
2. Make the text Dynamic, by converting it to a VDP Object, or to Universal Text

• Converting to Universal Text will increase performance, but exclude some graphic features (such

as a drop shadow effect). To do so, click the Convert to Universal Text  button.
• When converting to VDP Object (Adobe Illustrator Text), you will have lower performance than

with Universal Text, but all graphic features are supported. To do so, click the Convert to VDP

Object  button.

Note:  It is possible to convert Adobe Illustrator text to Universal Text, but not the other way
around.

3. Use the Dynamic VDP Properties to modify the properties of the newly created Dynamic VDP text
object.

Text Properties
Text formatting of a Dynamic VDP Text object can be done using the default Adobe Illustrator tools, but
text content can be changed in the Dynamic VDP Properties only.

Position, rotation and color properties are default Dynamic VDP Properties. See Dynamic VDP
Properties on page 336

The content of the Dynamic VDP text object is visualized in the Text field. It is the only place where
content changes can be made. Variables are visualized in square brackets and can be inserted or
modified only by the Insert/Modify button.
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Use the Rules... button to define rules for the Dynamic VDP object. See Object Rules on page 354

Use the Insert/Modify... button to insert a new Variable or (in case one single variable is selected when
clicking the button) to edit an exisiting one. For more information on defining Variable Fields, see Fields
on page 342

Fields
Some input text boxes provide support for so called Fields. Fields are acting as placeholders for
variable strings which will be inserted from the selected database.

Insert Field dialog can be opened either by clicking the Insert / Modify button or by clicking .

The dialog provides access to database fields, counters and predefined values.

The predefined values are:

• vdp_index: the number of the current record
• vdp_index_1k: the number of the current record divided by 1 000
• vdp_db_size: the total number of records in the database

11.4.3.  Dynamic Barcodes

Variable information encoded in a barcode is another popular way to make a job variable.

The classic 1D barcodes provide a simple way to transfer included information to a computer, using a
special barcode reader.
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Modern 2D barcodes are optimized to contain a lot of information on a small area. Smartphones
equipped with a camera and appropriate software can read this information and act accordingly.

Dynamic VDP provides support for a wide range of 1D and 2D barcodes, about 50 in total. The vast
majority of barcodes created by the Dynamic Barcodes plug-in is supported by Dynamic VDP. Only the
PZN and PZN8 barcodes are not supported.

To create a VDP Barcode, select a barcode created by the Dynamic Barcode plugin, and click the

Convert to VDP Object  button.

Note:  It is not possible to change the type of a barcode once it is converted to Dynamic VDP.

Barcode properties
Formatting of a Dynamic VDP barcode can be done using the default Adobe Illustrator tools. Additional
parameters like symbol size, bar width reduction or error correction can be modified in the Dynamic
Barcodes panel, but the content of the code can be changed in the Dynamic VDP Properties only.

Position, rotation and color properties are default Dynamic VDP Properties. See Dynamic VDP
Properties on page 336

The code of the Dynamic VDP barcode object is visualized in the Code field. It is the only place where
the code can be changed. Variables are visualized in square brackets and can be inserted or modified

only by the Insert/Modify button .

Use the Rules... button to define rules for the Dynamic VDP object. See Object Rules on page 354

Use the Insert/Modify... button to insert a new Variable or (in case one single variable is selected when
clicking the button) to edit an exisiting one. For more information on defining Variable Fields, see Fields
on page 342

Remarks on barcodes
• Rotating a barcode can reduce its readability. Try to limit the rotation of barcodes to 0, 90, 180 or

270 degrees.
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• For a good readability, you should pay attention when defining the colors for a barcode: a high
contrast between the background and the color used in barcode cells is recommended.

• Some of the barcodes can accept binary and decimal input. Dynamic VDP offers only one option.
Check the dialog for the code in order to insert correct form of input string.

• Althoug some GS1 barcodes in the Dynamic Barcode plugin can accept a composite component,
this feature is not supported by Dynamic VDP.

• Data records for GS1 barcodes with Application Identifiers can be provided in two formats:

• 10A1234567A[F1]011234567890123117201231.

• (10)A1234567A(01)1234567890123117201231. If this format is used, the brackets in the data
must be escaped by doubling it. For example, the RAW data 10A1234567(A) must be provided
as (10)A1234567((A)) to avoid misinterpretation.

More information about the GS1 Application Identifiers can be found in the Dynamic Barcodes
documentation: https://www.esko.com/en/support/product?id=Dynamic%20Barcodes%20for
%20Adobe%20Illustrator

11.4.4.  Dynamic Images

Using Dynamic VDP you can set up variable images. Dynamic VDP contains a set of features that allows
you to place images with a variable size and aspect ratio into a design with certain dimensions and
possibly a different aspect ratio.

A Variable image can also be used place output of a 3rd party application, for example a special
barcode symbol saved either as raster or vector based image.

Creating a new VDP Image object
1. If you need to place a new image, choose File > Place and make sure the Link option is enabled
2. If you want to use an already placed image, check if the image is Linked.

You can check if an image is linked (instead of embedded):

•
In the Links palette, an embedded image has an icon next to its name 

• In the Layers palette, the name of an embedded image will by default be <Image> while for
linked images, this will be <Linked File>.

In case the image is embedded:

a) Select the image, and open the Link palette
b) Choose Relink... from the fly-out menu of the palette.
c) Select the image to be used, enable the Link checkbox, and click Place

3.
In the Dynamic VDP palette, click the Convert to VDP Object  button

4. Use the Dynamic VDP Properties to modify the properties of the newly created Dynamic VDP image
object.
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Image Properties
Some of the properties can be modified using Adobe Illustrator tools and some of them by the VDP
Objects Properties only.

Position and rotation are default Dynamic VDP Properties. See Dynamic VDP Properties on page 336

Use the Size dropdown to define the target area, the rectangle in or on which the dynamic Images will
be placed during expansion. See Size on page 345

Note:  You can use the Adobe Illustrator tools to interactively change the position or size of the
target area. Changing the size will be reflected in the settings.

Use the Fit settings to define how the dynamic images are fitted in or on the target area. See Fit on
page 346

Define the Images to be used: the root path and file name. See Image on page 349

Use the Rules... button to define rules for the Dynamic VDP object. See Object Rules on page 354

Size

The Size drop-down list provides different options to define the size of the images.

Custom Size
Custom Size is the default option for newly created Dynamic Images. The Vertical and Horizontal
settings define the absolute dimension for the target area, and images are fit onto the target area,
using the Fit settings. See Fit on page 346.

When converting an image to a Dynamic VDP object, the size of the original image is used.

Working with Custom Size (when using uniform scaling) will always give a more or less predictable size
of the images. The scaling used will depend on the size of the images.
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Note:  In case the Dynamic VDP Object is selected, the target area is shown as a green
rectangle. However, if the currently selected image fits the target area in both directions, the
green rectangle will be hidden by the borders of the image.

Custom Scale
When using Custom Scale, you define a fixed scaling. The size of the images will depend on the size of
the input images.

Setting the scaling to 100% vertical and horizontal, will place every input image at its original size. By
entering a different value for horizontal and vertical scaling, you can apply non-uniform scaling.

In this case, the Size settings are not used.

Fit to Object
When using Fit to Object, the selected object is used as Target area, and the input images are fit on
that target area, using the Fit settings. See Fit on page 346

The Object can be the Trim Box, Media Box or another Dynamic Object (Dynamic Text, Dynamic
Barcodes, Dynamic Images or Named Dynamic Objects). You can not use the Dynamic Object itself.

Named Dynamic Art is any art in your Illustrator document, that you gave a name in the Layers palette,
and converted to a Dynamic Object: browse to the object you want to name in the Layers palette,
double click the default name (eg. <path>) and enter a name. Next, click the Convert to Dynamic VDP
Object button.

Shrink to Fit
Shrink to Fit works the same as Fit to Object but will only downscale the images, it will not enlarge
them..

Fit

The Fit setting offers four way to fit the image to the target area. In the example images underneath, an
image with aspect ratio 4:3 will be placed in a target area with aspect ratio 2:3.

• Uniform is the default option. The image will be scaled as big as possible to fit the target area, while
maintaining the aspect ratio.
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• Non-Uniform: the width and height of the image will fit the target area. The image aspect ratio is
not preserved, so the image will be distorted.

• Fit Width: The width of the image will fit the width of the target area. The image aspect ratio is
preserved, and the height of the image may exceed the target area.

• Fit Height: The height of the image will fit the height of the target area. The image aspect ratio is
preserved, and the width of the image may exceed the target area.
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Note:

Keep in mind that, when using "Fit Width" or "Fit Height", the image can be higher resp. wider
than the target area. In some cases (e.g. when placing a portrait image to a landscape area, see
the example underneath), the image might exceed the target area a lot.

Positioning
The Positioning diagram defines the position of the Dynamic VDP object inside the document. See
Position on page 336. The Positioning diagram combines the alignment (eg top right) of the Dynamic
VDP Object, on anchor points (e.g. bottom left corner) on the trim box (or other reference object). The
selected alignment is also used for positioning the Dynamic Image inside its area (but for this, the
"anchor point" is disregarded):

• Fit Width: the vertical alignment of the Dynamic VDP object is used: top, center or bottom.

• Fit Height: the horizontal alignment of the Dynamic VDP object is used: left, center or right.

• Uniform: either vertical or horizontal, depending on the scaling.
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Example: Using Fit Height: the Dynamic VDP object is set to align the bottom center of the object, on
the top left of the Trim box. The image will be aligned centered on the area

 

Image

In the Image settings, you define where and how to find the image files.

The path to the image is divided in two parts: the Root Path, which is the static part of the file path,
and the Name, defining the name (including variables) of the image and its sux.

By default the Root Path will show the path to the original linked image, and the Name will show the
original image name and sux.

You can change the Root Path by clicking the path, and browsing to the Root Path folder.

Use the Insert/Modify... button to insert a new Variable or (in case one single variable is selected when
clicking the button) to edit an exisiting one. For more information on defining Variable Fields, see Fields
on page 342

Using these Fields you can set up a variable image name, or even define in what (variable) subfolder an
image is. When defining a subfolder, use a backslash (\) when running on Windows, and a forward slash
(/) when running on Mac.

Example: if the Name is set to [model]/[color].png, and if a record has value "ModelA" for model, and
"Blue" for color, the image "Blue.png" will be taken from the subfolder "ModelA" inside the defined root
folder.

Different file types for Dynamic Images
The type of a Dynamic Image is set when creation it, based on the original image. During expansion, all
variable images should be the same type as the Dynamic Image.

It can be either

• multichannel raster, for example a CMYK JPG file

• single channel raster, for example a grayscale or bitmap TIFF. You can use the Dynamic VDP Color
properties to color a grayscale or bitmap image. See Color on page 337

• PDF

Raster images
For raster images, these file formats are supported:

• TIFF
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• JPEG
• PSD
• PNG

PDF
Vector based images must be provided as PDF files up to version 1.7 (Normalized PDF or Adobe PDF).

Note:  To ensure correct positioning after expansion, linked PDF documents must be placed
using their Trim Box.

Color space is not limited to CMYK only, as Grey, Bitmap, RGB or LAB are supported as well.

It is possible to use a multipage PDF. The Page input field allows to select the page to be used. By
applying a Variable field in this input field (see Fields on page 342), you can apply different pages
during expansion. Keep in mind that Expansion will fail if the requested page does not exist.
 

 

Note:  Adobe Illustrator will always display the first page of the PDF. Only after Expansion, the
correct page is shown.

11.5.  Checking and expanding a VDP file

To produce a variable job out of Adobe Illustrator, you have to Expand the job. By doing so, a PDF/VT
file is created when expansion finishes without any error. See Expand on page 351

Preflight allows to check if the Variable job can be expanded, but no output is generated. It can warn
you in advance whether there are some issues in the job. See Preflight on page 351.

The possible issues and how severe they are is defined in the Database Rules and Object Rules. See
Rules on page 352.

When dealing with a complex design and / or a big database, so where expanding can be very time
consuming, it might be recommended to Preflight first: Preflight runs through the complete database
and collects information about all issues found, while Expansion is canceled when a first error is
encountered.

If for example you have a big database, with two records (e.g. record 1000 and record 2000) that cause
an error, Expansion will error and stop after record 1000. Then you would have to fix this first error,
and restart expansion. When the second error is reached, expansion will stop again after expanding
2000 records, so you have to fix the second error, and restart the expansion all over again. When
Preflighting, you will get an overview of all errors in one go, without having to restart Expansion after
fixing every error.

After checking or expanding, you can limit the set of records used, to get quicker access to records
that require attention. See Record Sets on page 359
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Note:  You can use Check Database...  to do a quick check of the database. It does NOT expand
any Dynamic VDP objects, so a successful Database check does not guarantee successful
expanding. For that, you need to do a Preflight.

11.5.1.  Expand

Expansion will create a PDF/VT file. This file contains all the fonts and images, and can be easily send
for further processing.

1. Open a valid Dynamic VDP file in Adobe Illustrator. You might want to add Database Rules or Object
Rules to check during expansion. See Rules on page 352

2. Select Start Expansion... in the fly-out menu of the Dynamic VDP palette
3. Select the output folder and name for the PDF/VT file, and click Save.

The sux -vdp.pdf is automatically added to the file name.

During the output a progress bar is shown. You also get an indication of the total number of records,
the record currently expanding, and the amount of errors and warnings.

Note:  The progress bar might give unreliable results when expaning Adobe Illustrator text,
or when running Dynamic VDP in Adobe Illustrator CS5.

Note:  The Adobe Illustrator document is automatically saved during expansion if Adobe
Illustrator text is used

If no errors were encountered during Expansion, the resulting PDF/VT file can be found in the selected
output folder

Note:  Do not use the "Preview" application on Mac to inspect PDF/VT file. To avoid problems
with visualizing variable text you should use Adobe Acrobat.

It is also possible to expand a job on a server. This workflow has some limitations (AI text is not
supported) but can be significantly faster. See Expanding on a server on page 359

11.5.2.  Preflight

Preflight allows a fast overview of all issues related to the job. No PDF/VT is generated, but list of all
found issues is provided.

1. Open a valid Dynamic VDP file in Adobe Illustrator. You might want to add Database Rules or Object
Rules to check during preflight. See Rules on page 352

2. Select Start Preflight... in the fly-out menu of the Dynamic VDP palette

During the output a progress bar is shown. You also get an indication of the total number of records,
the record currently expanding, and the amount of errors and warnings.

3. You will get a message indicating if errors were found during the preflight. Click OK
The Dynamic VDP Log palette will open, summarizing the found issues. See The Dynamic VDP Log
on page 357
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4. Double-click any of the issues to open the properties of the corresponding rule, to check the error.

11.5.3.  Rules

As the output of a dynamic VDP job often contains many thousand labels, it is not feasible to inspect
them manually. Problems in database such as missing entries, invalid entries, duplicates, ..., or
problems of VDP objects such as text too long, missing check digit for bar codes would not be noticed.

Rules were introduced to automatically check (and in some cases fix) errors in the database entries.

Database rules are optional, and check individual values or complete records from the database.
Database rules do not take into account where the fields are used, since e.g. the customer name could
be used both in a text or in a bar code. Using Database rules you can check if a value is empty, the
number of characters, what characters are used, duplicity, etc.

Object rules are set for individual VDP objects.

Different VDP objects can have different rules, for example a VDP Image can have a rule to check if
the image file can be loaded, while VDP text can have a rule related to the used fonts. As the content
of VDP text or barcode usually contains one or more database fields, the string related rules (empty
value, number of characters, allowed characters,..) are also available there. Note that for Object rules
the complete input string, consisting of several static and variable parts, is taken into account .

Some of the Object rules, such as checking for empty values, are optional. Other Object rules are
always active: the application always needs to know what to do in case of a missing image or using
non-existing glyphs in a font.

Rules are checked during expansion and during preflight, and any issues will be reported. If the severity
of a rule is set to "error", expansion will be stopped when the first violation of the rule is encountered,
while preflighting will continue and report all errors.

Database Rules
By applying Database Rules, you can discover possible issues which may appear during processing.

The Database file might contain entries that can cause problems to the design or contain invalid
values, such as entries that are too long, or duplicate records. Specifying some boundaries or allowed
values for database fields can help to identify possible problems.

You can set Global Rules, applied across all fields in the Database, or Field Rules, which are only
applied on the selected field.

Actions for a Database Rule

For every Rule you set, you can define what to do when the rule is violated:

• Error: the error is logged, and processing of the job is canceled

• Warning: a warning is issued, but processing will continue

• Replace: the original value is replaced by the defined replacement value, and processing will
continue without any warning.

• Warning and Replace: the original value is replaced by the defined replacement value, a warning is
issued, and processing will continue.
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Note:  The available actions depend on the selected rule

Global Rules

Global Rules are applied across all fields in the Database. You can set a Global Rule by clicking the
Global Rules... button in the Select Database dialog.

Duplicates found in records checks whether all records are unique. Two records are unique if all their
fields are identical. If at least single field is different the records are also different.

Duplicates found in subsequent records checks whether subsequent records are unique. Two
records are unique if all their fields are identical. If at least single field is different the records are also
different.

Field Rules

Field Rules are applied on a specific field in the Database. You can set a Field Rule by selecting a field,
and clicking the Set Rules... button in the Select Database dialog.

The Current result column will show the result of the individual rule(s) for the currently selected record.
At the bottom of the dialog, the Current value is shown, along with the overal result (error, warning) for
all defined rules.

There are two groups of Field rules: Size and Content

Size

• Select Empty value to check whether this field has any empty values. If you select Ignore
whitespace characters, spaces and other typographic symbols will be treated as empty values. By
choosing "Replace" or "Warning and Replace", you can set to replace the empty value by what you
enter in the by field.

• To check for values that may be too short, select Minimum length is, and enter a number of
characters. Values shorter than this will fail the check.

• To check for values that may be too long, select Maximum length is, and enter a number of
characters. Values longer than this will fail the check.
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Content

• Select Duplicates found in values to check if the selected field has the same value in two different
records in the database.

• Select Duplicates found in subsequent values to check if the selected field has the same value in
two subsequent database records.

• You can check whether the field's values match a certain regular expression. You can use this for
example for barcode values, serial numbers, or phone numbers.

• An example could be to use this regular expression:  \+\d[\s\d]*  to check phone numbers. This
means the value must start with a plus sign and a digit, followed by only digits or spaces.

• Use the Value can contain only list to limit the types of characters that are allowed in the field's
values .

• Latin characters (a-z and A-Z), either only Uppercase, only Lowercase or both ("Any")
• Digits
• Special symbols (for example + ! > $ &).
• Non latin characters (Ã¼ Ä›)

Checking a Database

Once some rules are defined, you can check the current Database file.

The Database file is checked automatically when running a Preflight or Expansion (including when
the expansion is done on a server, since the rules are included in the VDT template. See Expanding on
a server on page 359). The result of the check is shown in the DynamicVDP Log. See Checking and
expanding a VDP file on page 350 for more info on Preflight and Expansion.

However, by choosing Check Database... from the fly-out menu of the Dynamic VDP palette, you can
manually check the Database.

Note:  Check Database...  only does a quick check of the database. It does NOT expand
any Dynamic VDP objects, so a successful Database check does not guarantee successful
expanding. For that, you need to do a Preflight. See Preflight on page 351

Note:  The Check Database... option is not available if no Database file is selected yet, or if a
Simple Database is used.

The result of the database check is first reported by a message. In case some issues were detected the
DynamicVDP Log palette is opened.

Object Rules
Using Object Rules you can check the content or placement of specific Dynamic VDP objects.

To apply a Rule on an object, select the Dynamic VDP object, and click the Rules button in the Dynamic
VDP Properties palette.

Unlike database field rules, Object rules are not limited to a single database field, and they can check a
combination of several variables and static text strings.

As object rules are linked to concrete Dynamic VDP object, they can be more specific and check validity
like "is number 123456 a valid entry for EAN 13 barcode?" or "is john.jpg a valid image?"

354



11DeskPack Advanced

The available rules depend on the selected Dynamic VDP object.

Note:  Object rules are included in a VDT template, and will be examined during expansion on a
server. Expansion might be cancelled based on the selected action in the rule.

The Current result column will show the result of the individual rule(s) for the currently selected object.
At the bottom of the dialog, the Current value is shown, along with the overal result (error, warning) for
all defined rules.

For every Rule, the same actions as for a Database Rule are available. See Actions for a Database Rule
on page 352

Actions for an Object Rule

For every Rule you set, you can define what to do when the rule is violated:

• Error: the error is logged, and processing of the job is canceled
• Warning: a warning is issued, but processing will continue
• Skip: the specific Object is not generated, and processing will continue without any warning.
• Warning and Skip: the specific Object is not generated, a warning is issued, and processing will

continue.
• Replace: the original value is replaced by the defined replacement value, and processing will

continue without any warning.
• Warning and Replace: the original value is replaced by the defined replacement value, a warning is

issued, and processing will continue.

Note:  The available actions depend on the selected rule

Text Rules

Note:  Some of the available rules are the same as the Database Rules. However, the Object
Rules check the complete input, which can be the combination of one or more variables and
static parts.

Size
• Empty value, Minimum length and Maximum length are the same as the Database Field Rules. See

Size on page 353
• Select Object outside Trim Box to check if the object is placed inside the trim box area.
• The Safe Margin allows to define the threshold from the Trim Box.

• a positive value means a "safe margin" is kept on the inside of the Trim Box
• a negative value allows objects that are slightly outside of the Trim Box
• The Safe Margin uses the unit set in the Adobe Illustrator Document Settings

• Text Overset is only available for Area Text and Text on Path, and not for Point text. It checks if the
contained text can be fitted in to the given area or path.

• Text fitting is only available for Universal Area Text. Two aspects can be checked:

• Text fits into single line allows to check for unwanted line breaks, e.g. in an address, required to
stay on 3 lines.

• Text fits into text box is useful for bigger texts with long paragraphs. It will check if the last line
of the text is still within the text box.
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Text fitting rules can provide an error or a warning. By clicking the Fit text size ... you can also set
an automatic fix. There are two options:

• If Scale text horizontally is selected, the text will be condensed, without going below the
defined Minimum value for horizontal scale. The advantage of this method is that the font
maintains the same height, and the position of the individual lines is not changed. Small
horizontal scaling is also less visible for reader. This option is recommended in combination with
Text fits into single line. Notice that if the text was already condensed, it will not be condensed
below the specified threshold.

• Change font size. is applied after scaling (when both are active). You can specify the Minimum
font size. This option is recommended in combination with Text fits into text box. If different
parts of the text uses different fonts and font sizes, all used fonts are scalled down by the same
factor.

If you select Notify when text size is changed, you get an indication how many times and for what
records the font size was adjusted.

• Using When fitting the text is not possible you can decide what to do if the text is too big, even
after scaling and changing the font size: either generate a warning (and continue), or generate an
error (and stop expansion).

Content
All available rules are the same as the Database Field Rules. See Size on page 353

Fonts

Note:  The Fonts rules cannot be disabled.

• The All fonts are available rule checks whether all fonts used in the selected text objects are
available.

• The All Characters are available rule check whether all characters used in given text objects are
available in the font used.

Barcode Rules

• Select Code is available to check whether this field has any empty values. If you select Ignore
whitespace characters, spaces and other typographic symbols will be treated as empty values. By
choosing "Replace" or "Warning and Replace", you can set to replace the empty value by what you
enter in the by field.

• The Check digit is specified rule checks whether the barcode input contains a valid check digit.
Obviously, this is only available for barcodes that require a checkdigit (e.g. EAN13). If the check
digit is not defined and the rule is not active, the check digit is computed and added silently. If the
rule is active, it can be set to "warning" or "error": "error" will stop the expansion, while "warning" will
compute the check digit and generate a warning

Note:  If the check digit is specified but it is wrong, this will always result in an error (and
expanding will stop).

• Select Object outside Trim Box to check if the object is placed inside the trim box area.

• The Safe Margin allows to define the threshold from the Trim Box.

• a positive value means a "safe margin" is kept on the inside of the Trim Box
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• a negative value allows objects that are slightly outside of the Trim Box
• The Safe Margin uses the unit set in the Adobe Illustrator Document Settings

Image Rules

• The Image Is Available rule checks if the referenced image exists on the specified path

• The Image Type is Supported rule checks whether the referenced image can be imported and
applied

• Select Object outside Trim Box to check if the object is placed inside the trim box area.

• The Safe Margin allows to define the threshold from the Trim Box.

• a positive value means a "safe margin" is kept on the inside of the Trim Box
• a negative value allows objects that are slightly outside of the Trim Box
• The Safe Margin uses the unit set in the Adobe Illustrator Document Settings

11.5.4.  The Dynamic VDP Log

The Dynamic VDP Log palette lists issues generated by the Dynamic VDP plug-in.

It can open automatically after Expansion or Preflight, or can be opened by choosing Window > Esko >
Dynamic VDP > Dynamic VDP Log.

 

 

The table shows:

• an icon showing the severity of the issue

• the name of the Dynamic VDP object

• the number of the record where the issue was detected.

• the message indicating the actual issue

You can select an entry in the palette and click Show or double-click the entry to preview the issue.

Note:  Rule settings are opened when showing or double-clicking database issues.

From the fly-out menu of the Dynamic VDP Log palette, you can

• apply a Filter on the log entries. See Filter on page 358
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• select Remove Filter to remove the currently applied filter
• Clear Issues: all issues listed in the palette are removed
• Save Report: an HTML report containing all currently listed issues is saved. This can be used e.g. to

submit to the database provider, requesting to solve all listed issues.

Filter
1. In the Dynamic VDP Log palette, choose Filter ... from the fly-out menu.

The Select Filter dialog will open

2. Set the first condition for log entries to be shown

Options Description

Severity show the log entries of which the Severity is or
is not

• Error
• Warning
• Database Issue
• Database Error
• Database Warning
• Object Issue
• Object Error
• Object Warning

Object Name show the log entries of which the Object Name
does or does not contain the string entered

Record shows the log entries of which the Record does
or does not contain the string entered

Message shows the log entries of which the Message
does or does not contain the string entered

3. By default, Condition 2 is set to Disabled. If you want to filter based on a combination of two
conditions, you can set the relation for Condition 2. This defines whether log entries should be
shown if they match both conditions (and) or any of the conditions (or).
a) Select and if log entries should be shown if they match both conditions
b) Select or if log entries should be shown if they match (at least) one of the conditions
c) Set up Condition 2 the same way you set up Condition 1
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4. Click OK to apply the filter

You can see a filter is applied as the bottom line in the Dynamic VDP Log dialog will no longer show the
total number of errors and warnings found, but also the amount of errors and warnings shown from the
total amount, e.g. "Filtered 771 of 771 errors and 0 of 898 warnings".

By choosing Filter ... from the fly-out menu again, you can modify the filter.

By choosing Remove Filter from the fly-out menu, you can remove the curently applied filter.

11.5.5.  Record Sets

By default, the Dynamic VDP uses all records from the selected database file or simple databsae.
However, using the Record Set functionality, you can limit Dynamic VDP to only use a restricted set of
records. This can be used to get quick access to records which might require attention.

The Record Set dropdown is available in the Select Database palette, and in the Dynamic VDP palette.

By default, this is set to All Records.

After a Database Check, you can limit the set to Records with database problems. See for more
information on database check

After a Preflight or Expand, you can limit the set to

• Records with database problems, since preflighting and expansion always includes a database
check

• Records with preflight errors and warnings
• Records with preflight warnings
• Records with preflight errors

See Checking and expanding a VDP file on page 350 for more information on Expansion and Preflight.

After using the function, you can also limit the set to Suspicious Records.

The Create Suspicious Record Set function, available from the fly-out menu of the Dynamic VDP
palette, creates a set of records that might require attention. It will contain:

• the longest string for every column
• the shortest string for every column
• the longest value among all columns
• the shortest value among all columns
• the longest record
• the shortest record

11.5.6.  Expanding on a server

The Dynamic VDP plug-in can export a Variable Data Template to be sent to and processed by a server

The template is generated by the Dynamic VDP plug-in. It allows to expand a job on a server which
provides faster processing thru parallel expansion.

The Variable Data Template contains all the graphical elements. The Database file and variable images
(if any) are not included.
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Exporting a Variable Data Template
To export a Variable Data Template:

1. Use Adobe Illustrator and the Dynamic VDP plug-in to create a Variable Data job
2. Define Rules and their severity. Rules are checked on the server, when the Database file and the

Variable Data job are combined. See Rules on page 352 for more info on Rules.
3. Choose Export Template... in the fly-out menu of the Dynamic VDP palette.
4. Select the output folder, and click OK

A Variable Data Template file (.VDT) will be generated.

Note:  It is not possible to import a Variable Data Template back into Illustrator. It is highly
recommended to keep the native Adobe Illustrator files for future modifications in the
templates.

Creating a VDP job from a Variable Data Template
To create a VDP job from a Variable Data Template file:

1. Start the DFE Client
2. Choose File > New Print Job...
3. Click Browse..., select the VDT file, and click OK
4. Define the Step and Repeat parameers in the automatically opened dialog, and close the dialog to

create the Print Job
5. Open the Print Job Properties
6. In the Files tab, define the database

Note:  A Simple Database must be defined in this dialog as well

7. Set the path to the variable images (if applicable)

Note:  The folder containing the images should be located in the prepress share of the
DFE

8. In the Step & Repeat tab, modify the variable data filling if needed.

The job is now ready to be processed.

11.6.  Tips and limitations

11.6.1.  Illustrator File Compatibility

Illustrator files containing Dynamic VDP settings are backward compatible, so you can open files
generated by older versions while preserving Dynamic VDP settings and editability of variable objects.
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However, when you are trying to open a file generated by newer version of Adobe Illustrator, you get a
message stating you can import the file, but some data loss might occur. If you continue the import, all
variable objects will be converted to static objects, and all properties will be lost

Saving files to be compatible with older versions of Illustrator
In Adobe Illustrator you can save the file in legacy file formats, by setting the Version while doing a
Save as to Adobe Illustrator format. Files saved using this procedure will handle dynamic objects
properly.

Note:  Although this procedure will preserve Dynamic VDP objects, other Illustrator version
specific objects still might be modified or lost.

11.6.2.  PowerLayout Client Import Assistant

To convert multiple XML files to Adobe Illustrator files and SRT templates:

1. Start Adobe Illustrator with the Dynamic VDP plug-in installed.
2. Make sure that no document is opened.
3. Open the PowerLayout Standalone palette.
4. Go to its contextual menu and choose PowerLayout Client Import Assistant.
5. Follow the on-screen information to convert multiple XML files to AI files and SRT templates.

Note:  Do not work with more than 100 XML files at once in order to avoid having Illustrator
crash.

Note:

• PowerLayout Client Import Assistant should work with batches of up to 100 XML files.
• PowerLayout Client Import Assistant progress is not reported properly: Illustrator can go to

a "not responding" state while the conversion is still running. In this case, it is recommended
to check the output folder, where new AI or SRT files should appear.

11.6.3.  Known limitations

Expansion: Maximum number of records
The biggest issue for expansion is the memory used by Adobe Illustrator. Since memory usage is
influenced by variable elements (barcodes requires more memory than universal text) and complexity
of fixed part of the job, it is not really possible to define a fixed maximum number of records that can
be expanded from the Illustrator.

When using Adobe Illustrator Dynamic Text (see  Dynamic Text  on page 340) is limited to 10.000
records.

A Job using Universal Text can go further, up to 50 000. The actual limit depends on the used file.

It is highly recommended to expand jobs with images or high volume or records using a 64-bit version
of Adobe Illustrator and sucient amount of RAM (e.g. 8 GB or more).
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Text formatting
Adobe Illustrator text is generated by the Adobe Illustrator text engine, while universal text is created
by Esko text engine.

Although those two text engine behaves almost identical in basic features (e.g. font face, size, color),
some differences may occur in advanced text features like line spacing, tracking, kerning, etc.

The preview shown in Adobe Illustrator uses the correct text engine, so it reflects the behavior of
expansion. Every unwanted behavior will be immediately visible to user. In some cases a warning
message is issued.

Note:  When a text object is being edited by the Text Editing tool of Adobe Illustrator, the text
is shown in "Edit View". When in Edit View, the text will be rendered by the Adobe Illustrator
text engine. This means that when starting or ending editing Universal Text, small differences
might occur.

Resizing and rotating Dynamic VDP objects
In some cases, you can resize Dynamic VDP objects using Adobe Illustrator tools. However, in some
cases (e.g. resizing area text by dragging), Adobe Illustrator behaves differently when working with
native Adobe Illustrator objects or with Dynamic VDP objects.

To avoid this, it is recommended to change dimensions and rotation of Dynamic VDP objects using its
properties panel.

Clipping masks
Adobe Illustrator allows to define clipping masks on objects. However, Expansion will ignore clipping
masks on Dynamic VDP objects.

11.6.4.  Performance tips

• Text : it is highly recommended to use Universal Text instead of Illustrator Text. Processing of
Universal Text is much faster when expanding using Illustrator or server.

• Document Structure: If possible, put all variable objects on a separate, top-most layer. Although
the Expand function can process job where static objects are placed on top of variable ones, this
will cost some time.

• Transparency: Any kind of transparency, opacity or PostScript overprint applied to a variable object
will slow down Ripping. If possible, it is recommended to keep variable objects opaque (which is the
default settings in Adobe Illustrator)

• Barcodes: Some barcodes, e.g. QR barcodes, allow to set a "correction level". This improves the
readability when the barcode is damaged, but it requires more time to compute and create such
barcode.

It is recommended to keep such settings on default values.
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12.  Image Extractor

12.1.  Copyright Notice
© Copyright 2022 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are the
property of Esko Software BV. The material, information and instructions are provided on an AS IS
basis without warranty of any kind. There are no warranties granted or extended by this document.
Furthermore Esko Software BV does not warrant, guarantee or make any representations regarding
the use, or the results of the use of the software or the information contained herein. Esko Software
BV shall not be liable for any direct, indirect, consequential or incidental damages arising out of the use
or inability to use the software or the information contained herein.

The information contained herein is subject to change without notice. Revisions may be issued from
time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system, or published, in
any form or in any way, electronically, mechanically, by print, photoprint, microfilm or any other means
without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®

 Colors displayed in the software application or in the user documentation may not match
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color.
PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to distribute
for use only in combination with Studio Visualizer. PANTONE Color Data and/or Software shall not be
copied onto another disk or into memory unless as part of the execution of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org). All
rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk Media
Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP are
Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric Young
(eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign, PDF,
Photoshop, PostScript, XMP and the Powered by XMP logo are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the United
States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are registered
trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark Oce.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by GlobalVision. ArtProof and ScanProof are registered
trademarks of GlobalVision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Raymonde de Larochelaan 13

B – 9051 Gent

info.eur@esko.com

12.1.1.  Third party license information

This product includes curl.

      COPYRIGHT AND PERMISSION NOTICE

      Copyright (c) 1996 - 2020, Daniel Stenberg, <daniel@haxx.se>, and many
      contributors, see the THANKS file.

      All rights reserved.

      Permission to use, copy, modify, and distribute this software for any purpose
      with or without fee is hereby granted, provided that the above copyright
      notice and this permission notice appear in all copies.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
      FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN
      NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM,
      DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
      OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
      OR OTHER DEALINGS IN THE SOFTWARE.

      Except as contained in this notice, the name of a copyright holder shall not
      be used in advertising or otherwise to promote the sale, use or other dealings
      in this Software without prior written authorization of the copyright holder.
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------------------------------------------------------------

This product includes lzw-ab.

    Copyright (c) David Bryant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of Conifer Software nor the names of its contributors
      may be used to endorse or promote products derived from this software
      without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
    AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
    ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
    SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
    CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
    OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
    OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenJPEG.

        The copyright in this software is being made available under the 2-clauses
        BSD License, included below. This software may be subject to other third
        party and contributor rights, including patent rights, and no such rights
        are granted under this license.
       
        Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
        Copyright (c) 2002-2014, Professor Benoit Macq
        Copyright (c) 2003-2014, Antonin Descampe
        Copyright (c) 2003-2009, Francois-Olivier Devaux
        Copyright (c) 2005, Herve Drolon, FreeImage Team
        Copyright (c) 2002-2003, Yannick Verschueren
        Copyright (c) 2001-2003, David Janssens
        Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France
        Copyright (c) 2012, CS Systemes d'Information, France
       
        All rights reserved.
       
        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions
        are met:
        1. Redistributions of source code must retain the above copyright
           notice, this list of conditions and the following disclaimer.
        2. Redistributions in binary form must reproduce the above copyright
           notice, this list of conditions and the following disclaimer in the
           documentation and/or other materials provided with the distribution.
       
        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
        AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
        IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
        ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
        LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
        CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
        SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
        INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
        CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
        ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
        POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FreeType.

    Portions of this software are copyright (C) 2014 The FreeType
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    Project (www.freetype.org) licensed under the Freetype License.
    All rights reserved.
    
------------------------------------------------------------

This product includes QtCopyDialog.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).
      All rights reserved.

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes QtMigration.

        Copyright (C) 2013 Digia Plc and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Digia Plc and its Subsidiary(-ies) nor the names
            of its contributors may be used to endorse or promote products derived
            from this software without specific prior written permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE."
    
------------------------------------------------------------

This product includes QtService.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies).

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
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        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes QtSingleApplication.

        Copyright (C) 2010 Nokia Corporation and/or its subsidiary(-ies). All rights
 reserved.

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:
          * Redistributions of source code must retain the above copyright
            notice, this list of conditions and the following disclaimer.
          * Redistributions in binary form must reproduce the above copyright
            notice, this list of conditions and the following disclaimer in
            the documentation and/or other materials provided with the
            distribution.
          * Neither the name of Nokia Corporation and its Subsidiary(-ies) nor
            the names of its contributors may be used to endorse or promote
            products derived from this software without specific prior written
            permission.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

    
------------------------------------------------------------

This product includes QtSql.

      Copyright (c) 2009 Nokia Corporation and/or its subsidiary(-ies).

      BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO
      WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
      EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR
      OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY
      KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE
      LIBRARY IS WITH YOU.  SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME
      THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
    
------------------------------------------------------------

This product includes svgio.

 Copyright Oleg Maximenko 2014.
 Distributed under the Boost Software License, Version 1.0.
    
------------------------------------------------------------

This product includes QtSvg.

      The Qt Toolkit is Copyright (C) 2019 The Qt Company Ltd.
    
------------------------------------------------------------

This product includes appleseed.
The MIT License (MIT)

Copyright (c) 2010-2013 Francois Beaune, Jupiter Jazz Limited
Copyright (c) 2014-2019 The appleseedhq Organization
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Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in
all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
THE SOFTWARE.
    
------------------------------------------------------------

This product includes bcd.
        
    Copyright (c) 2017 Malik Boughida and Tamy Boubekeur. All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its contributors
   may be used to endorse or promote products derived from this software
   without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You are under no obligation whatsoever to provide any bug fixes, patches, or
upgrades to the features, functionality or performance of the source code
("Enhancements") to anyone; however, if you choose to make your Enhancements
available either publicly, or directly to the authors of this software, without
imposing a separate written license agreement for such Enhancements, then you
hereby grant the following license: a non-exclusive, royalty-free perpetual
license to install, use, modify, prepare derivative works, incorporate into
other computer software, distribute, and sublicense such enhancements or
derivative works thereof, in binary and source code form.
    
------------------------------------------------------------

This product includes glad.

        The MIT License (MIT)

Copyright (c) 2013-2018 David Herberth

Permission is hereby granted, free of charge, to any person obtaining a copy of
this software and associated documentation files (the "Software"), to deal in
the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so,
subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes murmurhash3.
MurmurHash3 was written by Austin Appleby, and is placed in the public domain. The author
 hereby disclaims copyright to this source code.
------------------------------------------------------------

This product includes zlib.

 (C) 1995-2022 Jean-loup Gailly and Mark Adler

  This software is provided 'as-is', without any express or implied
  warranty.  In no event will the authors be held liable for any damages
  arising from the use of this software.

  Permission is granted to anyone to use this software for any purpose,
  including commercial applications, and to alter it and redistribute it
  freely, subject to the following restrictions:

  1. The origin of this software must not be misrepresented; you must not
     claim that you wrote the original software. If you use this software
     in a product, an acknowledgment in the product documentation would be
     appreciated but is not required.
  2. Altered source versions must be plainly marked as such, and must not be
     misrepresented as being the original software.
  3. This notice may not be removed or altered from any source distribution.

  Jean-loup Gailly        Mark Adler
  jloup@gzip.org          madler@alumni.caltech.edu
    
------------------------------------------------------------

This product includes Botan.

      Copyright (C) 1999-2020 The Botan Authors
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions are met:

      1. Redistributions of source code must retain the above copyright notice,
        this list of conditions, and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions, and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
      AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE
      LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
      CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
      SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
      INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
      CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
      POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes patented technology.

      This product and use of this product is under license from Markzware
      under U.S. Patent No. 5,963,641.
    
------------------------------------------------------------

This product includes pugixml.
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      MIT License

      Copyright (c) 2006-2019 Arseny Kapoulkine

      Permission is hereby granted, free of charge, to any person
      obtaining a copy of this software and associated documentation
      files (the "Software"), to deal in the Software without
      restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the
      Software is furnished to do so, subject to the following
      conditions:

      The above copyright notice and this permission notice shall be
      included in all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
      EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
      OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
      NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT
      HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
      WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING
      FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR
      OTHER DEALINGS IN THE SOFTWARE.
    
------------------------------------------------------------

This product includes GLEW: The OpenGL Extension Wrangler Library.

The OpenGL Extension Wrangler Library
Copyright (C) 2002-2007, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2007, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.

Redistribution and use in source and binary forms, with or without 
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, 
  this list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, 
  this list of conditions and the following disclaimer in the documentation 
  and/or other materials provided with the distribution.
* The name of the author may be used to endorse or promote products 
  derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Mesa 3-D graphics library
Version:  7.0

Copyright (C) 1999-2007  Brian Paul   All Rights Reserved.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and associated documentation files (the "Software"),
to deal in the Software without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the
Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL
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BRIAN PAUL BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN
AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Copyright (c) 2007 The Khronos Group Inc.

Permission is hereby granted, free of charge, to any person obtaining a
copy of this software and/or associated documentation files (the
"Materials"), to deal in the Materials without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Materials, and to
permit persons to whom the Materials are furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Materials.

THE MATERIALS ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
MATERIALS OR THE USE OR OTHER DEALINGS IN THE MATERIALS.
  
------------------------------------------------------------

This product includes JPEGLib.
This software is copyright (C) 1991-2016, Thomas G. Lane, Guido Vollbeding.
      All Rights Reserved.
      
      This software is based in part on the work of the Independent JPEG Group.
------------------------------------------------------------

This product includes tesseract.

  Copyright (C) 2016 Google, Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes robin-map.

    MIT License

    Copyright (c) 2017 Tessil

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in all
    copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
    SOFTWARE. 
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
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      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes cereal.

    Copyright (c) 2013-2022, Randolph Voorhies, Shane Grant
    All rights reserved.

    Redistribution and use in source and binary forms, with or without
    modification, are permitted provided that the following conditions are met:
        * Redistributions of source code must retain the above copyright
          notice, this list of conditions and the following disclaimer.
        * Redistributions in binary form must reproduce the above copyright
          notice, this list of conditions and the following disclaimer in the
          documentation and/or other materials provided with the distribution.
        * Neither the name of the copyright holder nor the
          names of its contributors may be used to endorse or promote products
          derived from this software without specific prior written permission.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY
    DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
    ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes libxml2.

    Copyright (C) 1998-2012 Daniel Veillard.  All Rights Reserved.

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is fur-
    nished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
    NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes gSOAP.

      EXHIBIT B.
      
      Part of the software embedded in this product is gSOAP software.
      Portions created by gSOAP are Copyright (C) 2001-2007 Robert A. van Engelen,
 Genivia inc. All Rights Reserved.
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      THE SOFTWARE IN THIS PRODUCT WAS IN PART PROVIDED BY GENIVIA INC AND ANY EXPRESS
 OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
 MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
 THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
 ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
 ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes LibTIFF.

      Copyright (c) 1988-1997 Sam Leffler
      Copyright (c) 1991-1997 Silicon Graphics, Inc.

      Permission to use, copy, modify, distribute, and sell this software and
      its documentation for any purpose is hereby granted without fee, provided
      that (i) the above copyright notices and this permission notice appear in
      all copies of the software and related documentation, and (ii) the names of
      Sam Leffler and Silicon Graphics may not be used in any advertising or
      publicity relating to the software without the specific, prior written
      permission of Sam Leffler and Silicon Graphics.

      THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND,
      EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY
      WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

      IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
      ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
      OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
      WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF
      LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
      OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes llvm.

      University of Illinois/NCSA
      Open Source License

      Copyright (c) 2003-2019 University of Illinois at Urbana-Champaign.
      All rights reserved.

      Developed by:

          LLVM Team

          University of Illinois at Urbana-Champaign

          http://llvm.org

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal with
      the Software without restriction, including without limitation the rights to
      use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
      of the Software, and to permit persons to whom the Software is furnished to do
      so, subject to the following conditions:

          * Redistributions of source code must retain the above copyright notice,
            this list of conditions and the following disclaimers.

          * Redistributions in binary form must reproduce the above copyright notice,
            this list of conditions and the following disclaimers in the
            documentation and/or other materials provided with the distribution.

          * Neither the names of the LLVM Team, University of Illinois at
            Urbana-Champaign, nor the names of its contributors may be used to
            endorse or promote products derived from this Software without specific
            prior written permission.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      CONTRIBUTORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
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      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS WITH THE
      SOFTWARE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (c) 1998-2017 The OpenSSL Project.  All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:

      1. Redistributions of source code must retain the above copyright
         notice, this list of conditions and the following disclaimer.

      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in
         the documentation and/or other materials provided with the
         distribution.

      3. All advertising materials mentioning features or use of this
         software must display the following acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

      4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
         endorse or promote products derived from this software without
         prior written permission. For written permission, please contact
         openssl-core@openssl.org.

      5. Products derived from this software may not be called "OpenSSL"
         nor may "OpenSSL" appear in their names without prior written
         permission of the OpenSSL Project.

      6. Redistributions of any form whatsoever must retain the following
         acknowledgment:
         "This product includes software developed by the OpenSSL Project
         for use in the OpenSSL Toolkit (http://www.openssl.org/)"

      THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
      EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
      PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
      ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
      SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
      NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
      LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
      STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
      ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
      OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes OpenSSL.

      Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
      All rights reserved.

      Redistribution and use in source and binary forms, with or without
      modification, are permitted provided that the following conditions
      are met:
      1. Redistributions of source code must retain the copyright
         notice, this list of conditions and the following disclaimer.
      2. Redistributions in binary form must reproduce the above copyright
         notice, this list of conditions and the following disclaimer in the
         documentation and/or other materials provided with the distribution.
      3. All advertising materials mentioning features or use of this software
         must display the following acknowledgement:
         "This product includes cryptographic software written by
         Eric Young (eay@cryptsoft.com)"
         The word 'cryptographic' can be left out if the rouines from the library
         being used are not cryptographic related :-).
      4. If you include any Windows specific code (or a derivative thereof) from
         the apps directory (application code) you must include an acknowledgement:
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         "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

      THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
      ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
      IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
      ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
      FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
      DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
      OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
      HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
      OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
      SUCH DAMAGE.
    
------------------------------------------------------------

This product includes xxHash.

    xxHash Library
    Copyright (c) 2012-2014, Yann Collet
    All rights reserved.

    Redistribution and use in source and binary forms, with or without modification,
    are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright notice, this
    list of conditions and the following disclaimer.

    * Redistributions in binary form must reproduce the above copyright notice, this
    list of conditions and the following disclaimer in the documentation and/or
    other materials provided with the distribution.

    THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND
    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
    WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
    DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR
    ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
    (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
    LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
    ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
    (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
    SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
  
------------------------------------------------------------

This product includes lz4.

        Copyright (C) 2011-present, Yann Collet.

        BSD 2-Clause License (http://www.opensource.org/licenses/bsd-license.php)

        Redistribution and use in source and binary forms, with or without
        modification, are permitted provided that the following conditions are
        met:

            * Redistributions of source code must retain the above copyright
        notice, this list of conditions and the following disclaimer.
            * Redistributions in binary form must reproduce the above
        copyright notice, this list of conditions and the following disclaimer
        in the documentation and/or other materials provided with the
        distribution.

        THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
        "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
        LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
        A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
        OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
        SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
        LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
        DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
        THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
        (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
        OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes ICU.
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      Copyright (c) 1995-2014 International Business Machines Corporation and others
      All rights reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy of
      this software and associated documentation files (the "Software"), to deal in the
      Software without restriction, including without limitation the rights to use,
      copy, modify, merge, publish, distribute, and/or sell copies of the Software, and
      to permit persons to whom the Software is furnished to do so, provided that the
      above copyright notice(s) and this permission notice appear in all copies of the
      Software and that both the above copyright notice(s) and this permission notice
      appear in supporting documentation.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
      FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
      SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
      CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
      WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF
      CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
      WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
    
------------------------------------------------------------

This product includes XByak.
   
Copyright (c) 2007 MITSUNARI Shigeo
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.
Neither the name of the copyright owner nor the names of its contributors may
be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.
-----------------------------------------------------------------------------
#######################################
#######################

#######################################
#######
#######################################
##########################
#######################################
###################################
#######################################
#######################################
######################################
########################### ###########
#######################################
######################################
######################################
#######################################
######################################
################
    
------------------------------------------------------------

This product includes ittnotify.
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Copyright (c) 2011, Intel Corporation
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes JBIG2Lib.

    Portions of this product copyrights (C) 2002 Glyph & Cog, LLC.
    
------------------------------------------------------------

This product includes PCRE.

  Copyright (c) 1997-2016 University of Cambridge
  All rights reserved.

  Copyright(c) 2010-2016 Zoltan Herczeg
  All rights reserved.

  Copyright(c) 2009-2016 Zoltan Herczeg
  All rights reserved.

  Redistribution and use in source and binary forms, with or without
  modification, are permitted provided that the following conditions are met:

      * Redistributions of source code must retain the above copyright notice,
        this list of conditions and the following disclaimer.

      * Redistributions in binary form must reproduce the above copyright
        notice, this list of conditions and the following disclaimer in the
        documentation and/or other materials provided with the distribution.

      * Neither the name of the University of Cambridge nor the names of any
        contributors may be used to endorse or promote products derived from this
        software without specific prior written permission.

  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
  AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
  IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
  ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
  LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
  CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
  SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
  INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
  CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
  ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
  POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Little CMS.
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    Little CMS
    Copyright (c) 1998-2011 Marti Maria Saguer

    Permission is hereby granted, free of charge, to any person obtaining a copy
    of this software and associated documentation files (the "Software"), to deal
    in the Software without restriction, including without limitation the rights
    to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
    copies of the Software, and to permit persons to whom the Software is
    furnished to do so, subject to the following conditions:

    The above copyright notice and this permission notice shall be included in
    all copies or substantial portions of the Software.

    THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
    IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
    FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
    AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
    LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
    OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
    THE SOFTWARE.
    
------------------------------------------------------------

This product includes XercesC.

    NOTICE file corresponding to section 4(d) of the Apache License, Version 2.0, in this
 case for the Apache Xerces distribution.

    This product includes software developed by
    The Apache Software Foundation (http://www.apache.org/).

    Portions of this software were originally based on the following:
     - software copyright (c) 1999, IBM Corporation., http://www.ibm.com.
    
------------------------------------------------------------

This product includes OpenShadingLanguage.

BSD 3-Clause License

Copyright (c) 2009-2019 Sony Pictures Imageworks Inc., et al.
All Rights Reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this
   list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice,
   this list of conditions and the following disclaimer in the documentation
   and/or other materials provided with the distribution.

3. Neither the name of the copyright holder nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes leptonica.

 -  Copyright (C) 2001-2016 Leptonica.  All rights reserved.
 -
 -  Redistribution and use in source and binary forms, with or without
 -  modification, are permitted provided that the following conditions
 -  are met:
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 -  1. Redistributions of source code must retain the above copyright
 -     notice, this list of conditions and the following disclaimer.
 -  2. Redistributions in binary form must reproduce the above
 -     copyright notice, this list of conditions and the following
 -     disclaimer in the documentation and/or other materials
 -     provided with the distribution.
 -
 -  THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 -  ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 -  LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 -  A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL ANY
 -  CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
 -  EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 -  PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
 -  PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
 -  OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
 -  NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
 -  SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes FCollada.

      Copyright 2006 Feeling Software. All rights reserved.

      Copyright 2005-2006 Feeling Software and
      Copyright 2005-2006 Autodesk Media Entertainment.

      Copyright (C) 1998-2003 Daniel Veillard. All Rights Reserved.

      Permission is hereby granted, free of charge, to any person obtaining a copy
      of this software and associated documentation files (the "Software"), to deal
      in the Software without restriction, including without limitation the rights
      to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
      copies of the Software, and to permit persons to whom the Software is fur-
      nished to do so, subject to the following conditions:

      The above copyright notice and this permission notice shall be included in
      all copies or substantial portions of the Software.

      THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
      IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FIT-
      NESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE
      AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
      LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
      OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN
      THE SOFTWARE.
    
------------------------------------------------------------

This product includes OpenImageIO.
    
        BSD 3-Clause License

Copyright (c) 2008-present by Contributors to the OpenImageIO project. All Rights
 Reserved.

Redistribution and use in source and binary forms, with or without modification, are
 permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
 conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
 conditions and the following disclaimer in the documentation and/or other materials
 provided with the distribution.

Neither the name of the copyright holder nor the names of its contributors may be used to
 endorse or promote products derived from this software without specific prior written
 permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
 OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
 SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
 INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
 PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
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 INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------------------

This product includes OpenJDK.
 
The GNU General Public License (GPL)

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA

Everyone is permitted to copy and distribute verbatim copies of this license
document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share
and change it.  By contrast, the GNU General Public License is intended to
guarantee your freedom to share and change free software--to make sure the
software is free for all its users.  This General Public License applies to
most of the Free Software Foundation's software and to any other program whose
authors commit to using it.  (Some other Free Software Foundation software is
covered by the GNU Library General Public License instead.) You can apply it to
your programs, too.

When we speak of free software, we are referring to freedom, not price.  Our
General Public Licenses are designed to make sure that you have the freedom to
distribute copies of free software (and charge for this service if you wish),
that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you
can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny
you these rights or to ask you to surrender the rights.  These restrictions
translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for
a fee, you must give the recipients all the rights that you have.  You must
make sure that they, too, receive or can get the source code.  And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2)
offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author's protection and ours, we want to make certain that
everyone understands that there is no warranty for this free software.  If the
software is modified by someone else and passed on, we want its recipients to
know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents.  We
wish to avoid the danger that redistributors of a free program will
individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification
follow.

TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice
placed by the copyright holder saying it may be distributed under the terms of
this General Public License.  The "Program", below, refers to any such program
or work, and a "work based on the Program" means either the Program or any
derivative work under copyright law: that is to say, a work containing the
Program or a portion of it, either verbatim or with modifications and/or
translated into another language.  (Hereinafter, translation is included
without limitation in the term "modification".) Each licensee is addressed as
"you".
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Activities other than copying, distribution and modification are not covered by
this License; they are outside its scope.  The act of running the Program is
not restricted, and the output from the Program is covered only if its contents
constitute a work based on the Program (independent of having been made by
running the Program).  Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as
you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and
disclaimer of warranty; keep intact all the notices that refer to this License
and to the absence of any warranty; and give any other recipients of the
Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may
at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus
forming a work based on the Program, and copy and distribute such modifications
or work under the terms of Section 1 above, provided that you also meet all of
these conditions:

    a) You must cause the modified files to carry prominent notices stating
    that you changed the files and the date of any change.

    b) You must cause any work that you distribute or publish, that in whole or
    in part contains or is derived from the Program or any part thereof, to be
    licensed as a whole at no charge to all third parties under the terms of
    this License.

    c) If the modified program normally reads commands interactively when run,
    you must cause it, when started running for such interactive use in the
    most ordinary way, to print or display an announcement including an
    appropriate copyright notice and a notice that there is no warranty (or
    else, saying that you provide a warranty) and that users may redistribute
    the program under these conditions, and telling the user how to view a copy
    of this License.  (Exception: if the Program itself is interactive but does
    not normally print such an announcement, your work based on the Program is
    not required to print an announcement.)

These requirements apply to the modified work as a whole.  If identifiable
sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and
its terms, do not apply to those sections when you distribute them as separate
works.  But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the whole must be on the terms
of this License, whose permissions for other licensees extend to the entire
whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your
rights to work written entirely by you; rather, the intent is to exercise the
right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the
Program (or with a work based on the Program) on a volume of a storage or
distribution medium does not bring the other work under the scope of this
License.

3. You may copy and distribute the Program (or a work based on it, under
Section 2) in object code or executable form under the terms of Sections 1 and
2 above provided that you also do one of the following:

    a) Accompany it with the complete corresponding machine-readable source
    code, which must be distributed under the terms of Sections 1 and 2 above
    on a medium customarily used for software interchange; or,

    b) Accompany it with a written offer, valid for at least three years, to
    give any third party, for a charge no more than your cost of physically
    performing source distribution, a complete machine-readable copy of the
    corresponding source code, to be distributed under the terms of Sections 1
    and 2 above on a medium customarily used for software interchange; or,

    c) Accompany it with the information you received as to the offer to
    distribute corresponding source code.  (This alternative is allowed only
    for noncommercial distribution and only if you received the program in
    object code or executable form with such an offer, in accord with
    Subsection b above.)
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The source code for a work means the preferred form of the work for making
modifications to it.  For an executable work, complete source code means all
the source code for all modules it contains, plus any associated interface
definition files, plus the scripts used to control compilation and installation
of the executable.  However, as a special exception, the source code
distributed need not include anything that is normally distributed (in either
source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy
from a designated place, then offering equivalent access to copy the source
code from the same place counts as distribution of the source code, even though
third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as
expressly provided under this License.  Any attempt otherwise to copy, modify,
sublicense or distribute the Program is void, and will automatically terminate
your rights under this License.  However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so
long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it.
However, nothing else grants you permission to modify or distribute the Program
or its derivative works.  These actions are prohibited by law if you do not
accept this License.  Therefore, by modifying or distributing the Program (or
any work based on the Program), you indicate your acceptance of this License to
do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program),
the recipient automatically receives a license from the original licensor to
copy, distribute or modify the Program subject to these terms and conditions.
You may not impose any further restrictions on the recipients' exercise of the
rights granted herein.  You are not responsible for enforcing compliance by
third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues), conditions
are imposed on you (whether by court order, agreement or otherwise) that
contradict the conditions of this License, they do not excuse you from the
conditions of this License.  If you cannot distribute so as to satisfy
simultaneously your obligations under this License and any other pertinent
obligations, then as a consequence you may not distribute the Program at all.
For example, if a patent license would not permit royalty-free redistribution
of the Program by all those who receive copies directly or indirectly through
you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any
particular circumstance, the balance of the section is intended to apply and
the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or
other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software
distribution system, which is implemented by public license practices.  Many
people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to
distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a
consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain
countries either by patents or by copyrighted interfaces, the original
copyright holder who places the Program under this License may add an explicit
geographical distribution limitation excluding those countries, so that
distribution is permitted only in or among countries not thus excluded.  In
such case, this License incorporates the limitation as if written in the body
of this License.

9. The Free Software Foundation may publish revised and/or new versions of the
General Public License from time to time.  Such new versions will be similar in
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spirit to the present version, but may differ in detail to address new problems
or concerns.

Each version is given a distinguishing version number.  If the Program
specifies a version number of this License which applies to it and "any later
version", you have the option of following the terms and conditions either of
that version or of any later version published by the Free Software Foundation.
If the Program does not specify a version number of this License, you may
choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs
whose distribution conditions are different, write to the author to ask for
permission.  For software which is copyrighted by the Free Software Foundation,
write to the Free Software Foundation; we sometimes make exceptions for this.
Our decision will be guided by the two goals of preserving the free status of
all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN OTHERWISE
STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs

If you develop a new program, and you want it to be of the greatest possible
use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program.  It is safest to attach
them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the "copyright" line and a
pointer to where the full notice is found.

    One line to give the program's name and a brief idea of what it does.

    Copyright (C) <year> <name of author>

    This program is free software; you can redistribute it and/or modify it
    under the terms of the GNU General Public License as published by the Free
    Software Foundation; either version 2 of the License, or (at your option)
    any later version.

    This program is distributed in the hope that it will be useful, but WITHOUT
    ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or
    FITNESS FOR A PARTICULAR PURPOSE.  See the GNU General Public License for
    more details.

    You should have received a copy of the GNU General Public License along
    with this program; if not, write to the Free Software Foundation, Inc.,
    51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it
starts in an interactive mode:

    Gnomovision version 69, Copyright (C) year name of author Gnomovision comes
    with ABSOLUTELY NO WARRANTY; for details type 'show w'.  This is free
    software, and you are welcome to redistribute it under certain conditions;
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    type 'show c' for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate
parts of the General Public License.  Of course, the commands you use may be
called something other than 'show w' and 'show c'; they could even be
mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school,
if any, to sign a "copyright disclaimer" for the program, if necessary.  Here
is a sample; alter the names:

    Yoyodyne, Inc., hereby disclaims all copyright interest in the program
    'Gnomovision' (which makes passes at compilers) written by James Hacker.

    signature of Ty Coon, 1 April 1989

    Ty Coon, President of Vice

This General Public License does not permit incorporating your program into
proprietary programs.  If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library.  If this is what you want to do, use the GNU Library General Public
License instead of this License.

"CLASSPATH" EXCEPTION TO THE GPL

Certain source files distributed by Oracle America and/or its affiliates are
subject to the following clarification and special exception to the GPL, but
only where Oracle has expressly included in the particular source file's header
the words "Oracle designates this particular file as subject to the "Classpath"
exception as provided by Oracle in the LICENSE file that accompanied this code."

    Linking this library statically or dynamically with other modules is making
    a combined work based on this library.  Thus, the terms and conditions of
    the GNU General Public License cover the whole combination.

    As a special exception, the copyright holders of this library give you
    permission to link this library with independent modules to produce an
    executable, regardless of the license terms of these independent modules,
    and to copy and distribute the resulting executable under terms of your
    choice, provided that you also meet, for each linked independent module,
    the terms and conditions of the license of that module.  An independent
    module is a module which is not derived from or based on this library.  If
    you modify this library, you may extend this exception to your version of
    the library, but you are not obligated to do so.  If you do not wish to do
    so, delete this exception statement from your version.
    
------------------------------------------------------------

This product includes tessdata.

 Inc. Licensed under the Apache License, Version 2.0
    
------------------------------------------------------------

This product includes XMP Toolkit.

      Copyright (c) 1999 - 2010, Adobe Systems Incorporated
      All rights reserved.

      Redistribution and use in source and binary forms, with or
      without modification, are permitted provided that the following
      conditions are met:

      * Redistributions of source code must retain the above copyright notice,
      this list of conditions and the following disclaimer.
      * Redistributions in binary form must reproduce the above copyright notice,
      this list of conditions and the following disclaimer in the documentation
      and/or other materials provided with the distribution.
      * Neither the name of Adobe Systems Incorporated, nor the names of its
      contributors may be used to endorse or promote products derived from this
      software without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
      "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
      LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
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      A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
      CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
      EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
      PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
      PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
      LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
      NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
      SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes openexr.

      Copyright Contributors to the OpenEXR Project. All rights reserved.

      Redistribution and use in source and binary forms, with or without modification,
 are permitted provided that the following conditions are met:

          * Redistributions of source code must retain the above copyright notice, this
 list of conditions and the following disclaimer.

          * Redistributions in binary form must reproduce the above copyright notice,
 this list of conditions and the following disclaimer 
            in the documentation and/or other materials provided with the distribution.

          * Neither the name of the copyright holder nor the names of its contributors
 may be used to endorse or promote products derived from this software 
            without specific prior written permission.

      THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY
 EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
      THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
 DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS 
      BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
 CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
      GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
 CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
      LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF
 THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.    
    
------------------------------------------------------------

This product includes ZXing C++ Library.

      --------------------------------------------------------------------------------
      NOTICES FOR C++ Big Integer Library
      --------------------------------------------------------------------------------

      I, Matt McCutchen, the sole author of the original Big Integer
      Library, waive my copyright to it, placing it in the public domain.
      The library comes with absolutely no warranty.
  
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC Profiles were created by FFEI Ltd. (www.ffei.co.uk) using Fujifilm
    ColourKit Profiler Suite (www.colourprofiling.com)
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) by European Color Initiative, www.eci.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) of WAN-IFRA, www.wan-ifra.org
    
------------------------------------------------------------

This product includes ICC Profiles.

    Some ICC profiles are copyright (C) IDEAlliance(R). G7(R), GRACol(R) and
    SWOP(R) are all registered trademarks of IDEAlliance(C).
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------------------------------------------------------------

This product includes PANTONE Color Libraries.

    PANTONE® and other Pantone trademarks are the property of Pantone LLC.
    Pantone is a wholly owned subsidiary of X-Rite, Incorporated.
    
------------------------------------------------------------

This product includes Bonjour SDK.

   Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.
  
   Redistribution and use in source and binary forms, with or without 
   modification, are permitted provided that the following conditions are met:
  
   1.  Redistributions of source code must retain the above copyright notice, 
       this list of conditions and the following disclaimer. 
   2.  Redistributions in binary form must reproduce the above copyright notice, 
       this list of conditions and the following disclaimer in the documentation 
       and/or other materials provided with the distribution. 
   3.  Neither the name of Apple Computer, Inc. ("Apple") nor the names of its 
       contributors may be used to endorse or promote products derived from this 
       software without specific prior written permission. 
  
   THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY 
   EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
   WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
   DISCLAIMED. IN NO EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
   DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
   (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
   LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
   ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
   (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
   SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
    
------------------------------------------------------------

This product includes Qt.

      The software uses Qt, licensed under LGPL v3. The Qt Toolkit is Copyright (C) 2020
 The Qt Company Ltd.

      Portions of this software are copyright (C) 2006-2015 The FreeType Project
 (www.freetype.org). All rights reserved.
      
      Copyright (C) 1991-2011, Thomas G. Lane, Guido Vollbeding.
      This software is based in part on the work of the Independent JPEG Group.
      
      Secure Hash Algorithm SHA-3 - brg_endian
      Copyright (c) 1998-2013, Brian Gladman, Worcester, UK. All rights reserved.

      LICENSE TERMS

      The redistribution and use of this software (with or without changes)
      is allowed without the payment of fees or royalties provided that:

       1. source code distributions include the above copyright notice, this
          list of conditions and the following disclaimer;

       2. binary distributions include the above copyright notice, this list
          of conditions and the following disclaimer in their documentation;

       3. the name of the copyright holder is not used to endorse products
          built using this software without specific written permission.

      DISCLAIMER

      This software is provided 'as is' with no explicit or implied warranties
      in respect of its properties, including, but not limited to, correctness
      and/or fitness for purpose.
    
------------------------------------------------------------
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12.2.  Introduction

This plug-in allows you to make internal images external in Adobe Illustrator. You can select an internal
image in the document and export it. The internal image will be replaced by the link to the outside
image.

The reverse operation (make external images internal) is supported by this plug-in for Esko CTs only.
You will be asked to select the format of the external file – TIFF, DCS2, Photoshop DCS2 or Esko CT.
Formats not suitable for the image data are disabled.

Part of the Image Extractor for Illustrator plug-in is support for placing (embedding/linking) Esko CT
file formats into the Illustrator document.

12.3.  Supported embedded raster image types

• 1bit rasters
• GrayScale + optional alpha
• CMYK - CMYK + alpha (including “PDF for Illustrator”)
• Device-N

• “PDF for Illustrator”
• “Photoshop PSD” - embedded object (every spot layer has its own path art object)

• Device-N + alpha

• “PDF for Illustrator”

Rasters can be clipped. Special effects and transparency are supported only in the simple raster
images (defined by one art object in Illustrator).

Due to Illustrator's limitations Device-N embedded images are exported to TIFF file each time with
empty CMYK channels.

12.4.  Image Extractor for Illustrator workflow

There are two ways of exporting images:

• Export one image

• Export all images in the document

12.4.1.  Export one image

1. Select the image you want to export.
2. Chose Window > Esko > Image Extractor > Export Image. The following dialog appears:
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3. Select the appropriate file format and click OK.

The standard Save As dialog appears.
4. Enter the name of the exported file and click Save. The image will be exported and relinked to the

exported file in Illustrator.

Caution:

When you work in an Automation Engine or FlexRip environment, it is recommended to write
exported files to the Automation Engine container.

12.4.2.  Export of all images in the document

1. Choose Window > Esko > Image Extractor > Export All Images. The engine of Image Extractor for
Illustrator goes through the whole document and collects all images. The dialog Export All Images
appears.

 

 

• The number of images that will be exported is indicated at the top.
• Folder specifies to which directory the images should be written.

• File Name starts with specifies the prefix of each exported image. The name of each image is
created with the prefix and order in the export.
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• File Format indicates the format in wich the image(s) will be exported. Only formats that can
store every image in the document are displayed.

2. After exporting the images the directory may contain following files: e.g. c:\picture_0.ct; c:
\picture_1.ct; c:\picture_2.ct; c:\picture_3.ct; …

12.5.  Other features

• Image Extractor for Illustrator supports placing (embedding/linking) of Esko CT files

• What Image Extractor for Illustrator does not support

12.5.1.  Placing (embedding/linking) of Esko CT files

• Image Extractor for Illustrator can place (embed/link) Esko CT files into the Illustrator document.

• If the Esko CT file contains a preview image, you will be asked if you want to place the preview or the
actual image in the document, for embedding as well as for linking.

• When the Esko CT file is linked and someone modifies the file, Illustrator displays a message box
offering an update.

Note:

When using a preview of an Esko CT file, this preview will be used even for printing, etc…

12.5.2.  What Image Extractor for Illustrator does not support

• Some special types of embedded PSD (layered PSD, opacity mask used in a special way (CMYK
raster art connected to the opacity mask), text in the hierarchy, special clipping paths for the
layer…)

• Export data to PSD file format
• ICC profile of the document is not stored into an external image file.
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13.  Instant Trapper

13.1.  Introduction

Instant Trapper is the interactive trapping tool from Esko, available as a plug-in for Adobe Illustrator. It
allows pre-press professionals to compensate for mis-registration effects on graphical objects.

With Instant Trapper, you can indicate adjoining colorpairs and create correctly shaped and colored
trap objects in a very intuitive way. You always stay in control of where and how trap objects are
created.

Since Instant Trapper generates the trap objects in a separate layer, trapping becomes a non-
destructive process. Any trap object is fully editable and can be shown or hidden for various proofing
purposes.

13.1.1.  DeskPack Trapper for Adobe Illustrator

If you install PowerTrapper Client, PowerTrapper for Adobe Illustrator or Instant Trapper for Adobe
Illustrator version 18.1 or higher, DeskPack Trapper for Adobe Illustrator is installed as well, using the
same license.

Note:  Automatic Trapping in the DeskPack Trapper for Adobe Illustrator is only available if you
have a PowerTrapper Standalone license.

For more information on the DeskPack Trapper for Adobe Illustrator, we refer to the DeskPack Trapper
for Adobe Illustrator documentation: https://www.esko.com/en/support/product?id=DeskPack
%20Trapper%20for%20Adobe%20Illustrator

13.2.  Getting Started with Instant Trapper

To introduce you to Instant Trapper, here is how to make your first trap.

1. Open the document you want to trap in Adobe Illustrator.
2. In Illustrator’s Tools panel, double-click Instant Trapper’s Trap to Objects or Trap to All tool.
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3. In the Instant Trapper palette that opens, choose your trapping parameters (Trap Distance,

Truncate mode, Corners type and Trapping to White Objects or not).
 

 

For more information about the trapping parameters, see Setting Instant Trapper Parameters on
page 393.

4. Trap your object as follows:

•
To spread an object to another object, click into the first object with the Trap to Objects 
tool, drag the cursor into the second object and click.

 

 
•

To spread an object to all objects touching it, click into it with the Trap to All  tool.
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Note:  Use  Option  to change the direction from spread to choke.

For more information about trapping an object to another object, or to all objects of the
background / foreground touching it, see:

• Using the Trap to Objects Tool on page 395,

• Using the Trap to All Tool on page 397.

13.3.  The Instant Trapper Plug-in

The Instant Trapper plug-in consists of two tools (Trap to Objects and Trap to All), and a Instant
Trapper palette.

• The Trap to Objects tool enables you to do full or partial interactive trapping of objects to other
objects.

You can use it for more complex trapping, for example when part of an object has to spread to
another object, while another part has to be choked by a third object.

• The Trap to All tool enables you to do fast, simple interactive trapping of objects to all adjoining
objects in the background / foreground. The background is everything under the object (flat paint,
images, other objects...), the foreground is everything on top of it.

You can use it to trap a single object, or several similar objects (e.g. letters of a text block).

• The Instant Trapper palette contains trapping parameters. See Setting Instant Trapper Parameters
on page 393.

13.4.  Setting Instant Trapper Parameters

1. Double-click the Trap to Objects or the Trap to All tool to open the Instant Trapper palette.
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Note:  For more information on the Trap to Objects and the Trap to All tools, see Using the
Trap to Objects Tool on page 395 and Using the Trap to All Tool on page 397.

2. Set the Trap Distance.

The unit used for the Trap Distance is the General unit defined in Illustrator’s Unit and Display
Performance Preferences.

3.
Choose how to Truncate your traps’ endings: On center  (as in the left picture below) or On edge

 (as in the right picture below).
 

 
4.

Choose how you want the Corners of your traps to be: Round  (as in the left picture below) or

Mitered  (as in the right picture below).
 

 
5. Choose what you want to do when your file contains white objects.

• Leave Trap to White Objects enabled to be able to trap colored objects to white objects / a
white background.
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• Disable Trap to White Objects if you don’t want to trap colored objects to white objects / a white

background. This will prevent you from accidentally trapping to white objects (and will give a
warning when you do).

Note:  You can always trap a white object to another object, as the trap will not be visible.
 

 

13.5.  Trapping

Both the Trap to Objects and the Trap to All tools create traps in your document’s Trap Layer. If your
document doesn’t contain a trap layer, Instant Trapper will create one.

Note:  The trap layer needs to be the topmost layer of your document and be called Trap Layer
for Instant Trapper to recognize it. If it isn’t, Instant Trapper will create a new trap layer on top
of the other layers.

13.5.1.  Using the Trap to Objects Tool

•

You can find the Trap to Objects tool  in Illustrator’s Tools panel.
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Trapping an Object to Another Object
• To spread an object to another object:

a) click into the object to spread,
b) drag the cursor (that draws an arrow) into the other object (across the boundary between the

two objects) and click.
 

 
• To change the trapping direction (from spread to choke), hold Option while dragging the cursor’s

arrow.

Note:

To cancel a trap while you are dragging the arrow, use Escape or Command + . (dot).

To cancel a trap after dragging the arrow, use Command + Z (or Ctrl + Z on PC).

Attention:

The two objects you want to trap must have a common edge.

When trying to trap two objects that appear to be touching but don’t actually have a
common edge, you will get a warning message.

This is the case for example when there is a small gap, or a third object like a stroke, in
between the two objects.

Trapping an Object to Several Other Objects
• To spread an object to several other objects:

a) click into the object to spread,
b) click the background and hold the mouse down to drag a rectangle around the other objects.
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Note:

This traps all objects in the rectangle you drag in the same direction (in the example above,
the purple star and the orange circle are both choked by the green rectangle).

If you need to trap different objects in different directions, you should use combined
trapping (see Trapping using Combined Traps on page 400).

• To change the trapping direction (from spread to choke), hold Option while dragging the arrow.

Trapping Several Objects to One Object
• To spread several objects to one object:

a) drag a rectangle around the objects to spread,
b) drag the arrow into the object to spread them into and click.

 

 

Note:

This uses the same trapping direction for all objects in the rectangle you drag.

If you need to trap different objects in different directions, you should use combined
trapping (see Trapping using Combined Traps on page 400).

• To change the trapping direction (from spread to choke), hold Option while dragging the arrow.

13.5.2.  Using the Trap to All Tool

•

You can find the Trap to All tool  in Illustrator’s Tools panel.

Trapping an Object to All Adjoining Objects
• To spread an object to the background and the foreground (to all objects under it and on top of it),

click in it.
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• To choke it instead of spreading it, hold Option while clicking in it.
• To spread an object to the background only (to all objects under it), hold Shift while clicking in it.

 

 
• To choke it with the background, hold Option and Shift while clicking in it.

Note:

Instant Trapper treats an object and its stroke as two different objects.

Therefore it will not trap the fill object to the background as the stroke object is between the fill
object and the background.

Trapping Several Objects to All Adjoining Objects
• To spread several objects to the background and foreground (to all objects under or on top of

them), drag a rectangle around these objects.
 

 
• To choke several objects with the background and foreground, hold Option while dragging the

rectangle around the objects.
• To spread several objects to the background only (to all objects under it), hold Shift while dragging

the rectangle.
• To choke several objects with the background, hold Option and Shift while dragging the rectangle.
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Note:

Instant Trapper treats an object and its stroke as two different objects.

When spreading a fill object and a stroke object to the background, Instant Trapper will only
spread the stroke object to the background, as it is between the fill object and the background.

It will not spread the fill object to the stroke object, as the stroke object is on top of the fill
object in the file.

 

 

13.5.3.  Combined Traps

When trapping an object to two or more other objects, you can use Combined Trapping to get a
smoother connection between the different traps, and thus a better visual result.

Use this in particular to trap an object to other objects intersecting with each other.

In the example below, you can see the difference between trapping with separate actions and
Combined Trapping, when spreading an object to two intersecting objects.

• When using two separate trapping actions, you may have a gap between the traps (at the
boundary between the second -orange- and the third -purple- objects).

 

 

• When using Combined Trapping to perform both traps at once, there is no gap at the boundary
between the second and the third objects.
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Note:  To know how to perform Combined Trapping, see Trapping using Combined Traps on
page 400.

Trapping using Combined Traps
• With the Trap to Objects tool:

a) click into the first object,
b) hold Shift,
c) drag the arrow into the second object to spread (hold Option to choke) and click.

 

 
• Still holding Shift,

a) click again into the first object,
b) drag the arrow into the third object to spread (hold Option to choke) and click.

 

 
• Release Shift.

This traps the first object to both the second and the third objects.
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13.6.  Known Limitations

Images

OPI Images
Instant Trapper doesn’t support OPI images.

Foreign Art
Instant Trapper does not support certain types of objects created in other applications, for example
complex gradients. You will get a warning message when trying to trap a foreign art object.

Non-Clipped Images
When spreading an image, Instant Trapper uses the underlying image data (when the image is clipped)
to create the trap.
When there is no underlying image data (the image isn’t clipped), it will create an empty trap.
 

 

Softmasks
When trapping objects with softmasks, traps will stop at the edge of the softmask (as you can see
below). This is because Instant Trapper treats the softmask as a single object.
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Patterns
When trapping patterned objects, Instant Trapper will treat each individual pattern as a separate
object.
 

 

Tip:  With the Trap to Objects tool, draw a rectangle around the whole patterned object before
trapping it to another object. See Trapping Several Objects to One Object on page 397 for
more details.
 

 

Strokes

Strokes in the Same Color as the Fill
When an object has a stroke, it is not possible to trap its fill to other objects in the background,
because the stroke is in between.
When the stroke has the same color as the fill, it may not be immediately visible, either in Preview or in
Outline view, so it may not be obvious to you why Instant Trapper won’t trap the fill to other objects in
the background.
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Speed
Database Synchronization
When trapping a document for the first time (drawing the first trap), Instant Trapper needs to
synchronize its internal database. This may cause some delay for larger files.

Note:  Instant Trapper uses the same internal database as the Esko Viewer plug-in. This
means that if you have already synchronized the database using Viewer (by generating a
preview), Instant Trapper won’t need to do it for the same document (and vice-versa).

1-bit Images
You may experience speed issues when trapping complex 1-bit images (for example image masks).

Progress Window
When trapping big and complex files, you may get a progress window, and the cancel button in the
progress window may sometimes not be immediately responsive.

Tip:  To cancel a trap in this situation, use the Escape key.

Blend Modes
Objects with Blend Modes
When trapping objects containing blend modes, the traps will be flattened, but the visual result will be
the same.

Text
Vectorizable Text
Instant Trapper can only trap live text if the text’s font is vectorizable in Illustrator.
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14.  PDF Import

14.1.  The PDF Import plug-in

The PDF Import  plug-in allows opening Esko PDF files in Adobe Illustrator. Almost every PDF object
or construction that can be present in an Esko PDF is supported, and non-native art (also known as
foreign art) is created only for free-form gradients and very complex meshes..

In addition to the artwork content, various high-level information or metadata  is preserved.

It also improves speed and memory allocation of Adobe Illustrator when a single raster file is linked
multiple times into the Illustrator document,even when PDF Import is not directly used to import the
document.

Errors and warnings generated during the import are logged to the Messages  palette.

Known limitations:
Gradients of type Conical, Rectangle and Parallellogramic created by PackEdge cannot be imported in
Adobe Illustrator, because Adobe Illustrator doesn't support those types of gradients

14.2.  Opening a PDF file

The behavior of the PDF Import plug-in and Illustrator depends on the type of file being opened:

• .inpdf : When the file being opened has the sux .inpdf, it is automatically opened by PDF
Import.

• .pdf  with Illustrator data: When the file being opened is an Adobe PDF with preserved Illustrator
editability, it is opened as Illustrator document.

• Regular .pdf : For all other PDF files, the following dialog is shown. PDF Import is used when the
first option (Esko PDF) is chosen. Adobe Illustrator shows this dialog automatically when multiple
file import filters support the file being opened.
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When the PDF file has multiple pages, a dialog will pop up, allowing you to specify the page you want to
import

 

 

If you enter a page number that is not in the PDF file, the nearest possible page number will be taken.

14.3.  High-level information preserved by PDF Import

14.3.1.  Layers

All Layer names are preserved, as well as the locked status and the printability flag.
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Note:

The Normalized PDF format does not support the hidden/visible flag, therefore all layers (and
artwork) present in the PDF file are imported as visible.

14.3.2.  Named objects

For named objects, the names of the artwork are preserved.

14.3.3.  Inks

Esko screenings, ink types, ink books, ink order and Printing Method as shown in the Ink Manager are
preserved.

14.3.4.  Object based screening

Object based Esko screening is preserved and shown in the InkManager. The Screening plug-in is not
needed for this functionality.

14.3.5.  Structural Design (CAD) data

The original structural design file is reimported using the Structural Design plug-in that is part of Esko
Data Exchange .

The original placement origin, rotation angle, front/back side, and printable part selection are
preserved. When the structural design file cannot be found, the user is asked to browse for it. When it
still can’t be found or importing fails, the original Structural Design layer is imported in expanded state
and the link to the external file is lost.

14.3.6.  Page boxes

All page boxes (Media Box, Trim Box, Crop Box, Art Box and Bleed Box) are imported and shown by the
Trim Box and Media Box plug-in.

14.3.7.  Text and fonts

PDF+
When importing a PDF+, text box and paragraph parameters are retrieved from the PDF+ metadata.
This information is used to set the text in Adobe Illustrator's text engine, to preserve the text box,
alignment, tracking, kerning, etc. However, there might be a slight offset between the characters in the
PDF file, and the result in Adobe Illustrator's text engine.
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In the PDF Import Preferences, you can set the Offset Tolerance

1. Choose Illustrator > Preferences > PDF Import Preferences.
 

 
2. Set the Offset Tolerance. By default this is set to 0.06 pt. A higher tolerance results in more

editability, while a lower tolerance results in more exact text positioning. The Preview shows the
maximum visual offset difference for text at 12pt.

3. Click OK

When opening a PDF where the difference between the glyphs in the PDF and the glyphs in Adobe
Illustrator's text boxes is bigger than the Offset Tolerance, a message will be shown:

 

 

• Click Use Point Type to keep the glyphs at their exact position. This will reduce editability of the
text. Enable the option to always use Point Type in the future.

• Click Open Preference... to open the PDF Import Preferences, where you can increase the Offset
Tolerance and continue open the file.

Normalized PDF
When importing a Normalized PDF, PDF Import will try to reassemble text objects into paragraph
and restore high-level typesetting information, so that you can edit these text objects as native
text in Adobe Illustrator. If this reassembly doesn't work, it may happen that text is split into several
text objects, where each object has a constant font style. In very rare circumstances, when it is not
possible to determine the encoding, the text is contourized.

407



14 DeskPack Advanced

Fonts
Any font available to Illustrator can be used without any limitations. When a font not available to
Illustrator is used, a substitution is used. However, the original font name is preserved in the Illustrator
document. Illustrator will give a warning in such cases.

When such a document is saved and reopened on a system with the font installed, it will be correctly
rendered without any warning.

14.3.8.  Linework with mixed (DeviceN) colors

Adobe Illustrator does not support mixing multiple inks (combinations of multiple spot inks or process
inks and a spot ink) in a single fill or stroke. Instead, they are simulated by multiple fills resp. strokes
visible in the Appearance palette.

When PDF Import encounters a path object with a DeviceN fill or stroke, it is imported as multiple
appearances with additional fills resp. strokes put into overprint. Such appearances are supported by
boostX Ink Mix which can work with them further. However, the Ink Mix plug-in is not needed for this
functionality of PDF Import.

14.3.9.  Linked images

PDF Import supports links to external images. The links are preserved.

Some file formats for external images are supported in a (Normalized) PDF, but are not supported by
Adobe Illustrator. For example multichannel PSD files can be placed in PackEdge or ArtPro, but it is not
possible to open such Normalized PDF using this plugin because Adobe Illustrator does not support
this variant of PSD. A workaround is to embed the PSD in PackEdge or ArtPro first. The following error
is shown by Adobe Illustrator in such cases:

 

 

The Image Extractor  plug-in is used for linked Esko CT/LP files. This is a free (non-licensed)
functionality of Image Extractor.

Linked files with remapped inks are imported as Channel Mapped images. The visual representation
will be correct, however a valid license for the Channel Mapping plug-in is needed to edit the channel
mapping.

Adobe Illustrator has performance problems when a single document contains many linked rasters, or
few linked files are referenced many times. It may sometimes cause that only Outline preview can be
used. The PDF Import plug-in improves the handling of such documents.
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Note:

This optimization works also for non-Normalized PDF files, including native Adobe Illustrator
documents, but only as long as the PDF Import is installed.

Missing images
It sometimes happens that the referenced file is not found. Then the following dialog pops up:

 

 

There are 3 options:

• Leave Unresolved : Only a single-pixel placeholder is embedded.

The link to the original file is lost. The Links  palette can be used to relink to the original file when it
becomes available (or to any other file).

• Use Embedded : The image preview embedded in the PDF is used. Normalized PDF often contains a
preview with a low resolution (up to 72 dpi). However, often there is just a single-pixel placeholder.

The link to the original file is lost. The Links  palette can be used to relink to the original file when it
becomes available (or to any other file).

• Relink : the standard file dialog opens, asking the user to find the missing linked file. When this
option is selected, the Use path for the rest of missing images  option becomes enabled.

14.3.10.  Dynamic Barcodes

Barcodes in Normalized PDF, created by PackEdge or an Automation Engine server task, are preserved
and recognised as barcode objects. If the Dynamic Barcode plug-in is installed and licensed, it allows
user to modify parameters of the barcodes supported by the Dynamic Barcode plugin.

As from version 16, also live Bar Codes created by ArtPro+, saved in PDF+ format, will be imported.

14.3.11.  Notes

Notes written by PackEdge, Plato or using the Notes plug-in in Adobe Illustrator, will be imported.
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For more information on working with notes, see Working with Notes on page 410

14.3.12.  Inspection Points

Inspection Points and Inspection Boxes written by PackEdge, Plato or the Inspection Setup Plug-in in
Adobe Illustrator, will be imported.

For more information we refer to the Inspection Setup Plug-in documentation, which is part of the
Esko Data Exchange documentation. See https://www.esko.com/en/Support/Product?id=Esko%20Data
%20Exchange%20for%20Adobe%20Illustrator

14.4.  Working with Notes

Using the Notes tool, you can add and edit notes in your document.

Importing and saving notes
Notes are saved in the Normalized PDF file as regular PDF Comments, and will show up as "Sticky
notes" in Adobe Acrobat. Sticky notes created in Acrobat will also show up in Adobe Illustrator, while
other types of comments (text corrections, highlights, ...), and note properties or statusses are
disregarded when opening a PDF file in Adobe Illustrator.

When importing a Normalized PDF containing notes created in ArtPro, PackEdge, Plato or DeskPack,
these notes will also show up in Adobe Illustrator.
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Notes in Adobe Illustrator

When selecting the Notes tool from the toolbox, all Notes become visible in the document.

A note consists of two parts: the Note itself, the yellow balloon indicating the location of the note, and
the Note Pop-up, containing text, the name of the user that created it, and the time of creation.

When hovering over a note, the Note Pop-up is temporarily shown. When clicking the note, the Note
Pop-up is opened, and you can edit its content. It will stay open until you close it using the X button.

Adding and editing notes
• To create a note, select the Note tool and click in your document.

• To move a note, click and drag the note.

• Select another tool to hide all notes and note pop-ups. Selecting the Note tool will make all notes
visible again. The note pop-ups that were open before will be reopened.

• To delete a note, hover over the note, and click the red cross.
• To hide a note pop-up, click the X in the top right corner. This doesn't affect the note itself, it only

hides the pop-up
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15.  PowerLayout Client

15.1.  Introduction

The PowerLayout Client plug-in is a complete label step & repeat solution inside Adobe® Illustrator®.
PowerLayout Client is a powerful tool for the creation of print-ready layouts. It offers an easy to use
interface to the tabular step and repeat task running on the Automation Engine server. PowerLayout
Client allows you to create step & repeat arrangements for single jobs or multiple jobs and create
a plate design in any flavor of the available output formats, including different PDF flavours. Also
included are the PowerLayout Client' SmartMarks™, SmartMarks™ adapt to changes to the sheet or
board size, the plate size and number of inks in the job, and automatically create printing production
controls like color bars, sheet corner marks, center marks, and trim marks. Step & Repeat templates
can be saved and re-purposed for any other Design flavors.

Normalized PDF or PDF+
In PowerLayout Client 21.07 and later, you can work with documents in PDF+ mode.

Documents in PDF+ mode and in Normalized PDF mode are sent to different Automation Engine tasks,
and use a different ticket. As a result, there are slight differences in the available options when working
in Normalized PDF or in PDF+ mode. For more information on PDF+, we refer to the Ink Manager
chapter of the Esko Data Exchange documentation: https://www.esko.com/en/support/product?
id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator

15.2.  Preparing your PowerLayout Client output

First, open all documents you want to include as one-ups in your final stepped output file. By opening
the documents, you will also be assured that all used fonts and images are present on the system.
If you get warnings or errors while opening these documents, you should solve these issues before
proceeding with the PowerLayout Client output.

To define the size that PowerLayout Client will use for each of your one-ups, go through the open
documents one by one. If no Document Trim Box is defined PowerLayout Client will take the Artwork
Bounding Box, this is the bounding box as the one-up size, meaning the smallest box that fits all the
graphics in that document. A more precise way of working is to define the Document Trim Box.

Tip:

To create the Document Trim Box. Go to Window > Esko > Trim and Media Box. The Trim and
Media Box allows you to fit the Trim Box to your Artboard, Artwork, Selection, CAD file or Crop
Area.

412

https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator
https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator


15DeskPack Advanced

15.3.  Plate and Sheet settings

 

 

Open the PowerLayout Client palette using Window > Esko > PowerLayout.

The first panel of the PowerLayout Client dialog shows the Plate and Sheet settings of your final output
file. The sheet size will be the area where your one-up grids will be positioned. Disable the Sheet size if
you only want to specify one size.

Automatically adjust height This feature allows you to define the height of the 'Plate Size' and 'Sheet
Size' based on a chosen grid. The height is calculated in such way, that the repetition of the chosen grid
can be printed in a vertical direction seamlessly for vertical gaps of any given size. Following formula is
being used to calculate the sheet height: (One-up Height + Vertical Gap) * Vertical Steps.

Scale Output Scale Output is used to compensate for Plate distortion later in the output process. You
should receive this parameter from your printer or platemaker.

Apply Distortion: You can choose to apply the distortion Later to keep the distortion values editable,
so that distortion can be applied later in the workflow, or you can choose immediately to apply the
distortion and prepare the output for 3rd party devices. This option is only available when working in
PDF+ mode.

Position of the Plate
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The preview icon where you see the sheet Position on the Plate can be changed by clicking it. Click
a corner to snap the sheet to the Plate corner. Click in the middle to center. This way, all alignment
options are available just by clicking a snap point. Depending on the snapping position of the sheet
icon, different Margin options will be available to finetune the position.

15.4.  Grid Settings (PDF+ Mode)

Click the Next button, or choose Grids from the dropdown menu.
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In the Grid Settings panel, you will construct the layout of your step and repeat file. Before you do this,
you should have an idea of how and which documents you want to use, and how many repeats you need
for each document.

To define a grid:

1. Set up the one-up. See Set the one-up on page 415
2. Set the Repeat. See Repeat on page 416
3. Set the Position for the grid. See Position on page 419

You can click the plus icon at the bottom of the Grids list to add a grid. Click the minus icon to delete
the grid you are working on. If other grids where aligned to the grid you are removing, their alignment
will now be to the sheet.

Adjust Height to: If in the Plate and Sheet settings the option Automatically adjust height is enabled
the Adjust Height to dropdown list becomes available. This allows you to define on which grid the
height of the 'Plate Size' and 'Sheet Size' will be based.

15.4.1.  Set the one-up

Start by selecting the document you want to use as first one-up file in the one-up dropdown list. Use
the placeholder option to make template step and repeat schemes for later use.

Note:  If you are working in Normalized PDF mode, the dropdown will only show the documents
in Normalized PDF mode, and when working in PDF+ mode, only the documents in PDF+ mode
are shown.
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Size Choose between Document Trim Box (borders) and Artwork Bounding box. You can adjust the
Document Trim Box (borders) with the Trim box and Media Box plug in.

Rotation Select a rotation for your one-up. If you choose to alternate the one-ups (see below) the
chosen rotation will apply to the top-left one-up.

If Clip Bleed is enabled, a clipping mask is applied around the one-up, based on the defined Size, using
a centerline algorithm.

The Clip at distance will offset the clipping mask, either positive (to the outside) or negative (to the
inside). If two one-ups (or their bleed) would overlap (i.e. if the "Clip at" distance is larger than the gap),
the clipping mask of both will be restricted to half way the overlap, so the clipping masks don't overlap.

Using the Keep Outer Bleed buttons, you can define if you want to keep the bleed at the outside of the
repetition. You can choose to keep the bleed on all sides, on top and bottom, or on the left and right
side.

15.4.2.  Repeat

Set the Horizontal and Vertical repeat, and the Gap. The gap is specified between the one-ups without
the bleed.

On the PowerLayout Client output, if you have specified a bleed distance, the actual gap will be smaller
than what you have entered here as gap. Note that the bleeds of two adjoining one-ups will never
overlap. If necessary, the bleed distance will be smaller than what you have specified.

You can choose one of the 4 Heat Turn buttons:

• No Head Turn 
 

 

• Head Turn on column 
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• Head Turn on row 
 

 

• Head Turn on row and column 
 

 

The Head Turn option will be visible in the little preview pane of the repeat: the rotated one-ups are
shown in a darker shade.

Fit around cylinder (for Continuous Printing): If you click the Fit around cylinder button, the
appropriate gap will be filled automatically to fit the specified number of steps around the cylinder.
Enter the cylinder circumference as the sheet height.

Staggering
Staggering allows to shift the 2nd, 3rd, ... row or column down or to the right.

 

 

1. Select the Direction in which you want to stagger the one-ups. From left to right, the choices are:
No Stagger, Stagger Columns, and Stagger Rows.
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2. You can define the distance for staggering. By clicking the button you can switch between entering
the distance as a fixed value in the current units, or as a percentage of the one-up size.

3. The stagger will be repeated for a number of rows or columns as defined in Restart after n
columns/rows. After that, the next one-up will be at the begin position again.

4. If Add Partial Labels  is enabled, the gaps created by staggering will be filled with partial labels.

Examples:

No stagger:

 

 

Stagger Vertical, 50% distance, using a negative horizontal gap, Repeat After 2 columns:
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Stagger Horizontal, fixed distance, using a negative vertical gap, Repeat after 3 rows:

 

 

Same as above, with Add partial labels enabled:

 

 

15.4.3.  Position

The position of a Repetition is based on 3 settings:
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Attach to
The position of the repetition can be based on

• the Sheet
• the Plate
• Another grid

The dropdown list for the first grid you make only contains the Attach to Sheet and Attach to Plate
option. When an extra grid is made, all previously defined grids will also be available in the Attach to…
list. It is advised to start with the grid that is the easiest one to align to the sheet.

Tip:

You can align the grid you are working on to a previously defined grid by Alt-clicking the target
grid in the grids preview pane. The Attach to dropdown will jump to the clicked grid.

Positioning
The way the repetition is attached, can be chosen by clicking and dragging the green square
(representing the Repetition) to the desired position on the grey square (representing the Attach To
reference). Each square has 9 reference points (top left center and right, middle left center and right,
and bottom left center and right), so you have 81 different ways of positioning the Grid.

Offset
In the Offset fields, you can move the Repetition based on the defined position.

15.5.  Grid Settings (Normalized PDF Mode)

Click the Next button, or choose Grids from the dropdown menu.
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In the Grid Settings panel, you will construct the layout of your step and repeat file. Before you do this,
you should have an idea of how and which documents you want to use, and how many repeats you need
for each document.

To define a grid:

1. Set up the one-up. See Set the one-up on page 421
2. Set the Repeat. See Repeat on page 422
3. Set the Position for the grid. See Position on page 423

You can click the plus icon at the bottom of the Grids list to add a grid. Click the minus icon to delete
the grid you are working on. If other grids where aligned to the grid you are removing, their alignment
will now be to the sheet.

Adjust Height to: If in the Plate and Sheet settings the option Automatically adjust height is enabled
the Adjust Height to dropdown list becomes available. This allows you to define on which grid the
height of the 'Plate Size' and 'Sheet Size' will be based.

15.5.1.  Set the one-up

Start by selecting the document you want to use as first one-up file in the one-up dropdown list. Use
the placeholder option to make template step and repeat schemes for later use.

Note:  If you are working in Normalized PDF mode, the dropdown will only show the documents
in Normalized PDF mode, and when working in PDF+ mode, only the documents in PDF+ mode
are shown.
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Size Choose between Document Trim Box (borders) and Artwork Bounding box. You can adjust the
Document Trim Box (borders) with the Trim box and Media Box plug in.

Rotation Select a rotation for your one-up. If you choose to alternate the one-ups (see below) the
chosen rotation will apply to the top-left one-up.

You can define bleed by setting the Mask for Bleed distance.

The one-up will be masked on the Document Trim Box or Artwork Bounding Box if the value is set to 0
mm. Depending on the value set as bleed your one-up will be extended with the bleed distance. All the
objects outside the Document Trim Box or Artwork Bounding Box + bleed distance area will be masked
out.

15.5.2.  Repeat

Set the Horizontal and Vertical repeat, and the Gap. The gap is specified between the one-ups without
the bleed.

On the PowerLayout Client output, if you have specified a bleed distance, the actual gap will be smaller
than what you have entered here as gap. Note that the bleeds of two adjoining one-ups will never
overlap. If necessary, the bleed distance will be smaller than what you have specified.

You can set Alternate Vertical or Horizontal:

• no Alternate
 

 

• Alternate Horizontal
 

 

• Alternate Vertical
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• Alternate Vertical and Horizontal
 

 

The Alternate option will be visible in the little preview pane of the repeat: the rotated one-ups are
shown in a darker shade.

Fit around cylinder (for Continuous Printing): If you click the Fit around cylinder button, the
appropriate gap will be filled automatically to fit the specified number of steps around the cylinder.
Enter the cylinder circumference as the sheet height.

15.5.3.  Position

The position of a Repetition is based on 3 settings:

Align to
The position of the repetition can be based on

• the Sheet
• Another grid

The dropdown list for the first grid you make only contains the Align to Sheet option. When an extra
grid is made, all previously defined grids will also be available in the Align to… list. It is advised to start
with the grid that is the easiest one to align to the sheet.

Tip:

You can align the grid you are working on to a previously defined grid by Alt-clicking the target
grid in the grids preview pane. The Align to dropdown will jump to the clicked grid.

423



15 DeskPack Advanced

Positioning
The way the repetition is attached, can be chosen by clicking and dragging the green square
(representing the Repetition) to the desired position on the grey square (representing the Align To
reference). When positioning on the Sheet, you have 9 options to position the repetition inside the
plate or sheet. When positioning on another grid, you have 16 options to position the repetition next to
(left, right, above or below) the reference grid.

Margin
In the Margin (for Sheet) or Gap (for grids) fields, you can move the Repetition based on the defined
position.

15.6.  Variable Data

When using Variable Data (Normalized PDF mode only), you can define all settings related to the
Variable Data in the Variable Data tab of the PowerLayout window.

For more information on Variable Data and the settings in this tab, we refer to the Variable Data for
Adobe Illustrator documentation here.

15.7.  Output Settings

Click the Next button. In the Output Settings panel you choose the output format, an output ticket and
if necessary the SmartMarks or Marks for the final output file.
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Task Type:

The choice you get in the Output Type dropdown list depends on the current licenses available on the
Automation Engine server. When working in Normalized PDF mode, the possible types are: PDF, EPS/
DCS, PostScript, Print, PAF, JDF Layout, JDF Stripping, Normalized file (GRS or PDF), Workflow and
VRML. When working in PDF+ mode, the possible types are Step & Repeat Tabular (Dynamic) and Step &
Repeat Tabular (Dynamic) - Workflow

Ticket Name The Output ticket depends on the Output type you have chosen. All corresponding tickets
for that type which reside on the server will be shown. A default set is always available, and extra
tickets can be made with the Pilot application. Your output file will be written to the directory specified
in the Output Ticket. Use Smartnames in the ticket to get unique files and folders.

Output settings for Normalized PDF Mode
SmartMark Set: A default set of smartmarks is installed on the DeskPack server. To create your own
smartmarks, you need an application like PackEdge or Plato.

Single Curve DGC and Automatic DGC You can select which Dot Gain Compensation (DGC) curves made
with IntelliCurve or IntelliCurvePro should be added as transfer curve.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your data.
• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy (.icpro

file). The former allows you to apply dot gain compensation selectively depending on the dot shape,
screen ruling, angles and even Contone or Linework properties. The latter does the same but also
offers ink based dot gain compensation.
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Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Note:

Instead of choosing DGC curves at output they can also be selected in the BackStage ticket
and saved along with the tickets you want to use.

If the Output Selfcontained File is selected, you will have a Normalized PDF with all images embedded.
If disabled, you'll get a PDFPLA file with links to different files, and folders where you can still have
linked images etc.

The Screen Registration option will preserve the same screening starting point for every occurence in
the repetition.

Include CAD info for Digital Flexo Suite: CAD info is tagged in the file. The file can then be split in a
print file and a cut file in the Digital Flexo Suite, the first goes to the rip or proofer, the other goes to the
cutting table. This works only for Digital Flexo Suite.

Output settings for PDF+ Mode
Marks

When working in PDF+ mode, you can add up to 8 different Marks sets. To add an extra Marks set, click
the + button on the right. To remove a Marks set, you can click the minus button.

The dropdown will show all available Marks sets from your Automation Engine server.

15.8.  Open / Save PowerLayout Client settings

If you want to open a previously saved template file, click the Open button. All the settings saved in the
template file will be filled in.

There is one exception: the one-up box in the grid settings will be put on “placeholder”. After opening
a template you will have to define which one-up file to use for each of the grids by replacing the
“placeholder” with the name of the appropriate one-up. PowerLayout Client will issue a warning if the
size of the selected one-up document differs from the size of the document that was used to create
the template. This warning may be ignored. In that case the grids will be updated to reflect the size of
the selected output file.

You can save your PowerLayout Client settings for later use by clicking the Save button. This opens the
save dialog. The directory immediately jumps to the Settings > PowerLayout Client directory on the
DeskpackContainer. This is the preferred place for saving your template files.

15.9.  Launching the PowerLayout Client task

Click the Launch button to launch the PowerLayout Client task. A check will be performed to see if
all grids have a one-up assigned to them. If this is not the case, a warning will appear: Some grids do
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not have a one-up assigned to them. These grids will not be included in the output. Do you want to
continue?

If you select no, you can go back to the grid Settings and change the Placeholder in the one-up box to
the name of the one-up that you want to use. If you select yes, then those grids that have no one-up
assigned to them, will be deleted from the output.

If the size of the one-up you choose is different than the size of the placeholder, a warning will pop up:

The document has a different size than the placeholder. Do you want to continue?

If you click yes, the grids in the sheet preview window will change to accommodate the new size.
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16.  PowerTrapper Client

16.1.  Introduction to PowerTrapper Client

Important:  PowerTrapper Client (Trapping on Server) is only available when working in PDF+
Mode. For more information on PDF+ Mode and PDF+ in general, we refer to the Ink Manager
chapter of the Esko Data Exchange documentation: https://www.esko.com/en/support/
product?id=Esko%20Data%20Exchange%20for%20Adobe%20Illustrator

16.1.1.  What is Trapping?

The trapping process is a safeguard against possible (even likely) fluctuations in the printing process.
Minor discrepancies in registration, slight paper shifting or stretching of e.g. PE foil can cause inks
to misregister. When two abutting colored objects do not meet exactly, you can end up with a printed
result like the one below:

 

 

The overlap creates a dark area and the gaps cause an undesirable light area. To prevent these
potential discrepancies, a trap can be implemented, causing the original colors to slightly overlap each
other:
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In general trapping is necessary when two abutting color areas do not share a common ink. Placing a
fine line where they join, made of a color that contains components of both abutting colors, can trap
such areas effectively.

16.1.2.  PowerTrapper Client: the Concept

1. Open the Adobe Illustrator file, and click Window > Esko > PowerTrapper Classic > Launch Trap
Task
 

 

Important:  PowerTrapper Client is not available when working on a PDF+ file. For more
information on PDF+, we refer to the Ink Manager chapter of the Esko Data Exchange
documentation: https://www.esko.com/en/support/product?id=Esko%20Data%20Exchange
%20for%20Adobe%20Illustrator

2. Choose a Trapping Ticket and click Trap.
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3. The Illustrator file is saved locally to reflect the latest changes.
4. The file is copied to the Server, and is trapped with the selected ticket.

 

 
5. Adobe Illustrator is freed up for other jobs, while the Shuttle palette monitors the progression of the

trapping.
6. The Server generates trap objects and saves them in a separate Trap layer.
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7. Once finished, you can open the file by double-clicking the task in the Shuttle window, and the Trap

layer is automatically placed on top of the layers.
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16.1.3.  DeskPack Trapper for Adobe Illustrator

If you install PowerTrapper Client, PowerTrapper for Adobe Illustrator or Instant Trapper for Adobe
Illustrator version 18.1 or higher, DeskPack Trapper for Adobe Illustrator is installed as well, using the
same license.

Note:  Automatic Trapping in the DeskPack Trapper for Adobe Illustrator is only available if you
have a PowerTrapper Standalone license.

For more information on the DeskPack Trapper for Adobe Illustrator, we refer to the DeskPack Trapper
for Adobe Illustrator documentation: https://www.esko.com/en/support/product?id=DeskPack
%20Trapper%20for%20Adobe%20Illustrator

16.2.  The PowerTrapper Client Workflow

1. To start trapping the current AI file, either select Window > Esko > PowerTrapper Classic > Launch
Trap Task... or use the shortcut [Alt+Shift+Cmd+X].

2. The Launch Trap Task window pops up.

Check the Ink Types. PowerTrapper Client supports special inks in the job like varnish areas, spot
colors or technical inks. To change the Ink Options, use the Ink Manager palette.

Select the Trapping Ticket. The list presents all PowerTrapper Trap Tickets stored centrally on the
Automation Engine Server.

 

 
3. Click Trap.

a. First the AI file is overwritten in native AI format at its original location (in order to include all the
latest changes!)

b. Secondly, it is also saved as an Esko Normalized PDF file into the Container on the Automation
Engine Server, and the trapping ticket is communicated to the server.

432

https://www.esko.com/en/support/product?id=DeskPack%20Trapper%20for%20Adobe%20Illustrator
https://www.esko.com/en/support/product?id=DeskPack%20Trapper%20for%20Adobe%20Illustrator


16DeskPack Advanced

c. Illustrator closes the document that is being trapped and becomes free for other tasks.
4. The Shuttle palette pops up and provides information regarding the status.

 

 
5. Once it is finished successfully , double-click the name of the file in the Shuttle palette to

open the selected document. The PowerTrapper Client plug-in now merges the trapping layer
with the original design. The document is opened and the traps are fully editable objects in a
separate Illustrator layer. The Color Pairs palette also pops up, now you can modify the trap object
parameters and update the traps if required.

 

 
6. When you are done updating the traps, save the AI file with the trapping layer on top.

16.3.  The Launch Trap Task window

The Launch Trap Task window lists all inks used in the job. The Trapping engine takes the type of ink
into account when trapping. That is why you might want to annotate the Spot inks. Use the Ink Manager
to select another type.
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• Normal Ink (Process, PANTONE and Designer inks)
• Spot Ink (PANTONE and Designer inks)
• Opaque (other inks will usually be trapped under opaque inks, even if they are considered darker

than the opaque ink.)
• Varnish (will be ignored by ColorStitch)
• Technical Ink (will be ignored by ColorStitch)

Use the dropdown list to select a Trapping Ticket. The Trapping Ticket contains all preferred trapping
parameters. They can be defined and/or modified in the Automation Engine Pilot.

Trapping starts after you click Trap.

The Shuttle window will pop up.

16.4.  The Color Pairs Palette

After trapping your document, the Color Pairs palette shows the trapping settings associated with
each of your document’s color pairs.

It pops up automatically after trapping, or you can go to Window > Esko > PowerTrapper Classic >
Color Pairs to open it.

 

 

For each color pair, the palette shows:

• the number of Hits (occurences of that color pair) in the document,
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•
the type of object in the pair (empty background , flat color , image  or gradient ),

Note:  When you click on the flat color icon, you will see the ink percentages.

• the type of trap performed on that color pair (normal trap , pullback , reverse trap ),
• the trapping Distance used,
•

the traps’ Shape (truncation , caps , corners ),
• the Intensity of the trap color,
• the Pullback Ink (when the trap is a pullback).

For details, see Color Pairs Options on page 435.

16.4.1.  Color Pairs Options

Trap Type
• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration problems

like ugly light gaps, and unwanted halo effects.

The trapping mechanism automatically chooses the most appropriate trap direction based on the
relative luminance of the adjoining colors. Lighter colors are generally trapped into darker colors to
minimize the visual effect of the trap.

• Pull Back: An ink pull back keeps away all but the darkest ink of a color area composed of multiple
inks that borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due to
registration errors during the printing process.

Ink pull back is also known as “Cutbacks” or “Keepaways”.
• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color pairs

with a white knockout (erasing) trap. The white knockout trap is put on top of the lighter of the two
colors.

This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where overprinting
of inks is not allowed as the inks would contaminate each other on the blanket.

Trapping Distance
Enter the width you want to give your traps. The unit used is the General unit defined in Illustrator’s
Unit & Display Performance Preferences.

The default trap width is 0.2 mm (or equivalent in your chosen unit).

Shape
Truncate Traps

The trapping mechanism can truncate the trap so that it doesn’t stick out on another color. There are
two truncation modes:

•
On Center  (default): when a portion of a trap comes too close to the contour of another object,
the trapping mechanism limits it to half the distance between the trapped object and the other
object.
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•
On Edge : when a portion of a trap comes too close to the contour of another object, it is
truncated on the other object’s edge.

 

 

End Caps

This option specifies how to shape the ends of an open trap.

•
Square  (default): this option ends the trap at right angle to the adjoining object.

•
Round : this rounds the ends of the trap. This option is typically only used in combination with
white knockout (reverse trapping).

Attention:

We recommend you don’t use Round End Caps together with Truncate Traps On Center, as
this can generate some artefacts (the round caps will be truncated).

•
Object Dependent : with this option, the trap is a logical continuation of the contour of the
spread object.

 

 

Trap Corners

This option allows you to change how the traps’ sharp corners will be handled.
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•
Round  (default): a round cap will be placed at all corners.

•
Beveled : this will cut sharp corners off.

•
Mitered : this option works with a miter ratio.
 

 

The miter ratio serves to limit the length of the sharp corner (the distance from the base of the trap
to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more than 4
times the Trapping Distance, then the corner will be cut off (beveled). If it is less than 4 times the
Trapping Distance, the corner will be left as it is.

 

 

Intensity
By default, the trapping mechanism uses the full color of the object to spread in the trap (100% trap
color intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity percentage.

Pullback Ink
The example below shows an object with 100% dark blue and 50% magenta on an empty background.
50% magenta is pulled back and a fine line of 100% dark blue remains. The color that remains (dark
blue) is the pull back ink.
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16.4.2.  Viewing Traps

• To select all the traps of a color pair in your document, click that color pair in the Color Pairs
palette.

Note:  Use Command or Shift to select several color pairs, and highlight all the
corresponding traps in your document.

•
To select traps without showing the highlight color around them, click  or select Don’t
Highlight Selected Edges in the palette’s fly-out menu.

To show the highlight color around selected traps again, click  again or select Highlight
Selected Edges in the menu.

•
To zoom on selected traps, click  or select Zoom to Selected Edges in the menu.

To revert to the previous zoom, click  again or select Don’t Zoom to Selected Edges in the
menu.

• If the Trap Select tool is active, use the arrow keys to browse through the color pairs. Activate the
Zoom to Selected Edges to browse and visualize your traps one by one in your job.

Note:  Use Arrow left-right to expand or collapse the trapping pair list.

16.4.3.  Viewing Trap Settings

You can hide trapping settings that you are not using to make the Color Pairs palette smaller.
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• To hide all color pairs that are not trapped with each other, select Hide Non-trapping Color Pairs in
the palette’s fly-out menu.

To show them again, select Show All Color Pairs in the fly-out menu.
•

To hide all color pairs that don’t have traps selected in your document, click  or choose Hide
Unselected Edges in the palette’s fly-out menu.

To show them again, click  again or select Show All Edges in the menu.
• To hide the Distance, Shape, Intensity or Pullback Ink column, select Hide Distance/Shape/

Intensity/Pullback Ink Column in the palette’s fly-out menu.

To show the column again, select Show Distance/Shape/Intensity/Pullback Ink Column in the fly-
out menu.

16.4.4.  Refining your Traps

You can use the Color Pairs palette to select certain traps and change their trapping settings.

1. Select either:

• the color pair(s) to edit in the palette,
• the traps to edit in your document (if you want to only edit certain traps of a color pair).

2. Make your desired changes as explained below:

to change a color pair’s... do...

trapping direction
click Swap Trap Direction . Trap direction
can be from left to right, from right to left, or
bidirectional. In case of bidirectional trapping,
the trap will go half the trapping distance in each
direction.

Note:

When you change the direction for only
certain traps of the color pair, the color pair
will be duplicated in the palette (e.g. one
entry for spread and one for choke).
 

 

trap type choose Normal Trap , Pullback  or Reverse Trap

 in the Trap column.

You can also use this to trap a non-trapping color
pair.
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to change a color pair’s... do...

trap distance click the Distance value to edit it.

trap truncation
choose On Center  or On Edge  in the Shape
column.

end caps
choose Square , Round  or Object Dependent

 in the Shape column.

trap corners
choose Round , Beveled  or Mitered  in
the Shape column.

trap color intensity click the Intensity value to edit it.

pullback ink (for pull back traps only) click the pullback ink to change it to another ink.

3.
Click Update Traps  to apply your changes to your document’s traps.

Note:  To change several color pairs the same way, use Command or Shift to select them,
then make the changes in one color pair. Clicking Update Traps will apply your changes to all
selected color pairs.

16.5.  The Trap Layer

The overprinting trapping areas are added in a separate Trap Layer, on top of the unmodified original
layers. The Trap Layer is visible in the Layers Palette.

Note:

If a design is trapped more than once (i.e. not update traps), the trapping objects will be in
subsequent layers called : Trap Layer 2, Trap Layer 3, etc.

Tip:

Trapping a job more than once may be a good solution if you want, for example, a particular
color pair to be trapped from A to B for certain objects, and from B into A for other objects.

16.6.  The Trap Select Tool

The Trap Select tool  is part of the toolbar. Use it to select trap areas in your job.
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Just click two adjoining color areas and the nearest edges will become highlighted. The selected
trapping pairs also will become highlighted automatically in the Color Pairs Palette.

Note:

It is also possible to make a rectangle selection with the Trap Select Tool. In that case all
corresponding color pairs will be selected in the Color Pairs Palette so that you immediately
know which pair to edit.

Tip:

On certain designs the highlight color may prove to be unpractical because of too little contrast
with the design colors. In this case it is recommended to modify the selection color of the
(first) Trap Layer.

16.7.  Selective Trapping

Selective trapping is trapping just a selection of objects rather than the whole design.

16.7.1.  Partial Re-Trap

Trapping a job more than once is a good solution if e.g. you want a particular color pair to be trapped
from A into B for certain objects, and from B into A for other objects.

The procedure to follow:

1. Trap a first time (making sure the direction for pair A/B is correct for the majority of objects (if not
invert the direction).

2. Delete those trapping objects in the Trap Layer which you think are in the wrong direction.
3. Trap a second time (do not use Update traps, because that function will actually replace the first

traps). You will get the following question :

 

 

Click No.
4. When the second trapping is finished, open the task. You will see that a second layer has been

added ("Trap Layer 2"). This new layer will only contain trapping elements on objects for which the
traps had been deleted before.
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5. Optionally, you can merge the two Trap Layers into one, but this is not necessary.

16.7.2.  Non-Printable and Hidden Layers

PowerTrapper Client ignores non-printable and hidden layers. Actually, they are even omitted from the
temporary AI file on the DeskPackContainer.

If you do not want certain objects to be trapped, it should be enough to move them to a non-printable
or hidden layer.

16.7.3.  Inks Annotations

Yet another way to omit objects (with a certain ink) from the trapping operation (and therefore making
the trapping selective) is to assign the ink type Varnish or Technical to it. All objects in these inks will
be ignored during trapping.

16.8.  Add Rich Black

The Rich Black tool can be used to obtain a darker black by overprinting all black areas with the ink that
you specify, for example Cyan.

1. Open the Rich Black dialog by choosing Window > Esko > PowerTrapper Classic > Rich Black
 

 
2. Select objects using the standard Adobe Illustrator selection tools.
3. Use the Add dropdown to select the ink (e.g. C) you want to add to create a rich black . The

dropdown will contain all inks present in the job. You can add another ink using New Separation ... if
needed.

4. Enter the Density you want to apply.
5. Set the Offset to define the distance between the edge of the added ink and the edge of the black

object.
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6. Set the Miter Limit as you would for trapping. Miter limit determines whether sharp corners in
objects appear pointed or beveled. You can also select Bevel and Round options.

Note:  The Miter Limit option is only available when the Miter option is selected.

7. Use the To dropdown to select the colors you want to change into rich black. All areas using the
selected color, and above the Minimal Density percentage, will become rich black by adding the Add
color.

8. Enable No Other Inks Present if you only want to create rich black from pure inks, and not in areas
that already contain a mix of inks.

9. Click Create to generate a layer of overprinting objects to enrich the source ink. The layer will be
called "Rich Black" by default.

16.9.  Warnings

 

 

You should always open a trapped document from the Shuttle window, that way the PowerTrapper
Layer will be fetched from the server and added to the document.

If not, this is the warning that will pop up. Click OK and the document will open, without the
PowerTrapper Layer.

 

 

If you trap a design which already contains a PowerTrapper Layer, you will get the question if you want
to remove the first PowerTrapper Layer.
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If you answer No, this means that the first PowerTrapper Layer will be included in the new trap task.
Answer Yes to throw away the first PowerTrapper Client Layer and to start trapping from scratch.
Answer Cancel if you want to interrupt retrapping the current job.

Attention:

You will only get this question if the PowerTrapper Layer has NOT been renamed.

16.10.  PowerTrapper Preferences

You can open the PowerTrapper Preferences by choosing Illustrator > Preferences > Esko >
PowerTrapper Classic Preferences (Mac) or Edit > Preferences > Esko > PowerTrapper Classic
Preferences (Windows)

Convert Blended Objects to Images in the PowerTrapper Classic Preferences will convert blended
objects to images before trapping. The Resolution for these images can be set to High (600 dpi),
Medium (300 dpi) or Low (150 dpi).

If the Use Postscript Compatible Image Traps preference is on, the image trap color option has no
influence on the result. Trapping will not generate any extra image data but image traps will create
traps with lineart representing vectorized pixels. The lineart will also use Postscript Overprints instead
of the multiply blend mode. These image traps are always created using the 'Use Original Data' option.
Note that to have a correct visualization of your traps, you need to switch on the 'Overprint Preview' in
the Illustrator View menu.

Note:  The Use Postscript Compatible Image Traps is only applied when using PowerTrapper
Classic. When using PowerTrapper Client, this option is not applied, since it is not compatible
with the PowerTrapper tasks in Automation Engine.
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If Keep Links in Image Traps is selected (default), a trap for a linked image will consist of the linked file
and a clip mask. This will cause the linked file to be placed (and shown in the Links palette) for every
trap. In case of a high number of traps, this might cause stability issues for Adobe Illustrator.

If the option is off, the image for the traps is embedded, and turned into a symbol, which is then used
for every trap (with a different clip mask). This will not affect the Links palette, nor will it affect Adobe
Illustrator's eciency. This does not change the original image.

See also Color and Shape Settings

In the Standalone Trapping Preferences, you can set the location where PowerTrapper Classic saves
the Trap Presets. See Defining a Trap Preset

• When choosing Use Shared Trap Ticket Folder, Trap Presets are saved in the default "shared users"
folder:

• /Users/Shared/EskoArtwork/Trap Tickets on Mac.

• C:\Users\Public\Documents\EskoArtwork\Trap Tickets on Windows.

• When choosing Use Custom Trap Ticket Folder, Trap Presets are saved in the folder you define by
clicking the Browse button.
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17.  Preflight

17.1.  The Preflight for Illustrator Concept

17.1.1.  What is Preflight for Illustrator ?

Preflight for Illustrator is a plug-in designed to evaluate the contents of your Adobe Illustrator
document by comparing each object attribute to a user-defined set of design or print specifications.
After checking, Preflight for Illustrator locates every problem object and allows you to edit. Validation
can be done interactively.

Another feature of Preflight for Illustrator lets you collect all items related to the job, which makes it
the ideal companion plug-in if you regularly transfer files to printshops.

17.1.2.  Import/Export of parameter sets

A pre press shop could create some parameter sets, which are distributed to all the design houses they
work with. These companies can check their designs with these parameter sets. This will reduce costs
at both sides: the design houses deliver better artwork (avoiding potential additional costs for fixing
problems in the print shop), and the print shop knows upfront if a job is good quality or not.

17.1.3.  Units

Note:

Preflight for Illustrator adapts the Units and Undo settings from the AI preferences menu.

17.2.  The Preflight menu items

Preflight for Illustrator adds a new submenu: Window > Esko > Preflight, containing the following
entries:

• Collect Files... opens a preferences dialog box which lets you collect all external files of the current
job, and write them to a separate directory. External files include images, fonts and ICC profiles.
See Collect Files... on page 447

• The Font List tool is used to manage the classification of used fonts. See The Font List on page
447
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• Preflight Parameters shows the palette for editing parameters that will be used when checking.
See The Preflight Parameters on page 451

• Thin Parts allows to search for areas where objects are thinner than a given minimum width. See
Thin parts on page 458

• Validator shows the check palette which is used for checking and selecting objects that do not
match the specified values. See The Validator palette on page 463

Note:  If you have Packaging Preflight for Adobe Illustrator installed, the Preflight menu will
also contain PitStop Preflight Profiles and PitStop Preflight Report. See the Packaging
Preflight for Adobe Illustrator documentation for more information.

17.3.  Collect Files...

This function will collect all necessary items needed to successfully open the current job on a remote
site.

Collected files include:

• The actual Illustrator file.
• External referenced objects (images, imported linework EPS...)
• Fonts used in the design

• Used ICC profiles

The collected items can be saved in a folder as native files, or they can be packed in a zip file.

The collection of files will be successful if all linked objects are found (images, fonts), and if the target
disk has enough free space.

Collection fails if Preflight for Illustrator cannot locate the external files or used fonts. If collection
fails, every item collected so far will be removed again.

Note:  A frequently occurring situation for failed collection is when an Illustrator file is opened,
and a warning about missing fonts is ignored.

Caution:  Collection will not work with multi file DCS2 files.

17.4.  The Font List

You can open the Font List by choosing Window > Esko > Preflight > Font List

17.4.1.  Why would you use font classification?
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Some font families are less printable than others when it comes to small font sizes. “Serif” fonts, like
e.g. Times Roman, have small decorative extensions at corners or extremities of each character. These
extensions tend to disappear or fade in print when using extremely small font sizes. Not every printing
process suffers equally from this phenomenon. The “bold” font family members, on the other hand,
facilitate the printing of small, thus allowing smaller font sizes than normal typefaces.

The information on which characteristics a specific typeface has, is not consistently stored in the
fontdata, making it impossible to automatically detect the nature of the font. The Font List brings a
solution to this, allowing the user to manually classify typefaces. This may seem to be a tedious job at
first, but after initial classification, the font database can gradually be updated when more fonts are
added.

However, this classification is not compulsory. If there is no need to distinguish between bold, serif
and normal fonts in the workflow, assigning a minimum value for normal fonts only will work in most
cases, every type instance will be compared to this value only, which can be an average for bold, serif
and normal fonts.

Also bear in mind that not every “sans serif” font (a font without these decorative extensions) is easier
to print than a serif font, since some font types have both thin and thick parts, which makes it more
logical to classify them as “serif” fonts than as “sans serif”.

The assigned values will be stored locally, allowing Preflight for Illustrator to use this database for every
job to be checked. This database can be exported for use at other sites where Preflight for Illustrator is
applied.

17.4.2.  Parameter Fonts

Each font family member occupies one line in the Font List. Next to the font name, 2 checkboxes allow
you to classify the typeface with a single click.
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For serif fonts, enable the S checkbox. For bold fonts, enable the B checkbox. The combination of the
two is also possible of course.

When Illustrator is launched, your system is scanned for active fonts. These can be fonts residing in
your system folder, or fonts activated with a font management tool like ATM, Suitcase or others. If new
fonts are active at that moment, they will be added to the Preflight for Illustrator Font List.

Depending on the availability and the state of classification of the font, each font entry can have one of
four different colors:

1. White: the font is classified and available on your system.
2. Blue: the font is NOT classified yet, but detected as active on your system.
3. Yellow: The font has been classified before, but is now unavailable on your system.
4. Purple: The font has not been classified yet and is currently unavailable on your system.

The latter case will happen only rarely, but it may occur in a situation in which a font scan is done on
one system, without assigning some fonts, then exporting the font list to another site where the font is
currently not unavailable.

17.4.3.  Font List fly-out menu

The fly-out menu of the Font List palette contains additional options:
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• Accept All Fonts will change the state of every unclassified font entry to ‘classified’.

• Import Font File allows you to import a font classification database generated on another system.
See Importing a Font File on page 450

• Export Font File will export the current font list settings into an external file.

• Revert Font List will revert any change made in the Font List to the last Save version of the Font
List.

• Save Font Listwill save the current Font List settings on your hard disk.

• Scan for changed fonts refreshes the font list.

Importing a Font File
When choosing Import Font File in the fly-out menu of the Font List, you first browse to the Font File
you want to import. When you click Open, an import control dialog opens.

 

 

It prompts the action Preflight for Illustrator should perform if the imported list contains other
classification parameters for the same fonts than those in the current font List. The options are:

• Completely Replace Font Database: this option specifies that all entries in the current Font List
will be removed, and the parameters from the imported file will be kept.

450



17DeskPack Advanced

• Accept New Attributes on Conflicts: the imported entries are merged with the current Font List,
and if there are conflicts, the settings from the import are assigned.

• Maintain Original Attributes on Conflicts: the imported font classification entries are merged with
the current font list, and if there are conflicts, the settings from the original font list are assigned.

• Ask on Each Conflict: the imported entries are merged with the current font list, and in case of
conflicts, the user will be prompted to assign the desired classification.

If the last option is selected, a dialog appears when a conflict occurs:

For every conflicting classification, the name of the font is displayed, followed by the original (local)
classification, and the new (imported) classification.

Following options can be selected:

• Keep Original: leaves the classification for this font face as defined on this machine.

• Use New: will assign the classification from the imported file.

• Always Use Original: stops prompting the user, keeping the local classification for every conflicting
font face.

• Always Use New: stops prompting the user, assigning the classification from the imported file for
every conflicting font face.

17.5.  The Preflight Parameters

The Preflight for Illustrator Preflight Parameters palette can be opened by choosing Window > Esko
> Preflight > Preflight Parameters. It contains all parameters that can be specified for checking. The
window is divided in tabs:

• Color on page 452: color and/or ink related settings

• Image on page 453: external image settings

• Line on page 454: line width and other line settings

• Font on page 455: text setttings

• Other on page 456: miscellaneous settings.

Each tab can be enabled/disabled.

The bottom of the dialog shows the name of the current parameter set, and an indication whether this
set has been modified or not: if modified, the name is suxed with a ‘+’ sign. The Revert button at the
bottom right restores the saved parameter settings from the current set.

Info
Many parameters or parameter groups have an info button at the right side of the dialog box. Clicking
this button opens a text entry dialog, where you can enter user information related to that particular
parameter.

You can click inside the text window to add or edit text.

Clicking OK stores the text to the current parameter set, while clicking Cancel disregards the changes.

The info can be seen either by clicking the info button, or in the info window of the Validator when the
appropriate rule is selected.
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The Info Dialog Box can be particularly useful for explaining non-experienced users why certain
parameters require specific values. It helps you to understand the printing process and, therefore, to
avoid more mistakes.

17.5.1.  Color

The Color tab allows you to define parameters regarding color and ink usage in a job.

Following parameters can be set:

• Maximum Number of Allowed Process Inks determines how many process inks can be used in the
job.

• Maximum Number of Allowed Spot Colors determines how many spot colors can be used.
• Maximum Number of Allowed Inks determines how many inks can be used altogether.
• Always Include in Ink Count: determines the process colors that must be counted as a used ink

even when not used in the job. This can be important if changing an ink in a printing tower is not
allowed. Some printers always keep all process colors on their press because changing an ink
comes too expensive. This means that, for example on a five color press, only 1 spot color can be
used on that press.

• Warn on RGB Inks Usage: Preflight for Illustrator will report all objects that use an RGB color
specification. Only RGB colors defined in Illustrator are considered, if e.g. an RGB image is
imported, Illustrator does not generate extra colors.

• Treat Registration Color as Process Color: When activated, the color “registration” is regarded as
CMYK components, thus counted as 4 inks, even if no or less than 4 process inks are in the job. This
is useful in a composite workflow, where often registration marks are converted to CMYK by default.

 

 

This is a traditional CMYK setup, for a 4 tower press
which only prints process inks. If any spot colors are
defined and used in the job, Preflight for Illustrator
will report this and request to convert to CMYK.
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In this setup, the 4 process colors plus one spot color
may be used. If more than one spot color is used in
the design, Preflight for Illustrator will notify you.

 

 

This is an example for a 5 tower press, where 3 spot
colors can be used. If the design contains 2 process
inks only, and 3 spot colors, there is a valid situation.
Other valid combinations are: 3 process / 2 spot 4
process / 1 spot.

 

 

In this example the C, M and K ink should always be
counted, even if they are not used. This means that,
if the job contains e.g. black, cyan, yellow and 2 spot
colors, an error will be reported, although only five
inks are used.

17.5.2.  Image

The Image tab allows you to define parameters regarding imported images.

Following parameters can be set:

• Check on EPSF images If any EPSF (EPS) images are referred to in the job, Preflight for Illustrator
will notify you.
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• Check on TIFF images, If any TIFF images are referred to in the job, Preflight for Illustrator will
notify you.

• Check on Other images, this option will invoke notification if the design references external images
which are not EPSF and/or TIFF.

• Check on Embedded images, this option signals if the design contains embedded images (not
linked).

• Check on RGB images, this option signals whether the design uses RGB images of any type.

• Check Resolution of Images when enabled, the resolution of all images will be compared to the
specified values. A minimum and a maximum resolution setting is available for both Contone and
Bitmap images.

17.5.3.  Line

The Line tab sets parameters for linewidths.

Min Width for Negative Line will report a problem for negative lines that are thinner than the specified
width (see Negative Strokes on page 454).The value for “negative “ color can be defined in the Other
tab, with the Color is Negative if Percent Below... parameter.

Min Width for Single Ink Line will report a problem for single color lines that are thinner than the
specified width (single color means that the color of the line only contains one ink component).

Min Width for Multi Ink Line will report a problem for multi ink lines that are thinner than the specified
width (multi ink means that the color of the line contains more than one ink component).

Warn if Line has More Than 1 Ink will report a problem if the design contains stroked objects where the
stroke color contains more than 1 ink.

Caution:

Preflight for Illustrator does not take brushstrokes into account.

Negative Strokes
Preflight for Illustrator compares the values of object attributes to the values stored in a Parameter
Set. This means that relations between objects are ignored.

The above has an impact on the Preflight for Illustrator definition of “NEGATIVE” strokes: A 3% cyan
stroke with a 1 mm width on top of a dark background is regarded as “negative”, while 2 dark rectangles
with a 1 mm gap inbetween on a 3% cyan background do not trigger a “negative” situation. Actually,
the program does not look at the background (since only individual object attributes are regarded), if a
stroke has a color of which the sum of percentages of ink components is below the predefined value,
the stroke will be assigned “negative”, regardless of the underlying color.
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Finally, the detection of a negative line (or color, for “negative fonts”) is based on the sum of all ink
percentages, and so NOT on the luminance of an object. 5% yellow is as negative as 5% black or 2%
cyan plus 3% magenta.

17.5.4.  Font

The Font tab parameters search your job for fonts that may cause diculties in printing because their
size is too small or some parts of the characters are too small.

Also, text which is perceived as ‘negative’ will be more dicult to print in the same small sizes as
‘positive’ characters.

Small text built up with more than one ink can be misregistered and, as a consequence, look fuzzy in
print.

Following parameters can be set regarding Fonts:

 Minimum size for Single Ink text will report a problem if single ink text is found that has
a smaller font size than the specified value (where single ink means that the color of the text only
contains one ink component).

 Minimum size for Negative text will report a problem if negative text is found that has a
smaller font size than the specified value (negative is defined later in this document).

 Minimum size for Multi Ink text will report a problem if negative text is found that has a
smaller font size than the specified value (where multi ink means that the color of the text contains
more than one ink component).

By default, the same settings apply for all types of fonts. However, separate settings can be entered for
Serif fonts and Bold fonts (Serif fonts have a short decorative line at the start or finish of a stroke in a
letter, and are therefore more dicult to print).
 

 

The following logic applies when checking fonts:

• if a font is both Serif and Bold: If Check on Serif Fonts is enabled, the Serif parameter setting is
applied. If Check on Bold Fonts is enabled, the Bold parameter setting is applied. If both items are
enabled, the highest value will apply.

• For Bold fonts: If Check on Bold Fonts is enabled, the Bold parameter is applied. Otherwise the
standard settings are applied.

• For Serif fonts: If Check on Serif Fonts is enabled, the Serif parameter is applied. Otherwise the
standard settings are applied.

• For all other fonts, the standard settings are applied.
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Minimum x-height allows to check for a minimum x-height of the font family. The x-height is the height
of the letter "x"

Build Font List This option will build a list with all fonts available on your system. Clicking this button
has the same result as selecting the Show Font List option in the Window Submenu.

This list is automatically created or updated when launching Illustrator, but in some situations (e.g.
when activating new fonts while working on a job) an update might be necessary.

For more details on this, see The Font List on page 447

17.5.5.  Other

The Other tab contains all parameters that are dicult to be catalogued within one of the other tabs:

Minimum Dot percentage will report a problem, if colors are used that have an ink component using a
density value below the specified percentage. Zero percent will always be ignored.

Maximum Dot percentage will report a problem, if colors are used that have a component using a
density value above the specified percentage. 100% is treated as an exception: if Include Solid is
enabled, 100% components will also report a problem, while if disabled, no problem will be reported.

Minimum Object size will report a problem, if objects are found that have a bounding box that is smaller
than the specified value in horizontal and/or vertical direction.The unit of measurement is adapted
from the current settings in the Illustrator Units & Undo Preferences.

Maximum Total Density will report a problem if the total sum of color components of a color exceeds
the specified value.

Color is Negative determines the total sum of percentages of ink components that still determine
whether a color is negative: if the sum is below the specified value, the color is regarded as negative.

Check for Non-Printing Layers will report a problem if a layer is non-printable.

Note:  A known limitation: Assume the check parameters are set as follows: min: 3%, max 97
%, assume that you have a gradient from 0% to 97%. This gradient will not be flagged as wrong
even though the minima are not respected. This is because white (0%) is always ignored and
because Preflight for Illustrator does not check in between stops, it only checks the actual
stops, in this case: 0% and 97%.

17.5.6.  Preflight Parameters fly-out menu

The Preflight Parameters palette fly-out menu offers a number of additional functions:

Open Parameter Set... allows you to open a previously saved parameter set. There is no need to
browse, Preflight for Illustrator stores its parameter sets in a dedicated directory. If a set is password
protected, the password must be entered in order to load the set.
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Save Parameter Set will save the current parameter set in a predefined Preflight for Illustrator
directory on the BackStage Server or on a DeskPack Container. Enter an appropriate name for the set,
according to company workflow standards. If applicable, enter a password in the password field. It then
will be requested when loading the set.
 

 

Save Parameter Set as... allows you to save the current parameter set with a different name.

New Parameter Set... creates a new parameter set with the default values.

Import Parameter File... allows you to browse to a user-defined folder or location, imports a previously
exported parameter set and adds it to the used parameter set list.

Export Parameter File... allows you to browse to a user defined folder or location and save the
parameter file with the current parameter file name, or allows you to enter a new name, possibly with a
password.
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17.6.  Thin parts

The Thin Parts function allows to search for areas where objects are thinner than a given minimum
width.

The Thin parts dialog can be opened by selecting Window > Esko > Preflight > Thin Parts

 

 

There are two methods to fix Thin Parts.

• You can Expand thin parts. This creates small objects over the areas where thin parts are found.
You can use this method by selecting Expand All Thin Parts or Expand Enclosed Thin Parts. See
Expand Thin Parts on page 459

• You can use Offset Selection, which creates duplicates of the selected objects shifted over a set
(small) distance, hence fixing any thin parts. This gives beter results e.g. for chinese characters.
See Offset Selection on page 462

The image underneath shows:

1. The original
2. The result of fixing using Expand
3. The result of fixing using Offset Selection.
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You can remove all thin part fixes in your selection by selecting Remove Fixes from the fly-out menu.

17.6.1.  Expand Thin Parts

Expanding Thin Parts creates small objects over the areas where thin parts are found. You can use this
method by selecting Expand All Thin Parts or Expand Enclosed Thin Parts

Clicking the Collect button, will create a Collection of all occurrences, showing all locations where
parts of objects are thinner than the entered Minimum Width.

Note:  Keep in mind that strokes are NOT considered.

Note:  Patterns are not supported. Objects with patterns might cause unexpected results
when using the Thin Parts functions.

The Collection palette will open, so you can browse through all occurences found. See Collection on
page 142 for more information on using a Collection.

Be aware that the Collection generated by Thin Parts, unlike normal collections, does NOT contain any
real objects. Instead it contains "occurences", virtual outlines of places where objects are thinner than
the entered Minimum Width, possibly including the suggested fix.

In the example underneath you can see that at the ends, the lines around the logo are smaller than the
Minimum Width. The red (virtual) objects show the suggested fix.

 

 

Note:  Since the Collection doesn't contain real objects, the Select option is disabled in the
Collection palette.
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Fixing all Thin Parts
You can use the Thin Parts function to automatically create fixes:

1. Open the Thin Parts palette and select Expand All Thin Parts or Expand Enclosed Thin Parts
2. Enter the desired Minimum Width
3. Click Collect

In the Collect palette, you can browse through the Thin Parts, and check the suggested fixes.
4.
5. In the Thin Parts palette, click the Fix button.

The Fix function will create objects (as shown in the Collection), immediately on top of the original
objects, fixing all Thin Part occurrences.

6. In the Select By Attribute palette, select "Thin Parts" in the Object Type section.
7. Click the Collect button
8. In the Collection palette, browse through all fixes, and correct or delete them as necessary.

Fix Thin Parts tool
You can use the Thin Part Tool to interactive create fixes:

1. Open the Thin Parts palette and select Expand All Thin Parts or Expand Enclosed Thin Parts
2. Enter the desired Minimum Width
3. Click Collect
4. In the Collect palette, browse through the Thin Parts, and check the suggested fixes.
5.

Select the Fix Thin Part tool 
6. Click the Thin Parts you want to fix

The Fix Thin Parts function will create objects (as shown in the Collection), immediately on top of
the original object.

Thin Part fixes created with the Fix Thin Part tool can also be selected using Select By Attribute. See
Select by Attributes on page 138

Thin Parts settings
Minimum Width: the minimum width below which parts of objects are shown as a "Thin Part"
occurence.

Expand All Thin Parts: If this option is chosen, all thin parts will be flagged. (In the example
underneath: the result on top)

Expand Enclosed Thin Parts: If this option is chosen, parts of objects are only flagged as Thin Parts
if the thin part is in between two parts of the object above the Minimum Width. (In the example below:
the result shown at the bottom)
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Suggest Fixes (in the Fly-out menu): If this option is enabled, Thin Parts will show the suggested fix,
instead of just highlighting the Thin Part itself.

Show Centerline (in the Fly-out menu): If this option is enabled, the centerline of the thin part is shown.

Thin Part fixes with transparency
When fixing Thin Parts on objects with transparency, the Thin Part Fix will have no transparency set.
This is shown in the image underneath, where you see an object with 50% opacity, and the thin part fix
at 100% (1).

Although it seems an easy fix, changing the opacity of the Thin Part Fix to 50% does not give the
expected result (2).

The workaround is to set both the object and the Thin Part fix at 100%, put them in a group and apply
the 50% opacity on the group (3).
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17.6.2.  Offset Selection

Unlike the Expand options, the Offset Selection option will affect the complete selected objects, and
not only the detected thin parts.

It will create a visual offset of the original object, over the Angle, the Horizontal Offset and Vertical
Offset as defined in the Finetuning Options. The image in the palette gives an indication of the result.
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1. Select the object you want to fix
2. Open the Thin Parts palette and select Offset Selection
3. Click the Fix button to create the Offset using the default values
4. In the Finetuning Options you can modify the Angle, Horizontal Offset or Vertical Offset
5. Click the Update button to apply the values you entered.

Note:  The Offset Selection option can only be used in combination with the Fix button. You can
not create a Collection, or use the manual Fix Thin Parts tool.

17.7.  The Validator palette

The parameters to Preflight are set in the Preflight Parameters palette (see The Preflight Parameters
on page 451) but the actual checking is performed using the Validator palette. This dialog contains
an overview of all rules that will be checked.The list can grow or shrink according to the options or tab
sheets that are enabled.

First, a parameter file is selected. This is done either by interactively defining the parameters in the
Preflight Parameters, or by selecting a parameter file in its fly-out menu.
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Parameter sets can also be selected in the Validator tab. A pulldown menu allows you to choose from
sets which were previously imported with the Import Parameter File... option in the Validator fly-out
menu.

The Check button will perform the actual inspection. The list is then updated to reflect the reported
problems and/or occurances.

The Stop at violating rule option determines whether Preflight for Illustrator will perform all tests or
stops at the first one that reports problems.

The indicator on the right, above the list box is the overall status indicator. Whenever one or more rules
indicate irregularities, this icon reflects this, to avoid missing out an error while scrolling the list:

•
 A grey dot means that the job has not been checked yet, or the design was changed after the

latest check, possibly introducing new problems, which makes a new inspection necessary.

•
 A green dot indicates the job has been checked and no problems have been found.

•
 An exclamation sign means that anomalities have been found.

Each rule can be in 4 states:

 

 

1. The rule has not been checked, or the latest check is no longer valid.
2. The rule has been checked successfully.
3. The rule has been checked, and 4 anomalities were found.
4. The rule has been checked, 6 anomalities were found, and the 2nd irregular object is currently

selected in the Illustrator job.

After checking, the dialog changes as follows: If Stop at Violating Rule is enabled, the rule indicators
will turn green upto the one that reports an irregularity. This one shows a yellow exclamation mark. The
following rule indicators will stay grey. If Stop at Violating Rule is disabled, all rule indicators will show
green except for those with a problem, which will be yellow.

In both cases, the Select First button will be enabled after a check. Clicking it will select the first
violating object. The button then changes to Select Next. After every violating object has been
selected, the button is disabled again.

Activating the Select All button selects all violating instances for the currently selected rule. Clicking
Check again will recheck the design, from the selected rule onwards.

Note:

If Adobe Illustrator Units and Undo preferences are set on pixels, the Valdator will provide no
information (e.g. on minimum object size and such.
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17.7.1.  The Validator fly-out menu

The fly-out menu of the Validator palette shows the following options:

Show/Hide Info: This toggle adds or removes an extra info field at the bottom of the Validator window.
After checking your job, selecting individual report lines then shows extra information, like the
parameters used for that particular report line. If the button Show Parameter Values is disabled above
the info field, the text window will only show user defined info.

Import Parameter File... imports a parameter file that was exported with Preflight for Illustrator. The
parameter file is saved automatically in a dedicated directory, and added to the parameter file list in
Preflight for Illustrator

Ignore Invisible Layers This feature will prevent Preflight for Illustrator from analyzing invisible layers,
hereby overruling the setting in the Preflight for Illustrator Parameters palette.

Auto Select First Violation If any, this option automatically selects the first anomalies found after a
check.

Zoom to Selection When activated, the object which reports anomalities will be zoomed into, and
centered in the Document Window.

17.8.  Select by Attributes

Select by Attributes opens the Select by Attributes palette, from which you can define a custom
selection filter based on the attributes of the objects in the Illustrator document.

Select By Attribute is both a productivity and a QA tool. It allows you to quickly select all elements in
the file (or sub-select within a selection) that comply with your criteria; color, object type, appearance
and even the shape of the object. Use it as a QA tool to trace elements in your document that are
outside the printing specifications (small text, thin lines, ...).

Click Select > Esko > Select By Attributes, to open the Select By Attributes palette.

Why Select by Attributes?
By combining multiple selection criteria in the Select by Attributes panel, you can create your own
special, tailor-made selection filter.
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The Select By Attributes option comes with four buttons Select, Refine, Deselect and Collect.

• Select: Select all objects in the document that match the criteria that are currently selected .

• Refine: Refine the current selection by adding additional selection criteria. This allows you to
quickly fine tune your result.

• Deselect: Deselect all objects that match the new selection criteria within the current selection.

• Collect: Make a Collection of all the objects in the document that match the criteria that are
curently selected. See Collection on page 142

Selection groups
The following groups of selection criteria are available:

• Object Type
• General Attributes
• Fill and Stroke
• Appearance
• Color

It's good to know that Select By Attributes works differently when combining selections within the
same selection group or when combining selection criteria in different selection groups.

When adding selection criteria in the same selection group, Select by Attributes will simply add the
search criteria, e.g. searching in "Object Type" for a "Path", "Text" and a "Mesh" will result in a selection of
all paths, all text and all mesh objects.

However when combining selections in different selection groups, Select by Attributes will combine
the selection criteria. e.g. searching for "Text" in "Object Type" and "Stroke" in "Fill and Stroke" will only
select text objects colored with a stroke.

Note:  Click on a triangle to collapse or expand the section. Alt-click on an expanded section to
open all the sections. Alt-click on a collapsed section to expand that secttion and collapse all
others.

17.8.1.  Object Type

The Object Type group has 11 options:
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• Path: Select objects based on the path type: Open, Closed or Compound. Using Any option, the
selection is made between objects which are Open, Closed or Compound.

• Text: Select all text, or all text smaller than the point size you specify in the Text field.
• Symbol: Select all the objects that are Adobe Illustrator symbols.
• Linked File: Select objects or images which have been linked to (and not embedded into) the Adobe

Illustrator file.
• Image: Selects all placed image files of the file type defined in the list. The image has to be

embedded in the file.
• Mesh: Select all objects that are Adobe Illustrator Mesh objects.
• Dynamic Barcodes: Select dynamic barcode objects generated by the Esko Dynamic Barcodes

plug-in.
• Dynamic Table: Select dynamic table objects generated by the Esko Dynamic Tables plug-in.
• Dynamic Object: Select XML-driven dynamic objects generated by the Esko Dynamic Content plug-

in.
• Thin Part Fix: Select objects created by using the Fix button in the Thin Parts function of the

Preflight For Illustrator plugin.
• Trapping Tags: Select objects that have a Trapping Tag or Reverse Trapping Tag defined, used by

Esko Trapping.

17.8.2.  General Attributes

The General Attributes group has three options:
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• Name: Select an object by typing its name. The name of an object can be found and modified in the
Illustrator Layer palette. Object names are by default placed between angled brackets (< >). Note
that you do not need to type the brackets, and that object names are case sensitive.

• Size: Select the size of the object (smaller or bigger than the typed size in mm).

• Shape: Select the objects which are of the same shapes as defined in the list. Note that the Similar
as Selected Objects option will only function if an object is selected.

17.8.3.  Fill and Stroke

The Fill and Strokes group has two options:

• Fill: Select the objects with a fill.

• Stroke: Select all strokes, or strokes smaller than the size you specify in the Text field.

17.8.4.  Appearance

The Appearence group has seven options:

• Current Style: Select objects similar to the selected object. The selection is tied to the style of the
Illustrator color palette. This means that you can also search for any object with a certain style.

• Fill Type: Select the objects with a certain Fill type. You can choose between Solid, Gradient or
Pattern.
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• Opacity: Select the objects that have a fill or a stroke with an opacity level or transparency lower
than a certain percentage.

• Blending: Select objects that have a fill or a stroke set with one of the blending types, for example
darken or multiply . Select a blending mode from the drop down list.

• Overprint: Select the objects set in overprint.

• Opacity Mask: Select any objects with an Opacity mask linked to it. Opacity masks are used to alter
the transparency of objects and can also be selected via the "Opacity" option.

• Effects: Select any object that has an Adobe Illustrator Effect applied to it.

17.8.5.  Color

The Color group has several options:

• Fill Contains Ink: Select an object based on the ink used for its fill. This can be a process color ink or
a spot color ink.

• Use the "Lower than" and "Higher than" options to only select the objects with certain
percentages of the ink.

• Select the No other inks present check box if you only want to select objects with a fill in the
selected ink, but without other additional inks.

• Stroke Contains Ink: Select an object based on the ink used for its stroke. This can be a process
color ink or a spot color ink.

• Use the "Lower than" and "Higher than" options to only select the objects with certain
percentages of the ink.

• Select No other inks present check box if you only want to select objects with a stroke in the
selected ink, but without other additional inks.

• Fill Color is: Select an object based on the color used for its fill. By clicking once the color patch will
take the color of the object currently selected or when no selection is made it takes the Illustrator
current style. When multiple different objects are selected and you click once the default color
black is chosen. Double-clicking the patch will open the Illustrator Color Picker.
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• Stroke Color is: Select an object based on the color used for its stroke. By clicking once the color
patch will take the color of the object currently selected or when no selection is made it takes the
Illustrator current style. When multiple different objects are selected and you click once the default
color black is chosen. Double-clicking the patch will open the Illustrator Color Picker.

Tip:  Change your current style for fill or stroke to "None" (see Tools palette or Appearance)
and select all objects with no fill or no stroke.

• White: Select any object with a white fill or stroke.

17.9.  Collection

A Collection is a temporary set of objects, based on a selection. It allows to navigate through the
objects in the Collection, automatically zooming in on them.

A collection is temporary, and only kept until it is cleared, or until the document is closed.

1. Select a number of objects.

You can select objects manually, or by using e.g. Select by Attribute
2. Choose Window > Esko > Collection... to open the Collection dialog

 

 
3. Click the Make Collection button to make a collection based on the selection

Note:  By clicking the Collect button in the Select by Attribute palette, you can skip step
2 and 3, and immediately create a collection based on the properties set in the Select by
Attribute palette . See also Select by Attributes on page 138

4. Browse through the collection
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The Collection dialog will show the number of objects in the Collection

• Use the browse buttons to navigate through the different objects in the collection
• The Info field shows the type of object currently selected
• Select the Zoom option to automatically zoom in on the currently browsed object.
• Select the Select option to automatically select the currently browsed object.

Note:

Selecting or deselecting objects doesn't change the collection. You can still select and/or
edit objects, without loosing your collection.

17.9.1.  Modifying a Collection

You can modify the Collection using one of the functions in the fly-out menu of the Collection palette:

• Click the Make New Collection button or select Make Collection from the fly-out menu to "forget"
the current collection, and create a new collection based on the current selection.

• Select Clear Collection from the fly-out menu to "forget" the current collection.
• Select one or more objects in the job, and select Add Selection from the fly-out menu to add the

selected objects to the collection.
• Browse to an object in the collection, and select Remove Selection from the fly-out menu to

remove the selected objects from the collection.

Note:  Objects that are removed in the job, are automatically removed from the collection.

• Select Select All from the fly-out menu to select all objects in the collection.
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18.  Screening

18.1.  Introduction

Screening for Adobe Illustrator is an addition to the Ink Manager (which is part of Esko Data
Exchange).

Screening for Adobe Illustrator is only usefull when working in Normalized PDF mode. For more
information on Normalized PDF vs PDF+ we refer to the Esko Data Exchange documentation.

Using the Ink Manager you can set the technical parameters of the inks. Every ink can have its own
type, ruling, angle and dotshape set. Using Screening for Illustrator you can make exceptions to these
inks parameters for specific objects.

18.2.  Screening for Illustrator workflow

The Screening for Illustrator workflow :

Note:  This workflow is specific for Normalized PDF mode. For more information on Normalized
PDF vs PDF+ we refer to the Esko Data Exchange documentation.

1. Ink Manager shows you the actual settings of all inks.

 

 
2. Select the objects of which you want to change the ink settings.
3. Select Window > Esko > Screening.

The Screening dialog appears.
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The dialog shows you all inks that are used in the selected objects including their ruling, angle,
dot shape and DGC curve. You can change the settings of these inks. You can either change one
specific ink or set the value to all inks by using the Apply To All edit boxes. If several technical
parameters of one ink correspond to the selection, the appropriate edits in the Screening dialog are
showing an unequal sign ≠.

4. After applying the inks, the specific ink’s parameters are set to the object.
5. The exceptional inks are shown in the Ink Manager table.

 

 
6. For every exceptional ink, you can edit the specific ink parameters by double-clicking the ink in the

Ink Manager, just like for the normal inks. You can also select all objects using the exceptional ink by

selecting it and clicking the Select Art Using Ink button .

473



18 DeskPack Advanced

18.3.  Use Properties from Job Setup

When a document is opened from an Automation Engine Job, for example by using File > Job Folder
> Open from Job Folder ..., you can force Ink Manager to use the ink parameters defined in the Job
Setup, overwriting the current Ink Paramters, by enabling Use Properties from Job Setup, either from

the fly-out menu or by clicking the button in the Ink Manager palette 

In that case, if you select Window > Esko > Screening..., the Screening dialog will show the status of
the inks.

•
 : the ink is defined in the Job Setup. The parameters defined in the Job Setup will be used.

You can't edit most of the properties for that ink. The DGC Curve is not part of the Job Setup
parameters, so this can be changed freely.

•
 : the ink is not in the Job Setup but is used in the document. You can modify its parameters.

If the Job Setup defines multiple variants of the same ink, all variants are listed in the dropdown menu
in the Ink Options dialog.
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For more information on using Ink parameters from the Job Setup, we refer to the Esko Data Exchange
documentation.
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19.  Shuttle

19.1.  What is Shuttle?

The Automation Engine Shuttle is a client tool for easy submission of files to Automation Engine
workflows. Shuttle also allows monitoring these workflows.

This Shuttle technology is also integrated in classic Esko editors and in Adobe Illustrator as a DeskPack
plug-in. This enables to launch Automation Engine tasks on the open file from inside these editors.

ArtPro+
Shuttle functionality is used when ArtPro+ is connected to an on-premises Automation Engine server,
and either ArtPro+ or the Automation Engine server is version 22.03 or older. Note that only launching
a workflow is available: there is no Shuttle dialog to show progress of the launched jobs from within
ArtPro+.

Launching the open document to an Automation Engine workflow is handled by "My Workspace" instead
of Shuttle functionality

• when ArtPro+ is connected to an Automation Engine SaaS server, or
• when ArtPro+ is connected to an on-premises Automation Engine server, and both ArtPro+ and

Automation Engine are version 22.07 or higher.

For more information on ArtPro+ and its connection to Automation Engine, we refer to the ArtPro+
documentation here

DeskPack
Connection to an Automation Engine server from Adobe Illustrator is handled by the Adobe Illustrator
Client plugin.

Shuttle functionality is used when Adobe Illustrator Client plugin is connected to an on-premises
Automation Engine server, and either Adobe Illustrator Client plugin or the Automation Engine server
is version 22.03 or older.

Connection to an Automation Engine workflow is handled by "My Workspace" and "Launch Workflow"
instead of Shuttle functionality when both Adobe Illustrator Client plugin and Automation Engine are
version 22.07 or higher.

Note:  When Adobe Illustrator Client plugin version 22.03 or lower is connected to an
Automation Engine SaaS server, you can use the Tasks palette to monitor tasks run on
the Automation Engine server. For more information, see the Adobe Illustrator Client
documentation version 22.03 here

For more information on Adobe Illustrator Client plugin, we refer to its documentation here

For more information on My Workspace, we refer to the Automation Engine documentation here and
the Blended Learning modules here.
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Note:  When this documentation was updated in 2020, all information on integrating Shuttle
with legacy applications Nexus and Odystar was removed. If needed, you can still find this
information in older versions of the Shuttle user guide.

19.1.1.  Shuttle Setup Overview

Using the Shuttle requires to set up your server, your Shuttle client, and make sure they can exchange
files via a shared folder.

Automation Engine Server Setup
This is done in Automation Engine’s Configure tool.

Learn more in Configuring Shuttle in Automation Engine on page 477.

Shuttle Client Setup
Set up your Shuttle client in the applications you use.

Learn more in Shuttle Clients Setup on page 486.

Shared Folder Setup
You also need to make sure that the relevant shared folders are mounted on the Shuttle client
computers, with the permission to read and write.

For Automation Engine, the shared folder is either an Automation Engine Container, or an Upload
Folder that you set up in Configure.

Learn more in Configuring Shuttle in Automation Engine on page 477.

19.2.  Configuring Shuttle in Automation Engine

1. In the Pilot, go to Tools > Configure.
2. Select Shuttle.
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3. Enter the Port to use for communication between your Automation Engine server and the Shuttle

clients.

Note:  By default this is port 5182. If this port is already used by other processes, enter the
next available port.

4. Click on  and select an Upload Folder.

This is where Shuttle clients will upload files that were not yet located in a Container, for example a
file that you drag and drop from the desktop of a Mac (except the DeskPack Shuttle plug-in, that will
always upload files to the DeskPackContainer).

Note:  The Upload Folder must be located in a Container.

5. Select 'Start Shuttle server automatically when Automation Engine is started' if you plan to make
frequent use of the Shuttle technology.

6. Select 'Use the task history to re-launch using the same public parameters' if you want Shuttle
to propose to use the same public parameters when you launch a same file on the same workflow.
The Shuttle then checks prior tasks, not just those shown in a Tasks overview pane but also those
present in the Task History tool.

7. Click the Start button to start Shuttle server.

The Shuttle server then makes Automation Engine’s workflows, tasks and files accessible to the
Shuttle clients.

8. Save your settings.

Note:  To make changes to this setup, you must first Stop the Shuttle server.

19.2.1.  Making Tickets Public

Only Public tickets (of single tasks or workflows) can be launched from Shuttle (or from the client
applications using Shuttle).
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Learn about making (workflow) tickets public here.

Note:  Default tickets and (blue) Job tickets can not be made public.

19.2.2.  Using Public Parameters in Automation Engine

Concept

Users often do not want or need to see all the parameters of a selected task ticket. You can make them
see and define only the parameters that you decided to make Public. Seeing less options makes it
simpler and helps reduce mistakes.

Ticket parameters that are made Public will be the only parameters visible to users when they want to
launch tasks from:

• Automation Engine client applications: Pilot, Shuttle and browser client workspaces.
• Esko Editors connected to the Automation Engine server: ArtPro+, DeskPack (Adobe Illustrator) and

the legacy editors ArtPro, PackEdge, Plato, FastImpose.

Note:  Only Public Tickets can be launched from these client applications or editors.

For each Public Parameter, you can decide if the user can either:

• select a value from a list,
• enter a value himself.

Making a Parameter Public

Note:

• Not all ticket parameters can be made public.
• Parameters need to be made public before you start the workflow that their ticket is part of.

Open the ticket and follow these steps:

1. Right-click the parameter and select Make Parameter Public.
2. Right-click it again and select Modify Public Parameter...
3. In the Modify Public Parameter dialog that opens:

a) Prompt as: If you want, change the way the parameter will be called in the client application.
b) Choose either:

• Allow the user to set the value: Select this if you want users to be able to freely enter a
value.
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• Let the user select a predefined value: Select this if you want users to choose from a list of
values that you define.
 

 

Note:  Users will only see (and choose from) the Predefined Settings. They will not
see the associated Values. So if they need to be aware of the value, just add it to the
name of the setting.

In the above example, this is how the public parameter will look like to the users of
the client application:

If you chose 'Allow the user to set the
value'

If you chose 'Let the user select a
predefined value'

 

 

 

 

If, in the ticket, that parameter already offers a list of values to choose from, they will be
displayed here.

Default Predefined Setting: You can here define the setting that will be used when the user
didn’t select another one.

4. Click OK.

Important:  Settings related to public parameters are saved when you save the ticket.

Important:  Don't forget to save the ticket itself as 'Public' as well.

Managing Public Parameters in a task Ticket
The Manage Public Parameters... dialog of a ticket is where you overview and manage its public
parameters. In this dialog, your goal is to make it as simple as possible for the user that is asked to set
these parameters.
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1. In your ticket, go to Advanced > Manage Public Parameters...
 

 

The left pane shows all the parameters in this ticket that can be made public. The ones that were
already made public are greyed out.

The right pane shows the public parameters and their settings.
2. You can:

• drag parameters from left to right to make them public
• click  if you don’t want it to be public anymore
• drag them up or down to rearrange the order that they will be shown to the user.
• change public parameters’ settings (Prompt as, Predefined Settings, etc.)
• group public parameters under a custom header (click Add Group, click  to edit the header

and drag parameters from the left). An example:
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• use Presets to further simplify the users' choices (see Making Presets to Simplify the Users’
Choices on page 482).

Making Presets to Simplify the Users’ Choices
Presets are customized combinations of parameters. They limit the amount of decisions that users
have to make.

Example

Let's assume you want users to use different trapping settings when printing offset versus dry offset.
You can collect those trapping settings in a Preset, so that users will only have to choose between
'offset' and 'dry offset'.

We start from a dialog of a workflow ticket where the trapping step has 3 public parameters:
 

 

1. Click  to remove the (default) Group named "Trap with PowerTrapper"
2. Click Add Group.

A new "Untitled Group" is created. Click  to change its name.
3. Click Add Preset.

A new "Preset" is created. Click  to change its name.
By default, two example values will appear. The preset was renamed to 'Choosing Process to
Decide Traps':
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4. Define what the users will see:

a) in Prompt as, enter the text that users will see (replacing 'Type the name of the preset
here (e.g. “Paper Size”)')

b) enter the values that the users will choose from (replacing 'Type a value here (e.g.
A4)'). In our example, we add 'Offset' and 'Dry Offset'.

Click Add if you want to add extra values (not the case in our example).

5. Drag the parameters from the dialog’s middle pane onto one preset item. This will make them
automatically appear under each preset item (here both under Offset and Dry Offset).
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6. Define the parameters values for each preset item.

See the above screen shot for a good example.
7. Use the buttons Move Up / Down to define the order of the Presets in the panel that the end-user

will see.
8. Click OK to confirm and close the dialog.
9. Save your ticket to also save these public parameters.

This is how the resulting dialog will look like to the users of the client applications:
 

 

19.2.3.  Setting Up Operator Routing in Your Workflow

You can build your workflow so that users will route your files to other users based on their expertise.

They will get a notification, and the processing will be paused until they decide where to send the file.

To use this in your workflow:
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1.

Add the Wait for Action (Checkpoint)  step to your workflow.
2. Double-click the step to open its settings.
3. Create the notification that will be sent:

a) Choose which user you want to send it to
b) Enter a Subject
c) Add a Message if desired
 

 
4. Choose a Due date. Either:

• choose one of the predefined due dates (from Immediate to Next sunday),
• choose Other... in the Due date list and pick the due date yourself.

 

 
5. In Output states, define the output possibilities you want for your checkpoint.

By default, this step has two outputs: Completed and Aborted.

To add an output:

a) Click Add
b) Enter the output’s name

Add as many outputs as you like.
6. If necessary, use the Move Up and Move Down buttons to display your outputs in a different order.

Note:  You can Remove the default outputs if you don’t need them.
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7. If you want your file to be automatically sent through one of the outputs if no action is taken by the

operator after a period of time:
a) Select Release automatically
b) Enter the time delay after which the file should be released
c) Choose the output to release the file to

 

 
8. Click OK to apply your settings.
9. On your canvas, the Checkpoint step has the outputs you defined. Connect each output to the

appropriate step.
 

 

Operators will be able to route files gone through the Checkpoint from the Pilot’s Tasks pane, the
workflow editor, or Shuttle.

19.3.  Shuttle Clients Setup

19.3.1.  Connecting your Shuttle Client to your Automation Engine

Shuttle Clients connecting from Editors

1. In the editor, open the Preferences.
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In... go to...

ArtPro+ Edit > Options >  Automation Engine

Adobe Illustrator • (Mac) Illustrator > Preferences > Esko > Shuttle Preferences...

• (Windows) Edit > Preferences > Esko > Shuttle Preferences...

ArtPro ArtPro > Preferences... or use Command + K

PackEdge/Plato (Windows) Edit > Preferences >  Server&Resources

FastImpose
Standalone

Tools > Shuttle Preferences...

2. Fill in the name of the Automation Engine server.
3. Enter your User Name and Password.

Enter a User Name and Password that is also valid to sign in to a Pilot.

You will have the same access rights in Shuttle as you have in the Pilot (for example the right to
change processing priorities).

Shuttle Application connecting to Automation Engine

1. Launch the Shuttle application.
2. You will be asked to sign in to an Automation Engine server

Sign in in the same way as you would do for a Pilot. Learn more in Signing In to the Pilot or Shuttle.

Tip:  If, on that same computer, you are already signed in to a Pilot or another Shuttle
client (possibly from within an editor), the system will check what you selected in Pilot > 
Configure > Login automatically with user name and password from other application
connected to the server.

19.3.2.  Setting Preferences in the DeskPack Shuttle Plug-in

When the Shuttle plug-in was installed, Adobe Illustrator offers to control these Shuttle related
preferences.

Find them in Edit >  Preferences >  Esko Shuttle Preferences....

Tab General
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• Workflow Name Format:

Note:  These settings are only relevant when the server you connect to is a legacy workflow
server like Nexus or Odystar.

Set the Workflow Name Format this way: to display the workflow name like this:

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Expand Ink Lists:

When a public parameter shows you a list of inks, define here if you want that list expanded by
default or not.

By default, the ink list is expanded when it is the most used case for that public parameter (for
example, for Proof, RIP or Export workflow steps).

Note:  This is only applied when it makes sense to add all of your file’s inks by default (for
example, it is not applied for parameters removing inks from your file).

Tab Servers
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• Servers:

See the server you decided to connect to when installing the Shuttle plug-in, including the current
connection status.

Click + to add another Automation Engine server (for example a test-server with a pre-release
software version).

Note:  The options Browse Method and Bonjour were only relevant when connecting to
legacy workflow servers Nexus or Odystar.

• Filter On Workflow Type:

For example, add DeskPack Only in the filter to only show tickets of tasks which name contains
“DeskPack Only”.

Tab Units
 

 

These units will be used when you submit a file to a workflow with public parameters.
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19.4.  Launching Files into a Workflow

19.4.1.  Launching Tasks from Adobe Illustrator (the Shuttle Plug-in)

Note:  To launch tasks from Adobe Illustrator, you need to install the Shuttle Plug-in. Download
it from https://mysoftware.esko.com/.

Follow these steps to launch a task or workflow on the file that you have open in Illustrator (and in front
of any other open files):

1. Go to File > Launch Workflow... or use Option + CMD + Z.
 

 
2. In Launch As, choose Esko PDF to copy a Normalized PDF or PDF+ version of your file onto the

DeskPack Container. Choose Adobe PDF to copy the Adobe Illustrator PDF version.

• 'Esko PDF' uses the 'PDF Export' plug-in to convert your Illustrator file to either Normalized PDF
or PDF+, depending on the setting in Ink Manager. To refine the conversion, you can select one
of the PDF Export Presets, or click Settings... and edit the PDF Export Settings. These changes
are not saved.

• 'Adobe PDF' uses the Adobe PDF preset 'Illustrator Default'.

Note:  'Color Conversion' and 'Profile Inclusion Policy' are not part of the preset
'Illustrator Default', but Launch Workflow will apply color conversion with the last
settings used.

3. If you want to link your file to an existing Automation Engine Job, fill in an existing Job ID and/or
Job Sub ID. The task on the Normalized PDF will then run in that Job context, which means it can
use the Job Setup parameters when SmartNames refer to them in the selected workflow..
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Note:  If your open file is already saved in an Automation Engine Job folder, the Job ID and/
or Job Sub ID will be filled automatically.

4. Select the task or workflow you want. If it has public parameters, fill them in.
5. Click Launch. If your file was changed since the last save, you can click Save and Launch to first

save your document and then launch the task.

19.4.2.  Launching Tasks from ArtPro+

1. To launch an Automation Engine task on the currently open file, go to  File > Launch Workflow....

This opens the Launch Workflow dialog.

 

 

• Launch as: Your open file is an ArtPro file, but you can choose as which file type you will send it
to the selected workflow.

Note:  For more information about PDF flavors or PS options in the ArtPro Print dialog,
please see the ArtPro documentation.
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• If you want to add your file to the Job Folder of an Automation Engine Job, select it from the Job
list or fill in its Job ID and/or Job Part ID.

Note:  Use the Search... button to see a list of active Jobs, including some of their
metadata.
 

 

• If you want to add your file to an Automation Engine Product, select it from the Products list or
fill in the Product ID and/or Product Part ID.

Note:  Use the Search... button to see a list of your server's Products.

• Select the workflow you want to launch.

• Fill in any of its Public Parameters.

If you want to go back to the default parameters values after changing them, click 'Reset To
Defaults'.

2. Click Launch.

19.4.3.  Launching Tasks from ArtPro

In Preferences > Servers >  Shuttle, add the name of your Automation Engine server.

Note:  In that same dialog, the tab Automation Engine serves to define other preferences
related to that server. You do not need to fill that one in when you only need this connection to
the "Shuttle Server".

1. To launch a workflow on the currently open file, go to File > Launch Workflow...

This opens the Launch Workflow dialog.
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2. Launch as: Your open file is an ArtPro file, but you can choose as which file type you will send it to

the selected workflow.

If your workflow is... you can launch the file as... with...

an Automation Engine
workflow accepting Normalized
PDF files as input,

Normalized PDF either Normalized PDF or
Normalized PDF (embedded).

an Automation Engine
workflow accepting PDF files
as input,

PDF any of the available PDF
flavors.

an Automation Engine
workflow accepting ArtPro files
as input,

ArtPro with the included images (TIFF,
EPS...) or without (then only the
ArtPro file and any ArtPro CT
file).

Note:  For more information about PDF flavors or PS options in the ArtPro Print dialog,
please see the ArtPro documentation.
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3. If you want to add your file to the Job Folder of an Automation Engine Job, select it from the Job
list or fill in its Job ID and/or Job Part ID.

Note:  Use the Search... button to see a list of active Jobs, including some of their
metadata.
 

 

4. If you want to add your file to an Automation Engine Product, select it from the Products list or fill
in the Product ID and/or Product Part ID.

Note:  Use the Search... button to see a list of your server's Products.

5. Select the workflow you want to launch.
6. Fill in any of its Public Parameters.

If you want to go back to the default parameters values after changing them, click 'Reset To
Defaults'.

7. Click Launch.

19.4.4.  Launching Tasks from PackEdge or Plato

Attention:  Before you can launch a task on it from within PackEdge or Plato, you must save
your file on an Automation Engine Container.

1. Go to File > Launch Workflow...

The dialog lists all public tickets. When selected, a ticket shows it Public Parameters.
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Tip:  When you expect tickets to show up here but none do, check if the Shuttle server is
running.

2. Select the task or workflow you want. If it has public parameters, fill them in.
3. Click Launch to launch that workflow on your open file.

Tip:  To access this "Shuttle Server" easily in the future (without using the menus):

1.

Go to Window > Toolbars > Shuttle to open the Shuttle palette. 
2. Drag it into your application's toolbar.
3.

Click  to open the Launch Workflow window. Click  to open the Shuttle window
where you can monitor and manage the launched tasks.

19.4.5.  Launching Tasks from FastImpose

When working with FastImpose Server, you must save your file on an Automation Engine Container
before you can launch a task or workflow.

1. Go to File > Launch Workflow...
2. Choose what file type you want to launch your file as.

• When working with FastImpose Server, you can only launch your file as an IMP file.
• When working with FastImpose Standalone, you can launch your file either as a JDF or a PDF file.

Click the Settings... button to set JDF or PDF Export Preferences. Learn more in the
FastImpose documentation.

3. Select the workflow you want. If it has public parameters, fill them in.
4. Click Launch to launch the workflow on your file.
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19.5.  Monitoring Files with the Shuttle Window

The Shuttle window shows all files belonging to you or to all users, in all workflows your Shuttle is
connected to.

Note:  In ArtPro+, there is no Shuttle dialog to monitor the progress of the workflows that were
launched from within this editor. ArtPro+ users however can easily monitor these workflows in
an Automation Engine browser client (or a Pilot).

To open a Shuttle window:

In... go to...

Adobe Illustrator Window > Esko > Shuttle

ArtPro, PackEdge and Plato Window > Shuttle

FastImpose View > Shuttle

The Shuttle window shows each file's name, status, the workflow the file is in, etc.

 

 

It has several areas: buttons, a filter to view files, the file list, and the Inspector panel that shows more
information.

19.5.1.  The Shuttle Window Buttons

These buttons allow to perform basic tasks on the file selected in the Shuttle window.
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Note:  You can also access these tasks in each file’s context menu.

With the Hold button you can put a file on hold from Shuttle.

With the Release button you can release a file that is on hold from Shuttle.

With the Delete button you can delete a file.

With the Abort button you can cancel your workflow’s processing from Shuttle.

With the Users button you can choose to show only your files, or all users’ files.

With the Inspector button you can open (or close) the Inspector panel to see more
information.

See also:

Holding or Releasing a File on page 502,

Deleting a File from your Workflow on page 504,

Showing Only Your Files / Everybody's Files on page 501.

The Inspector Panel on page 500.

19.5.2.  The Connection to Automation Engine

In case of a connection problem with one or more server(s) you added in the Preferences, the Shuttle
window shows a connection status:

• If at least one of the servers isn’t running, it shows: 

•
If none of the servers are running, it shows: 

Go to the Preferences and check the servers’ list.

Tip:  In the Shuttle plug-in, you can click the colored dot to open the Servers Preferences.
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To edit the connection to a server which is not running anymore, see Shuttle Clients connecting from
Editors on page 486.

19.5.3.  The Shuttle Window Filter

In the Shuttle Window, you can set criteria to filter files.

 

 

Use the filter to show only certain files, e.g. files for a specific user, for a specific workflow or process,
by status, based on the file name...

 

 

You can set extra criteria by clicking the + button, and remove criteria by clicking the - button.

 

 

19.5.4.  The Files List

The files list shows all files in the selected server belonging to either just you or all users.

It shows:

• the file’s Run Status and File Status (see below),
• its name,
• the Workflow processing the file,
• the workflow/task type,
• the user it belongs to,
• the time the file entered the workflow,
• the job ID (if any),
• the job Part ID (if any),
• the server name (if you are connected to several servers).

Note:  Click on the column headers to rearrange the files by file status, name, workflow,
starting time...

Run Status
The Run Status shows you how the processing is going so far.

File finished.
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File on hold.

File processing.

File needs attention (File in a Hold folder, where a user choice is necessary).

File is aborting.

File is deleting.

File Status
The File Status shows you the final processing state of the file.

OK.

Info: more information on the file is available.

Warning.

Error.

Fatal error: The file could not be processed.

For example,  means that the file is on hold and that it generated a warning.

19.5.5.  The Context Menu

Each file’s context menu allows you to perform several actions on the file, or to get more information
about the file.

 

 

Use this... to...

Open open either:
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Use this... to...

• the main file,

• all the files,

• the file folder.

Hold put a file on hold from Shuttle.

Release release a file that is on hold from Shuttle.

Priority increase or decrease a file’s priority rank.

Show Log... open the log of the selected file.

Delete delete the selected item from the server (this deletes the task for Automation
Engine workflows).

Abort cancel the selected file’s processing in your workflow.

Filter on Job ID show only the files that have the same Job ID as the one you selected.

Note:  This is only available for files that are in an Automation Engine
Job.

See also:

Opening Files / the Enclosing Folder on page 501,

Holding or Releasing a File on page 502,

Changing a File's Priority on page 502,

Opening the Log file on page 503,

Viewing a File's Relations,

Routing Files that Need a Decision on page 503,

Deleting a File from your Workflow on page 504.

19.5.6.  The Inspector Panel

The Inspector panel shows information about the file you selected.
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In the More Info area, you can raise or lower the file’s priority.

If you have sent several files at once to your workflow, the Files area will list them all.

The Messages area shows any messages generated by the workflow during processing.

19.5.7.  Showing Only Your Files / Everybody's Files

•
Click  to only show your files in the Shuttle window.

•
Click  to show all users’ files.

19.6.  Working with Shuttle when your File is Processing

19.6.1.  Opening Files / the Enclosing Folder

You can open any file that has a tag (from an Odystar canvas) or a label (from a Nexus workflow) from
Shuttle. You can also open the enclosing folder (for Nexus workflows).

• To open the main file, double-click it in the Shuttle window list.
• To open another related file:
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a) right-click the main file in the Shuttle window list,
b) select Open in the context menu,
c) click the name (files in Automation Engine workflows) of the file you want to open.

Depending on your workflow type and on where your job is in your workflow, opening the main file has
different results:

For... if your job is... opening the “main” file opens...

paused in a Wait for Action
(CheckPoint) step

the input file of the Wait for Action
(CheckPoint) step.

Automation Engine
workflows

running anywhere else in the
workflow

the output file of the last workflow step
completed.

19.6.2.  Holding or Releasing a File

Check which files you can hold or release:

For.. you can hold or release... when...

Automation Engine tickets everybody’s files your user has sucient
privileges in the Automation
Engine Pilot.

• To hold or release a file, you can either:

• right-click it and select Hold or Release in the context menu,
•

select it and click the Hold  or Release  button.

19.6.3.  Changing a File's Priority

Check which files’ priority you can change:

For.. you can change the priority of... when...

Automation Engine tickets everybody's files your user has sucient
privileges in the Automation
Engine Pilot.

• To change the priority of a file, you can either:

• right-click it and select Priority > Increase or Priority > Decrease in the context menu.
•

select it and click either  or  beside Priority in the More Info area of the Inspector (to
either increase or decrease the file’s priority).
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19.6.4.  Opening the Log file

• To open a file’s log, right-click it and select Show Log...

19.6.5.  Routing Files that Need a Decision

When your file is paused in a workflow and needs a user decision to take one of several workflow paths,
you can route it from Shuttle.

This is the case for files in a Wait for Action (Checkpoint) workflow step in Automation Engine.

Note:

The user name used in the Checkpoint step settings and the user name used in Shuttle to
connect to Automation Engine must match.

In the Shuttle window, you see an icon ( ) indicating that the file needs attention.
 

 

The Inspector panel also shows an attention icon, and the notification defined in your workflow.
 

 

To route the file, you can either use:

1. the Shuttle processing list:
a) Right-click the entry that requires attention (the exact workflow step and not the main workflow

entry) and select Attention in the context menu.
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This shows the message and output options set in your Hold Gateway, Decision or Wait for OK
Activity, or Checkpoint step.

b) Select one of the output options to route the file.
2. the Inspector panel:

a) Select the file with the attention icon in the list to show it in the Inspector panel.
b)

Click  and select one of the output options to route the file.
 

 

19.6.6.  Deleting a File from your Workflow

Check which files you can delete:

For.. you can delete... when...

Automation Engine tickets everybody’s files your user has sucient
privileges in the Automation
Engine Pilot.

• To delete a file, you can either:

•
select it and click the Delete  button,

• right-click it and select Delete.
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20.  Text Recognition

20.1.  Text Recognition

DeskPack Text Recognition for Adobe Illustrator is a plug-in to convert vectorized (contourized)
text back into live editable text. This can be used e.g. to do last-minute text corrections on packaging
artwork.

1. Choose Window > Esko > Text Recognition to open the Text Recognition palette.
 

505



20 DeskPack Advanced

 
2. Select the outlined text that you want to convert.
3. Set the Text Orientation and the Language. See also Languages on page 508
4. Click Convert to Live Text

Text Recognition will search your locally installed fonts for the best matching fonts, and
immediately show the text converted to the top matching font.
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a) Select a different font from the list to see the converted text using the selected font.
b) Click and hold Hold to View Original to hide the converted text and see the original outlined text.
c) Enable Highlight Differences to highlight characters that are not correctly recognized.
d) If a character was not recognized or replaced by the wrong character (e.g. a zero instead of an

"o"), you can select the character in the text, correct it and click the Re-align Text  button, to
align the corrected text with the original outlined text.

e) Even though the Text Recognition plugin tries to clean up the converted text, sometimes there
will be inaccuracies in the text recognition result, such as jumping text baselines, different font
sizes, etc. Using the Even Out Character Settings, you can even out these differences to achieve
a better recognition result.
 

 

Note:  You can also perform the Even Out Character Settings function after the Clean
Up & Finish.

5. When you're happy with the result, you can click the Clean Up & Finish button. This will remove the
original outline from the document and close the Text Recognition session, leaving you with a live
text object that you can edit as needed.

Note:  If you want to keep the original contours as well as the live text, you can enable Keep
Original in the fly-out menu of the Text Recognition palette.

20.2.  Known limitations

• Text in an image is not supported. Only linework text can be recognised.

• Text Recognition might not give acceptable results if two lines of text are too close to each other.
You can work around this by selecting and converting one line of text at a time.

• Vertical text or right to left text is not supported.

• Text on a path can not be recognised.

• You can only have one active Text Recognition session. That means that as long as you don't close
the session by using Clean Up & Finish or by undoing it, you can't use Convert to Live Text on
another outlined text object.
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20.3.  Languages

Although not strictly necesssary, text recognition will work best if you specify which language is used
in the Text Recognition window.

By default, only English is installed and available in the Language dropdown list.

If you select "Download Languages", the Download Languages dialog will open.

 

 

Click the Download button for the additional languages you want to install. You need internet
connection to do this.

If you have a text box containing mixed languages, text recognition can be less accurate. In this case it
is advised to select the language with most accents and specific characters.
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21.  Viewer

21.1.  Welcome to Viewer

Benefits of using Viewer
Viewer is a very accurate separation viewer with a lot of extra production tools. It eliminates the need
for separated proofs and will help you to avoid bad plate-making.

You can preview the separations of your document as they would be produced by exporting the
document using Launch Workflow, and rasterizing it on an Esko FlexRip.

Note:

Separations shown in Viewer may differ from the final output when an alternative workflow is
used.

Basic concepts
Viewer works with Press Settings. The Press Settings allow you to define press-specific
characteristics such as the first printable dot, dot gain, dot gain curves, and more.

After defining your Press Settings, you can generate an accurate separation preview.

In this preview, you have access to advanced tools such as the Densitometer, TAC Limit Preview, Plate
Preview, Print Preview and Registration Error Preview.

Normalized PDF or PDF+
Certain functions might be slightly different if you are working in Normalized PDF or PDF+. For more
information on Normalized PDF versus PDF+ we refer to the Ink Manager documentation (part of Esko
Data Exchange for Adobe Illustrator) here.

21.1.1.  Viewer and Viewer (deprecated)

In Viewer for Adobe Illustrator 21.07, the Viewer was completely replaced by a new version. This new
Viewer is using native PDF technology, and is based on the Viewer functionality in Esko's ArtPro+
application.

The new Viewer will completely replace the existing Viewer plugin. However, during a transition period
the older version of the Viewer is still available next to the new one, under the "Viewer (deprecated)"
name and menu entrance.
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21.2.  The Viewer window

You can open the Viewer window by selecting Window > Esko > Viewer > Viewer or by its shortcut
Comand-Option-V (Mac) or Control-Option-V (Windows).

21.2.1.  Define Press Settings

Before you can start working with Viewer in a meaningful way, you should define your Press Settings.
Without basic information on the properties of the press you are using, Viewer cannot simulate
accurately.

1. In the fly-out menu of the Viewer window, select Press Settings...

The Press Settings dialog will open.

 

 

• In the list of Press Settings, there is always one Press Setting called Default, which you can edit
but not delete.

• Click New to create a new Press Setting. You can enter its name, and change its parameters. See
The Press Setting parameters on page 511

• Select a Press Setting and click Copy... to create a new Press Setting based on the parameters
of the selected Press Setting. After entering a name, you can edit its parameters. See The Press
Setting parameters on page 511
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• Select a Press Setting and click Edit... to edit its parameters. See The Press Setting parameters
on page 511

• Select a Press Setting and click Remove to delete the Press Setting.
2. Click Close to close the Press Settings dialog.
3. You can select the Press Setting to use using the Press dropdown in the Viewer window

The Press Setting parameters

First Dot (%)
Specifies which minimal gray value (expressed in %) in the file still will yield a dot on the plate, provided
the RIP and platemaking occur under normal conditions.

Note:

Normal conditions indicate that the DGC must have been set up completely. The value does not
correspond with any measurement that has been made prior or during DGC set up, nor does
it correspond with any densitometer measurement on plate or on print. In fact, this value is
(implicitly) chosen by the person who set up the DGC and plate-making. Typical values range
from 0.4% to 1.6%.

Adobe Illustrator uses 8-bit precision, yielding 256 different possible gray values. A single gray value in
an image may make the difference between a dot or no dot on a flexo plate. To allow for this precision,
Viewer uses percentages with one decimal digit.

8-bit gray value in Illustrator Percentage

0 0.0%

1 0.4%

2 0.8%

3 1.2%

... ...

254 99.6%

255 100%

Note:

If you do not specify a first dot, you will not be able to use the following Viewer view modes for
this press setting:

• The Flexo Plate Preview

• The Flexo Print Preview

Dot Gain in Highlights
When you have specified a First Dot job percentage, you can also specify how dark it should actually
print. Enable Dot Gain In Highlights and specify the dot gain parameters:
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• First Dot Prints As: indicates the dot gain for the first dot. Typical values range from 5% to 15%
depending on the substrate. The value is a job percentage, that will print on an ideal reference press
as dark as the first dot prints on this press.

• Range: while the previous value measured the amount of dot gain in the highlights, this value
expresses how far this effect penetrates into the midtones. Typically plate making is configured in
such a way that the mid-tones print like an offset press.

Note:

If you do not specify Dot Gain In Highlights, you will not be able to use the following Viewer
viewing mode: Flexo Print Preview.

Limited Total Area Coverage
The Total Area Coverage is the sum of percentages of the different channels on the same location. A
higher total area coverage means more of the various inks is printed on top of each other.

If you want, you can specify the Maximum Total Area Coverage to specify the maximum amount of ink
that the substrate can take on the same spot on your press.

Note:

Exceeding the Maximum Total Area Coverage for the press may cause drying problems,
unexpected color results, and other problems.

Registration Error
Specifies the average maximum Registration Error on your press.

If you enable this option in the Press Settings, you can use the Registration Errors preview in Viewer to
check whether your trapping is sucient to compensate for possible registration errors on the press.

Moiré Settings
In the Moiré Detection settings of the Press Settings, you can define the default values for the settings
in the Moiré Detection window.

For more info on the different settings, see Moire Detection on page 528

21.2.2.  Generate the Preview

Before you can use Viewer, you have to generate a preview of the current document, based on your
specific Press Settings.

• In the Viewer window, you can click the Generate button.

• In the menu, you can choose Window > Esko > Viewer > Generate. This will also open the Viewer
window if it isn't open yet.

• You can also use the shortcut Command+shift+7 (Mac) or Control+shift+7 (Windows).

The preview is displayed in the Viewer palette once the rendering finishes.

After you make changes to the document, you need to update the preview. This is reflected in the
Viewer window: the Generate button changes to the Update button. You can also choose Window >
Esko > Viewer > Update or use the shortcut Command+shift+7 (Mac) or Control+shift+7 (Windows).
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21.2.3.  Navigating in the Preview

The Viewer window shows the preview of your document in the left pane, and the list of used inks in the
right pane of your Viewer palette.

At the bottom of the palette, you will find:
 

 

1. a zoom-in and zoom-out button and a dropdown menu with several zoom percentages, and two
extra zoom factors: fit artboard and fit graphics.

2. a zoom-link button. When in link mode, the Viewer window will reflect what your Adobe Illustrator
Document window does.

3. a Densitometer (see Measure Ink Densities on page 513), Measure tool (see Measure Tool on page
514) and Zoom tool (see Zoom Tool on page 515).

Note:

You can minimalize the user interface by selecting Hide options from the dropdown menu. You
can choose Show Options to make the full interface visible again.
 

 

Measure Ink Densities
1. Select the Densitometer tool.
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2. Click in the preview pane to measure the density of a specific point, or click and drag a rectangle to
measure the average density of the area

The densitometer will correctly measure through linework and images, even placed DCS2 multichannel
images that normally cannot be measured in Adobe Illustrator.

Viewer is compatible with Xinet fullpress and Helios OPI systems and is able to show the high resolution
images stored on the OPI server.

The densities are shown to the right of each separation. The total density of all inks on the point that is
being measured (the TAC value) is shown at the bottom of the separation list.

 

 

Note:  The percentages of Technical Inks or Processing Step Inks are not included in the TAC.
See also Technical inks and Processing Step Inks in Viewer on page 521

Measure Tool
Measure tool helps you to measure the:

• Horizontal and vertical distance from the Adobe Illustrator axis zero point.
• Horizontal and vertical distance between first and second point.
• The total distance and the angle between first and second point.

To use the Measure Tool:

1.
Click the Measure tool  on the Viewer pallet.

2. Click the first point and then click or drag to the second point on the Preview.

The following details are displayed on the right hand side;

• X: x-axis
• Y: y-axis
• D: Distance between the first and second point.
• W: Width
• H: Height
• A: Angle
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Zoom Tool
To zoom in the preview pane of the Viewer palette, select the zoom tool and just click, and the view will
zoom in using the clicked point as center point.

To zoom out, click while holding the Alt key pressed, and the view will zoom out using the clicked point
as center point.

You can also drag a rectangle to zoom in, and the new viewport will be a closest match to the rectangle
you dragged.

To pan the view, hold down the spacebar and drag a line in the preview pane. The view will move the
direction and the length of the line you drag.

21.2.4.  The Separations list

In the Ink list, you can:

• Click the eye icon in front of a separation/color name to show or hide it.
• Alt-click an eye button to quickly hide all other separations and go in single-separation mode. Alt-

click the same eye button again to show all separations.
• You can use the fly-out menu to decide if you also want to see the Printing Method for every ink.

When working in Normalized PDF, you can also decide if you want to see the Ruling, Angle, Dot
Shape or DGC curve.

• When only one separation is visible, you can use the buttons above the separations list to inspect
the single separation in different modes:
 

 

1. Color: the single separation is shown in its own color
2. Positive film: the single separation is shown in black
3. Negative film: the single separation is shown in black, but negative.

• You can double-click a separation to open the Ink Options. See the Ink Manager documentation
(part of Esko Data Exchange for Adobe Illustrator) here for more information.
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Note:  If Show Technical Inks or Show Processing Step Inks in the fly-out menu of the Viewer
is enabled, Technical Inks or Processing Step Inks are also shown in this list. See also Technical
inks and Processing Step Inks in Viewer on page 521

21.2.5.  Quality Control

In the Quality Control section you can perform some quality control functions.

• Check the Total Area Coverage: see Total Area Coverage on page 516

• Check for highlight Breakout: see Breakout on page 516

• Check your document in Flexo Print Preview: see Flexo Print Preview on page 518

• Check for Moiré: see Moiré Detection on page 518

• Visualize the used Screen Sets. See Object Screening on page 519

• Check your trapping by showing a Registration Errors: see Registration Errors on page 519

The Quality Control section is not availabe in Viewer (deprecated)

Total Area Coverage
The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

To enable the Total Area Coverage preview, select "Total Area Coverage" from the Quality Control
dropdown list and - if no Eye icon is visible yet, click on the "-" icon in front of "Total Area Coverage".

Once the Total Area Coverage preview is enabled, the image in the preview pane will be dimmed and all
areas where the sum of the densities is higher than the TAC limit will be highlighted. You can define the
highlight color in the Preferences: see Viewer Preferences on page 534

The Limit is the maximal Total Area Coverage that your document may contain. This value depends on
the press and the substrate your design will be printed on. Your printer should provide you with the TAC
Limit value to use.

By default, the TAC limit from the current Press Setting is used.

You can click inside the Limit field and change the Limit value, or you can use the arrow up key to
increase the TAC Limit value or the arrow down key to decrease the value. You can set the value up to
500%. You can hold the Shift key to increase or decrease the value 10 times faster. If the Limit matches
the TAC Limit of a Press Setting, the Press dropdown will change to that Press Setting, otherwise it will
show "custom". If you change the Press Setting in the Press dropdown, the TAC Limit will be adjusted to
the value from the Press Preset.

You can use the Densitometer to measure the densities at a specific location. See Measure Ink
Densities on page 513.

Note:  Invisible layers, invisible separations and Technical Inks are not taken into account.

Breakout
A Breakout is an area where the percentage of a single separation is lower than the First Printable Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

516



21DeskPack Advanced

To enable the Breakout preview, select Breakout from the Quality Control dropdown list and - if no Eye
icon is visible yet, click on the "-" icon in front of "Breakout". Once Breakout is selected and enabled,
all areas where a single separation has a value lower than the First Printable Dot value (but higher
than 0%), will be displayed in highlight color. You can define the highlight color in the Preferences: see
Viewer Preferences on page 534.

Your printer should provide you with the First Printable Dot value. The First Printable Dot value is the
same as used in the Flexo Print Preview. See Flexo Print Preview on page 518. The value is always
rounded off to the closest system value (n/255 in %).

By default, the settings from the current Press Setting are used.

You can click inside a field and enter the value, or you can use the arrow up key to increase the value or
the arrow down key to decrease the value. You can hold the Shift key to increase or decrease the value
10 times faster. If you change a value, the Press dropdown will change to "custom". If you change the
Press Setting in the Press dropdown, the settings will be adjusted to the values from the Press Preset.

Note:  Because breakouts are only highlighted if they are lower than (and not equal to) the
Limit value but higher than 0%, and because of the rounding off to the closest system value
(n/255 in %), the minimum value is 0,8%. When this value is entered, any breakouts that are
rounded off to 0,4% will be highlighted. If you also want breakouts of 0,8% to be highlighted,
you should enter the next value, i.e. 1,2%.

You can use the Densitometer to measure the densities at a specific location. See Measure Ink
Densities on page 513.

Note:  Invisible layers, invisible separations and Technical Inks are not taken into account.

Flexo Plate Preview
Flexo Plate Preview shows a single separation as a simulated flexo plate. In the Plate Color dropdown
you can choose the plate color (Cyrel Red, Cyrel Blue, Olive Green or Safran Yellow, or a High Contrast
Blue&White) to match the type of plate you are using.

Going from light to dark, the Preview will display percentages below the first dot percentage as 0%.
The first dot percentage will be shown darker (using the Prints As value). Towards the midtones this
darkening effect will fade out until the Range value. Any percentage larger than Range, is displayed
unchanged

To enable the Flexo Print Preview, select Flexo Print Preview from the Quality Control dropdown list
and - if no Eye icon is visible yet, click on the "-" icon in front of "Breakout".

Your printer should provide you with the First Printable Dot, Prints as and Range values. The First
Printable Dot value is the same as used in Breakout. See Breakout on page 516. The values are always
rounded off to the closest system value (n/255 in %).

By default, the settings from the current Press Setting are used.

You can click inside a field and enter the value, or you can use the arrow up key to increase the value or
the arrow down key to decrease the value. You can hold the Shift key to increase or decrease the value
10 times faster. If you change a value, the Press dropdown will change to "custom". If you change the
Press Setting in the Press dropdown, the settings will be adjusted to the values from the Press Preset.

You can use the Densitometer to measure the densities at a specific location. See Measure Ink
Densities on page 513

Note:  Invisible layers, invisible separations and Technical Inks are not taken into account.
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Flexo Print Preview
Flexo Print Preview shows the effect of highlight dot gain on your document. Going from light to dark,
the Preview will display percentages below the first dot percentage as 0%. The first dot percentage will
be shown darker (using the Prints As value). Towards the midtones this darkening effect will fade out
until the Range value. Any percentage larger than Range, is displayed unchanged

To enable the Flexo Print Preview, select Flexo Print Preview from the Quality Control dropdown list
and - if no Eye icon is visible yet, click on the "-" icon in front of "Breakout".

Your printer should provide you with the First Printable Dot, Prints as and Range values. The First
Printable Dot value is the same as used in Breakout. See Breakout on page 516. The values are always
rounded off to the closest system value (n/255 in %).

By default, the settings from the current Press Setting are used.

You can click inside a field and enter the value, or you can use the arrow up key to increase the value or
the arrow down key to decrease the value. You can hold the Shift key to increase or decrease the value
10 times faster. If you change a value, the Press dropdown will change to "custom". If you change the
Press Setting in the Press dropdown, the settings will be adjusted to the values from the Press Preset.

You can use the Densitometer to measure the densities at a specific location. See Measure Ink
Densities on page 513

Note:  Invisible layers, invisible separations and Technical Inks are not taken into account.

Moiré Detection
Using the Moiré Detection preview, you can detect possible screening problems in your document.

Using the filter, you can choose to only include objects with a density between two values, e.g.
5,1% and 94,9%. By enabling Ignore light separations you can choose to ignore separations with a
luminance higher than the Maximum Luminance.

If you enable Moiré Detection, the document will be shown dimmed, and areas with possible screening
problems are highlighted.

A possible screening problem exists if one of these conditions is met:

• the angles for the separations used in that area are the same
• the angles for the separations used in that area do not differ 30 degrees
• the rulings for the separations used in that area are different
• the dot shapes for the separations used in that area are different

You can enable or disable the toggles to only highlight screening errors matching the selected
conditions.

• If an unscreened object is involved, this is considered matching all of the conditions.

• Angles are considered the same if they differ a multiple of 90º. E.g. an angle of 7,5º and an angle of
97,5º will highlight as "Angles are the same".

• If the angles are the same, this is not highlighted as "Difference between angles is not 30º "

• All visible separations are taken into account. If you want to disregard a separation (e.g. a Technical
ink or a Processing Step Separation) you can hide that separation.

By default, the settings from the current Press Setting are used.
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You can click inside a field and enter the value, or you can use the arrow up key to increase the value or
the arrow down key to decrease the value. You can hold the Shift key to increase or decrease the value
10 times faster. If you change a value, the Press dropdown will change to "custom". If you change the
Press Setting in the Press dropdown, the settings will be adjusted to the values from the Press Preset.

Object Screening
Using the Object Screening Preview, you can get an indication of what Screening Set is used on what
objects.

The Quality Control section will show a list of all Screen Sets used in your file, each with a different
color. Objects using a specific screen set will show in the corresponding color. Areas where multiple
screen sets overlap are shown in red.

Using the eye icons, you can make the objects using the selected Screen sets visible or invisible.

For more information on Screening, we refer to the Ink Manager documentation (part of Esko Data
Exchange for Adobe Illustrator) here.

Registration Errors
The Registration Error Preview is a simulation of a design printed with registration errors. It can be
very helpful to see if trapping is applied suciently and correctly. To enable the Registration Errors
preview, select Registration Errors from the Quality Control dropdown list and - if no Eye icon is visible
yet, click on the "-" icon in front of "Registration Errors".

The Maximum Deviation defines the amount of registration error.

By default, the Registration Error Distance from the current Press Setting is used. If you change
the value, the Press dropdown will change to "custom". If you change the Press Setting in the Press
dropdown, the Maximum Deviation will be adjusted to the values from the Press Preset.

The separations are moved exactly the distance of the Maximum Deviation, but all under a random
angle.

If you want to see another random registration error simulation, press Y

 

 

In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

Compare
Using the Compare function, you can compare the current document with a Reference file

1. To enable Compare, select Compare from the Quality Control dropdown list.
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2. Set a Reference file. You can select any open file from the dropdown list, or select another file by
choosing Browse. If the Reference file contains multiple pages, you can define the page to be used.

3. If the Reference file contains multiple pages, you can define the page to be used.
4. If needed, (re)set the Alignment

Viewer will align the two documents, based on the common visual objects. If you make any edits,
e.g. change the visibility of specific elements, the documents will not be realigned automatically.
You need to click the Align on All button to realign the two jobs based on the new visual objects. If
you want to align the two jobs based on the selected objects, you can use the Align on Selection
button. If not enough common elements are found, the two jobs will be aligned using the bottom left
corner of their trim box. If the Trim Box is missing, the ArtBoard is used instead.

Note:  When nothing is selected, or when the Compare is already aligned on the current
selection, the Align on Selection button will be disabled.

5. Set the Separation Matching

• If all separations of the current document match with a separation in the reference document,
the button will show "Separations Matched"

• If there are separations in the current document that don't match a separation in the reference
document or vice versa, the button will show "Unmatched Separations"

• By clicking the button, you can open the Separation matching dialog
 

 
• Every separation in the current document that is not found in the reference document is

shown as Unmatched - Show Warning. You can match it with a separation from the reference
document by selecting it in the dropdown, or you can set it to Don't Compare

• The Unmatched reference separations at the bottom indicate what separations in the
reference document are not matched to a separation in the current document. You can set
these to Show Warning or Don't Compare
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• As soon as all unmatched separations are matched or set to "Don't Compare", the button will
change to Separations Matched

6. Compare the documents:

Viewer will calculate the visual differences. The job will be shown dimmed, and when Highlight
different pixels is enabled, the difference in pixels is highlighted. You also get an indication on the
number of areas containing visual differences, along with a notification in case the Separations list,
trim box or media box of the two documents don't match.

• Click the eye icon in front of Compare to toggle between differences view and normal view.
• Hold the C key to temporarily show the reference file instead of the current document. By using

this toggle, you can easily see the difference between both documents.

Note:  If any of the two documents is modified, you need to click the Update button to
ensure you are comparing the latest version.

21.2.6.  Technical inks and Processing Step Inks in Viewer

By default, all technical inks (Normalized PDF) or Processing Step Inks (PDF+) are shown in Viewer, and
rendered as opaque inks.

You can disable Show Technical Inks or Show Processing Step Inks in the fly-out menu of the
Viewer. In that case, technical inks or Processing Step Inks will not be shown in the Viewer, nor in the
separation list. However, if a technical ink or Processing Step Ink influences another separation (e.g. if
an object in a technical ink is knocking out the background), this will still be visible.

Even when shown, technical inks and Processing Step Inks have no influence on the Total Area
Coverage, Breakout or Moire Detection.

Technical inks and Processing Step Inks are also not included in the total ink value below the
separation list when measuring a color. See Measure Ink Densities on page 513

21.3.  The Viewer (deprecated) window

You can open the Viewer (deprecated) window by selecting Window > Esko > Viewer (deprecated) >
Viewer.

• Defining Press Settings works the same as in the Viewer window: see Define Press Settings on page
510

• Generating or updating the Preview is also the same as in the Viewer window. See Generate the
Preview on page 512. In Viewer (deprecated) no shortcut is available, and the menu item is
different: Window > Esko > Viewer (deprecated) > Generate/Update

• Navigating in the Preview is the same as for the Viewer window. See Navigating in the Preview on
page 513
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•

21.3.1.  Separations

The first viewing mode, Separations, shows a list of all used inks.

You have the same options as in the Separations List in the Viewer window: see The Separations list on
page 515

Scale Ink Densities
When viewing a document containing very dark overprinting areas (e.g. traps into dark colors) it is
sometimes dicult to examine the color composition of such areas in Viewer.

Therefore the Separations view mode offers a slider control to temporarily dim (= reduce the density
of) one or more selected separations.

For example: setting the density value to 50% will reduce the actual density values of the selected
separations by 50% when computing the composite (RGB) view.

Highlight
Transparency

This will highlight all objects that have an opacity percentage, a blend mode or an opacity mask
(regardless of what is underneath).

Overprint

Highlight Overprint will highlight the areas where an “overprint” setting in the paint style takes effect.

Screening Conflict

The Screening Conflict checkbox highlights areas where a screening conflict can occur. They can
occur if an object with transparency (opacity mask, opacity percentage or blend mode) is overlapping
on an object with another screening. The PDF definition clearly states that screening is always taken
from the topmost object, even if that object is completely transparent in some areas. In most cases,
this is not what you would expect.

In the example underneath, you can see a cyan rectangle, and a circle on top, with an opacity mask. The
objects have a different screening. Where the circle is on top of the cyan rectangle, the cyan will take
the screening of the blended circle. Therefore, as shown on the right, these areas will be highlighted as
Screen Conflict.
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Color

When you enable a Highlight option, the objects are highlighted in the color you chose in the Color
Picker.

21.3.2.  Total Area Coverage

The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

TAC Limit
The TAC Limit is the maximal Total Area Coverage that your document may contain. This value depends
on the press and the substrate your design will be printed on. Your printer should provide you with the
TAC Limit value to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. See Define Press Settings on page 510). By default the
TAC Limit is set to 270%.

Viewing areas over the TAC Limit

When you switch to the Total Area Coverage preview, the image in the preview pane will be dimmed
and all areas where the sum of the densities is higher than the TAC limit specified in the current Press
Setting will be displayed in the highlight color.
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Note:

You can Alt-Control-click (Windows) or Alt-Command-click (Mac) the black pixels to use the
densitometer tool, and to measure the actual TAC amount in that specific area. See Measure
Ink Densities on page 513.

To quickly see the maximum TAC in your document, use the TAC Limit slider.

Move the slider to the right to use a TAC Limit value higher than that used by your current Press
Setting. The more you move the slider to the right, the less pixels will typically be over the TAC Limit.

Note:  Technical Inks are not taken into account. See also Technical inks and Processing Step
Inks in Viewer on page 521

21.3.3.  Flexo Plate

If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first in the
list) will be shown as a simulated flexo plate.

Note:

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.
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First Visible Dot
The Flexo Plate preview will use the First Visible Dot percentage from the press settings (see The Press
Setting parameters on page 511).

Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas without
dots.

Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as areas
with dots.

Plate Color
The Flexo Plate preview predicts how clean your flexo plates will be. Especially in very light or very dark
areas, you could end up with isolated dots or holes on the flexo plate, and those areas are dicult to
hold on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast Blue&White)
to match the type of plate you are using.

21.3.4.  Flexo Print

This Viewer preview mode shows the effect of highlight dot gain on the image.
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This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview will
use the First dot and the Dot gain in highlights settings from the Press Settings (see Define Press
Settings on page 510).

Going from light to dark:

• The Flexo Print Preview will display percentages below the First visible dot percentage as 0%.

• The First visible dot percentage will be shown using the First Dot Prints as percentage.

• Percentages above the First visible dot percentage will be shown darker.

• Towards the midtones this darkening effect will fade out until the Range value.

• Percentages above the Range value are displayed unchanged.

21.3.5.  Registration Error

The Registration Error Preview is a simulation of a design printed with registration errors of a specific
press (defined in the Press Settings, see Define Press Settings on page 510). It can be very helpful to
see if trapping is applied suciently and correctly.

The Registration Error value is taken from the Press Setting you selected.

The separations are randomly shifted. In fact, all separations are moved exactly the distance of the
Registration Error, but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again button.

 

526



21DeskPack Advanced

 

In the example above, you can see a small area of a job in regular preview (left) and with registration
errors (right). In this case, you can clearly see no trapping was applied, so white lines appear at the
registration shifts.

21.3.6.  Breakout

A Breakout is an area where the percentage of a single separation is lower than the First Visible Dot
value. This can be used to track areas that won’t show up on print because the values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in the Press
Settings: see Define Press Settings on page 510.When switching to Breakout mode, the preview will
be dimmed and all areas where a single separation has a value lower than the First Visible Dot value
(but higher than 0%), will be displayed in highlight color.

You can measure the actual percentages in that specific area using the densitometer (see Measure Ink
Densities on page 513).
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Note:  Technical Inks are not taken into account. See also Technical inks and Processing Step
Inks in Viewer on page 521

21.3.7.  Moire Detection

Moire Detection allows to detect possible screening problems (Moire) in the file.

Note:  Moire Detection is not available when working in PDF+ mode.

You can set the options to highlight overlapping areas, to detect situations in which Moire might
occur:

• when the two overlapping areas have screening angles that do not differ 30 degrees.
• when the two overlapping areas have the same angle
• when the two overlapping areas have different rulings
• when the two overlapping areas have different dot shapes.

You can use the Ignore inks option to ignore inks that have

• a density lower than a certain value,
• a density higher than a certain value
• a Luminance higher than a certain value

as in all those cases, the Moire patterning will hardly be visible.

All these Moire Detection options are stored in the Press Settings. See Define Press Settings on page
510

Note:  Technical Inks are not taken into account. See also Technical inks and Processing Step
Inks in Viewer on page 521

21.3.8.  Viewer Compare Tool (deprecated)

You can use the Viewer Compare tool to compare the active document with another document.

To compare the active job:

1. Go to Window > Esko > Viewer (deprecated) > Compare...

The Compare dialog opens, and the name for the Current Document is shown.
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2. Select the file you want to compare the active document to:

• If you want to compare it to an open document, select its file name from the dropdown list
• If you want to compare it to a document on disk, click Open from this computer... and select the

file
• If you are connected to an Automation Engine SaaS server, and you want to compare to a

document from My Workspace, click Open from My Workspace and select the file.
3. Define what to compare:

• all artwork
• the current Artboard
• only Trim Box or Media Box (if they are defined)
• only the selected area.

4. Click OK

A Viewer Compare window will open, showing a comparison between the two jobs.

Note:

If you have a Trim Box defined in the Illustrator job, the Viewer Compare tool will only show
what’s inside the trim box.

The Viewer Compare window
The Viewer Compare window shows the two jobs and their differences, and contains a number of tools
and buttons to inspect these differences in various ways.

Move over a button with the cursor and the tooltip will indicate what it stands for.

Buttons with a triangle in the lower right corner contain additional options: Control-click (Windows) or
Command-click (Mac) the button, or click and hold the button to see the extra options.
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Navigating the Viewer Compare window
The Viewer Compare window contains different ways to navigate:

The Inspect tools
 

 

• The Zoom tool. Under the zoom tool you find

• Zoom out

• Fit document in view

• Fit document width / height

• Zoom to 1:1 view

• Show Zoom Options (showing all these options as individual buttons)

• The Zoom out tool
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• The Pan tool

The Navigator
By dragging the red rectangle (when zoomed in), you can navigate through the job.

 

 

The View options
The View options allow to go back to the previous view, or use additional settings, such as rotate,
invert or mirror the view.

 

 

Compare modes
Using the Compare butons, you can choose different Compare modes / views

 

 

• View Current version only
• View Reference version only
• View Both documents on top of each other.

Additional options:

• View Both in their original colors
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• View Both - Show difference: the differences will be shown in the "Added" and "Substracted"
highlight colors.

• View Both - highlight difference: same as above, but the identical parts are dimmed.
• View Both - only difference: same as above, but the identical parts are hidden.
• Change "Added" Highlight Color, Change "Substracted" Highlight Color and Change Both

Highlight Color, to change the colors in which differences are shown
• Reset Difference Highlight Colors to reset the default colors
• Channel Matching, to match corresponding channels/inks for the two documents.

• View Both - side by side shows both versions next to each other. You can choose between

• Automatic tiling
• Horizontal tiling
• Vertical tiling.

• View both - mirror reference shows the current document on top of the mirrored reference
document.

Alignment
Comparing files with different sizes may seem like a challenge as they are not aligned in the Viewer
Compare window, but it provides some tools that make it very easy.

 

 

• Alignment

• on one of 9 corner / center points
• Align From Ruler: see Align from Ruler on page 532
• Auto Align From Ruler: see Auto Align from Ruler on page 533
• Auto Align: see Auto Align on page 534

• Auto Align: see Auto Align on page 534
• Use trim box for alignment
• Offset, Horizontal and Vertical

Align from Ruler
The ruler tool works by defining two points (one in each file) that have to be aligned.

1.

Select the reference version of the file by clicking the  icon.
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2.

Select the Ruler tool 
3. Indicate the ruler anchor point

 

 
4.

Switch to the other version by clicking the  icon (or use Ctrl + S).

The anchor point, here in the red circle, will be in a different location in the second file version.
5. Indicate the point that should be positioned on the ruler anchor point (here in the blue circle)

 

 
6.

Click the Alignment button and select Align From Ruler. The files are now aligned.

Note:  Depending on how precisely you defined the second ruler point, you may have to
zoom in and repeat the alignment procedure to align your files with more precision.

Auto Align from Ruler
Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate at high
resolution.

If the details of the alignment points match, the viewer will be able to increase the alignment precision
(and have a good alignment with fewer iterations).
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Auto Align
Auto Align does not use the ruler, but rather the currently visible view of the two compared images to
attempt an automatic alignment.

For convenience, a separate tool button is available to perform an Auto Align operation without having
to open the Alignment pop-up menu. Clicking this button will perform an Auto Align from Ruler if a ruler
selection is active, otherwise an Auto Align (from view).

Viewer Compare Preferences
You can open the Compare Preferences by choosing Illustrator > Preferences > Esko > Viewer
Compare Preferences (on Mac OS) or Edit > Preferences > Esko > Viewer Compare Preferences (on
Windows).

You can define the resolution for the Viewer Compare previews: either based on the document size, or
at a fixed resolution. "Based on Document Size" will result in a low resolution for big documents, so e.g.
aligning will become more dicult when zooming in. On the other hand, a "Fixed Resolution" can result
in a very heavy preview calculation if the fixed resolution is high and the document is large.

You can define if anti-aliasing should be applied.

21.4.  Viewer Preferences

Open the Viewer Preferences dialog by choosing Preferences > Esko > Viewer Preferences or open
the Viewer (deprecated) Preferences dialog by choosing Preferences > Esko > Viewer Preferences
(deprecated).

You can set one or more of the following options:

Image Display Quality
This allows you to selected the preferred quality for displaying the contone images present in a
document.

• Low: A low resolution preview image (< 72dpi) will be used (if present). When such preview image is
not available, a gray box will be displayed.

• High: A preview image of at least 150dpi will be used. When such preview image is not available, a
gray box will be displayed. This is the default option.

• Very High: If sucient memory is available, the real data (not subsampled) of the image will be
displayed. When the image is too large to fit into memory (typically if the size is larger than 64MB) a
high resolution display image will be shown.

Anti-Aliasing
This preference offers control over the Anti-Aliasing method used to prevent display-artifacts like
rough (“blocky”) edges in rendered artwork.

• Off: Do not perform any anti-aliasing (default value, fastest).
• Low: Some anti-aliasing (slower).
• High: Highly accuracte anti-aliasing (slowest).
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Note:

Setting Anti-Aliasing to “High” will result in high-quality preview at the expense of significantly
slower rendering / viewing speed (up to ten times slower than when Anti-Aliasing is turned off).
It is advised to only use the “High” setting on fast workstations.

Densitometer Mode
This option lets you select the preferred resolution of the densitometer.

• Exact: Ink densities will be measured with an accuracy (resolution) of 1/255 percent. This
corresponds to the (8 bits per pixel) accuracy typically used by a Rip for outputting (unscreened)
separations. In other words what is measured will correspond “exactly” to the digital output of the
Rip.

• Rounded: Ink densities will be measured and presented with an accuracy of 1%. Densities with a
non-integral (e.g. 33.2%) value will be rounded to the nearest integral value (e.g. 33%).

If Densitometer Mode is set to "Rounded", the values shown in the Ink Coverage palette will also be
rounded.

Highlight Color
You can define the Highlight Color to be used for Total Area Coverage, Moire Detection etc. This option
is not availabe in Viewer Preferences (deprecated), as you can set the highlight color in the Viewer
(deprecated) window.

Press Settings Folder
This allows to define the folder from which the Press Settings should be loaded.

If no folder is set up, Viewer will try to use the default location: DeskPack Container/Settings/
Press. If there is no DeskPack Container mounted or available, then it will automatically switch
to Users/Shared/EskoArtwork/Settings/Press on macOS, or C:/Users/Public/
Documents/EskoArtwork/Settings/Press on Windows. The Viewer installer will automatically
create these folders.

If no Press Settings Folder is available (e.g. the defined or default folder has been removed), you will not
be able to change or create Press Settings.

Note:  If the Viewer Preferences and Viewer Preferences (deprecated) have different Press
Settings Folder defined, the Press Settings will not be shared between both Viewers.

21.5.  Ink Coverage

With Ink Coverage, you can calculate the ink usage for every ink.

1. Click Window > Esko > Viewer > Ink Coverage... to open the Ink Coverage dialog.
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2. In the dropdown, select the area you want to scan. By default, Ink Coverage is calculated on the

Current Artboard
3. Click Calculate

For every separation, the size (in square mm or square inch) and percentage of the total surface is
shown.

Note:  By setting the Densitometer Mode to "Rounded" in the Viewer preferences, the
values in the Ink Coverage palette will be rounded off.

4. Click Save as XML... to save the result of the Ink Coverage calculation into an XML file.
5. Click Close to close the Ink Coverage dialog.

Note:  Technical inks will not be presented in the list, nor in the exported XML.
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22.  White Underprint

22.1.  White Underprint

White Underprint allows you to create a white background underneath the selected objects. This white
background can be necessary when printing on transparent or metal material. The White Underprint
plug-in can generate white underprint objects for all kinds of Illustrator objects.

To open the White Underprint palette, click Window > Esko > White Underprint. The White Underprint
palette appears.

22.2.  Adding and Removing White Underprint

White Underprint objects will be created in a top-level "White Underprint" layer, and will be put in
overprint.

A new White Underprint layer will be created:

• If a different White Underprint ink is used
• If the White Underprint layer doesn't exist yet
• If the White Underprint layer was locked, hidden or no longer positioned as top layer.

1. Click Window > Esko > White Underprint to open the White Underprint palette.
2. Select one or more objects in the Illustrator document.
3. Set the White Underprint settings: see White Underprint settings on page 538
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4. In the White Underprint palette:

• Click Add to add White Underprint for the selected artwork: the plug-in will compute the union
of the selected artwork and add the resulting paths at the top of the White Underprint layer

• Click Subtract to subtract the selected artwork from the White Underprint layer. The plug-in will
compute the union of the selected artwork, and put the resulting paths at the top of the White
Underprint layer, in overprint, and at 0% of the selected White Underprint ink.

Note:  If you want the White Underprint to be slightly bigger than the original objects, you
should use a spread (an outward offset) when adding to the White Underprint layer, and a
choke (an inward offset) when subtracting from the White Underprint layer. If the White
Underprint should be slightly smaller, you should do it the other way around.

22.3.  White Underprint settings

To set up White Underprint:

1. Select Window > Esko > White Underprint to open White Underprint dialog box.
2. Define the Offset: the distance between the edge of the White Underprint layer and the edge of

the object under which White Underprint is applied. By default the offset is set to Spread (outward
offset). You can also choose to Choke (inward offset).

3. Set the Miter Limit as you would for trapping. Miter limit determines whether sharp corners in
objects appear pointed or beveled. You can also select Bevel and Round options.

Note:  The Miter Limit option is only available when using mitered corners.

4. Define if White Underprint should be generated only on visible parts of selected objects, by setting
the Only Visible Parts option.

5. In the Gradients section, set how to handle Gradients.

• None: By default objects with a gradient fill will be backed using a 100% solid white
• Choke by distance: a gradient will be added to the White Underprint layer. The gradient will be

choked over the entered distance, and run from the minimum % to 100%.
• Bump minimum %: a gradient will be added to the White Underprint layer. The gradient will

follow the same density as the original object, but values below the minimum % will be bumped
up to the minimum value.

• Clip to minimum %: a gradient will be added to the White Underprint layer. The gradient will
follow the same density as the original object, but values below the minimum % will be clipped to
0%.

22.4.  White Underprint Ink

The Ink used for White Underprint can be defined by selecting Options from the fly-out menu of the
White Underprint palette, and entering the name of the Ink to be used for White Underprint.
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In case the defined ink doesn't exist yet, a new spot color will be added to the swatches, using the Ink
name and the Color patch.

When the name of an existing swatch is entered, this ink will be used for White Underprint.

Note:  White Underprint can only use Spot Colors. If an existing swatch name is entered, and
the swatch is not a spot color, a warning will be generated: "A swatch by this name already
exists but is not defined as a Spot Color".

Multiple White Underprint inks can be used in 1 document. After you've applied White Underprint using
a first ink, just change the name and color patch of the White Underprint ink in the Options dialog. As of
then, any new White Underprint objects will be generated using the new White Underprint ink.

Note:  In order to prevent changes to existing White Underprint objects, be sure not to have
any active selections while changing the White Underprint ink. If you wish to modify the color
values of the existing White Underprint ink, please do so directly in the Swatch library.

22.5.  Include White Objects

The Include White Objects option can be set by selecting Options from the fly-out menu of the White
Underprint palette.

If the option is disabled (default), no White Underprint is generated for white objects (colored with
CMYK 0/0/0/0). By selecting the option, those objects will also get a White Underprint.

Note:  Uncolored objects (i.e. if the fill and the stroke color is set to "none") will never get a
White Underprint, regardless of this option.
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